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Informazioni sui diritti e i marchi
registrati

Questa guida, le  DPS RDR2 e RIO2, i dischi in dotazione e tutti i materiali ed essi
correlati sono © Copyright 1998, Digital Processing Systems Inc. Tutti i diritti sono
riservati.
La versione inglese stampata di questo documento è contrassegnata dal codice
707-3825. Il numero della versione è 1.1.
Traduzione e impaginazione a cura di Paolo e Roberto Castellano (1999 v.1.00)

Marchi Registrati
La DPS RDR2, la DPS RIO2 e Video Action sono marchi registrati della Digital
Processing Systems, Inc. Windows NT è un marchio registrato della Microsoft. Tutti
gli altri marchi registrati appartengono ai legittimi proprietari.

Avvertimenti
Le informazioni presenti in questa guida possono cambiare senza preavviso.
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CAPITOLO 1
INTRODUZIONE
Menù Principale e
Barra degli Strumenti

Timeline

Gallery

Video Action è un programma di montaggio(editing) dotato di straordinari effetti
speciali. E’ l’interfaccia con la vostra scheda di acquisizione video e permette la
digitalizzazione del materiale video da montare. Inoltre garantisce la possibilità di
lavorare con un’ampia scelta di file multimediali, con video, suoni, immagini e file di
sequenze animate. Fornisce una soluzione completa per il montaggio video al
computer con filtri, transizioni, effetti di chiave e animazioni, così come un ampia
scelta di tendine ed effetti preimpostati, con la possibilità di personalizzazione e/o
creazione ex-novo.
Durante l’installazione, Video Action riconoscerà automaticamente la scheda di
acquisizione DPS istallata caricando la versione ottimizzata per la scheda
posseduta. Questa guida descrive il funzionamento di Video Action in congiunzione
con la vostra DPS Perception RT.
In questa configurazione(con Perception RT) Video Action utilizza il doppio stream
video della scheda, visualizzando in tempo reale le transizioni e gli effetti.
L’acquisizione  dispone di un’interfaccia integrata per il Batch Capturing.
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Creare un filmato, con Video Action, implica alcuni passaggi :

1. Digitalizzazione
del materiale.

2. Utilizzo della
Gallery per
organizzare le
clip
multimediali

3. Utilizzo della
Timeline per il
montaggio

4. Riproduzione
del filmato
finale a monitor
e/o
registrazione su
nastro
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Digitalizzazione
La raccolta di tutto il materiale sorgente è il primo passo da compiere lavorando
con il video digitale. Esistono diversi tipi di fonti da cui attingere i contributi
multimediali utilizzabili per i vostri filmati. Questi possono provenire da CD-ROM,
dalla televisione  o dalla radio, da video e/o audio pre-registrato, da immagini
prestampate, da fotografie, da disegni, e da animazioni create con altri
software(Es.: disegno(paint) o di modellazione/animazione 2/3D). I  filmati saranno
digitalizzati in file RVA o RVD. L’Audio in ingresso sarà digitalizzato in file WAV. Le
immagini e i disegni potranno essere acquisite tramite scanner e saranno salvate
come file di immagini. Tutti questi files costituiranno le clip multimediali che userete
per il vostro montaggio.
Video Action permette la digitalizzazione del video analogico direttamente dal
videoregistratore. Usando le funzioni di acquisizione di Video Action si potranno
sfruttare formati di file speciali e il batch capturing.

La Gallery
Come in una galleria di quadri, la gallery di Video Action permette di raggruppare,
gestire e rifinire(trim) le vostre clip multimediali. Posizionando una clip nella gallery
vi sarà mostrata una miniatura per aiutarvi nell’identificazione della stessa. Sulla
gallery, potrete posizionare molteplici copie di una stessa clip. Per gestire le proprie
clips, si possono creare  tutte le gallery  che si vogliono. Si potranno usare  gallery
differenti per i vari tipi di clip, per  soggetto, per fonti (es., nastri diversi), o per tanto
altro ancora.

La Timeline
Dopo aver disposto le vostre clip su una gallery, potrete iniziare a montare
trascinando  le clip desiderate sulle tracce della timeline. Una volta sulla Timeline
potrete accedere alle tantissime funzioni di montaggio disponibili in  Video Action.
Potrete rifinire una clip, tagliandola in segmenti, aggiungendo indici, cambiando la
velocità di riproduzione, aggiungendo transizioni ed effetti, modificando la traccia
audio ed aggiungendo animazioni ed effetti di chiave. Con Perception RT sono
disponibili più di 200 transizioni in tempo reale. Inoltre sono disponibili, con
rendering, più di 1000 transizioni e più di 60 filtri, tutti impostabili a proprio
piacimento.
In ogni momento, durante il montaggio, sarà possibile visionare e verificare i
progressi del proprio lavoro con diversi tipi  di anteprima(preview). Potrete generare
automaticamente uno story board, stamparlo e presentarlo ai  clienti per
l’approvazione.
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Generazione del filmato
Una volta terminato il montaggio, potrete visionare il filmato direttamente dalla
Timeline. Tutte le clip e le transizioni RT saranno riprodotte in tempo reale, senza
tempo di rendering addizionale, nell’ordine in cui sono poste sulla timeline. Altri tipi
di clip, transizioni ed effetti (da renderizzare) devono essere renderizzati prima di
essere visionati. Una volta renderizzati tutti i segmenti  della Timeline sarà possibile
riprodurre il vostro filmato e registrarlo su nastro.
Con il comando Make Movie(Crea Filmato) otterrete un unico file video di grande
qualità. Il risultato finale costituisce un modo perfetto per l’archiviazione dei vostri
filmati.

Caratteristiche

Timeline
• Numero illimitato di tracce(Tracks) video ed Audio (Dipende dalla memoria

disponibile)A/V Scrubbing durante il montaggio.
• Numero illimitato di tracce (undo) (Dipende dalla memoria disponibile).
• Riproduzione in tempo reale dei file video di Perception RT (RVA e RVD).
• Il Rendering Selettivo, effettuato automaticamente solo dove necessario,

permette di “renderizzare”  solo l’effetto desiderato, conservandolo  durante
tutte le fasi di montaggio.

• Missaggio audio multicanale in tempo reale del volume e del bilanciamento.
• Riproduzione in tempo reale di illimitate tracce audio (Dipende dalla potenza del

computer – rendering audio in background quando vengono superate le reali
possibilità del computer).

• Funzioni di Copia ed Incolla su sezioni della Timeline (Clip Virtuali).
• Barre e toni per la riproduzione dalla Timeline.
• Creazione dello Storyboard.
• Creazione di un unico file video digitale del vostro filmato.
• Regolazione parametri Proc Amp in uscita.
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Transizioni ed Effetti
• Più di 200 transizioni differenti in tempo reale su cui è possibile applicare degli

effetti in tempo reale.
• Gli effetti in tempo reale impiegano immagini a 11bits.
• Creazione personalizzata delle transizioni in tempo reale (tramite file di

immagini per creare tendine a gradienti o sfumate).
• Dissolvenza da/a nero sulle clip in tempo reale.
• Accesso integrato ad inscriber CG, un avanzato generatore di titoli (i titoli statici

sono in tempo reale).
• Scorrimento di titoli da renderizzare con regolazione di bordi, trasparenze ed

ombre.
• Più di 1000 transizioni preimpostate da renderizzare.
• Personalizzazione delle Tendine(Wipes) usando le vostre sequenze in

Grafica/Video.
• La funzione “Transition WizardTM”permette di combinare degli effetti speciali,

delle grafiche e persino delle transizioni preesistenti creando delle transizioni
personalizzate.

• Più di 60 potentissimi filtri da applicare sulle immagini o su sequenze video. La
disponibilità di 100 “key-frames” per l’applicazione dei filtri fornisce una
flessibilità e un controllo impareggiabile. Spline ed interpolazione lineare. Le
proprie combinazioni di effetti sono salvabili e riutilizzabili.

• Visualizzazione instantanea degli effetti durante la creazione degli stessi.
• Effetti di chiave in Croma, Difference, e chiave con maschere in canale Alpha.
• Animazione(VSA) di finestre video su traiettorie curvilinee definibili tramite

Keyframing, con effetti 2D/3D.
• Supporto per filtri ed effetti con  moduli (Plug-In) compatibili.

La Gallery
• Gestione dei file multimediali.
• Supporto diretto per file di immagini e/o sequenze in più di 10 formatiSono

inclusi:  AVI, BMP, FLI/FLC, DIB, PCX, PCT, PHOTO CD, TGA, TIF, WAV e
JPG.

• Supporto per sequenze con 50/60 semiquadri al secondo.
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• Rifinitura di un clip, creazione di indici, divisione in più clip e copie multiple di
una stessa clip.

Acquisizione video ed interfacciamento hardware
• Ottimizzato per essere usato con Perception RT e con la sua interfaccia SCSI.
• Le dimensioni dei file  Perception RT (RVD) sono limitate dallo spazio sui propri

dischi( superando la limitazione di 2GB dei file di Windows).
• Semplice acquisizione video in modalità rapida (Quick Capture) e batch (Batch

Capture).
• La funzione di Crop rimuove i bordi neri  presenti sulle sequenze  video

acquisite.
• Generazione e supporto per EDL (Edit decision List) per il montaggio Offline
• Visualizzazione immediata su monitor video durante tutte le fasi di montaggio.
• Controllo dei Videoregistratori (Videoregistratori con interfaccia RS422)
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Requisiti di Sistema
Prima di  avviare Video Action bisogna che abbiate installato e configurato la vostra
DPS RDR2 con i suoi dischi SCSI dedicati e la scheda RIO2. Consultate la guida
della Perception RT per le istruzioni di installazione.
Video Action richiede Windows NT versione 4.0 o successiva. Sarà necessario un
lettore Cd-Rom per installare il software. Se intentede usare le 1000 Transizioni
fornite con il programma, dovrete lasciare inserito il CD durante  l’esecuzione di
video Action.  Se sceglierete l’installazione completa, saranno occupati circa
120Mb. L’acquisizione di video più audio richiede spazio disponibile anche sui
dischi di sistema per la memorizzazione dei file contenenti i dati audio. (I file che
contengono le immagini video saranno immagazinati sui dischi dedicati della
Perception RT)
Tuttavia, la tipologia di lavoro e di impiego determinano i requisiti del sistema. Ad
esempio, se il vostro prodotto finale è un video a piena risoluzione con un basso
rapporto di compressione delle immagini, potrebbe essere consigliabile un sistema
con più di 64 MB di RAM. Se state pianificando di elaborare un filamto con
numerosi e complessi effetti speciali, dovreste prendere in considerazione l’impiego
di una CPU molto veloce.
Per maggiori dettagli sui requisiti di sistema, per piacere, consultate la Guida di
Perception RT.
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Capitolo 2
Creazione di un filmato in tempo reale

Questo capitolo vi aiuterà a compiere i primi passi attraverso il processo di
creazione di un semplice filmato in tempo reale. Ricordatevi, che dovete installare
la vostra  Perpeception RT e formattare i suoi dischi dedicati, prima di poter usare
le clip in tempo reale con Video Action.
Avviate Video Action. Si apriranno una Timeline e una Gallery vuote, più la finestra
di anteprima(Preview). Per iniziare è necessario raggruppare o acquisire le clip
multimediali da usare e da disporre sulla Gallery.

Acquisizione delle clip usando Quick Capture
(Acquisizione Rapida)

Catturerete le clip da Video Action usando la funzione Quick Capture. (Se
disponete di un VTR con porta di comunicazione RS422 collegata al vostro
computer, sarà possibile usare anche la funzione di Batch Capture. Questo
argomento è trattato nel Capitolo 3: Acquisizione)
Per abilitare la funzione Quick Capture:

Passo 3: Acquisite il vostro
video:

Inserite una cassetta
nel vostro
videoregistratore Dopo
aver premuto Play,
dovreste riuscire a
vedere il vostro filmato
sul monitor e sentire il
suono proveniente dagli
altoparlanti
Premete il pulsante
rosso di registrazione
(rec) per avviare
l’acquisizione, il
pulsante Stop (verde)
per terminarla. Premete
sul pulsante (save)  col
dischetto nero per
salvare i file acquisiti.

Passo 1: Premete sul
pulsante di
Acquisizione
presente sulla
barra dei Titoli
della Gallery

Passo 2: Modificate i
parametri  di
Quick Capture:

A. Premete il pulsante
dei parametri e
selezionate il formato
video desiderato

B. Inserite un nome per
il file di acquisizione

C. Definite la
compressione
( in MB/s)

D. Selezionate il
percorso per i vostri
file da acquisire

E. Definite i parametri
per l’acquisizione
dell’audio
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Quando salvate i filmati acquisiti tramite Quick Capture, state creando un file RVA
ed un file RVD ad esso associato. Dopo essere stata salvata, ogni  clip apparirà
sulla gallery come miniatura di se stessa. Quindi sarà possibile acquisire un’altra
clip o tornare sulla Gallery.

Visionate la vostra clip
Una volta sulla Gallery, la clip potràessere visionata in due dfferenti modalità. Se
premete una sola volta sulla immagine della miniatura, la clip sarà visualizzata sul
monitor video. Se premete due volte sul nome della miniatura, si aprirà il pannello
di VA Player  che vi permetterà di visionare e rifinire la clip stessa.
Se volete vedere una breve elenco delle proprietà(properties) della vostra nuova
clip vi basta premere con il tasto destro del mouse sulla miniatura. Se desideraste
aggiungere una descrizione o  un titolo alla vostra clip, aprite il menù Edit (in alto
sotto la barra della finestra di Video Action) e selezionate Edit Clip

VA Player
Usando il VA Player vi trovate davante un avanzato pannello di controllo con cui
visualizzare(play) o rifinire(trim) una clip.

Controllo Jog/Shuttle

Durata

Barra di Scrub

Modalità di Riproduzione

Barra di Trimming e degli
Indici

Divide la clip agli indici

Avanza di un fotogrammaIndicatore Fotogramma Corrente

Play tra i punti in ed out

Stop

Play

Aggiunge/Cancella gli indici

Chiude senza salvare cambiamenti

Indietro di un fotogramma
Riproduzione ciclica

Salva i cambiamenti

Imposta In

Imposta out
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Per visualizzare una clip usate i pulsanti di controllo posti vicino l’angolo in alto
destra della Finestra del VA Player. Potrete  esaminare la clip tramite la barra di
scrubbing posta sul lato  sinistro della finestra.
Si possono impostare dei punti indice sulla clip, da usare come riferimento quando
la si rifinisce(trim), quando la si mette in relazione ad altre clip e ogni volta che
servano punti di riferimanto.  Per impostare un punto indice o marcatore, spostatevi
sul fotogramma dove intendete inserilo e premete sul pulsate con il triangolino
giallo. All’indice sarà dato il numero mostrato alla destra del pulsante.
La linea gialla sotto la barra di ***scrub*** mostra i tempi(relativi) di ingresso (in) ed
uscita della clip(linea rossa) ed ogni indice impostato (quadrati blu).Usate le frecce
agli apici di questa linea per spostarvi da undice all’altro. Se avete posizionato un
indice, potrete tagliare la clip in quel punto premendo il pulsante SPLIT at Index
(dividi all’indice). Saranno create due clip che appariranno automaticamente sulla
Gallery.
I tempi(relativi) di ingresso ed uscita della clip sono mostrati sotto i comandi di
riproduzione (play). Potrete usare i pulsanti In e Out per impostare dei nuovi tempi
di ingresso e di uscita. Quando impostate dei nuovi tempi, la linea gialla sotto la
barra di ***scrub si accorcierà in funzione della nuova durata. Usate i tasti freccia
posti alla sinistra dei tempi di ingresso ed uscita per spostarvi con il cursore sui
rispettivi tempi.La durata della clip è mostrata sotto la barra di scrub. Ognuno di
questi tempi può essere bloccato con la pressione del pulsante verde alla fine
dell’indicazione del tempo.
Dopo aver rifinito la vostra clip, per uscire salvando i cambiamenti effettuati
premete il pulsante OK . Per uscire senza alcun salvataggio, premete Cancel.
VA player dispone di alcune combinazioni di tasti per la scelta rapida dei comandi.
Premendo con il tasto destro del mouse, su qualsiasi punto del pannello di VA
player, apparirà un elenco di queste combinazioni.

(Per una completa trattazione del VA Player si rimanda al capitolo 4)

Lavorando con le Clip sulla Timeline
Una volta  raggruppate le clip sulla gallery, si pùo cominciare a  posizionarle sulla
finestra della Timeline. Per posizionare una clip sulla Timeline basta
semplicemente premere su una miniatura e trascinarla sulla traccia video prescelta.
La clip video sarà riconoscibile tramite il nome relativo al file nell’angolo in basso a
sinistra. Per vedere le proprietà della clip, premete con il tasto destro del mouse
sulla clip stessa e selezionate CLIP INFO dal menù a comparsa.
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Avendo posizionato le clip sulla timeline, potreste visionarle sia premendo una sola
volta sulla freccia posta al centro della clip (PLAY) sia con una doppia pressione
(doppio click)   su di esse richiamando ul pannello del VA PLAYER. Si possono
impostare i punti di ingresso e di uscita della clip direttamente accorciandone le
due estremità. Se imposterete i punti di in e out, sarà mostrata sulla timeline solo la
sezione compresa tra i due punti stessi. Con la pressione del pulsante Timeline/clip
index, il piccolo triangolo giallo presente sulla barra degli strumenti(tool bar),
potrete aggiungere e rimuovere i punti indice.
Per vedere la traccia audio delle clip, premete il pulsante della traccia
video(Es:V1,V2,V3,V4,...Vn) posto sulla sinistra della timeline. La traccia audio
apparirà sotto la corrispondente traccia video. Le tracce audio e video possono
essere rimanere attaccate o separate con la pressione del pulsante SPLIT/REJOIN
presente sulla barra degli strumenti(tool bar). Per ripristinare il collegamento di una
traccia audio con la sua traccia video dovete selezionare la traccia audio che
desiderate ricollegare.

Transizioni
Sovrapponete due clip sulle tracce V1 e V2, vi apparirà, nell’area di
sovrapposizione, la barra delle transizioni. La transizione predefinita è la
dissolvenza incrociata(Cross fade). Ogni transizione è modificabile permettendovi
di scegliere come debbano fondersi le immagini per passare da una clip all’altra.
Video Action dispone di un grande  numero di transizioni predefinite e fornisce tutti
gli strumenti per definirne delle proprie.
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Se le clip poste su V1 e V2 sono dei file RVA o RVD la transizione predefinita sarà
visualizzabile in tempo reale. Le transizioni eseguibili in tempo reale impegnano i
due stream offerti dalla vostra Perception RT. Se le clip non sono file RVA o RVD,
(AVI,BMP, etc.) la transizione predefinita sarà una transizione da renderizzare. In
questo caso posizionate i file RVA acquisiti con Quick Capture sulle tracce V1 e
V2.
La pressione del tasto destro del mouse su una transizione aprirà il menù delle
transizioni. Per scegliere le transizioni in tempo reale si deve selezionare RT
transition. Il pannello di selezione delle transizioni in tempo reale permette la scelta
tra più di 200 transizioni personalizzabili. La pressione su una delle miniature
presenti determina la scelta di una transizione differente. Dopo aver premuto su OK
la transizione mostrata sulla timeline sarà sostituita con una nuova icona.

Dissolvenza Da/A Nero
La pressione del tasto destro del mouse sulle clip  RVA ed RVD consente
l’attivazione dell’opzione RT fade. Si aprirà una finestra che vi permetterà di
dissolvere dal nero e/o dissolvere a nero. Potrete specificare il numero di
fotogrammi (frames) da usare per la dissolvenza. Potrete scegliere, al posto del
nero, anche un altro colore tra quelli disponibili.

Effetti da Renderizzare
Potrete aggiungengere un ampia varietà di effetti da renderizzare a qualsiasi clip o
transizione da renderizzare. Questi effetti vi offriranno diverse opzioni. Potrete
aggiungere qualsiasi filtro o effetto disponibile alle vostre clip e personalizzare ogni
effetto adattandolo alle vostre esigenze. Potrete aggiungere effetti multipli per ogni
clip. Una lista di effetti mosterà un elenco di tutti gli effetti selezionati. Potreste
selezionare dal semplice blur fino alla complessa Animazione Video 3D(VSA). Tutti
gli effetti da renderizzare richiedono dei tempi di calcolo prima di essere visualizzati
e saranno illustrati nei Capitoli 7/8/9.
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Titoli
Video Action impiega file di immagine TGA a 32bit, che hanno un canale alpha
interno, come titolazione fissa in tempo reale. Potete creare questi file TGA a 32bit
usando Inscriber CG, che è stato incluso con Video Action RT. Inscriber CG è
accessibile direttamente dalla Gallery: selezionate Inscriber CG dal menù aperto
con la pressione del tasto destro del mouse nella finestra della Gallery .
Se aprirete Inscriber CG dalla Gallery, ogni file che voi salverete sarà posizionato
automaticamente sulla Gallery.
Per creare un titolo in tempo reale salvate un file TGA con Inscriber CG.
Posizionate le clip sulle tracce V1 e V2. Posizionate il titolo sulla traccia V3 (o su
una traccia successiva V4;V5;V6;Vn). Potete incrementare la durata della clip TGA
sulla timeline spostando il cursore alla fine della clip e  trascinando il bordo della
clip stessa.

E’ possibile utilizzare anche dei Titoli da renderizzare tramite il generatore di titoli
incluso negli effetti di Video Action.  Potrete usarli per sovraimporre del testo sulle
vostre clip senza creare un file separato. I titoli realizzati in questa maniera
necessiteranno di tempo per il rendendering prima di essere visualizzati.
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Editing Audio
Premendo sull’icona(posta sul lato sinistro della timeline) di una qualsiasi traccia
video aprirete sotto la relativa traccia audio. La traccia audio aperta mostrerà il
livello del volume. Potete modificare la linea del livello da 0% fino 200%.

Potrete creare un nodo con la pressione del tasto del mouse sulla linea del volume.
Regolate il volume trascinando i nodi verso l’alto, il basso, a destra o a sinistra.
Il bilanciamento(Balance) dei canali destro e sinistro e la forma d’onda(Waveform)
sono visualizzabili tramite la pressione del tasto destro del mouse sulle icone delle
tracce video e selezionando l’opzione voluta. E’ possibile contrallare il
bilanciamento allo stesso modo del volume.( Per maggiori informazioni consultate il
capitolo 10).

Rendering
Una barra verde chiaro, posta sopra le tracce video e audio, indica che quella parte
del progetto è pronta per essere visualizzata o inserita in un filmato senza alcuna
elaborazione. Le clip RVA, RVD e le transizioni in tempo reale(RT Transition) non
necessitano di elaborazione e presenteranno questa barra verde chiaro  sopra ed
in corrispondenza delle rispettive tracce.
Se userete altri tipi di clip o effetti e transizioni da renderizzare, la barra verde
chiaro diventerà bianca. Queste sezioni dovranno essere elaborate o renderizzate
prima di poter essere visualizzate o inserite in un filmato.  Tutte le parti non
renderizzate del vostro filmato, saranno renderizzate ed elaborate quando
trasformerete il vostro filmato in unico file digitale. Per renderizzare una sezione
non renderizzata dovete premere sull’area bianca della traccia da renderizzare, si
apriranno delle finestre che vi guideranno durante tutto il processo di elaborazione.
 Le sezioni elaborate saranno indicate con una barra verde scuro. Se le clip
contrassegnate dalla barra verde scuro saranno spostate o cambierete un effetto o
una transizione,  dovranno essere renderizzate di nuovo.
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Anteprima(Preview) e Visualizzazione(Playback)
Se il vostro filmato è composto solo da clip RVA e RVD, da transizioni RT e titoli
TGA, potrete visualizzarlo dalla timeline  in tempo reale senza alcuna
elaborazione.Premete la barra spaziatrice della tastiera per visualizzare tutte le clip
presenti sulla timeline dalla posizione del cursore in avanti. É possibile visualizzare
un anteprima di una sezione della timeline trascinando il cursore eviziando la zona
desiderata. La zona evidenziata sarà visualizzata sul monitor video. Terminata la
visualizzazione, per poter rivedere l’anteprima della zona evidenziata, premete “p”.
Per interrompere l’anteprima in qualsiasi momento, premete il tasto ESC.
Se le sezioni del vostro filmato richiedono rendering la zona evidenziata per
l’anteprima sarà  visualizzata in modalità a taglio. Le clip a cui sono state
assegnate degli effetti  non ancora renderizzati saranno visualizzate, durante
l’anteprima, con le loro immagini inalterate.Dove è presente una transizione non
renderizzata dalla traccia A alla traccia B, saranno visualizzati prima i fotogrammi
sulla traccia A e poi quelli della traccia B. Ci sono diversi modi di farsi un’idea del
montato senza dover necessariamente impiegare del tempo per  un render
completo. Per maggiori informazioni consultate il Capitolo  5 – Anteprima

Creazione del Filmato
La  barra gialla sopra le tracce etichettata “Movie”  indica la zona della timeline  che
sarà trasformata in unico  file video.  Potete regolare i tempi di inizio e fine
trascinado le due estremità. Alternativamente, con la doppia pressione del tasto
sinistro del mouse sulla barra gialla, si aprirà una finestra che permetterà di inserire
numericamente i tempi di inizio e fine.
Per generare il filmato dovete richiamare dal Menù Movie il comando Make Movie.
Selezionate RVA File Output, Scegliete la  destinazione e il nome del file RVA per
generare la clip del filmato.
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Il Filmato sarà generato secondo i parametri fissati precedentemente nel Menù
Movie Output Settings. Se userete i parametri predefiniti (NTSC.ost o PAL.ost) il
filmato sarà registrato come un file RVA e il suo associato file RVD. Se si desidera
salvare il filmato in formato avi dovrete cambiare il tipo di compressore desiderato
nella finestra Movie Output Settings.
La generazione di unica clip di un filmato  che impiega solo file RVA e transizioni
RT sarà un processo molto veloce.  Diversamente se vi sono parecchi effetti
renderizzati, la generazione del file può richiedere tempi rilevanti a seconda dal
numero di clip e dagli effetti presenti. Durante tutta la fase di generazione
comparirà una barra di stato che vi informera sull’ andamento dell’elaborazione da
parte del computer.

Creazione di un Fermo Immagine(still/freeze frame)
Se si desidera salvare un fotogramma di una clip come un file di immagine, dovete
spostare il puntatore della timeline sul fotogramma da salvare e selezionate da
menù Movie>Make Single Frame. Il formato dell’immagine usato sarà quello
impostato nella finestra Movie settings Images.

Generare un Clip audio(WAV)
Se si desidera salvare la colonna sonora del vostro filmato o una traccia audio di
una clip come file Wav è necessario  definire tramite la barra gialla Movie i punti
d’inizio e fine della timeline da trasformare e quindi selezionate Movie>Make
Movie>WAV file output.
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Capitolo 3: L’acquisizione

Video Action dispone di due modalità di acquisizione che si integrano
completamente con le vostre schede RDR2 e RIO2. La modalità Quick Capture
permette di acquisire direttamente clip singole semplicemente avendo del segnale
video in ingresso. La modalità Batch Capture permette di specificare i timecode che
serviranno per acquisire le clip e a controllare il videoregistratore affinchè registri
un elenco di clip. La modalità Batch Capture è stata progettata per essere
impiegata in conbinazione con i videoregistratori collegabili al vostro computer e
controllabili tramite il protocollo Rs-422.
Le modalità di acquisizione permettono di specificare l’ammontare della
compressione video e della qualità audio. I file sono registrati in file di tipo RVD
(real time video) e di tipo RVA (real time video con audio)
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Quick Capture
Quick capture permette di digitalizzare il video in ingreso, di creare i file RVA e/o
RVD. I file RVD contengono le immagini video che sono immagazzinate sui dischi
SCSI connessi alla scheda DPS RDR2. I file RVA contengono i dati audio
memorizzati sui dischi di sistema  ed un puntatore al file RVD associato.
Per  aprire la finestra Quick Capture: premete sul pulsante di Acquisizione presente
sulla barra della Gallery

Il timecode delle clip

Acquisizione Video, Audio,
E-E-Display

Abilita drop Frame; Non Drop Frame
Timebase(solo in NTSC)

La compressione in MB/s

Il nome della clip

Apre i la finestra per i controlli del
volume

Impostazioni della qualità Audio

Il percorso dei file RVD sui dischi
PVR RT

Il percorso dei file RVA sui dischi di
sistema

Abilita il limite di acquisizione della
durata prestabilita
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Impostazioni per Quick Capture
Prima di acquisire si dovrebbero controllare i parametri della finestra  Quick
Capture.
Parametri Video
La pressione del pulsante Video settings aprirà la finestra di configurazione.

Per poter cominciare l’acquisizione si deve selezionare il tipo di ingresso video.
Dopo aver selezionato l’ingresso diventeranno attivi i selettori del Proc Amp
settings. Usate il pulsante DEFAULT per reimpostare tuuti i selettori ai valori
predefiniti. Spostateli se intendete regolare il segnale in ingresso. La scheda  PVR
RT elabora il segnale video in ingresso attraverso la sua circuiteria e la manda al
monitor video in uscita. Potete verificare il risultato sul segnale video di ciascun
selettore in tempo reale direttamente sul monitor video.

Imposta il tipo di ingresso Video:
Composito,S-VIDEO, Component(CAV) o
D1

Questo pulsante riporta tutti i selettori ai
parametri standard CCIR

Le regolazioni del segnale video in
ingresso: si può verificare il risultato di
ciascun selettore direttamente  sul monitor
video in tempo reale.le regolazioni
possono essere fatte durante
l’acquisizione.

Opzioni addizionali per l’acquisizione
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Sono presenti in basso a questa finestra altre 3 opzioni aggiuntive:
• PADDING: Questa opzione vincola l’utilizzo della stessa occupazione di

memoria per tutti i fotogrammi della clip, col fattore di compressione impostato
(in MB/s). Quando questa opzione non è attiva, il programma di acquisizione
adotta un fattore di compressione dinamico, che comporta una differente
occupazione per ogni fotogramma, per beneficiare al massimo della
compressione. Tuttavia, se intendete modificare i singoli fotogrammi di una clip
(ad esempio dei fotogrammi di un’animazione), la dimensione dei nuovi
fotogrammi potrebbe diventare più grande di quella dei fotogrammi originari (per
la compressione dinamica) causando dei problemi.  Se attivate il Padding si
riserveranno lo stesso spazio per i dati di tutti i fotogrammi, in tal modo i nuovi
fotogrammi avranno sempre spazio a sufficienza.

• Create RVA: Quando questo riquadro è attivato, viene creato un file RVA per
ogni cattura, anche quando non si registra l’audio. Questo vi potrebbe essere
utile per l’organizzazione delle vostre clip. Se questa opzione non è attiva, le
clip senza audio saranno registrate solo come file RVD.

• Audio Skew: Alcuni Videoregistratori hanno un lieve ritardo quando riproducono
il suono da un nastro. L’impostazione dell’Audio Skew vi permette di ritardare di
0-3 fotogrammi la cattura delle immagini video relative alla cattura audio, in
modo da compensare il ritardo.

Drop Frame/ Non drop frame (per il formato NTSC)
Il Non-Drop Frame Time Code  è una modalità di time code (nel sistema NTSC)
che identifica ogni fotogramma video con una sequenza numerica divisa in ore,
minuti, secondi e fotogrammi. A causa della discrepanza tra i 30 fps e gli attuali
29.97 fps, questa modalità non rappresenta in maniera accurata la durata reale di
un programma video. Generalmente il suo utilizzo è quindi limitato a programmi di
durata molto breve (spot pubblicitari) oppure ad applicazioni non-broadcast. Con
questo sistema ogni ora vengono contati 108 fotogrammi in più rispetto alla realtà.
Ciò si traduce che quando questo time code indica 01:00:00:00, il tempo reale è
invece di un’ora e 3.6 secondi. Per non andare incontro ai problemi di questo tipo di
time code, viene generalmente utilizzato il Drop Frame Time code come riferimento
corretto. Nel Drop Frame Time Code , ogni minuto non vengono numerati due
fotogrammi per “colmare” questa discrepanza. Pertanto in questo time code, alla
dicitura 01:00:00;00 (si noti il punto e virgola prima dei fotogrammi) corrisponde
perfettamente un’ora di video.
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Il pulsante <:/;> del Quick Capture vi permette di selezionare, quando lavorate in
NTSC, il tipo di time code che desiderate. Questo verrà utilizzato durante tutte le
operazioni di Video Action, come ad esempio durante la rifinitura (trimming) delle
clip, oppure durante l’aggiunta di indici.
E’ comunque possibile cambiare il tipo di time code ad una clip già catturata
cliccando con il tasto destro del mouse sulla miniatura della clip, nella Gallery. Nel
menù che appare vi è infatti una selezione per il drop frame. Una volta che la clip è
sulla Timeline, potete cambiare il Timecode selezionando la clip ed utilizando il
menù principale per selezionare Edit> Clip> Time-code clip che vi permette di
aprire la stessa finestra.

 Il Nome del File di Cattura
Prima di ogni acquisizione, selezionate un unico nome che identifica il materiale da
acquisire e inseritelo nel riquadro Capture Filename. Con questo nome, quando si
acquisisce una clip, saranno creati un file RVA e  l’associato file RVD.

 Qualità
Impostate la qualità del video da acquisire in MB/s inserendo il valore desiderato
nell’apposito riquadro (Quality). E’ bene notare che per un acquisizione senza
perdita apparente è necessario usare almeno 3MB/s per il video Composito,
4,5MB/s per il S-Video e 6 MB/s per il video component. Se desiderate conservare
più spazio sui dischi e se nello stesso tempo l’alta qualità non è necessaria, potete
comunque assegnare  valori più bassi di quelli suggeriti.

Limite di Cattura
Il riquadro Capture Limit imposta la durata massima di acquisizione per ogni clip.
La durata assegnata al Capture Limit non sarà vincolante, potrete premere il
pulsante Stop in qualsiasi momento per terminare l’acquisizione.  Se non si
conosce la durata della clip che si intende catturare potete disattivare il riquadro
Capture limit.
Si ricorda che il tempo disponibile per la cattura dipende  dalla quantità di spazio
rimasto libero sui dischi e dalla compressione utilizzata.
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RVA/RVD Directory
Questi riquadri permettono di selezionare il percorso di destinazione dei file RVA e
dei rispettivi file RVD. La directory per i file RVA  dovrà essere sui dischi di sistema.
La Directory per i file RVD sarà una cartella nei dischi SCSI della PVR RT. Fate
attenzione al fatto che non potete salvare i file video nella directory radice di un
disco Perception RT. Per salvare i file dovete necessariamente creare una cartella
all’interno della radice tramite il Perception RT Manager.
Prima che cominciate a catturare, pensate di creare directory separate per ogni
progetto, in modo da organizzare meglio e rendere più accessibili le clip. Utilizzate
queste directory quando specificate i percorsi dei file RVA ed RVD.

Cattura Audio
Mettete a punto i parametri per la cattura audio  (tasso di campionamento,
stereo/mono, e bit dei dati) secondo la qualità audio desiderata. Ad impostazioni di
qualità audio più elevate corrispondono file RVA di dimensioni maggiori.
Assicuratevi che la directory temporanea dispone di spazio a sufficienza per
registrare le informazioni audio durante la cattura. Catturando alla qualità CD
(44.1KHz/16 bit/stereo), un file audio, della durata di 5 minuti, occupa circa 70 MB.

Alla pressione del pulsante del controllo Volume corrisponde l’apertura del mixer
audio del sistema. Per vedere il mixer di registrazione, selezionate Opzioni>
Proprietà di Registrazione. Il mixer vi consente di controllare il livello audio
durante la cattura e la riproduzione. Potete regolare i livelli spostando i cursori del
volume.

Utilizzo del  Quick Capture
1. Avviate il Quick Capture ed effettuate le vostre impostazioni.
2. Inserite una video cassetta nel vostro VCR e premete il tasto play. Dovreste

vedere le immagini nel vostro monitor video ed ascoltare il suono provenire
dai diffusori acustici. Quando vedete delle immagini video che volete
catturare, premete sul pulsante rosso Record.

3. Fermate la cattura premendo sul tasto verde Stop. Se impostate un limite di
cattura, questa s’interromperà automaticamente quando viene raggiunto il
limite di cattura.

4. Salvate la clip che avete appena catturato utilizzando il pulsante nero Save to
disk. Ciò creerà una file RVA costituito dai dati audio e da un puntatore per il
file RVD salvato nel disco Perception RT. Noatate che non dovreste mai
rinominare i file RVD o RVA tramite la gestione delle risorse di Windows. I
puntatori dei file RVA non sarebbero più in grado di trovare i file RVD loro
corrispondenti.

5. La vostra nuova clip appare nella Gallery come miniatura. Potete poi
registrare un’altra clip o uscire dal Quick Capture.
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Utilizzando le funzioni del Quick Capture è molto semplice sovrascrivere una clip
non salvata. Tutte le clip indesiderate non varranno quindi salvate. Prima della
sovrascrittura viene dato un avvertimento per evitare di sovrascrivere clip
considerate utili.
Non è possibile catturare un file con lo stesso nome di un file salvato in
precedenza.

Batch Capture

Visione d’Insieme

FIGURA n.1 PAG.25

La funzione Batch Capture di Video Action vi consente di controllare un
videoregistratore esterno per digitalizzare clip multiple da una videocassetta
sorgente. Il Batch Capture richiede:
Un VTR in grado di essere controllato dal protocollo RS-422
Un convertitore di protocollo RS-232/RS-422 (come il DPS Part #774-542)
collegato alla porta seriale RS-232 del computer
Un cavo di collegamento tra il convertitore e la porta RS-422 del VTR
Una volta che il VTR è stato collegato al computer, Video Action può controllarlo. E’
poi possibile creare una lista di cattura batch che specifica i tempi di In e di Out di
ogni singola clip.

Uno degli utilizzi principali della cattura batch è la creazione di clip a bassa
risoluzione che possono essere utilizzate per il montaggio. Quando siete pronti per
creare il video finale, potete catturare nuovamente le stesse clip (solo le parti
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realmente utilizzate) a piena risoluzione e farle sostituire automaticamente da
Video Action a quelle a bassa risoluzione.

Accesso all’Interfaccia del Batch Capture
La modalità di cattura base di Video Action è quella Quick Capture. Per commutare
la modalità in batch capture, cliccate con il tasto destro nella Gallery e selezionate
Capture Mode. Selezionate RT – Batch Capture. Potete fare la medesima
selezione, quando la finestra Timeline è attiva, tramite File> Preferences> Capture
Method.

Utilizzazione del Batch Capture
Una volta che avete selezionato la modalità Batch Capture, cliccate sul pulsante di
Cattura posto sulla barra con il nome delle Gallery. In questo modo appare
l’interfaccia del batch capture.

FIGURA n.1 PAG.26
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Prima che cominciate la cattura, è necessario che modifichiate alcune
impostazioni. Cliccate sul pulsante Settings (quello con tre levettine). Dovete
effettuare una serie di opearzioni: selezionare il formato video, la porta di
comunicazione utilizzata dal vostro VTR, la compressione espressa in MB/s, e
operare le impostazioni di proc amp. Una volta che avete fatto le giuste
impostazioni, potete salvarle (nel formato .brs) in modo che possiate utilizzarle
nella colonna Settings (impostazioni) della lista di batch capture.

FIGURA n.1 PAG.27

Nella parte alta della finestra delle impostazioni trovano posto le Opzioni Generali.
Selezionate l’ingresso video dal menù a scomparsa. Selezionate dal relativo menù
a scomparsa la porta di comunicazione utilizzata per il
Controllo del VTR.
Nella sezione delle Opzioni generali sono presenti due quadri di selezione.

• Create RVA: Quando questo riquadro di selezione è attivo, viene creato un file
RVA per ogni file RVD catturato, anche quando non viene registrato l’audio.
Questo potrebbe essere utile per l’organizzazione di tutte le clip in una
directory RVA. Se questo riquadro non è attivo, le clip senza audio vengono
registrate unicamente come file RVD.
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• Sticky Mode Jog/Shuttle: Normalmente, quando utilizzate lo jog/shuttle nella
finestra di batch capture, quando lo rilasciate, il controllo si posiziona sullo
stop. Selezionando lo Sticky Mode, lo Jog/Shuttle rimane nel punto in cui si
trova quando lo rilasciate.

Una volta che avete selezionato l’ingresso video desiderato, vengono attivati i
relativi controlli di proc-amp.  Utilizzate il pulsante Default per impostare tutti i
cursori sui livelli CCIR standard, oppure muovete i cursori stessi per regolare il
segnale video. L’hardware Perception RT permette il passaggio del segnale
attraverso i propri circuiti, dall’ingresso all’uscita per il monitor; pertanto è possibile
vedere in modo interattivo, in tempo reale, quali effetti sortiscono le variazioni dei
controlli.
Potete utilizzare la sezione Quality per impostare la compressione video che verrà
utilizzata per la cattura, così come un’altra opzione, il Padding.

• PADDING: Questa opzione vincola l’utilizzo della stessa occupazione di
memoria per tutti i fotogrammi della clip, col fattore di compressione impostato
(in MB/s). Quando questa opzione non è attiva, il programma di acquisizione
adotta un fattore di compressione dinamico, che comporta una differente
occupazione per ogni fotogramma, per beneficiare al massimo della
compressione. Tuttavia, se intendete modificare i singoli fotogrammi di una clip
(ad esempio dei fotogrammi di un’animazione), la dimensione dei nuovi
fotogrammi potrebbe diventare più grande di quella dei fotogrammi originari
(per la compressione dinamica) causando dei problemi. Se attivate il Padding
si riserveranno lo stesso spazio per i dati di tutti i fotogrammi, in tal modo i
nuovi fotogrammi avranno sempre spazio a sufficienza.

Alcuni Videoregistratori hanno un lieve ritardo quando riproducono il suono da un
nastro video. L’impostazione dell’Audio Skew vi permette di ritardare di 0-3
fotogrammi la cattura delle immagini video relative alla cattura audio, in modo da
compensare il ritardo.
Se state lavorando nel sistema NTSC, avete bisogno di sapere il tipo di timecode
utilizzato durante la registrazione della videocassetta sorgente. Molti
videoregistratori con una porta di controllo RS-422 mandano un segnale che
permette al programma di determinare quale tipo di timecode utilizzare, tra drop
frame (;) o non-drop frame (:). Ad ogni modo non tutti i videoregistratori sono dotati
di questa caratteristica, e vi impongono quindi di impostare il tipo di timecode
tramite il quadratino di selezione Override. Quando quest’ultimo è segnato viene
utilizzato un timecode non-drop frame. Se segnate sia il quadratino Override che
quello Drop Frame, verrà utilizzato un time code Drop Frame.
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Una volta che siete soddisfatti delle vostre impostazioni, avete la possibilità di
salvarle per un utilizzo futuro. Cliccate sul pulsante Save e sarete in grado di dare
un nome al file delle impostazioni di Batch Capture. Se avete già salvato un file che
volete riutilizzare, è sufficiente premere sul tasto Load per ripristinare tutte le
informazioni. Una volta che cliccate sul tasto OK posto sul fondo della finestra delle
impostazioni, le impostazioni correnti saranno utilizzate come impostazioni di base
per la corrente batch list.
Una volta che siete soddisfatti di tutte le impostazioni siete pronti per creare una
lista di Batch Capture. Inserite la vostra cassetta sorgente nel VTR e utilizzate i
pulsanti posti nella parte alta della finestra per controllare il VTR. Il timecode verrà
mostrato in numeri turchesi. Una volta che avete localizzato la sezione che volete
usare come clip, siete pronti per immetterla nella batch list.
Tutte le voci immesse nella batch list possono essere modificate, semplicemente
cliccandoci sopra. Le voci della BatchCapture List sono:

• View: Cliccate qui per riprodurre la clip dal punto di In a quello di Out senza
catturare la clip

• Reel: Potete assegnare un qualsiasi nome al nastro

• Clip: Potete assegnare un qualsiasi (unico) nome/numero

• Status: Mostra lo stato di cattura della clip. Prima della cattura questo potrebbe
essere una linea tratteggiata (inattivo) o Capture. Dopo la cattura questo
potrebbe essere Done, Recapture o Incomplete.

• Source In ed Out: i tempi di In e di Out della clip. Potete cambiare questi tempi
scrivendo con la tastiera i timecode desiderati. Potete anche evidenziare i
tempi di IN (cliccando sul riquadro In) e poi cliccare sul timecode del VTR
mostrato nella parte alta della finestra Batch Capture per uniformare il tempo di
In a quello corrente

• V/A: Solo video, solo audio, entrambi

• Audio: Le impostazioni delle qualità audio disponibili verranno mostrate
cliccando sul riquadro Audio

• Settings: Utilizzate il file di base o caricate il vostro file personalizzato per le
impostazioni di formato video, compressione, proc-amp, etc. Potete anche
selezionare Custom, per cambiare l’impostazione di proc amp per una clip
singola nella lista di batch capture.
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• Note: E’ possibile corredare ogni voce con una nota. Le note così immesse
possono comparire nella gallery assieme alle relative miniature.

La locazioni delle directory di cattura possono essere variate utilizzando i pulsanti
posti nella parte bassa della schermata di Batch Capture. La directory RVA è la
directory di sistema che utilizzerete per i vostri file RVA. La directory Video è la
directory dei dischi SCSI collegati alla Perception RT che utilizzerete per i vostri file
RVD. Ricordate che avete bisogno di creare una cartella per le vostre clip di
cattura. Non potete catturare direttamente nella directory radice dei vostri dischi
Perception RT. (Utilizzate il Perception RT Manager per creare nuove cartelle nei
vostri dischi Perception RT. Consultate la guida utente del sistema Perception RT
per ricevere  maggiori dettagli.) La directory Audio è quella directory che verrà
utilizzata quando registrerete solo l’audio (come file WAV). L’ammontare di spazio
rimanente in ogni directory è mostrato per aiutarvi a determinare se disponete di
sufficiente spazio per la cattura.
Dopo che avete completato la vostra lista di Batch Capture, assicuratevi di salvarla
utilizzando il pulsante Save. Se volete riordinare le voci presenti nella lista, è
sufficiente che clicchiate sulla prima colonna per posizionare nell’ordine desiderato
le voci componenti la lista.
Premete il pulsante Begin Batch Capture per iniziare la registrazione. I numeri dei
timecode mostrati nella parte alta della finestra di cattura diventano rossi una volta
che le clip sono state registrate. Se volete arrestare la Batch Capture premete il
tasto <Esc> della vostra tastiera.
Quando tutte le clip saranno state catturate, saranno immesse nella Gallery attiva
con le relative note che avete loro assegnato. Se aprite una nuova Gallery e
collezionate queste stesse clip RVA, queste clip non conterranno le note (le note
fanno parte della gallery non delle clip). In ogni caso, se aprite la Gallery che avete
utilizzato durante il processo di Batch Capturing (con le note connesse alle clip), e
trascinate le clip da questa Gallery in un’altra nuova, assieme alle clip saranno
trasportate anche le relative note.

TRUCCHETTO: Arresto della Batch Capture

Se cercate di registrare delle clip utilizzando una lista di cattura batch che contiene
un timecode che non esiste sul nastro , il VTR continuerà  a cercare il timecode
mancante. Premete <Esc> per fermare la cattura
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Batch Recapture

Se avete utilizzato la cattura batch per creare clip a bassa risoluzione per le
operazioni di montaggio, vorrete catturare le clip in alta risoluzione per il risultato
finale, sostituendo le clip a bassa risoluzione con quelle ad alta sulla timeline.
Video Action è dotato di una funzione di Batch ReCapture per rendere
automatizzato questo processo.
Prima di cominciare il processo di batch recapture potete accedere al menù delle
impostazioni tramite la selezione di File> Preferences> Recapture Settings.

Una volta regolate le impostazioni con i parametri desiderati  selezionate dal menù
Movie>Batch Recapture

La finestra Batch Recapture visualizza le stesse voci della finestra Batch Capture.
La colonna Settings vi indicherà l’uso delle nuove impostazioni di cattura. Se
questa colonna indica “Default”, sarrano usate le impostazioni predefinite
(assegnate in File>Preferences>ReCapture Settings). La Batch Recapture list
impiega i punti di ingresso ed uscita delle clip presenti sulla vostra Timeline per le
nuove clip da riacquisire. Dovreste salvare questa lista cliccando sul pulsante Save
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Prima di iniziare il processo di Batch Re-Capture controllate le directory relative ai
file RVA e RVD indicate nella parte inferiore-destra della finestra. Se volete
registrare in directory differenti è possibile cambiarle usando i relativi pulsanti. Per
iniziare il processo di Batch Re-Capture cliccate sul pulsante GO. Se non avete già
salvato la vostra Timeline vi verrà proposto di farlo. Quindi vi sarà chiesto di
controllare che il natro corretto sia inserito nel VTR. Una volta confermato ciò
inizierà l’acquisizione. I numeri di Timecode posti nella parte inferiore della finestra
diverranno rossi.
Una volta che il processo di acquisizione è completamente terminato vi sarà
chiesto il permesso di sostiture tutte le vecchie clip sulla Timeline con le nuove.
Potete sostituirne una all volta oppure tutte cliccando “Yes to all”. Quando sostituite
le clip sulla Timeline
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Capitolo 4: La Gallery

Introduzione

 FIGURA n.1 PAG.33

La Gallery di Video Action rappresenta un modo molto semplice per collezionare e
mostrare i vostri file multimediali. Questo flessibile organizzatore multimediale, vi
permette di tenere a disposizione clip video, clip audio, immagini e animazioni.
Una volta che sono nella Gallery, le clip possono essere riarrangiate in modo da
aiutarvi a decidere l’ordine di riproduzione delle stesse. Una volta che avete
dislocato le clip nel modo che ritenete più opportuno, è possibile stampare la
Gallery in modo da definire un semplice storyboard.
Cliccando due volte sulla miniatura della clip, appare il VA Player. Questo vi
consente di poter rifinire (trim) la clip, modificando i punti di In e di Out della clip, di
posizionare degli indici e di procedere all’eventuale split at index (separa agli indici)
che permette di ottenere clip multiple a partire da una sola.
In Video Action, la Timeline e la Gallery sono integrate perfettamente. E’ possibile
spostare le clip, tramite “Drag and Drop” da una Gallery alla Timeline, da una
Gallery ad un’altra o dalla Gestione delle Risorse di Windows® ad una Gallery. E’
possibile utilizzare Gallery multiple per un unico progetto in modo da poter
raggruppare assieme diversi tipi di clip.
Dall’interno della Gallery è possibile anche avviare programmi di titolazione forniti
da terze parti, come Inscriber CG o Alpha CG. Cliccate col tasto destro all’interno
della Gallery, nel menù che appare saranno presenti i programmi di titolazione
disponibili. Entrando in questo modo in un programma di titolazione, i file che
vengono salvati vengono automaticamente posizionati nella Gallery.
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Avviare una Gallery

Utilizzazione della Gallery di Base
Quando avviate Video Action vengono aperte tre finestre: una Timeline vuota, una
Gallery vuota e una finestra di preview (anteprima). La Gallery vuota viene
chiamata Untitled.gy. L’estensione .gy viene utilizzata da Video Action per
identificare il file Gallery. Ogni volta che salvate una Gallery, automaticamente
viene aggiunta al nome l’estensione .gy. La gallery vuota di base può essere
utilizzata se volete una nuova Gallery quando aprite Video Action.

Creazione di una nuova Gallery
Per creare una nuova Gallery utilizzate il menù principale File>
New, oppure utilizzate il pulsante New Gallery posto sulla barra
degli strumenti. Apparirà una finestra con nome Untitled#.gy (dove
# viene incrementato di un’unità ogni volta che viene creata una
Gallery).

Apertura di una Gallery preesistente
Per aprire una Gallery preesistente utilizzate il menù principale File>
Open, oppure premete il tasto Gallery Open posto sulla barra degli
strumenti. Dalla finestra “Open Gallery File”, selezionate la Gallery che
desiderate aprire, e cliccate su OK.



       Video Action RT

______________________________

36

Collezione e Posizionamento delle Clip nella Gallery

Semplice Collezione di Clip
Per aggiungere delle clip ad una Gallery, utilizzate il pulsante il pusante
posto sulla barra che reca il nome della Gallery, oppure il menù
principale tramite la voce File> Collect. Facendo ciò appare una finestra
che vi permette di selezionare le clip multimediali che volete aggiungere
nella Gallery.

Picture n.1 Pag.35

Se volete collezionare un tipo specifico di file multimediale, potete cambiare il “List
File of Type” da “All Multimedia File”(tutti i file multimediali) a quello desiderato.
Fate ciò cliccando sul triangolino che nasconde un menù che permette la
selezione.
Cercate i file che desiderate aggiungere cambiando i campi “Drives” e “Directories”
e poi evidenziando i/il file specifici/o. I vostri file RVA si strovano su un disco di
sistema, mentre i file RVD si trovano nel disco della Perception RT. Utilizzate il
pulsante Add per immettere i file nella lista di quelli selezionati. Potete selezionare
file multipli, accompagnando al click del mouse la pressione costante del tasto Crtl,
oppure selezionare file contigui accompagnando al click del mouse la pressione del
tasto SHIFT. Quando avete selezionato tutti i file che volete collezionare, cliccate
su OK. Una volta che i file sono stati collezionati, appaiono nella finestra Gallery.
Oltre alla collezione, per aggiungere file ad una Gallery è possibile utilizzare il
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trascinamento dello stesso dalla gestione delle risorse di Windows®, oppure da
un’altra Gallery.
Per rimuovere una clip dalla Gallery, selezionatela cliccandoci sopra, e poi premete
il tasto <Canc> sulla tastiera. Fate attenzione al fatto che quando una clip viene
aggiunta o cancellata da una gallery, questa viene immediatamente aggiornata per
rispecchiare immediatamente lo stato corrente. Per questo motivo non è
necessario salvare le gallery per registrare i cambiamenti.

Collezione di Sequenze di Immagini
Video Action vi dà la possibilità di collezionare direttamente sequenze di immagini.
Potete produrre queste sequenze di immagini se state lavorando con un
programma di animazione che prevede l’esportazione come sequenza di immagini,
o se avete utilizzato una scheda di cattura video che prevede l’output come una
sequenza di immagini in alta risoluzione. La sequenza risultante può essere
importata nella gallery come una singola clip, e poi disposta direttamente sulla
timeline per permettervi di aggiungere ad essa effetti video, suoni e
sovraimpressione su clip video.

Per collezionare un’intera sequenza di immagini nella Gallery, selezionate “Enable
Image Sequence Collection” nella finestra di collezione. Dopo aver fatto ciò,
evidenziate la prima immagine nella sequenza e cliccate su Add. Le immagini con
la stessa base per il nome, con numero ascendente di sequenza, tipo di estensione
di file, dimensione del fotogramma, e profondità cromatica, che si trovano nella
stessa directory, saranno automaticamente raggruppati come sequenza.

Quando state per creare la vostra sequenza di immagini, datele il nome utilizzando
il formato:
nomeXXXX.yyy
“nome” è nome costante di 4 caratteri utilizzato per l’intera sequenza
“XXXX” è il numero del fotogramma/immagine cominciando da 0001
“yyy” è il tipo di estensione del file su cui si basa la sequenza
Il primo fotogramma della sequenza dovrebbe essere nome0001.yyy, il secondo
nome0002.yyy, e così via. Video Action supporta 9 tipi di formati d’immagine dove
“yyy”=BMP, DIB, FLC, GIF, JPG, PCT, PCX, TIF o TGA.
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Quando avviate la collezione delle immagini, appare una finestra che vi permette di
impostare delle opzioni.

PICTURE n.1 Pag.37

Il nome della prima immagine in sequenza viene mostrato nella parte alta della
finestra.
Il numero di immagini trovate nella directory viene mostrato nel riquadro “number of
files in sequence”. Potete cambiare questo valore se volete collezionare un numero
inferiore di immagini.
Dal momento che Video Action può operare a 60 file per secondo, possono essere
utilizzate immagini rappresentanti i semiquadri per mantenere la qualità più alta
possibile. Vengono rilevati cinque tipi di semiquadri.  Questi verranno mostrati in
una sezione successiva.
Potete impostare il numero di fotogrammi/secondo da utilizzare per creare la clip
sequenza di immagini nella Gallery. Potete impostare questa da 1 fps a 32 fps.
Infine, potete selezionare l’opzione posta nella parte bassa della finestra per
utilizzare le opzioni che avete selezionato come impostazioni di base per le
sequenze, senza che vi compaia ogni volta la finestra delle opzioni.

Il nome della prima immagine

Il numero dei file in sequenza

Gestione  dei field(Semiquadri)

Numero di fotogrammi per
secondo

Numero di fotogrammi per
secondo

Clicca Ok per iniziare il
caricamento. Cancel per uscire.
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Gestione dei Semiquadri delle Sequenze Di Immagini
No fields – utilizzate questa quando non è contenuta un’informazione per i
semiquadri nei file d’immagine della sequenza. Le linee individuali di ogni
fotogramma non sono associate ai semiquadri dipari e pari. Il numero dei file di
immagine è uguale a quello del numero di fotogrammi.

Interlaced, field order A –Ogni file d’immagine è un fotogramma che contiene sia i
semiquadri dispari che quelli pari, interlacciati in un singolo file d’immagine. Il
numero dei file è uguale a quello dei fotogrammi.

Interlaced, field order B – Ogni file d’immagine è un fotogramma che contiene sia
i semiquadri dispari che quelli pari, interlacciati in un singolo file d’immagine.
L’ordine dei semiquadri è inverso rispetto a quello field order A, con le linee pari
che vengono lette prima di quelle dispari.

Fotogramma 1
- - Linea 1 - -
- - Linea 2 - -
- - Linea 3 - -
- - Linea 4 - -

etc...

Fotogramma 2
- - Linea 1 - -
- - Linea 2 - -
- - Linea 3 - -
- - Linea 4 - -

etc…

Fotogramma 1
- - Linea 1 - -
- - Linea 2 - -
- - Linea 3 - -
- - Linea 4 - -

etc…

Fotogramma 2
- - Linea 1 - -
- - Linea 2 - -
- - Linea 3 - -
- - Linea 4 - -

etc…

Fotogramma 1
- - Linea 2 - -
- - Linea 1 - -
- - Linea 4 - -
- - Linea 3 - -

etc…

Fotogramma 2
- - Linea 2 - -
- - Linea 1 - -
- - Linea 4 - -
- - Linea 3 - -

etc…
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1 filed per file, order A – Ogni file d’immagine contiene solo un semiquadro. Il
numero di file è pari al doppio del numero di fotogrammi, dal momento che due file
sono necessari per garantire i due semiquadri di un fotogramma. Ogni fotogramma
è metà dell’altezza, dal momento che contiene solo le linee pari o dispari.

1 filed per file, order B – Ogni file d’immagine contiene solo un semiquadro. Il
numero dei file è pari al doppio del numero di fotogrammi, dal momento che due
file sono necessari per garantire i due semiquadri di un fotogramma. Ogni file è a
metà altezza, dal momento che contiene solo le linee pari o dispari. L’ordine dei
semiquadri e rovesciato se confrontato con il field order A, vengono letti prima i file
contententi le linee pari

Formati di Clip Supportati da Video Action
Video Action Supporta i seguenti tipi di formati video, audio, d’immagine e
d’animazione:

Video
RVA/RVD   Formato di file utilizzato dalla DPS RDR2. I file RVD sono immagini

video, e i file RVA sono i file audio uniti a legami associati ai file video
RVD.

Fotogramma 1
Semiq. Dispari
- - Linea 1 - -
- - Linea 3 - -
- - Linea 5 - -

etc…

Fotogramma 1
Semiq. Pari
- - Linea 2 - -
- - Linea 4 - -
- - Linea 6 - -

etc…

Fotogramma 2
Semiq. Pari
- - Linea 2 - -
- - Linea 4 - -
- - Linea 6 - -

etc…

Fotogramma 2
Semiq. Dispari
- - Linea 1 - -
- - Linea 3 - -
- - Linea 5 - -

etc…

Fotogramma 1
Semiq. Dispari
- - Linea 1 - -
- - Linea 3 - -
- - Linea 5 - -

etc…

Fotogramma 1
Semiq. Pari
- - Linea 2 - -
- - Linea 4 - -
- - Linea 6 - -

etc…

Fotogramma 2
Semiq. Dispari
- - Linea 1 - -
- - Linea 3 - -
- - Linea 5 - -

etc…

Fotogramma 2
Semiq. Pari
- - Linea 2 - -
- - Linea 4 - -
- - Linea 6 - -

etc…
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AVI Formato Audio/Video interlacciato, sviluppato da Microsoft per
permettere la sincronizzazione dei file audio e video. Viene ottenuto
interlacciando ogni fotogramma video al suono associato. L’AVI
supporta numerosi valori di fotogrammi/secondo,  varie dimensioni dei
fotogrammi, colori, tipi di compressione, etc.

Audio

WAV            Formato di file audio utilizzato da molti computer. Supporta vari tassi
di campionamento e risoluzione, così come stereofonia e monofonia.

Immagine/Animazione

BMP Questo formato bitmap è nativo per Windows ed è comunemente
utilizzato da molti programmi Windows ed OS/2.

DIB Questo formato di file fu progettato per essere indipendente, per la
rappresentazione, da hardware specifico. Viene utilizzato come
schermo comune per varie applicazioni per trasferire informazioni
relative ad immagini. Questo formato può essere letto, ma non scritto,
da Video Action.

FLI/FLC  Sviluppato primariamente da Autodesk per applicazioni CAD ed
animazione. Questi formati non supportano né più di 256 colori, né
tantomeno audio. Video Action legge entrambi i formati, ma esporta
solo nel formato con più colori FLC.

GIF Graphic Interchange Format, sviluppato da CompuServe, per l’utilizzo
su Internet.

JPG Joint Photographic Expert Group (JPEG) ha sviluppato questo
standard per fornire una compressione che minimizzi l’impatto su
informazioni imporatnti perl a visualizzazione dell’immagine. Questo
formato fornisce uno dei migliori risultati disponibili per l’alta
compressione.

PCX Sviluppato dalla Zsoft Corporation per uno dei primi programmi di
Paint, PC PaintBrush. E’ un formato comune per molti programmi di
desktop publishing. Il PCX può supportare colere a 24bit.

PCT Nativo della piattaforma Macintosh, i file PCT possono utilizzare sia
vettori grafici che bitmap. Questo flessibile formato può supportare il
colore a 24bit.

Photo CD Sempre più popolare, il formato Kodak Photo CD è spesso utilizzato
per trasferire immagini ad alta risoluzione su compact disk. Questo
formato può essere letto ma non scritto da Video Action.
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TGA Sviluppato dalla TrueVision per i suo hardware a pieno colore, questo
formato è ampiamente utilizzato nell’immagine professionale e nelle
applicazioni di colore. Questo formato può supportare file a colori a
32bit che includono informazioni interne di Alpha Channel (canale
Alfa).

TIF Sviluppato dalla Aldus primariamente per immagini scansite, il formato
TIF è utilizzato da moltissimi programmi di uso comune. Il TIF supporta
sia formati compressi che non compressi. La compressione TIFF LZW
è lossless (senza perdita). Questo formato è molto utilizzato sia dalla
piattaforma PC, che da quella Mac.

WPG Il formato di grafica di Wordperfect era stato sviluppato per essere
utilizzato con il programma di video scrittura Word Perfect.Questo
formato può essere letto ma non scritto da Video Action.

Lavorare con le Clip nella Gallery

               Visionare le Clip in una Gallery
Le clip nella Gallery vengono normalmente viste come miniature, immagini in
formato francobollo utilizzate per rappresentare le clip. Per le clip audio, la
miniatura mostrerà una forma d’onda generata dai primi secondi del file WAV.
Potete cambiare le dimensioni delle miniature selezionando View> Size e
scegliendo tra small, medium e large.

Punto Rosso = Filmato
Punto Blu      = Immagine
Punto Verde = clip Audio
Punto Giallo = Sequenza  di Immagini

Click sulla immagine miniaturizzata per riprodurre la clip
Doppio Click per aprire il pannello VA Player
Click sul titolo per selezionare la clip senza riprodurla

Il punto nero sull’angolo
destro indica che la clip e’
cambiata da quando è
stata caricata e potrebbe
non essere più disponibile.

Il nome del file seguito da
un numero in parentesi
indica la copia di una clip
già presente nella Gallery
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Sono disponibili altre opzioni per la visualizzazione delle clip
nella Gallery. Potete vedere delle informazioni addizionali
assieme alle immagini in miniatura selezionando View>
Tumbnail and Note oppure  View> Tumbnail and Detail.
Potete anche vedere le informazioni sulla clip unicamente
nella forma testo, senza l’immagine in miniatura,
selezionando View> Detailed Text.

Proprietà di una Clip
Le informazioni sulla clip possono essere mostrate cliccandoci sopra con il tasto
destro e selezionando Clip Info o selezionando dal menù principale View> Clip
Information. Le informazioni sulla clip includonoil nome della clip, la locazione, la
dimensione dei fotogrammi, il tipo di file, la dimensione del file, la qualità audio, la
durata, ed il nome ed una nota assegnate dall’utente. Questo titolo e queste note
possono essere editate cliccando con il tasto destro sulla clip e selezionando Edit
Clip oppure selezionando la clip e la voce Edit> Edit Clip  dal menù principale.
Potete anche editare informazioni di timecode per le clip video cliccando sopra le
clip con il tasto destro e selezionando Time-Code.

SUGGERIMENTO: OTTENERE INFORMAZIONI SULLA CLIP

Informazioni su una qualsiasi delle clip presenti nella gallery può essere ottenuta
cliccando con il tasto destro sulla clip. Appare un clip con informazioni specifiche
sulla clip. Cliccate sulla clip per far scomparire questa finestra.

Arrangiamento delle Clip
Per selezionare una clip, cliccate sulla clip (con il tasto sinistro). Il nome della clip
sarà evidenziato. Per muovere una clip, selezionatela e trascinatela sulla posizione
di un’altra clip. La clip appare nella nuova posizione, e tutte le altre clip vengono
spostate a destra di un posto.
Per cancellare una clip, selezionatela e premete il tasto <Canc> sulla tastiera.

Ordinare le Clip Automaticamente
Normalmente le clip vengono dislocate nella gallery secondo l’ordine in cui sono
state collezionate. Potete scegliere ordinare le clip nella gallery  per Nome, Tipo di
File, Dimensione (Size) o Data, selezionando View> Sort By dal menù principale.
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Lavorando con le gallery

Proprietà di una Gallery
Le informazioni di su una gallery sono costituite da Nome, data di Salvataggio,
dimensione del File Gallery, numero di immissioni (entries) dimensioni delle
miniature ed una breve descizione ed un titolo assegnati dall’utente tramite il menù
Edit> Edit Gallery.

Divisione della Gallery
Selezionate le clip di una Gallery preesistente da utilizzare per la creazione di una
nuova gallery. Premete il pulsante <Ctrl> per selezionare più di una clip  od il tasto
<Shift> per selezionare più di una clip. Selezionate Edit> Split Gallery dal menù.

Stampa di una Gallery
Potete stampare una gallery sia selezionando l’icona della stampante posta sulla
barra degli strumenti, sia selezionando  File> Print dal menù. Vi apparirà una
finestra per le impostazioni di stampa. Selezionate l’escursione di stampa e cliccate
su OK per mandare la Gallery alla stampante.

Chiusura di una Gallery
Per chiudere una gallery, selezionate la specifica finestra gallery e selezionate
File> Close dal menù, oppure cliccate sulla X posta nella barra titolo della gallery.
Ciò non cancella la Gallery, ma la chiude semplicemente nel progetto corrente.
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Utilizzo del VA Player
Quando cliccate due volte sulla miniatura di una clip, questa viene aperta
utilizzando il VA Player. Il VA Player vi permette di riprodurre la clip, di trimmarla, di
aggiungere punti indice, e di sub-dividere la clip creando nuove miniature nella
gallery.

PICTURE n.1 PAG.44

Il numero posto nell’angolo in alto a sinistra mostra il timecode del frame mostrato
attualmente. Subito al di sotto di questo ci sono dei pulsanti verdi che permettono
di abilitare o disabilitare lo scrub Fuzzy Logic o l’audio, e che indicano se il file
contiene dati video.
La barra di controllo dello jog/Shuttle blue e grigiaposta al di sotto dell’inidicatore
del timecode può essere utilizzata per i movimenti in aventi e indietro sulla clip.
Quando l’opzione Fuzzy Logic è abilitata (la freccia verde posta al di sopra della
barra è accesa), se effettuate lo scrub a velocità costante, automaticamente verrà
abilitata la riproduzione della clip. La barra di scrub posta al di sotto dello
jog/shuttle può essere utilizzata per lo scrub sulla clip. Le freccie poste alle
estremità della linea di scrub possono essere utilizzate per andare all’inizio o alla
fine della clip.
La linea gialla al di sotto della linea di scrub mostra i tempi di In e Out (le linee
rosse) e tutti i punti indice che avete impostato (i quadratini blu). Utilizzate le frecce
poste alle estremità di questa linea per muovervi da un indice ad un altro.
Per impostare un punto indice, portati sul fotogramma sul quale volete mettere
l’indice e cliccate sul triangolino giallo. All’indice verrà dato il numero mostrato alla
destra del pulsante. Potete evidenziare questo numero e cambiarlo su qualsiasi
valore desiderato. Dopo che avete aggiunto un punto indice, il numero verrà

Controllo Jog/Shuttle

Durata

Barra di Scrub

Modalità di Riproduzione

Barra di Trimming e degli
Indici

Divide la clip agli indici

Avanza di un fotogrammaIndicatore Fotogramma Corrente

Play tra i punti in ed out

Stop

Play

Aggiunge/Cancella gli indici

Chiude senza salvare cambiamenti

Indietro di un fotogramma
Riproduzione ciclica

Salva i cambiamenti

Imposta In

Imposta out
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incrementato automaticamente. Per cancellare un punto indice portatevi esso (il
modo più semplice è quello di utilizzare le frecce poste alle estremità della barra
gialla) e cliccate sul triangolino giallo. Una volta che avete disposto  un punto
indice, potete tagliare la clip nel punto dove è situato l’indice tramite il tasto Split at
Index . Questo creerà due nuove clip e le disporrà nella gallery. In questo modo,
impostando degli indici nei punti opportuni, potrete ottenere quante clip volete.
Utilizzate i controlli posti nella parte alta a destra per riprodurre la clip.
I tempi di In e Out sono mostrati al di sotto dei comandi di riproduzione. Se
riproducete le clip o utilizzate la barra di scrub per muovervi sul punto in cui volete
impostare il nuovo In oppure l’Out. Potete impostare dei nuovi valori anche
evidenziando i tempi di In o Out e introducendo con la tastiera i valori desiderati.
Per impostare l’In oppure l’Out mentre state eseguendo il trimming, utilizzate i punti
verdi  vicini ai tempi di In ed Out. Quando impostate dei nuovi valori, la barra gialla
viene accorciata per mostrare i nuovi valori. Utilizzate i tasti a forma di freccia posti
alla sinistra dei tempi di In ed Out per portarvi sull’In o sull’Out.
Potete cambiare la durata di una clip evidenziando il tempo di durata e digitandovi
un nuovo numero. Potete cliccare sul punto verde vicino al tempo di durata per
bloccare la durata durante le operazioni di trimming. Se avete bloccato la durata,
quando cambiate il punto di In, il punto di Out verrà cambiato di conseguenza in
modo da mantenere inalterata la durata. Allo stesso modo, cambiando il punto di
Out, il punto di In verrà aggiornato in modo da mantenere inalterata la durata.
Una volta che avete ultimato le operazioni di trimming, cliccate su OK per uscire
salvando i cambiamenti effettuati, oppure su cancel per uscire senza salvare.
Il VA Player dispone di un gran numero di funzioni richiamabili da tastiera. Cliccate
con il tasto destro su qualsiasi punto del VA Player per far apparire la lista di questi
tasti.
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Utilizzo di Inscriber (Generatore di Caratteri)
Video Action viene fornito assieme ad Inscriber CG per permettervi di creare file
TGA a 32bit che possono essere utilizzati come titoli fissi in tempo reale. Per aprire
Inscriber CG cliccate con il tasto destro nella Gallery. Dal menù che appare
selezionate Inscriber CG. In altro modo potete selezionare dal menù principale,
quando una Gallery è attiva, Edit> Inscriber CG.
Quando avviate Inscriber CG da Video Action, lo sfondo che verrà mostrato mentre
state impostando i titoli sarà rappresentato dal fotogramma su cui si trovava il
cursore di Video Action al momento dell’apertura di Inscriber. Ciò vi sarà d’aiuto per
posizionare le parole sopra le immagini che saranno mostrate quando
sovraimporrete i titoli.
Quando accedete ad Inscriber CG attraverso Video Action, utti i file che salverete
saranno automaticamente inseriti nella Gallery. Al file verrà automaticamente dato
il nome di Ins01.tga (il numero viene incrementato ogni volta che salvate un file) e
disposto nella cartella Video Action posta a sua volta nella cartella Graphics. Se
volete modificare un file Inscriber che avete salvato in questo modo, cliccate con il
tasto destro sulla sua miniatura e selezionate Inscriber dal menù. Se volete salvare
il file con un nome a vostra scelta, selezionate File> Export> Image dal menù
principale di Inscriber. Quando esportate file TGA a 32 bit in questo modo, sarete
comunque in grado di utilizzare il file come titolo in tempo reale, ma dovrete
collezionarlo all’interno della Gallery come se fosse un qualsiasi altro file
d’immagine.
Quando salvate i vostri file di Inscriber come TGA a 32 bit, quesi includono le
informazioni interne di canale alfa di cui avete bisogno per sovraimporli come titoli
in tempo reale ai vostri file RVA ed RVD. (Consultate il Capitolo 8 per informazioni
circa i titoli di Video Action.) Se salvate i titoli utilizzando un altro formato potete
utilizzarli come titoli, ma il filmato avrà bisogno di essere renderizzato.
Fate riferimento al manuale di Inscriber CG (fornito come file pdf sul CD), oppure
all’aiuto in liea per dettagli completi su come utilizzare Inscriber CG.
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Capitolo 5: La Timeline

Introduzione

PICTURE n.1 PAG.47

La Timeline di Video Action  dispone di strumenti che vi permettono di arrangiare le
clip in maniera temporale, in cascata, in modo che possano esser riprodotte come
un filmato. Per posizionare le clip sulla timeline potete semplicemente trascinarle e
lasciarle (drag and drop) dalla Gallery La Timeline può essere utilizzata per
modificare le clip, visonare in anteprima differenti arrangiamenti audio/video, unire
differenti clip con transizioni di vostra scelta ed effetti speciali, ed aggiungere
dell’audio.
La Timeline di Video Action è costituita da tre tipi di tracce: tracce Video (V), traccia
delle transizioni (X), e tracce Audio (A). Quando le clip sono posizionate sulle
tracce V1 e V2, e quando c’è una sovrapposizione tra esse, automaticamente
viene inserita una transizione nella traccia delle transizioni (X). Le tracce V3 e
superiori sono le tracce di sovraimpressione e di utilizzo generale. A tutte le clip
video e alle transizioni è possibile applicare effetti tramite i cosiddeti filtri. A tutte le
tracce video è associata una traccia audio, che può essere aperta direttamente al
di sotto della relativa traccia video per mostrare la parte audio di una clip.  Le
tracce audio A1 e superiori possono essere utilizzate per contenere file WAV.
Sebbene è possibile che più finestre Gallery siano aperte contemporaneamente, è
possibile tenere aperta una sola finestra Timeline per volta.



       Video Action RT

______________________________

49

Posizionamento delle Clip sulla Timeline

Aggiunta delle Clip alla Timeline
Selezionate una clip nella Gallery e trascinatela su una traccia vuota della Timeline.
Fate attenzione, la Timeline accetta video clip della durata minima di 2 fotogrammi.
Posizionate le vostre clip principali sulle tracce V1 e V2, in modo che le transizioni
possano essere eseguite fra esse. Posizionate delle clip di sovraimposizione sulle
tracce video addizionali, e solo clip audio (file WAV) sulle tracce audio. Se una
qualsiasi parte di una clip si sovrappone ad un’altra clip presente sulla stessa
traccia, l'oprazione non sarà consentita. Se una clip si sovrappone a due clip
presenti sulla stessa traccia, appare la finestra Insert Clip, che vi consente di
decidere di quanto incrementare la dimensione della distanza tra le due clip o di
diminuire le dimensioni della clip che viene inserita.
A questo punto viene inserito sulla Timeline un rettangolo che rappresenta la clip
che avete appena disposto.

SUGGERIMENTO: COME RICEVERE INFORMAZIONI SULLA CLIP

E’ possibile vedere informazioni su ogni clip cliccando con il tasto destro sulla clip e
selezionando Clip Info. Cliccate sul pulsante OK per rimuovere la finestra di
informazioni.
Potreste trovare questa funzione comoda se state utilizzando clip corte e non
potete vedere l’intero nome della clip.

Regole di Disposizione delle Clip
La disposizione delle clip sulla Timeline segue poche e semplici regole.
• Tracce con numeri più alti sono viste prima dalla “telecamera” durante la

riproduzione o durante l’operazione di Make Movie. E’ come se una telecamera
guardasse dal basso attraverso le tracce con numero più alto fino alla traccia
V1.

• Le clip disposte sulle tracce V1 e V2 sono “Transizionabili”. Ciò vuol dire che è
possibile utilizzare transizioni per cambiare le immagini da una traccia ad
un’altra.

• Le tracce V3 e superiori sono tracce si sovraimposizione dove la trasparenza
può essere assegnata utilizzando le tracce inferiori come background (sfondo).
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• E’ possibile applicare effetti a tutte le clip poste sulle tracce video e sulla traccia
delle transizioni, tramite filtri.

Selezione di una Clip
Per selezionare una clip sulla Timeline, cliccate sulla clip su qualsiasi punto al di
fuori del triangolino di riproduzione. Attorno alla clip apparirà una linea tratteggiata
rossa e bianca. Per deselezionare la clip, cliccate su uno spazio vuoto sulla
Timeline o su un’altra clip.

Visione delle Clip
Per riprodurre una clip sulla timeline, cliccate una volta sola
sull’icona di riproduzione della clip (il triangolino posto al centro
della clip). La clip verrà riprodotta tra il punto di In e quello di
Out in modo che possiate vedere la lunghezza e il contenuto di
ogni clip così come sarà riprodotto dalla Timeline.
Se cliccate due volte sulla clip, questa sarà aperta utilizzando il VA Player. Il VA
Player vi permetterà di riprodurre la clip, di trimmarla, e di aggiungerle punti indice.
Consultate il Capitolo 4 per maggiori dettagli.

Spostamento di una Clip o Cambiamento di Tracce
Selezionate la Clip e trascinatela nel posto desiderato della Timeline. Se una
qualsiasi parte di essa si sovrappone con un’altra clip sulla stessa traccia, il
movimento non sarà accettato. Durante il movimento, vengono mostrate, alle
estremità destra e sinistra della clip, due linee molto sottili  per l’allineamento.
Utilizzate i tasti cursori per posizionare la clip con l’accuratezza del fotogramma.

SUGGERIMENTO: ALLINEAMENTO

Se avete abilitato la funzione snap nella finestra File> Preferences è molto
semplice allineare il bordo di una clip sorgente a quello di una clip di destinazione.
Muovete la clip sorgente in modo che i bordi da allineare siano vicini uno all’altro.
Video Action unirà le estremità automaticamente. (L’opzione snap può essere
spenta/accesa nella finestra Preferences.)
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Inserimento di una Clip Tra due Clip sulla
Stessa Traccia
Una clip può essere inserita sulla stessa traccia tra due altre clip se c’è spazio
libero a sufficienza per la clip che desiderate inserire. Trascinate semplicemente la
clip nel punto d’inserimento sulla Timeline.
Se la distanza tra due clip adiacenti è inferiore rispetto alla lunghezza della clip che
desiderate inserire (o se le due clip adiacenti sono attaccate), potete comunque
inserire la clip tra esse. Sovrapponete la clip che volete inserire sulla clip
precedente e su quella successiva per far apparire la finestra Insert Clip Option.

PICTURE n.1 PAG.50

Questa finestra delle opzioni vi permette di aumentare la distanza tre le clip, di
trimmare la clip precedente o quella successiva, di diminuire la lunghezza della clip
che volete inserire. Nel riquadro in basso a destra viene data una descrizione di
ogni opzione. Ogni opzione non disponibile per un particolare tipo di inserimento di
clip non sarà selezionabile.
Potete anche muovere o trimmare una delle clip per dare spazio alla clip da
inserire, oppure utilizzare il gap tool per spostare tutte le clip.

Cambiare la distanza tra due Gruppi di Clip
Il gap tool muoverà contemporaneamente tutte le clip poste sopra o alla destra
della linea blu di gap (distanza). Ciò permette la creazione o l’eliminazione di
distanze contemporaneamente su tutte le tracce della Timeline, senza intervenire
sulle loro posizioni relative. Ciò preserverà tutte le transizioni preesistenti.

Per utilizzare il gap tool, cliccate sul pulsante relativo a questo comando
che si trova sulla barra degli strumenti. Portate il cursore sulla Timeline.
Appare una linea blu. Se volete incrementare una distanza, posizionate la
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linea blu dove vorreste che la nuova distanza abbia origine, mantenete la pressione
sul tasto sinistro del mouse, e trascinate la linea blu alla destra sulla Timeline. Se
volete diminuire una distanza, piazzate la linea blue alla fine dello spazio da
rimuovere, e trascinate la linea alla sinistra sulla Timeline. Se posizinate la linea su
una clip, anche questa clip verrà spostata. Nel momento in cui trascinate la linea,
appare un menù che vi informa sulla lunghezza della nuova distanza, assieme ad
un’anteprima che vi mostra dove verranno posizionatele le clip influenzate dallo
spostamento.
Il gap tool vi permette di inserire delle clip in un qualsiasi punto della Timeline
spostando un gruppo di clip nel punto desiderato. Utilizzate il gap tool assieme al
Lock track Tool (strumento per il bloccaggio delle tracce) per riposizionare delle clip
senza muovere le altre.

Bloccare/Sbloccare una Traccia
Bloccare una traccia fa si che non è possibile effettuare alcun cambiamento su
essa. Una volta che una clip è bloccata non è possibile modificarla o riarrangiarla in
nessun modo. L’unica eccezione è la possibilità di cancellare una traccia bloccata
se è vuota. Bloccare una traccia può rivelarsi molto utile se  volete proteggerla da
cambiamenti accidentali, o se volete utilizzare un’operazione (come ad esempio il
gap tool) che influenzerà tutte le tracce, ma volete proteggere alcune tracce da
questa operazione.
Per bloccare o sbloccare una traccia, cliccate sul pulsante contrassegnato
da un catenaccio, posto sulla barra degli strumenti (oppure il tasto <U>). Il
cursore si trasformerà in un catenaccio. Spostate questo catenaccio sulla
traccia che volete bloccare o sbloccare e cliccate con il tasto sinistro del
mouse.
Una traccia bloccata è rappresentata da un catenaccio chiuso sull’etichetta della
traccia che si trova all’estrema sinistra della traccia stessa.

Opzioni di Visualizzazione della Timeline

Scala della Timeline (Time Scale)
La Time Scale è la scala orizzontale della Timeline. Per cambiarla, utilizzate il
regolatore apposito che si trova nell’angolo in alto a sinistra della timeline.
Un metodo alternativo cambiare la scala
del tempo è quello di utilizzare il menù
principale per selezionare  View> Time
Scale. Selezionate una scala tra le
numerose disponibili.



       Video Action RT

______________________________

53

Altezza delle Tracce
L’altezza delle tracce è la scala verticale della timeline. Per cambiare l’altezza delle
tracce, selezionate View> Track Height. Slezionate small, medium, o large dal
submenù.

Zoom In/Out
La funzione di Zoom In/Out permette una modifica alternativa della scala del tempo
e dell’altezza delle tracce. Questo strumento vi consente di cambiare la scala della
Timeline zoommando sul punto preciso su cui state cliccando. Per cominciare la
procedura di Zoom, selezionate dal menù principale View> Zoom oppure cliccate
sul pulsante con la lente di ingrandimento posto sulla barra degli strumenti. Per
incrementare la scala cliccate con il tasto sinistro del mouse. Per decrementare la
scala, cliccate con il tasto destro del mouse. Per aumentare l’altezza delle tracce,
mantenete la pressione sul tasto <Shift> della tastiera e cliccate con il tasto sinistro
del mouse. Per diminuire l’altezza delle tracce mantenete la pressione sul tasto
<Shift> della tastiera e cliccate con il tasto destro del mouse. Per deselezionare la
modalità Zoom, premete il tasto <Esc>, oppure cliccate da qualche parte al  di fuori
della Timeline.

Mostra la Traccia Audio
Per mostrare la traccia audio associata ad una traccia video, cliccate
sul pulsante della traccia posto all’estremità sinistra della traccia
stessa. Questa operazione farà aprire la traccia audio giusto al di sotto
della traccia video. Per nascondere la traccia audio cliccate
nuovamente sul pulsante della traccia video.
Le opzioni di formato della traccia definiscono se mostrare la traccia audio
associata alla traccia video, e quale formato utilizzare per mostrare le tracce audio,
tra volume, forma d’onda e grafico di bilanciamento dei canali destro/sinistro.
Per selezionare le opzioni del formato della traccia audio, cliccate con il tasto
destro sul pulsante della traccia. Ciò farà apparire la finestra delle opzioni.
Selezionate l’opzione che meglio soddisfa i vostri bisogni e cliccate su OK.
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Divisione della Finestra Timeline
Per evitare lo scorrimento continuo sopra/sotto durante l’editing su
tracce multiple, potete dividere la Timeline per vedere più tracce
contemporaneamente. Per dividere la Timeline, cliccate e trascinate
il rettangolo piatto che si trova sopra la freccia dello scorrimento della
finestra all’estrema destra. Il Cursore cambierà, ed apparirà  una
sottile linea grigia. Quando rilasciate il cursore, la Timeline viene
divisa in due parti dalla linea grigia. Ogni modifica fatta in una
finestra sarà automaticamente aggiornata nelle altre finestre.

Durata della Timeline
Le Timeline vengono create con la durata di un‘ora. Se volete cambiare questa
durata potete selezionare Edit> Timeline> Timeline Duration dal menù principale.
Potete utilizzare una qualsiasi durata fino a 24 ore.

Andare ad un Punto della Timeline
Se volete portarvi su una specifica locazione di timecode sulla vostra Timeline,
potete utilizzare il menù per selezionare Edit> Go To oppure potete premere
CTRL+G.  Si aprirà una finestra che vi permetterà di immettere il timecode dove
desiderate andare. Il cliccare su OK in questa finestra fa sì che la linea di
anteprima del Timecode si muova sul valore che avete immesso e sposta la vista
su quesll’area.

Indici
PICTURE n.1 PAG.53

Gli indici vi permettono di posizionare etichette sulla timeline, sulle clip video, e su
quelle audio. Questo è utili per marcare dei punti dove dovrebbero avvenire degli
eventi. Una volta che un indice viene posizionato su una clip o sulla Timeline, le
altre clip o altri indici vengono attratti da questi indici per l’allineamento.
Per creare un indice:
1. Selezionate la clip video o audio che volete contrassegnare con un indice. Se

non selezionate nessuna clip, l’indice sarà posizionato all’interno della
Timeline stessa.
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2. Potete sia premere il pulsante indice posto sulla barra degli strumenti
(il triangolino giallo), sia selezionare Edit> Create Index dal menù
principale.

3. Muovete il cursore sulla posizione desiderata con il mouse. Una volta che
siete sulla zona prescelta, utilizzate i tasti cursori per ottenere regolazioni con
l’accuratezza al fotogramma.

4. Una volta che avete posizionato l’indice all’interno di una clip o sulla Timeline,
appare una finestra di dialogo che vi permette di assegnare un numero e una
descrizione all’indice. Cliccate su OK per creare l’indice, o su  Cancel per
annullare l’operazione. L’indice apparirà come un piccolo triangolo giallo con
un numero.

Per muovere un indice, potete trascinarlo a destra e sinistra con la pressione
continua del tasto sinistro del mouse. Per modificare un indice, cliccate due volte
su esso per far apparire un riquadro di dialogo che vi permetterà di cambiare il suo
numero e la sua descrizione. Da questo riquadro è possibile cancellare
permanentemente l’indice cliccando sul tasto  Delete.
Potete aggiungere e cancellare punti indice alle clip anche tramite il VA Player.
Cliccate due volte sulla clip per far apparire il VA Player, e utilizzatene il pulsante
index. (Consultate il Capitolo 4 per maggiori informazioni sul VA Player.)
Potete anche aggiungere punti indice ad una clip sulla timeline mentre viene
riprodotta. Cliccate sul pulsante di riproduzione della clip (il triangolino posto al
centro della clip). Durante la riproduzione della clip premete il tasto < , > della
tastiera per aggiungere un punto indice.

SUGGERIMENTO: UNDO E REDO

Molte operazioni possono essere annullate. Per annullare un’operazione,
selezionate Edit> Undo dal menù principale. Una volta che un’operazione è stata
annullata, può anche essere rispristinata. Per ripristinare un’operazione annullata
selezionate  Edit> Redo dal menù principale. Il numero massimo di annullamenti
consentiti dipende dalla memoria di sistema del computer. Per cambiare il numero
di livelli di Undo, selezionate  File> Preferences dal menù principale.

Modifica delle Clip
Video Action vi fornisce una piena disponibilità di funzioni di editing che sono
accessibili dalla Timeline. Potete accedere ad esse utilizzando la barra degli
strumenti, tramite il menù principale o tramite tastiera. Molte funzioni sono
accessibili tramite la pressione del tasto destro del mouse sulla clip.
Quando muovete una clip, aiutatevi nel posizionamento tramite la barra delle
informazioni posta sul fondo della finestra di Video Action. Le locazioni dei
timecode del punto di partenza e di fine della clip, e del tempo di ogni transizione
fatta con la clip stessa, sono indicate in Ore : Minuti : Secondi : Fotogrammi.
Alcune procedure di modifica come il trimming, utilizzano lo scrubbing video ed
audio per fornire un utile aiuto. Potete rendervi conto anche degli effetti renderizzati
tramite l’uscita per il monitor video della sceda di cattura. Potete rendervi conto
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delle sequenze non renderizzate tramite la finestra di anteprima (preview) nello
schermo del computer.

Trimming di una Clip sull Timeline
Spesso avrete necessità di regolare con esattezza il punto di partenza e di fine di
una clip. Video Action vi permette di fare ciò in numerosi modi.
1. Per cambiare il punto di In di una clip, posizionate il cursore sul bordo sinistro

della clip. Il cursore si trasforma nella bandierina IN ed una freccia. Premete il
tasto sinistro del mouse e trascinate il punto di IN nella posizione che
desiderate. Quando cambiate il tempo di IN, eliminate i primi fotogrammi della
clip. Non potete incrementare la lunghezza originale di una clip in questo modo
(per fare ciò dovreste cambiare la velocità della clip).

2. Per cambiare il tempo di OUT di una clip, posizionate il cursore sul bordo
destro della clip stessa. Il cursore si trasforma nella bandierina OUT e in una
freccia. Premete il tasto sinistro del mouse e trascinate il tempo di OUT nella
posizione che desiderate. Quando cambiate il tempo di OUT, eliminate dalla
clip gli ultimi fotogrammi della clip. Non potete incrementare la lunghezza
originale della clip in questo modo.

3. Cliccate sull’icona di riproduzione della clip (il triangolino posto al centro della
clip stessa) per riprodurre la nuova versione della clip, dal punto di In a quello
di Out.

Durante il trimming di una clip, una piccola finestra a comparsa mostrerà il
timecode del frame in cui si sta effettuando il trimming. Dopo aver attivato il trimmer
con il mouse potete utilizzare i tasti cusori per ottenere modifiche con la precisione
al fotogramma.
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Trimming di una Clip Tramite il VA Player
La finestra VA Player può anche essere utilizzata per impostare i punti di In ed Out.
Cliccate due volte sulla clip da trimmare per aprirla con il VA Player.

PICTURE n.1 PAG.56

1. Muovete lo scrubber fino a quando non viene visualizzato il punto di IN
desiderato. Impostatelo cliccando sul pulsante IN.

2. Muovete lo scrubber fino a quando non viene visualizzato il punto di Out
desiderato. Impostatelo cliccando sul pulsante OUT.

3. Utilizzate i controlli di riproduzione per riprodurre la clip utilizzando i nuovi punti
di In ed Out. Premete OK quando siete soddisfatti delle vostre impostazioni.

4. Tornando alla Timeline, la clip video cambierà dimensioni dopo le impostazioni
e probabilmente avrà bisogno di essere riposizionata. Se le vostre regolazioni
daranno come risultato la sovrapposizione di clip nella stessa traccia, saranno
annullate.

5. Se avete una clip sulla Timeline cui avete bisogno di assegnare una lunghezza
specifica (ad esempio se dovete riempire lo spazio esistente fra altre due clip
presenti sulla Timeline, oppure se debba combaciare con un segmento
musicale), potete cliccare sul piccolo pulsante verde posto alla fine del tempo
di durata. In questo modo blocchere la durata della clip. Cambiando il punto di
In (oppure quello di Out), il punto di Out (oppure quello di In) sarà aggiornato in
modo da mantenere la stessa durata alla clip.

Muovete lo scrubber

La clip rifinita è evidenziata
tra i marcatori rossi

Riproduce  dal punto IN ad OUT

Assegna la durata della clip;
Blocca la durata della clip con
il led verde

Assegna In o Out
con i rispettivi
bottoni;
I led verdi
bloccano il tempo
di In e di Out

Spostatevi sui tempi di In
ed Out con queste frecce
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Fate attenzione, il VA Player non viene utilizzato per trimmare immagini statiche.
Esse possono essere modificate unicamente dalla Timeline tirando e spingendo i
bordi della  clip tramite il puntatore del mouse o tramite i tasti cursori della tastiera.

Move Edit
Questa funzione viene abilitata con la pressione del tasto <Ctrl> mentre si effettua
un’operazione di trimming sulla Timeline. Questa funzione fa sì che tutte le clip
successive a quella che si sta modificando, adeguino la loro posizione in modo da
mantenere inalterata la loro distanza dal punto di Out della clip che state
modificando.

Edit Simultaneo
Un “edit simultaneo” può essere attivato solo tra due clip che si trovino “al taglio”,
l’una accanto all’altra, sulla stessa traccia video. Questa funzione vi permette di
trimmare simultaneamente, con pari ammontare, il punto di Out della prima clip e il
punto di In della seconda clip. Se avete un secondo monitor video collegato
all’uscita di Preview/Key del breakout box, vedrete il punto di Out della prima clip
attraverso il monitor collegato all’uscita principale (main output) e il punto di In della
seconda clip attraverso il monitor collegato all’uscita di Preview/Key.

Taglio di una Clip
Tagliare una clip fa si che questa venga eliminata dalla Timeline. Quando una clip
viene eliminata, l’area che questa occupata viene lasciata libera. Per tagliare una
clip, selezionatela e poi cliccate sul tasto con le forbici sulla barra degli strumenti,
oppure selezionate  Edit> Clip> Cut dal menù principale, oppure premete il tasto
<Canc> della tastiera.

Copia di una Clip
Selezionate la clip da copiare e poi premete sull’icona Copy posto sulla barra degli
strumenti, oppure selezionate dal menù principale Edit> Clip> Copy, oppure
premete Ctrl+C.

Incollare una Clip
Prima che possiate incollare una clip, è necessario che una copia della clip venga
salvata all’interno del buffer utilizzando le funzioni di taglio o di copia. Per copiare
una clip potete premere sull'icona paste che si trova sulla barra degli strumenti o
selezionate Edit> Clip> Paste dal menù principale.
Muovete il cursore sul posto desiderato della Timeline. Apparirà il perimetro della
clip che vi aiuterà nel posizionamento. Cliccando con il tasto sinistro del mouse la
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clip viene incollata nella posizione attuale. Se la locazione prescelta è più piccola
della lunghezza della clip apparirà una finestra contenente delle opzioni.

PICTURE n.1 PAG.58

Questa finestra è molto simile a quella che appare quando si effettua un  insert in
una spazio più piccolo della clip da inserire. Vi permette di inscrementare la
distanza tra le clip, di trimmare la clip precedente o la successiva, o di diminuire la
lunghezza della clip che state incollando. Nel riquadro in basso a destra viene data
una descrizione per ogni opzione. Ogni opzione non disponibile per la particolare
operazione di incollamento viene disabilitata.
Se volete potete anche muovere o trimmare le clip presenti sulla Timeline in modo
da fare spazio alla clip da incollare.

Rimpiazzare una Clip
Selezionate la clip da rimpiazzare e selezionate  Edit> replace Clip  dal menù
principale. Apparirà una finestra che vi permette di selezionare una clip tra quelle
contenute all’interno del computer. Scegliete quella con la quale volete rimpiazzare
la clip selezionata correntemente e premete Replace.

Copia/Incolla degli attributi di una Clip
Gli attributi di una clip sono la lista degli effetti o delle impostazioni audio che
vengono applicate ad una clip.
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Selezionate la clip di cui volete copiare gli attributi, Dal munù scegliete  Edit> Clip>
Copy Clip Attributes. Slezionate la clip su cui volete copiare gli attributi. Dal menù
scegliete Edit> Clip> Paste Clip Attributes.

Divisione di una Clip in Segmenti Multitpli

PICTURE n.1 PAG.59

Selezionate lo strumento Rasoio dalla barra degli strumenti. Il cursore si trasforma
in un rasoio che potete utilizzare per tagliare le clip. Portate il rasoio nella posizione
desiderata con il mouse. Una volta che siete nell’area prescelta potete anche
utilizzare i tasti cursori per avere la precisione al fotogramma. Una piccola finestra
a comparsa vi mostra il timecode del fotogramma che il monitor video sta
mostrando attualmente per aiutarvi a capire dove state tagliando. Attraverso l’uscita
principale (main)  viene mostrato il fotogramma alla destra della linea di taglio. Se
avete collegato un secondo monitor video all’uscita Preview/key, in questo verrà
mostrato il fotogramma immediatamente alla sinistra del punto di taglio. Per tagliare
la clip, premete il tasto sinistro del mouse o il tasto Invio. Premete un qualsiasi altro
tasto per uscire da questa operazione.
Una volta che la clip è stata tagliata, il punto di out della clip sarà rappresentato dal
punto in cui è stata tagliata. Il punto di In della seconda clip si trova alla fine della
prima clip. La seconda clip ha come fine il punto di Out della clip originale.

Cambiare la Velocità della Clip
Per cambiare velocità ad una clip, selezionatela, poi potete sia cliccare sul pulsante
di Speed Change (cambiamento della velocità) posto sulla barra degli strumenti,
sia cliccare sulla clip con il tasto destro e selezionare Clip Speed.
Quando premete il pulsante Speed Change il cursore cambia forma per permettevi
di cambiare la velocità di riproduzione della clip trascinando il bordo sinistro o
destro della clip. Potete ridurre la velocità sino all’1% o accellerarla sino al 50.000%
(se la cli è lunga a sufficienza). Il risultato finale sarà una clip più lunga o più corta.
Quando selezionate  Clip Speed dal menù, appare una finestra che vi permette di
incrementare o ridurre la velocità corrente della clip.
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RT Fade From/To Black
Quando state lavorando con i file RVA od RVD potete cliccare con il tasto destro
sulla clip e selezionare  RT Fade. Apparirà una finestra che vi permetterà di
assolvere e dissolvere da/a nero con il numero di fotogrammi mostrati. Potete
cambiare il colore da/a cui assolvere/dissolvere cliccando due volte sul riquadro
colorato. Potete anche selezionare il riquadro “Apply to Full Clip” per avere
l’assolvenza o la dissolvenza sull’intera clip.

PICTURE n.1 PAG.60

E’ possibile disabilitare questo effetto cliccando con il tasto destro sulla clip per poi
selezionare No Effects. Fate attenzione al fatto che se sulla stessa porzione di clip
è presente un altro effetto, l’RT Fade non verrà attivata.

Audio sulla Timeline

Separazione/Sincronizzazione Audio/Video
Questa funzione vi permette di separare e riunire la porzione sonora di una video
clip. La clip contenente il video rimane nella sua posizione originale, mentre la sua
parte audio viene disposta come clip audio su una traccia audio. Ciò conferisce
maggiore flessibilità per combinazioni Audio/Video sul filmato finale, lasciandovi
editare e modificare l’audio separatamente dal video. ***
***Cliccate sul pulsante  A/V Split posto sulla barra degli strumenti, oppure
selezionate Edit> Clip> Split Audio/Video dal Menù principale.
Per riunire l’audio alla sua clip video originale, selezionate la clip audio e poi
cliccate sul pulsante A/V Split. Quando l’audio viene riunito al suo video originale,
tutte le funzioni di editing assegnate alla porzione audio, come il trimming e il
cambiamento della posizione, vengono annullate. Possono essere fatte copie
multiple della parte audio, ma solo l’originale può essere riunita al video.
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Dopo aver mosso l’audio che è stato separato da una clip, potreste desiderare di
sincronizzare nuovamente l’audio al video (ad esempio per riottenere il sincronismo
labbiale) senza riunirle. Ogni qualvolta che che muovete una clip audio che è stata
separata da una clip video, sulla Timeline appaiono due linee di sincronismo con
un punto. La prima appare nel centro della clip audio mossa, mentre la seconda
appare nel punto di sincronizzazione equivalente della porzione video. Se allineate
questi riferimenti otterrete di nuovo il sincronismo desiderato. Una volta che sono
state sincronizzate, il sincronismo sarà visualizzato su entrambe le clip in lettere
rosse. Se vengono fatte copie multiple dell’audio, solo l’originale mostrerà linee di
sincronismo.

Regolare il Volume di una Clip
Video Action fornisce un per regolare il volume della porzione audio della vostra
clip. Il Capitolo 10 contiene maggiori dettagli sull’editing audio.
1. Selezionate la clip audio e posizionate il puntatore sulla linea mediana nella

sezione di controllo audio. Il puntatore si trasforma in nel dito di una mano.
2. Cliccate sul tasto sinistro del muose per creare una maniglia (un punto rosso).

Potete creare quante maniglie volete. (Per cancellare una maniglia cliccate
due volte su essa.)

3. Trascinate lemaniglie sopra o sotto per definire come l’audio assolva o
dissolva. La linea tra due maniglie indica se la clip assolva o dissolva: una
linea ascendente indica audio in assolvenza; una linea discendente indica
audio in dissolvenza. Utilizzate i tasti cursori per regolare il volume di un punto
percentuale per volta. La pressione del tasto Shift e il trascinamento della linea
audio tra due maniglie fa si che quest’area venga spostata in maniera
uniforme.

Aggiungere e Cancellare Tracce

Aggiungere una Traccia
Selezionate Edit> Track> Add Track dal menù principale, oppure cliccate con il
tasto destro sulla Timeline e selezionate Add Track. Appare il riquadro di dialogo
Add Track. Selezionate il tipo di traccia, il numero di tracce da aggiungere, e
cliccate su OK. Una traccia del tipo selezionato viene aggiunta sul fondo della
Timeline. Il numero delle traccia appena aggiunta è superiore di un’unità rispetto
alla traccia adiacente dello stesso tipo. Ad esempio, se ci fossero 4 tracce video, la
traccia appena aggiunta sarebbe la V5.
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Cancellare una Traccia
Potete cancellare tracce audio e video. Solo l’ultima traccia audio o video può
essere cancellata, e deve essere necessariamente vuota. Selezionate  Edit>
Track> Delete Track dal menù, o cliccate con il tasto destro sulla Timeline e
selezionate Delete Track. Appare il riquadro di dialogo Delete Track. Selezionate
il tipo di traccia e cliccate su OK. V1 e V2 non possono essere cancellate.

Import/Export Timeline
Il comando Import/Export Timeline vi permette di “copiare ed incollare” una
porzione di una timeline su un’altra, salvandola (export) e poi inserendola (import).

Esportare una Timeline
1. Evidenziate la parte di Timeline desiderata (trascinando il puntatore sul

timecode della timeline). Premete Esc per fermare il Preview.
2. Selezionate Edit> Export dal menù principale. Apparirà il riquadro di dialogo

“Save as Timeline File”.
3. Immettete un nome e cliccate su OK. Ora potete aprire la nuova timeline

selezionando File> Open Timeline dal menù.

Importare una Timeline
1. Posizionate la linea di Preview nel punto (vuoto) della Timeline dove volete

inserire la Timeline da importare.
2. Selezionate Edit> Import dal menù e scegliete per selezionare un file Timeline

per eseguire l’inserimento.
3. Cliccate su OK per inserire la timeline selezionata dalla linea di Preview. Le

clip inserite spingono oltre le clip preesistenti in modo da creare spazio a
sufficienza per l’inserimento.

Copiare ed Incollare Sezioni della Timeline
Potete copiare ed incollare sezioni della Timeline in differenti aree della stessa
Timeline. Qunado state copiando sezioni della Timeline, verranno copiate solo clip
intere (non verranno copiate sezioni di clip) per questo motivo la vostra selezione
deve includere clip intere. Non dovete essere particolarmente precisi quando
effettuate una selezione; le clip parzialmente selezionate saranno ignorate
nell’operazione di copia.
Selezionate l’area della Timeline che volete copiare muovendo il cursore all’inizio
dell’area che vi interessa e trascinate il cursore. L’area sarà evidenziata. (L’area
sarà automaticamente riprodotta quando rilasciate il pulsante del mouse. Premete
Esc per fermare la riproduzione.)
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Considerate i seguenti tre esempi:
Se selezionate l’area mostrata in basso solo il file TGA posto nella traccia V3 sarà
copiato:

PICTURE n.1 PAG.63

Se avete selezionato l’area mostrata in basso, saranno copiate la prima clip sulla
traccia V1 e il file TGA posto sulla traccia V3, mentre al transizione e la clip sulla
traccia V2 saranno escluse.

PICTURE n.2 PAG.63

Se avete selezionato l’area mostrata in basso, saranno copiate: la prima clip sulla
traccia V1, il file TGA sulla traccia V3, la prima transizione, e la clip posta sulla
traccia V2.

PICTURE n.3 PAG.63

Una volta che avete selezionato l’area desiderata potete copiarla utilizzando il
pulsante di copia posto sulla barra degli strumenti, o cliccare con il tasto destro del
mouse all’interno dell’area evidenziata e selezionare Copy, o premere Control+C.
Muovete il cursore sull’area vuota della Timeline dove volete incollare le clip.
Premete il pulsante incolla posto sulla barra degli strumenti o cliccate con il tasto
destro sulla Timeline e selezionate Paste Clip oppure premete Ctrl+V. La Timeline
verrà incollata a partire dalla posizione del cursiore, e tutte le clip copiate verrano
incollate sulla Timeline.
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Trovare delle Clip
Una volta che avete collocato molte clip sulla Timeline potreste avere dei problemi
nel trovare e spostare una clip specifica. Utilizzate il menù principale per
selezionare  Edit> Find Clip, oppure premete Ctrl+F. Sarà generata una lista di
tutte le clip presenti sulla Timeline. Evidenziate la clip su cui vi volete muovere e
cliccate su OK , o più semplicemente cliccate due volte su essa.

Preferenze – Impostazioni
Sono a vostra disposizione numerose impostazioni per la Timeline e per le clip
presenti su essa. Queste possono essere cambiate per assecondare le vostre
preferenze.  Dal menù principale, selezionate  File> Preferences> Settings.

PICTURE
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Preferenze della Timeline
• Snap to clip edge when moving clips – Quando questa opzione è selezionata,

il bordo di una clip che viene mossa sarà attratto automaticamente dal bordo
di qualsiasi altra altra clip che incontra sulla Timeline. Ciò è particolarmente
pratico quando volete allineare due clip senza lasciare alcuno spazio tra esse.

• Snap to Timeline/Clip index when moving clips – Il bordo di una clip che
muovete sarà automaticamente attratto da un qualsiasi punto che è stato
marcato da un indice. Ciò include sia gli indici posizionati sulla Timeline, sia
quelli posizionati direttamente sulle altre clip. Ciò è utile specialmente quando
avete un indice specifico che segna  un tempo specifico e volete che una o
più clip partano in questo punto.

• Show warning when deleting transitions – Se una clip posta su V1 forma una
transizione con una clip su V2, portando via una delle clip, la transizione verrà
cancellata. Quando questa opzione è selezionata, Video Action vi avvertirà
ogniqualvolta siete sul punto di rimuovere una transizione. Potete sempre
utilizzare la caratteristica Undo presente nel menù Edit per ripristinare la
transizione (e le originali posizioni delle clip).

• Show miniatures / video feedback when editing – Quando questa opzione è
selezionata, il frame corrente sarà mostrato nel monitor video mentre
effettuate le operazioni di trimming, di indicizzazione e di taglio tramite rasoio
su una clip RVA/RVD. Durante le stesse operazioni su una clip AVI, una
piccola finestra “appesa” al cursore del mouse  vi mostrerà il fotogramma su
cui state intervenendo. Normalmente è pratico disporre di questo strumento,
ma dovete tener presente può rallentare le operazioni se lavorate su
fotogrammi di grandi dimensioni o se lavorate con una macchina lenta. Se la
macchina su cui lavorate è lenta, potete disabilitare questa opzione.

• Enable audio scrubbing – Disablita lo scrub audio durante le operazioini di
editing sulla Timeline. Lo scrub è la riproduzione istantanea di audio e video
quando il cursore si muove sulla Timeline. Normalmente dovreste tenere
abilitata questa funzione, ma se il vostro sistema non è veloce a sufficienza, o
se volete un responso immediato in fase di editing, disabilitatelo.

• Scrub resolution – Imposta l’intervallo di riproduzione tra ogni punto di
riferimento. Impostate la risoluzione di scrub sul migliore valore che il vostro
sistema riesce a gestire. Cominciate con 1/8 di secondo e variate in base ai
risultati della qualità dello scrub. Se la risoluzione di scrub sarà troppo piccola,
il suono sarà scoppiettante. Se la risoluzione di scrub sarà troppo piccola,
l’audio avrà un effetto eco e rallenterà le operazioni di editing.
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• Auto save – Salva automaticamente la Timeline attiva con l’intervallo di tempo
selezionato. Se alla Timeline non è stato dato un nome, automaticamente le
viene assegnato il nome timeline.bak; questo file viene inserito nella directory
Video Action. Se la Timeline è stata salvata con un nome, verrà aggiornata
utilizzando lo stesso nome.

• Audio auto Cross Fade at Transitions – Quando create una transizione tra le
clip poste tra le tracce V1 e V2, l’audio tra le transizioni dissolverà dall’una
all’atra traccia. Per esempio, durante una dissolvenza incrociata,  l’audio della
traccia V1 si abbasserà mentre quello della traccia V2 si alzerà
progressivamente.

• Use field handling defaults for AVI – Se questa opzione è selezionata, tute le
clip AVI posizionate nella Timeline  adotteranno le opzioni di rappresentazione
dei semiquadri (fields) che sono stati definiti utilizzando il pulsante AVI  Field
Defaults. Questa è solo l’impostazione di base. L’ordine di rappresentazione
dei semiquadri delle clip può essere alterato utilizzando andando sul menù
Edit e selezionando AVI Clip Field Option.

• TGA Fade In/Out Defaults – Se state utilizzando file TGA a 32 bit come titoli in
tempo reale, potreste volere che questi assolvano e dissolvano
automaticamente. Cliccate su questo pulsante per impostare i tempi di
dissolvenza  utilizzati quando cliccate con il tasto destro sulla clip e
selezionate dal menu che vi appare TGA Fade In/Out.

PICTURE n.1 PAG.66

• Undo Levels – Definisce quanti livelli di Undo (annullamento dell’ultima
operazioine effettuata) devono essere presi in considerazione da Video
Action. Questo numero è limitato solo dalla quantità di memoria di cui dispone
il vostro computer. Video Action mostrerà un messaggio d’errore se non è
disponibile abbastanza memoria disponibile per il numero di livelli di Undo
selezionati.
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• Temporary Directory – Video Action crea dei file temporanei durante le
normali operazioni di editing per effettuare il salvataggio automatico e per il
rendering audio in background. L’ammontare di spazio necessario per il
salvataggio della Timeline è abbastanza piccolo. L’ammontare di spazio
necessario per il rendering audio in background dipende dal progetto
specifico, ma è anch’esso, di solito, piccolo. Questi file vengono cancellati
quando uscite da Video Action.

• Cropping - All Clips – Rimuove zone non desiderate dai fotogrammi video.
Alcuni ingressi video hanno delle poco desiderate bande nere ai bordi
dell’immagine Il cropping può essere utilizzato per rimuoverle. (Nei paragrafi
seguenti l’argomento sarà trattato più specificamente.)

• Timeline Time Base – Questa è la base dei tempi standard utilizzata per la
Timeline. Potete scegliere tra 30, 29.97 DF, 29.97 NDF, 25 o 24 fotogrammi
per secondo. Scegliete una base dei tempi di 29.97 DF/NDF per l’NTSC o di
25 FPS per il PAL.

AVI Field Handling Defaults (Rappr. Dei Semiquadri per i File AVI)

In modo da processare clip AVI in movimento a 50/60 semiquadri al secondo,
Video Action permette all’utilizzatore di assegnare la rappresentazione dei
semiquadri in base al particolare tipo di codec che state utilizzando. Sono forniti
molti preset per gestire file AVI generati da schede come la DPS Personal
Animation Recorder/Perception Video recorder e le Truevision Targa 2000/1000.
Premete il pulsante  AVI Field Defaults posto sulla parte destra della finestra
Preferences.

PICTURE n.1 PAG.67

Selezionate il tipo di compressore che state utilizzando e poi impostate la
corrispondente opzione di Field Handling (No fields, Interlaced order A o interlaced
order B). Se non siete sicuri su quale impostazione di semiquadro (field) utilizzare,
consultate la documentazione del codec oppure sperimentate se il risultato su una



       Video Action RT

______________________________

69

transizione è buono (come una semplice tendina), cioè se la transizione è fluida.
Un bordo che prosegue a scatti per la transizione indica che la transizione è stata
effettuata con l’ordine dei semiquadri invertiti o che i semiquadri non sono stati
impostati. Cambiate opzione e provate ancora.
Per aggiungere un nuovo tipo di codec per la gestione dei semiquadri, utilizzate il
pulsante Add. Ciò fa aprire una finestra che vi permette di selezionare una clip
campione creata con il codec. Video Action estrarrà le informazioni necessarie per
identificare il tipo di codec utilizzato e permetterà all’utilizzatore di di selezionare il
tipo di gestione dei semiquadri di base che desidera. Fate attenzione al fatto che la
maggior parte dei codec non supportano  la gestione dei semiquadri.
La gestione dei semiquadri può anche essere cambiata in modo individuale sulle
clip, utilizzando la voce AVI Clip Field Option presente nel menù Edit.

Cropping
Molte telecamere ed altre sorgenti video non forniscono una risoluzione orizzontale
piena di 720 pixel. Il risultato è costituito da due bordi neri, posti uno sul lato destro
e una su quello sinistro dell’immagine. In modo da rimuovere questi bordi neri,
viene fornita una funzione che viene utilizzata ogniqualvolta  un effetto speciale
mostra i bordi estremi di un fotogramma.
Nell’angolo in basso a sinistra troverete un pulsante  Cropping – All Clip. Premete
questo pulsante per far apparire la finestra Cropping.

PICTURE n.1 PAG.68

Il numero esatto di pixel che necessitano di essere “croppati” varia in base al
segnale di ingresso. Cominciate con il crop di 15 pixel, sia  dal lato destro  che da
quello sinistro. Controllate che questo valore si a appropriato  renderizzando un
effetto come un voltapagina che mostra il bordo della pagina. Assieme al Video
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Screen Animation (effetto DVE) è fornita un’altra funzione di cropping, che
consente anche di variare l’aspetto dell’immagine.
Il cropping è un effetto da renderizzare. Non vedrete alcun risultato sul cropping
finchè non renderizzerete il vostro filmato.

Salvataggio delle Impostazioni
Quando uscite dalla finestra delle preferenze di Video Action, i cambiamenti che
avete effettuato vengono salvati automaticamente. Non avete bisogno di doverli
reimpostare  ogni volta che avviate Video Action.

Preferenze - Opzioni RT
Ci sono numerose opzioni per la Timeline e per le clip video presenti sulla Timeline
che influenzano le clip e gli effetti in tempo reale. Queste possono essere cambiate
per rispondere alle vostre esigenze. Dal menù principale, selezionate File>
Preferences.

RT Settings

PICTURE n.1 PAG:69

In questa finestra sono disponibili quattro impostazioni. La prima vi consente di
selezionare o meno l'aggiornamento dell'uscita principale (main output) dopo aver
effettuato lo scrubbing di una parte non renderizzata della Timeline. Per processare
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un fotogramma della parte di Timeline non renderizzata, destinato all'uscita
principale, sono necessari alcuni secondi (i tempi variano a seconda della
complessità dell'effetto). Disabilitando questa opzione, l'operazione di scrubbing su
aree non renderizzate risulterà più veloce.
Potete anche selezionare il modo in cui vengono processati file d'immagine più
grandi o più piccoli della dimensione standard dello schermo, quando vengono
mandati alla Timeline. Di solito le immagini sono ridimensionate per riempire lo
schermo, anche se ciò distorce le proporzioni originali. Se volete mantenere lo
stesso rapporto tra le dimensioni potete scegliere una tra le opzioni disponibili,
inclusi il ridimensionamento per rimepire lo schermo nel miglior modo possibile, o il
riposizionamento dell'immagine sullo schermo senza cambiare le dimensioni. Se
l'immagine non riempe lo schermo, la parte inutilizzata di quest'utltimo resterà nera.
Se parte dell'immagine fuoriesce dallo schermo, non verrà rappresentata. Fate
attenzione al fatto che vedrete il risultato del cambiamento di questa opzione solo
dopo aver renderizzato la sezione della Timeline che contiene la clip d'immagine.
Potete anche selezionare quanti canali audio debbano essere utilizzati in tempo
reale durante la riproduzione dalla Timeline. Per dattagli completi su questa
opzione, consultate il Capitolo 10: Audio.
Potete anche selezionare di mostrare un avvertimento di superamento delle
possibilità di riproduzione del vostro sistema (Data Rate Overrun Warning). Se
questa opzione è abilitata, vi sarà dato un avvertimento se il volume di dati è più
alto di quello supportato dai vostri hard disk.

RT Genlock

PICTURE n.1 PAG.70

Se state utilizzando un segnale di Genlock con il vostro hardware Perception RT
potreste utilizzare questa finestra per cambiare la temporizzazione del segnale da
interna ad una esterna analogica o ad un segnale di genlock D1.

RT Output Proc Amp
Potete regolare le impostazioni del processore di amplificazione del segnale per
l'intera Timeline, utilizzando queste impostazioni. Utilizzate il pulsante Default per



       Video Action RT

______________________________

72

ripristinare i cursori nella posizione iniziale (senza regolazioni). Utilizzate il pulsante
Restore per riportare i cursori sull'ultima posizione salvata.

PICTURE n.1 PAG.71

RT Rendered Outputs

PICTURE n.2 PAG.71

Utilizzate questa finestra per impostare i dischi e le directory utilizzate dalla
Perception RT per i file renderizzati di uscita. Possono essere selezionate fino ad 8
destinazioni, ognuna delle quali viene utilizzata quando la precedente è piena.

E’ molto importante
verificare questa
impostazione prima di
iniziare il rendering
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Potete anche impostare la qualità dei file renderizzati, espressa in MB/s. Prima che
cominciate un progetto dovreste prima controllare questo valore; dovrebbe
rispecchiare il data rate  che intendete utilizzare per la vostra uscita finale. Per
esempio, se state utilizzando clip catturate a 6MB/s, dovreste impostare anche
questo valore a 6MB/s. In altra maniera potreste notare un decadimento della
qualità nelle sezioni della Timeline che hanno necessitato di essere renderizzate.

RT Manager

PICTURE n.1 PAG.72

L'RT Manager si apre slezionando l'omonima voce nel menù. (Queta funzione è
disponibile attraverso il Pannello di Controllo di Windows.) Il Perception RT
Manager vi permette di gestire i vostri dischi della Perception RT, incluse
operazioni a basso livello come formattazione, striping ed ottimizzazione. Per
maggiori informazioni consultate la Guida Utente Perception RT.

RT Cleanup
Durante la normale operatività di Video Action, vengono creati file temporanei  di
lavoro sui dischi della Perception RT. Questi file potrebbero essere creati se
ottimizzate una transizione in tempo reale, o per del rendering video normale.
Alcuni di questi file vengono rimossi quando chiudete Video Action, mentre altri
vengono salvati per permetterne un utilizzo futuro.
Ci sono numerosi casi in cui i file temporanei vengono lasciati su vostro disco
anche quando non sono più necessari. Se utilizzate il Perception RT Manager per
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cancellare un file RVD, tutti i file temporanei che sono stai creati utilizzando questo
RVD non saranno cancellati. Se Video Action viene chiuso in maniera anormale
(ad esempio se viene a mancare la corrente elettrica), questi file non verranno
rimossi. Per poterli cancellare eseguite la funzione RT Cleanup. Questa troverà tutti
i file temporanei che non sono utilizzati da file esistenti e vi permetterà di
cancellarli.

PICTURE n.1 PAG.73

Auto Color Bars/Tones
Questa opzione vi permette di riprodurre delle barre colore standard assieme a dei
toni  e delle regioni di nero per 2-20 secondi prima che cominci la riproduzione
delle clip dalla Timeline.

PICTURE n.2 PAG.73
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Barre colore Automatiche e toni vengono eseguite quando riproducete la Timeline
attivando il cursore e premendo la barra spaziatrice o quando risproducete una
parte evidenziata della Timeline. Le barre e i toni non saranno mostrate prima della
rispoduzione di una clip tramite la pressione del tasto play posto al centro di ogni
clip video.

Creazione dello Storyboard
Uno storyboard è un sommario su carta del filmato. Questo mostra il primo e
l'ultimo fotogramma di una clip e/o le immagini definite da anteprima di un filmato.
Uno story board di Video Action viene salvato come una gallery speciale, con le
immagini mostrate come miniature. Questa Gallery può contenere note associate
alle immagini e alla durata delle clip all'interno del filmato.

PICTURE n.1 PAG.74

Prima di creare uno story board potreste voler segnare delle posizioni di snapshot.
Una snapshot definisce un fotogramma sulla Timeline da essere posizionato nello
story board.
Per creare uno Snapshot, premete con il tasto destro  su una zono vuota della
barra di rendering posta al di sopra della Timeline. Si apre la finestra Edit
Snapshot. Potete immettere qualunque nota che volete salvare assieme allo
Snapshot. Se cliccate su OK, viene creato un simbolo Snaphot sulla Timeline. Per
cancellare uno Snapshot, cliccate con il tasto destro su di esso e cliccate su delete.
Per muovere uno Snapshot, trascinate lo Snapshot su una nuova posizione sulla
barra di rendering.
Per creare uno story board:
1. Selezionate Tools> Story Board Settings dal menù. Apparirà la finestra Story

Board Option. Potete selezionare le Opzioni di Cattura di Snapshot Only, Clip
Edge Only o Snapshot & Clip Edge. Potete slezionare le Time Option del
filmato (Movie) o dell'intera Timeline. Se viene selezionato Movie come Time
Option, il timecode mostrato è relativo alla lunghezza contrassegnata dalla
banda gialla movie posta al di sopra della timeline. Se viene selezionata la
time option Entire Timeline, verrà mostrato il Timecode relativo all'intera
timeline.

2. Selezionate Tools> Convert to Story Board dal menù.
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3. Apparirà una finestra Save as Gallery File che chiederà il nome di un file. Dal
momento che uno Story Board è un tipo speciale di Gallery, che ne utilizza
anche l'estensione del file (.gy). Il suo contenuto includerà le immagini così
come richieste nella finestra Story Board Settings.

4. Durante la creazioine dello Story Board appare un indicatore di completamento
in percentuale.

5. LE note che avete immesso quando avete creato lo Snapshot possono essere
mostrate cliccando con il tasto destro all'interno della Gallery e selezionando
"Tumbnail and Note". Per modificare queste commenti collegati ad una clip,
cliccate con il tasto destro sulla sua miniatura nella Gallery e selezionate Edit
Clip Info. Apparirà una finestra conenete le inforamzioni di modifica di una
clip. Potete aggiungere commenti nel riquadro  Description.

6. Potete visionare in anteprima lo Story Board prima di stamparlo selezionando
File> Print Preview. Lo Story Board stampato sarà costituito dalle miniature
delle immagini e dai relativi timecode.

7. Per stampare lo Story Board, selezionate File> Print dal menù. Selezionate le
opzioni di stampa che desiderate e cliccate su OK.

Impostazioni del Make Movie
Una volta che avete terminato tutte le operazioni di modifica delle clip inserite sulla
Timeline, e che avete inserito gli effetti e le transizioni, avete la possibilità di
realizzare un file unico per registrare il prodotto finito. Se avete utilizzato solo clip e
transizioni in tempo reale, sarete in grado di visionare il filmato in tempo reale e di
poi fare il fimato finale con un processo di elaborazione molto breve. Se avete
utilizzato alcune transizioni ed effetti da renderizzare, o delle clip multimediali, il
tempo necessario ala realizzazione del filmato finale potrebbe essere anche molto
lungo. Potete avvalervi dei vari metodi di anteprima disponibili per fare in modo che
il risultato sia quello da voi desiderato.
Video Action vi offre numerose opzioni per il salvataggio del progetto finale. Le
impostazioni di base salveranno il vostro filmato utilizzando quelle della Perception
RT. Queste tuttavia possono essere cambiate per darvi una gran varietà di
finalizzazioni.
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Movie Output Settings: Video
Selezionate Movie> Movie Settings dal menù principale. Queste impostazioni
determinano il modo in cui il vostro filmato verrà finalizzato quando utilizzate le
funzioni di Make Movie di Video Action. Notate che alcune impostazioni sono
disponibili solo per alcune selezioni di compressioni; per altre impostazioni di
compressione sono disabilitate.
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• Frame Rate: Questo riquadro mostra il numero di fotogrammi per secondo dei
file video di uscita, sequenze di immagini, e file di animazione (FLC). A numeri
di fotogrammi per secondo maggiori corrispondono tempi di calcolo e
maggiore spazio di  immagazzinamento negli Hard Disk. Per lo standard PAL
utilizzate 25 Fps, per lo standard NTSC 29.97.

• Sub-Pixel Rendering: L'attivazione di questa opzione fa sì che venga
utilizzata la modalità di rendering ad elevatissima risoluzione. Elaborazioni
effettuate in questa maniera danno come risultato immagini estremamente
uniformi. E' molto utile utilizzare questa opzione per rimuovere bordi squadrati
(specialmente quando sono presenti linee seghettate), ma non è utile per
immagini che richiedono bordi netti, come immagini geometriche. Quando
questa opzione è selezionata, il fabbisogno di RAM sale di 4 volte, come del
resto il tempo necessario per l'elaborazione.

Questi bottoni selezionano il pannello
relativo alle impostazioni per Video,
Audio, Immagini e Animazioni.
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• Recompress Output: Quando questo riquadro è selezionato, costringe
l'uscita ad essere sempre ricompressa. Normalmente, il video non viene
ricompresso se i parametri di ingresso ed uscita sono gli stessi (come
dimensione di fotogramma, numero di fotograami per secondo, etc.)

• Video Width and Video Height: Questi riquadri mostrano la dimensione dei
fotogrammi, larghezza ed altezza dell'uscita dell'immagine in pixel. (Notate che
la dimensione dei fotogrammi in uscita è indipendente per Video, Immagini ed
Animazioni.) Per una normale uscita nel formato PAL dovete impostare la
larghezza (width) su 720 e l'altezza su 486 pixel. Per una normale uscita
NTSC dovete impostare la larghezza su 720 e l'altezza su 486 pixel.

• Lock at 4:3 Aspect Ratio: Quando questa opzione è abilitata, ad una
regolazione della larghezza  del fotogramma corrisponde una regolazione
dell'altezza in modo tale che il loro rapporto rimanga costante sui 4:3. Vale il
viceversa.

• Compression: Questo riquadro mostra il tipo di compressione utilizzato. Per
filmati RVA/RVD utilizzate il codec Perception RT. Le opzioni di compressione
disponibili dipendono dai codec installati sul vostro sistema. Video Action
dispone dei compressori più popolari. Se nel vostro sistema sono installati
codec aggiuntivi, questi saranno mostrati in questo riquadro. Per alcuni tipi di
compressione video potete utilizzare il pulsante  Compression Options posto
nella parte bassa della finestra, per regolare la compressione al livello e alla
qualità desiderati.

• Color: Questo riquadro mostra il numero di bit utilizzati per rappresentare le
informazioni del colore. Possono essere effettuate diverse impostazioni di
uscita per video, immagini e animazioni.

• Playback Platform: Questo riquadro mostra il tasso di riproduzione
supportato dalle periferiche di riproduzione che riprodurranno il filmato
generato. Video Action utilizza le impostazioni di base.

• Field Handling: I fotogrammi video sono solitamente costituiti da due
semiquadri, quello dispari è costituito dalle linee orizzontali numerate con
numero dispari, e quello pari costituito dalle linee verticali numerate con
numero pari. Per avere un'uscita video fluida è necessario che sia impostato
l'ordine corretto di rappresentazione dei semiquadri. Potete impostarlo su "No
Field", "Interlaced Field Order A", (per avere una dominante dei semiquadri
pari, dove le linee pari vengono rappresentate prima), o "Interlace Field Order
B" ( per avere una dominante dei semiquadri dispari). Il Sistema Perception RT
utilizza "Interalced Field Order B". Per controllare la rappresentazione dei
semiquadri, finalizzate una breve transizione (come una semplice tendina) e
controllatene visivamente la fluidità. Un andamento a scatti del bordo della
transizione indica che l'uscita è stata realizzata con un ordine inverso dei
semiquadri o che è stata realizzata senza considerare i semiquadri. Cambiate
su una differente rappresenzazione dei semiquadri e provate ancora.
Consultate anche il Capitolo 4 alla voce Collezione delle Sequenze di
Immagini.
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• Additional Options: Questo pulsante apre una finestra che fornisce
impostazioni per l'interlacciamento audio/video utilizzato per la creazione di file
AVI. Di solito per la migliore qualità questo valore dovrebbe essere impostato
su 1. Consultate la documentazione del vostro codec per raccomandazioni
specifiche.

Movie Output Settings: Audio

PICTURE n.1 PAG.78

• Frame Rate:  Questo parametro è uguale in tutte le finestre di impostazione,
pertanto avete bisogno di impostarlo una volta sola.

• Enable Audio: Assicuratevi di attivare l'opzione Audio se volete registrare del
suono assieme alle vostre clip.

• Sample Size, Sampling Rate, e Channels: Queste opzioni possono essere
regolate per ottenere la qualità del suono che desiderate. Le impostazioni
mostrate in figura  (16 bit, 44100 Hz, Stereo) sono quelle della qualità CD.
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Movie Output: Images

PICTURE n.1 PAG.79

Le impostazioni delle Immagini specificano il modo in cui il vostro filmato verrà
finalizzato come sequenza di immagini, ed il modo in cui il programma esporterà un
fotogramma in un file d'immagine.

• Frame Rate: Questo sarà lo stesso in tutte le pagine d'impostazione pertanto
avrete bisogno d'impostarlo una volta sola.

• Image Width/Image Height: Potete impostare qualsiasi larghezza ed altezza
ad i vostri file d'immagine (se il vostro codec supporta questa possibilità).

• Lock at 4:3 Aspect Ratio: Quando questa opzione è abilitata, ad una
regolazione della larghezza  del fotogramma corrisponde una regolazione
dell'altezza in modo tale che il loro rapporto rimanga costante sui 4:3. Vale il
viceversa.

• Sequence Type: Questa impostazione determina il formato utilizzato per
salvare sia i fermi immagine e le sequenze d'immagine. Potete cambiare il tipo
di sequenza tra i tipi di file disponibili, a seconda dell'utilizzo che volete farne.
Video Action vi permette di salvare i vostri file d'immagine nei formati BMP,
TIF, JPG, GIF, PCT PCX e TGA. Per alcuni formati di file impostazioni
addizionali saranno disponibili tramite il tasto "Options" posto nella parte bassa
della finestra.
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• Color: Il colore dovrebbe essere impostato su 24 bit o maggiore per avere i
migliori risultati.

• Field Handling: Per i fermi immagine, l'ordine di rappresentazione dei
semiquadri dovrebbe essere "No Fields" come mostrato sopra. Per la
finalizzazione di sequenze di immagini avete bisogno d'impostare il tipo di
rappresentazione che volete utilizzare. (Consultate la sezione sulla Sequenza
di Immagini nel Capitolo 4: Cattura.)

Movie Output: Animation

PICTURE N.1 PAG.80

Potreste aver bisogno di modificare le impostazioni di animazione per la
finalizzazione in file FLC. Le impostazioni di basesaranno quelle degli standard
PAL od NTSC.

• Frame Rate: Questo sarà lo stesso in tutte le pagine d'impostazione pertanto
avrete bisogno d'impostarlo una volta sola.

• Sub-Pixel Rendering: L'attivazione di questa opzione fa sì che venga
utilizzata la modalità di rendering ad elevatissima risoluzione. Elaborazioni
effettuate in questa maniera danno come risultato immagini estremamente
uniformi. Quando questa opzione è selezionata, il fabbisogno di RAM sale di 4
volte, come del resto il tempo necessario per l'elaborazione.

• Animation Width/Image Height: Potete impostare qualsiasi valore per la
larghezza e l'altezza dei vostri file d'immagine.
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• Lock at 4:3 Aspect Ratio: Quando questa opzione è abilitata, ad una
regolazione della larghezza  del fotogramma corrisponde una regolazione
dell'altezza in modo tale che il loro rapporto rimanga costante sui 4:3. Vale il
viceversa.

Salvataggio delle Vostre Impostazioni
Se cambiate una qualsiasi delle impostazioni di Make Movie, assicuratevi di
salvarle con un nome differente (Esempio: Mieimpostazioni.ost e non PAL.ost o
NTSC.ost) se pensate di utilizzarle nuovamente.

Impostazioni di Anteprima (Preview)
Le impostazioni di anteprima influenzano il modo in cui filmato AVI di anteprima
verrà realizzato. Potete ad esempio voler effettuare un filmato di Preview se state
lavorando ad un progetto  con transizioni ed effetti da renderizzare.
Cliccate su un punto qualsiasi della Timeline. Dal menù principale selezionate
Movie> Preview Settings. Le impostazioni corrispondono perfettamente a quelle
di Movie Output. Per creare un filmato di anteprima molto rapido potete volere
realizzare un filmato con numero di fotograammi per secondo inferiore o con una
dimensione di immagine ridotta. Le impostazioni di Anteprima (Preview) non
influenzeranno il filmato finale.

Modifica dell'Area del Filmato
Molte volte, quando vorrete finalizzare un filmato, probabilmente vorrete riprodurre
solo parte della Timeline.  Per fare ciò potete definire la parte di Timeline che vi
interessa con la barra gialla posta nella parte alta della finestra. Tutte le clip video e
audio e tutti gli effetti speciali inclusi in quest'area saranno inclusi nel filmato finale.
1. Per regolare il tempo di IN del filmato muovete il cursore alla sinistra della

banda gialla e spostate il triangolo dell'IN. Per semplificare l'allineamento,
viene rappresentata una linea sottile.

2. Per regolare il punto di Out del filmato, muovete il cursore alla destra della
banda gialla e spostate il triangolo dell'Out. Per semplificare l'allineamento,
vengono rappresentate due linee sottili.

3. Per muovere la banda gialla mantenendo i tempi di In e Out relativi invariati
(senza cioè cambiare la lunghezza del filmato), muovete il cursore sulla banda
Movie, e cliccate e trascinate la sua area compresa tra i triangoli di In ed Out.
Per semplificare l'allineamento, vengono rappresentate due linee sottili.

In modo alternativo, cliccate due volte su un punto qualsiasi della riga dove si trova
la banda gialla; si aprirà una finestra di dialogo che permette la definizione, con
l'accuratezza del fotogramma, dei tempi di In ed Out. Il box di dialogo vi permetterà
di definire in quale Ora, minuto, secondo e fotogramma il filmato deve avere inizio e
fine.
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Timeline Playback and Preview
Questa funzione fornisce un veloce riscontro visivo dei risultati del vostro editing.
Dalla Timeline sono presenti cinque modalità:
1. Riproduzione dell'intera Timeline dalla posizione corrente del cursore in avanti.

Vengono mostrate tutte le transizioni renderizzate e gli effetti in tempo reale.
Le sezioni non renderizzate vengono mostrate come "tagli".

2. Riproduzione di una parte della Timeline. Vengono mostrate tutte le transizioni
renderizzate e gli effetti in tempo reale. Le sezioni non renderizzate vengono
mostrate come "tagli".

3. Rappresentazione del singolo fotogramma sul monitor del computer.
4. Creazione di un file di riproduzione di una parte della Timeline. Questo file può

essere un file video AVI, un file audio WAV, una sequenza di immani o un file
d'animazione.

5. Un rapido preview mostrato ad un basso numero di fotogrammi al secondo in
una piccola finestra di anteprima nel monitor del computer, nel quale vengono
mostrati tutte le transizioni e gli effetti. Ciò è utile se volete vedere rapidamente
effetti e transizioni non renderizzate.

Suggerimento: Riproduzione della Timeline

Cliccate su un punto della Timeline o premete il tasto Esc per interrompere in
qualsiasi momento la riproduzione.
Premete la barra spaziatrice per riprodurre tutte le clip video presenti sulla Timeline
(un'anteprima a "taglio" per sezioni non renderizzate) dalla posizione del cursore in
poi. Premete la barra spaziatrice durante la riproduzione per arrestarla.
Una volta che avete riprodotto una parte evidenziata, premete il tasto "p" per
riprodurre nuovamente la stessa parte.
Se premete il tasto <Shift> mentre selezionate una parte evidenziandola, la
riproduzione non comincerà automaticamente quando rilasciate il tasto del mouse.
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Riproduzione dell'Intera Timeline
Posizionate il cursore della Timeline sul primo fotogramma che volete riprodurre.
Premete la barra saziatrice. Tutte le clip presenti sulla Timeline saranno riprodotte
dalla posizione del cursore in avanti. Tutte le transizioni renderizzate e gli effetti
vengono mostrati, mentre le le sezioni della timeline non renderizzate vengono
mostrate al "taglio". Se il vostro progetto è stato completato e avete renderizzato
tutte le sezioni della parte di Timeline da riprodurre, in questo modo potrete
registrarlo (il progetto) su una videocassetta.

Riproduzione di Una Parte della Timeline
1. Posizionate il cursore sull'indicatore del tempo nel punto in cui volete dare

inizio alla riproduzione e trascinate il puntatore del mouse orizzontalmente per
creare un intervallo di riproduzione. La parte della Timeline interessata viene
evidenziata.

2. Tutte le sezioni renderizzate dell'intervallo di riproduzione vengono riprodotte
con i loro effetti e le loro transizioni. Le sezioni non renderizzate vengono
riprodotte senza effetti o transizioni (al "taglio"). Se avete renderizzato tutte le
transizioni dell'intervallo di riproduzione, potrete utilizzare questa funzione per
come filmato finale da registrare su videocassetta.

3. Premete il tasto"p" della vostra tastiera per riprodurre nuovamente l'intervallo
di riproduzione, oppure selezionate Movie> Preview> No Effect Preview dal
menù principale.

Anteprima di un Fotogramma Singolo
Ogni qualvolta che la linea di preview viene mossa, il fotogramma corrente viene
mostrato nel monitor video (per i fotogrammi renderizzati) o nella piccola finestra di
anteprima (per i fotogrammi da renderizzare). Se volete vedere l'anteprima del
fotogramma nel monitor del computer nel Clip Player/Trimmer:

1. Cliccate con il tasto sinistro del mouse sul righello del tempo per ottenere la
linea rossa di preview.  Muovete la linea di preview sul fotogramma desiderato.

2. Selezionate Movie> Preview> Preview Single Frame, Display Only
dal menù, o premete sul pulsante "single frame preview posto sulla
barra degli strumenti.

3. Il preview del singolo fotogramma appare  nella finestra Clip Player/Trimmer.
Premete il tasto "Full Scrn" per allargare la finestra a pieno schermo. Premete
il tasto <Esc> per tornare al programma.
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Creazione di un Filmato di Anteprima
(Preview)
Se create un filmato contenente numerosi effetti e transizioni da renderizzare,
avete la possibilità di visionare un preview prima di lanciare il rendering finale,
selezionando Movie> Preview> AVI File Output. Di solito le impostazioni di
Anteprima (Preview Options) vengono configurate con un numero di fotogrammi
secondo ed una risoluzione inferiori rispetto a quelle effettive, in modo da rendere
molto rapida la creazione del preview.  Ovviamente c'è una relazione tra qualità del
preview ed il tempo necessario a realizzarlo. Pre dettagli su come cambiare le
impostazioni di Preview, consultate le pagine precedenti di questo capitolo.
1. Posizionate il cursore sul righello del tempo nel punto in cui volete che inizi il

preview e trascinate il mouse lungo lo stesso righello in modo da evidenziare
la parte che vi interessa della Timeline. Automaticamente verrà riprodotta
questa parte della Timeline "al taglio" senza cioè effetti e transizioni
renderizzate. Se non volete che quest'area venga riprodotta automaticamente,
premete il tasto <Shift> mentre evidenziate l'area. Quando selezionate
l'intervallo di preview, tenete presente che ad intervalli più lunghi
corrispondono tempi di rendering maggiori.

2. Selezionate Movie> Preview dal menù e scegliete una delle quattro opzioni
dal submenù. Il file finale di preview utilizzerà le Impostazioni di Preview.

3. Vi apparirà una finestra per permettervi la selezione del nome del file e di
stabilire la locazione del file. Durante la creazione del file, appare un indicatore
di progresso in percentuale.

4. Una volta che Video Action ha creato il file di Preview, questo viene mostrato
nella finestra Clip Player/Trimmer.

Preview Rapido
Se volete visionare in anteprima sezioni non renderizzate della vostro filmato,
l'opzione Display Only Preview è la più rapida, ma comporta la perdita di
fotogrammi e il mancato supporto dell'audio. Per realizzare un tale Preview:
1. Posizionate il cursore sul righello del tempo nel punto in cui volete che inizi il

preview e trascinate il mouse lungo lo stesso righello in modo da evidenziare
la parte che vi interessa della Timeline. Automaticamente verrà riprodotta
questa parte della Timeline "al taglio" senza cioè effetti e transizioni
renderizzate. Se non volete che quest'area venga riprodotta automaticamente,
premete il tasto <Shift> mentre evidenziate l'area.

2. Premete il tasto Display Only Preview posto sulla barra delle
applicazioni, o selezionate Movie> Preview> Display Only dal menù.
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3. Nel monitor del vostro computer sarà mostrata una piccola finestra che mostra
il vostro Preview. Premete il tasto <Esc> una volta per interrompere il Preview
e per chiudere la finestra.

PICTURE n.1 PAG.85

Finestra di Anteprima
La finestra di anteprima standard che viene aperta quando lanciate Video Action vi
fornisce una visione istantanea della vostra clip nel punto della linea di preview. Per
attivare o disattivare questa caratteristica, selezionate View> Preview Window dal
menù. Potete chiudere la finestra di Preview anche cliccando sulla X posta
nell'angolo in alto a destra della finestra. Per cambiare le dimensioni della finestra
di Preview, prendetene un bordo e trascinatelo sino ad ottenere la dimensione
desiderata. Cliccate sull'icona locata nell'angolo in alto a destrea della finestra di
preview per potere utilizzare le opzioni addizionali di questa finestra.

Realizzazione di un Filmato Finale
Dopo le operazioni di montaggio, potete assegnare a Video Action di processare le
clip secondo le vostre decisioni, e di produrre un file finale singolo che utilizza le
impostazioni predefinite in Movie Settings. Potete realizzare il vostro filamto finale
come: file RVA, file AVI, fermo immagine, sequenza di immagini, un file di
animazione (FLC) o file wav.

Realizzazione di un Filmato RVA o AVI
1. Selezionate Movie> Make Movie dal menù e scegliete RVA o Avi dai tipi

differenti che è possibile realizzare (video, audio, sequenza di immagini o file
di animazione), o premete il sulsante make movie posto sulla barra degli
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selezione strumenti per creare un filmato RVA. Appare una finestra che
permette la selezione del nome e della locazione del file.

2. Dopo aver immesso nome e locazione del file, cliccate su OK per dare inizio
all'elaboarazione. Appare un indicatore di avanzamento espresso in
percentuale.

3. Quando Video Action processa il filmato, l'indicatore di avanzamento cambia
da 0% a 100%. Premete il tasto <Esc> per interrompere in qualsiasi momento
l'elaborazione. Video Action si fermerà comunque solo dopo aver processato il
fotogramma corrente.

Realizzazione di un File d'Immagine
Singolo
1. Selezionate Movie> Make Single Frame dal menù. Apparirà una finestra che

vi permetterà di selezionare nome e locazione del file. IL tipo di file sarà quello
che avete imposta nella finestra Movie> Movie Settings nell impostazioni per
le immagini.

2. Dopo aver immesso il nome e la locazione del file, cliccate su OK per
cominciare a processare il filmato.

Fate attenzione che quando Video Action crea un file RVA , il file system virtuale vi
dà immediatamente accesso a al video come sequenza d'immagini. Ciò vi permette
di di accedere a fotogrammi individuali dei vostri file BMP, IFF, PIC, SGI, TGA, o
TIF. Consultate la Guida della Perception RT per maggiori informazioni in
proposito.
Prima che realizziate un file un singolo fotogramma, partendo da un file AVI,
dovreste controllare le impostazioni di rappresentazione dei semiquadri. Per fare
ciò, cliccate sulla clip (attorno ad essa appare una ilnea tratteggiata), e poi andate
alla barra del menù e aprite Edit> Clip> AVI Field Options.
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Codec differenti utilizzano differenti rappresentazioni dei semiquadri. L'utilizzo della
corretta rappresentazione dei semiquadri può produrre miglioramenti notevoli
nell'aspetto di qaulsiasi file d'immagine che create da un fotogramma singolo,
specialmente che catturano un soggetto in movimento.
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Realizzazione di una Sequenza di Immagini
1. Selezionate Movie> Make Image Sequence dal menù. Appare una finestra

che consente di selezionare la locazione e le prime quattro lettere del nome
dei file della sequenza di immagini. Gli ultimi quattro caratteri saranno numeri
che verranno incrementati automaticamente incrementati quando viene creata
la sequenza di immagini. Il tipo di formato di file sarà quello che avete
impostato nella finestra Movie> Movie Settings.

2. Dopo aver immesso il nome e la locazione del file, cliccate su OK per per
cominciare l'elaborazione. Quando Video Action processa il filmato, un
indicatore di progresso mostra l'avanzamento in percentuale.

Fate attenzione al fatto che quando Video Action crea un file RVA , il Virtual File
System vi fornisce un accesso immediato al video come sequenza di immagini.
Consultate la Guida Utente della Perception RT per maggiori informazioni.

Realizzazione di un File d'animazione
(FLC/FLI)
Selezionate Movie> Make Image Sequence dal menù. Appare una finestra che vi
permette la selezione della locazione e del nome del file d'animazione. Potete
anche selezionarte il formato di file FLC o FLI.

Realizzazione di una Clip Sonora (WAV)
Slezionate Movie> Make Movie> WAV File Output dal menù se volete salvare la
traccia sonora del filmato come file WAV. Appare una finestra che permette la
selezione della locazione e del nome del file WAV.
Fate attenzione al fatto che potete elaborare la porzione audio del file RVA
utilizzando Sound Forge senza salvare il filmato come file WAV. (Consultate il
Capitolo 10 per maggiori dettagli.)
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Edit Decision List (EDL)

Tipi di Elaborazione
I tipi di editing sono essenzialmente due: elaborazione online ed off-line.
La finalizzazione dell'elaborazione video online è considerata come un prodotto
finito di alta qualità. L'elaborazione online richiede l'utilizzo delle videocassette
originali per creare una cassetta finale di alta qualità. Per creare un prodotto finito
d'alta qualità in genere vengono utilizzate attrezzature molto costose  come
periferiche S-VHS, Beta SP e periferiche da 1". Quando è interessato video
digitale, vengono utilizzate video clip ad alta definizione (clip catturate ad un alto
data rate, di solito 6MB/s o più alto).
Dalla parte opposta si colloca l'elaborazione off-line, che utilizza sorgenti video a
qualità più bassa (copie delle sorgenti video originali, o clip video digitali a bassa
risoluzione) per produrre un prodotto intermedio che aiuta a prendere decisioni
sull'elaborazione.
L'elaboarazione analogica off-line tradizionale utilizza copie delle cassette sorgenti.
Ogni volta che le videocassette vengono visionate, la loro qualità peggiora.
Utilizzando delle copie mentre si effettuano le opportune decisioni, si preserva la
qualità delle cassette sorgenti. La bassa qualità delle videocassette copiate non
costituisce un problema, in quanto esse non saranno utilizzate per l'elaborazione
finale.
L'elaboarazione off-line digitale utilizza video clip digitali a bassa risoluzione.
Queste clip a risoluzione più bassa occupano meno spazio sugli Hard Disk. Inoltre
quando ad esse vengono applicati effetti, i tempi di rendering sono inferiori,
permettendo di risparmiare tempo mentre di effettuano decisioni.
Durante l'elaborazione off-line tutte le procedure di montaggio, come transizioni,
tagli, e sovraimposizioni, vengono fatte come se fossero sul prodotto finale. In
seguito una Lista delle Elaborazioni detta "Edit Decision List" (EDL) viene creta per
permettere decisioni off-line da essere utilizzate per l'elaborazione online. L'EDL è
un file di testo che descrive la struttura del video elaborato. L'EDL identifica il
Timecode dei segmenti utilizzati sulla cassetta sorgente originale. L'EDL
sincronizza i videoregistratori in modo da utilizzare le videocassette originali per
realizzare il prodotto finale ad alta qualità.
Lavorare in off-line per creare un EDL prima di andare in online offre due vantaggi:

• La qualità delle cassette sorgenti è preservata perché le decisioni di montaggio
vengono prese lavorando su delle copie.

• Il tempo richiesto per compilare un video in una costosa regia online viene
ridotto notevolmente.
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Esportazione di un EDL
Una volta che avete completato un progetto sulla vostra Timeline (Inclusi effetti,
transizioni e tagli), potete generare un EDL con Video Action, che utilizza il formato
CMX 3600.
Per generare un EDL dalla Timeline:
1. Quando la Timeline è attiva, selezionate Movie> Export to EDL> CMX 3600

EDL dal menù principale.
2. Nella finestra "Save as EDL File" potete cambiare:

• Titolo - Il file EDL può contenere un titolo opzionale di 16 caratteri.

• La registrazione in tempo - Selezionate il tempo espresso in timecode
SMPTE in cui la cassetta comincerà la registrazione.

• La selezione dei codici delle tendine - "la finestra "Wipe code… " mostra i
codici delle tendine utilizzati di solito nelle regie di alta qualità. Il codice
delle wipe è costituito da 1 a 4 caratteri, codici alfanumerici che
descrivono la transizione tra due clip.

3. Scegliete un nome per il file ela locazione, poi cliccate OK. Fate attenzione al
fatto che un file EDL da utilizzare con  un sistema online deve avere un nome
essere composto da un numero massimo di 6 caratteri e deve
necessariamente avere l'estensione .edl.

Il file EDL appare sul vostro schermo per la visualizzazione. Un file EDL CMX 3600
è un semplice file ASCII ("composto solo da testo") che usa un formato molto
specifico. Gli altri formati di file (GVG, Sony, etc.) sono simili ma incompatibili. Se il
vostro file Edl dovrà essere utilizzato da un sistema online che utilizza un formato
differente, è possibile effettuare la conversione tramite programmi esterni come
EDLMAX, Turbo Trace Pro o EDL Pro.
Il file EDL è composto da alcuni componenti principali.

• Header: L'header contiene il titolo che avete dato al file quando lo avete salva.
Notata che questo non è il nome del file.

• FCM (Frame Count Mode): Per l'NTSC questo mostrerà quando la vostra
sorgente sta utilizzando la modalità Drop Frame o Non-drop Frame.

• Note od altre informazioni.

• Linee di modifica numerate: Queste rappresentano le vostre decisioni. Un
taglio utilizza una singola linea di modifica, mentre un effetto (come una
dissolvenza, una tendina o un filtro) utilizza due lineee di modifica. Ogni linea è
costituita da:

• Numero di modifica
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• Nome del nastro (Reel) - Il nome della cassetta che contiene la clip (Notate
che questo in un EDL deve essere composto da un numero massimo di 8
caratteri alfanumerici, con non più di 7 caratteri per permettere l'aggiunta  della
"B" per B-Rolls.)

• Tipo di Modifica - Mostra una clip audio (AA) e/o video (V)

• Source In/ SourceOut - I timecode in cui la clip comincia e finisce sulla
cassetta sorgente

• Record In/Out - I timecode in cui la clip comincia e finisce sulla cassetta finale.

Un semplice taglio dal reel sorgente "Animals" alla cassetta di destinazione
Edit# Reel Name Channel Trans Dur Source In Source Out Record In Record Out
002 Animals AA/V C 00:00:06:00 00:00:29:00 00:00:04:00 00:00:27:00

Una dissolvenza di 120 Fotogrammi. La linea finale è una nota EDL.

Edit# Reel Name Channel Trans Dur Source In Source Out Record In Record Out
003 Animals AA/V C 00:00:29:00 00:00:29:00 00:00:27:00 00:00:27:00
003 Dogs AA/V D 120 00:00:40:00 00:00:44:00 00:00:27:00 00:00:31:00
EFFECT NAME IS CROSS DISSOLVE

Fate attenzione al fatto che potete agiungere o cambiare il nome del reel  e i
timecode di una clip. Nella Gallery, cliccate con il tasto destro su una clip e
selezionate Timecode dal menù che paare. Sulla Timeline, cliccate sulla clip (per
selezionarla) e scegliete Edit> Clip> Timecode Clip dal menù principale.
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Lavorare con i Progetti di Video Action
Ogni volta che avviate Video Action viene avviato un nuovo progett o vuoto, con
una Timeline vuota ed una Gallery vuota anch'essa. Non potete tener aperto più di
un progetto per volta. Ogni progetto può avere quante Gallery desiderate, ma non
potete avere più di una Timeline per progetto. Inoltre non potete aggiungere una
nuova Timeline se il progetto corrente ne ha già una.
Un progetto di Video Action rappresenta un collegamento tra la Timeline e le
Gallery che erano aperte nel momento in cui avete salvato il progetto. Quando
salvate un progetto, vi sarà chiesto di salvare anche le vostre finestre Timeline a
Gallery. Dovete necessariamente salvarle se volete che il vostro progetto venga
registrato nello stato corrente del vostro lavoro.

Cominciare un Nuovo Progetto
Per cominciare un nuovo progetto:
1. Selezionate  File> New Project  dal menù principale.
2. Vengono create una Timeline ed una Gallery nuove.
3. Se una Timeline ed/od una Gallery erano già aperte vi sarà data la possibilità

di salvarle prima che il nuovo progetto venga creato.

Caricare un Progetto
Per caricare un progetto creato in precedenza:
1. Selezionate File> Load Project  dal menù principale. Apparirà la finestra File

Open.
2. Scegliete un file di progetto da aprire (con estensione .pj)
3. Cliccate su OK. Se il progetto corrente non è stato ancora salvato, apparirà

una finestra che vi chiederà di salvare o di annullare i cambiamenti effettuati al
progetto corrente. Cliccate su Yes o No per salvare o meno il progetto corrente
prima di aprire il nuovo progetto. Fate attenzione al fatto che i cambiamenti
effettuati nelle Gallery vengono aggiornati nel momento in cui vengono fatti,
per questo motivo non possono essere ripristinate la loro stato originario anche
se erano state salvate in un progetto.

4. Il progetto selezionato viene caricato.
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Capitolo 6
Le Transizioni

Fig.1 Pag.93

Introduzione
Una transizione è il passaggio da una clip ad una altra attraverso un processo di
conversione come una dissolvenza o una tendina. Questo processo combina due
clip in un solo flusso video.
Video Action gestisce due tipologie di transizioni: Transizioni in tempo reale (RT
transitions) e Transizioni “renderizzate”. Le prime sono generate instantaneamente,
in tempo reale, non appena si sovrappongono le clip sulla Timeline. Esse si
avvantaggiano della gestione Dual Stream della PVR RT che permette l’accesso
simultaneo alle clip poste su V1 e V2 durante l’esecuzione delle transizioni.
Per ottenere ulteriori possibilità di transizione, si possono utilizzare le transizioni
renderizzabili, che devono essere “pre-calcolate” prima  di poter essere visionate
nei filmati.
Ogni volta che sovrapporrete due clip sulle tracce V1 e V2 della Timeline, sarà
creata automaticamente una dissolvenza incrociata. Questa transizione potrà
essere modificata.
Potrete scegliere tra più di 200 transizioni RT preconfigurate che possono essere
personalizzate usando “ Keyframes”, Bordi e filtri. Potrete realizzare delle proprie
transizioni RT caricando un qualsiasi file di immagine. Le  transizioni renderizzate
già preconfigurate tra cui scegliere sono 80 e tutte  sono personalizzabili. Video
Action è fornito di un catalogo di oltre 1000 transizioni, garantendo la possibilità di
scelta fra ulteriori transizioni renderizzabili. Grazie alla funzione Transizion Wizard
combinando effetti speciali, proprie grafiche e transizioni pre-esistenti otterrete altre
transizioni renderizzabili.
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Come  Creare una Transizione
1. Caricate sulla Gallery le clip da montare.
2. Posizionate la clip di partenza sulla traccia V1 della Timeline. Posizionate la

seconda clip  sulla traccia  V2 della Timeline.
3. Trascinate la seconda clip verso la prima clip in modo che la fine della prima si

sovrapponga con l’inizio della seconda.  La lunghezza della sovrapposizione
determina la durata della seconda. Automaticamente, una dissolvenza sarà
posizionata sulla traccia X per tutta l’area di sovrapposizione.

Fig.1 pag.94

4. Per sostituire una transizione con un’altra presente nell’elenco delle transizioni,
selezionate la transizione da sostituire. Il doppio click sulla transizione aprirà il
menù delle Transizioni RT. Alternativamente cliccando col tasto destro del
mouse si potrà aprire il menù a comparsa delle Transizioni o selezionando il
menù Transition dal menù principale. Si potrà scegliere RT transition per aprire
il menù delle transizioni  in tempo reale o rendered transition per aprire il menù
delle transizioni renderizzabili.

5. Selezionate la transizione desiderata, personalizzatela, aggiungete degli effetti
e tornate alla timeline per visionare il vostro filmato.
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Transizioni in Tempo Reale
La gestione a doppio stream(flusso) della vostra scheda permette la generazione di
transizioni che non necessitano del processo di rendering prima di essere
visionate.  Sarete capaci di cambiare transizioni, cambiare la durata, di aggiungere
effetti, e di vedere il risultato istantaneamente.
Per aprire il menù delle transizioni RT bisogna prima creare una transizione su cui
lavorare. Posizionate i file RVA e RVD su V1 eV2, sovrapponeteli e effettuate un
doppio click sulla transizione di base generata sulla traccia x.

Una descrizione della
transizione
selezionata

Riproduzione
Apre la seconda
metà della Finestra

Chiude la  finestra
con/senza effettuare
cambiamenti

Salva una transizione
personalizzata o ne
carica una  pre-
registrata

Aggiunge un effetto
Realtime

Inverte la direzioneUsate i regolatori dei
Keyframes  per
impostare i keyframes

Il tipo di transizione

Cliccate sui rettangoli
per selezionare le
transizioni

Cliccate sulle frecce
per spostarvi sulle
pagine delle transizioni

Spostate i cursori per
impostare i keyframes

Linear: cambiementi graduali tra
un Keyframe ed un altro.
Discontinuous: Assume una
constante

Risparmia spazio su disco
comprimendo la maschera
di  transizione creata
usando RT filter

Il click col tasto destro su
qualsiasi  area grigia di
questa finestra apre la
finestra  Options

Spunta questi
riquadri per attivare i
Keyframes per il
Bordo e Sfumatura
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Usare i Keyframe con le Transizioni RT
Un Keyframe è un fotogramma di una clip su cui poter impostare e salvare delle
proprie impostazioni. Video Action effettua l’interpolazione tra i Keyframe,
cambiando gradualmente i parametri da un keyframe al successivo. Si possono
personalizzare tutte le transizioni, gli effetti e i  filtri impostando dei Keyframe.
Per accedere ai keyframe delle transizioni Real Time attivate il pulsante
Customize presente sul pannello Real Time Transitions. Apparirà un altro pannello
per permettere l’inserimento  dei parametri dei keyframe e il controllo dei Keyframe.
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La sezione dei controlli dei Keyframes consente di determinare la Progressione
della transizione, Il Bordo (lo spessore dei colori mostrati ai bordi della transizione),
il colore (il colore del bordo) e il “softness”(la smussatura e trasparenza dei bordi).
Spostate i selettori per cambiare i parametri del Keyframe correntemente attivo. (Il
Keyframe attivo è contraddistinto da un indicatore blu sotto la barra graduata in
percentuale.)  Si noti che in configurazione senza scheda R3DX sono presenti dei
box di attivazione alla fine dei selettori Border e Softness. Attivandoli sarà possibile
impostare Keyframe per l’ampiezza del bordo e la variazione del colore e della
smussatura del bordo. Se non saranno attivati verranno usati gli stessi valori per
tutti i keyframe. Per cambiare il colore da usare per il bordo cliccate due volte sul
rettangolo colorato, si aprirà la palette dei colori.
Prima di effettuare qualsiasi cambiamento ci saranno 2 Keyframe, uno all’inizio
della transizione ed uno alla fine. Potrete aggiungere i Keyframe in qualsiasi punto
della barra graduata. Quando si aggiunge un Keyframe saranno assegnati tutti i
parametri correnti.  Potrete modificare questi parametri finchè il cursore è
posizionato sul Keyframe.
Potrete spostare un Keyframe una volta creato. Posizionate il puntatore del mouse
sopra un indicatore del Keyframe che si desidera spostare, il puntatore si
trasformerà in una doppia freccia orizzontale. Trascinate l’indicatore a destra o a
sinistra.

Fig 1 pag97

Usare gli effetti RealTime(Ridefinire una Transizione)
Le transizioni Real Time sono ulteriormente personalizabili tramite un certo numero
di effetti real time. Per selezionare questi effetti cliccate su Customize, si aprirà il
pannello per l’impostazione dei Keyframes, quindi cliccate su Filters. Apparirà la
finestra RT Effect Preview. Per alcuni effetti, sempre su questa finestra, saranno
presenti delle opzioni specifiche per ciascun effetto. Userete questa finestra per
aggiungere i filtri real time (Rt Filters) su molte transizioni.

Ricordate: Altri effetti RT

Se si desidera aggiungere un’assolvenza da/verso il nero basta cliccare con il tasto
destro del mouse sulla clip prescelta e selezionare “RT Fade” dal menù
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La finestra Design Transition

Impostazioni  per Transizioni specifiche.
Alcune transizioni possono essere ulteriormente personalizzate tramite la funzione
Filters. Queste transizioni presentano un piccolo triangolo in alto sulla parte destra
delle loro icone. Sulla destra della finestra RT Effect Preview ci saranno tutti gli
ulteriori controlli. Sarà possibile spostare il centro di una transizione o cambiarne
l’orientamento.
Le transizioni, con il triangolino, sono:

• Split Screen (Simple, pagina 1, numero 8):orientation

• Clock Wipe Off Center (Simple: pagina 1,numero 15) Move center(Sposta il
centro), start angle(angolo di partenza)

• Clock Wipe Center (Simple: pagina 1, numero 16): start angle(angolo di
partenza)

• Radial Wipe Left (Simple: pagina 1, numero 17): Location of fixed point on left
side, (Posizione di un punto fisso sul lato sinistro)

• Radial Wipe Right (Simple: pagina 1, numero 18): Location of fixed point on
right side, (Posizione di un punto fisso sul lato destro)

• Radial Wipe Bottom (Simple: pagina 1, numero 19): Location of fixed point on
bottom side, (Posizione di un punto fisso sul lato inferiore)

• Radial Wipe Top (Simple: pagina 2, numero 1): Location of fixed point on top
side, (Posizione di un punto fisso sul lato superiore)

• Radial Wipe Corner (Simple: pagina 2, numero 2): Location of corner with fixed
point, (Posizione dell’angolo con  un punto fisso)
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• Circle (Shapes: pagina 1, numero 16): Move center(Sposta il centro)

• Diamond (Shapes: pagina 1, numero 17): center(centro),angle(angolo), lenght
of  arms(lunghezza delle punte)

• Star(Shapes: pagina 1, numero 19): number of  arms(numero delle punte),
angle(angolo), lenght of  arms(lunghezza delle punte),center(centro)

• Checkerboard (Pattern, pagina 1, numero 16); rows(righe), columns(colonne)

• Random Checkerboard (Pattern, pagina 1, numero 17); rows(righe),
columns(colonne), seed(“seme”, per la casualità dell’effetto)

• Louvers (Patterns, pagina2, numero 3) number of louvers, orientation

• Slices (Patterns, pagina2, numero 6) number of Slices, orientation

• Jaw (Patterns, pagina2, numero 6) number of teeth, orientation

Aggiungere gli “RT Filters”
Per applicare gli RT alle proprie transizioni cliccate sul pulsante Add Filters posto
sulla finestra di “RT Effect Preview ”. Si noti che gli effetti sono cumulabili, l’ordine
secondo cui li applicherete risulterà significativo.

Evidenziate il filtro
che volete applicare
e cliccate su Add

Potrete salvare una lista
di filtri (con le relative
impostazioni) o caricare
una lista salvata
precedentemente

Gli effetti prescelti
saranno mostrati qui. Il
doppio click sul filtro o
cliccando su Options
vi permetterà di
cambiarne le
impostazioni.

Cliccando Cancel uscirete senza
cambiamenti, OK per uscire salvando i
cambiamenti.
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Flip (Inversione)

Questo filtro inverte la transizione orizzontalmente, verticalmente o orizzontalmente
e verticalmente.

Mirror(Specchio)

Questo filtro agisce sulla transizione dividendo lo schermo in due metà,
specchiando una metà nell’altra. Potrete scegliere di dividere lo schermo a metà in
verticale, specchiando il lato sinistro sul destro (L->R) o il lato destro sul sinistro
(L<-R), oppure potrete scegliere di dividere lo schermo orizzontale, specchiando la
parte superiore nella inferiore (T->B) o viceversa (B->T)
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Repetition(Ripetizione)

Questo filtro suddivide in più caselle lo schermo tramite righe e colonne, ripetendo
l’effetto per ogni casella.

Twirl/Lens/Rotate(Vortice/Lente/Rotazione)

Questo effetto dispone di diversi tipi di effetti da distorsione basati sulle
caratteristiche di lenti ottiche. Su ogni effetto è possibile regolare la
concavità/convessità, e la distanza dalla clip. Inoltre possono essere applicate una
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rotazione e un vortice al tipo di lente circolare. Tramite l’impostazione di Keyframe,
spostando la lente e regolandone le sue dimensioni e/o l’angolo di rotazione, è
possibile generare effetti impressionanti.

Lens Type (Tipo di lente)

• Circular Lens Custom Size-Garantisce lo stesso risultato di una vera lente
ottica di forma circolare posta di fronte ad un’immagine. Regolate le dimensioni
della lente usando il puntatore del mouse e trasinando il suo  bordo esterno.
Spostate la lente trascinando il suo punto centrale.

• Circular Lens Fit to Frame- Queste lenti producono lo stesso risultato di
Circular Lens Custom Size quando la lente è grande abbastanza da coprire
tutto lo schermo.

• Pinch_Deforma l’immagine sotto la lente mentre i bordi sono mantenuti a posto
da un immaginario annello delle dimensioni dello schermo. Regolando la
concavità/convessità, l’immagine può essere trasformata per sembrare  come
se il centro e fosse schiacciato fuori o dentro lo schermo.

• Custom Pinch_ Questa lente produce lo stesso risultato dell’effetto Pinch con
la possibilità di modificare le dimensioni e posizione  della lente stessa.

• Rectangular Pinch Simile al Pinch tranne per i bordi che sono bloccati da un
rettangolo. Possono essere impostate la concavità e la convessità. Questa
lente non supporta la distanza o il vortice.

Lens Effect:

• Concavity/Convessity(Concavità/Convessità)-regola il profilo della lente.
Spostando il cursore verso destra si aumenta la concavità, determinando un
effetto di ingrandimento. Spostanto il selettore a sinistra si ha il risultato
opposto, ad esempio aumentando la convessità si avrà un ridimensionamento.
Quando questo selettore è su none (es: 50), la lente non altera la clip(Gli effetti
“rotation” e “twirl” potranno essere comunque applicati ottenenendo risultati
molto interessanti.) Le unità utilizzate per rappresentare la concavità ela
convessità sono numeri relativi.

• Distance – Definisce la distanza tra la lente e lo schermo. Aumentando la
distanza per una data Convessità o Concavità si provoca un maggior
ingrandimento/de-ingrandimento. Le unità utilizzate per rappresentare la
distanza sono numeri relativi.

Rotation/Twirl

• Twirl – Regola l’entita della distorsione di un’immagine quando quest’ultima
subisce una rotazione. Esistono due casi. Quando questa opzione non è
attiva, angle( angolo) e turns ruotano semplicemente l’area sotto la lente.
Quando questa opzione è attiva, angle e turns creano un effetto ciclone, dove
partendo  dal centro, è più forte la rotazione mentre diminuisce
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progressivamente verso l’esterno della lente. Questa opzione è attivabile solo
per lenti circolari.

• Angle – Determina l’angolo della rotazione all’interno di un giro completo.
Spostando questo selettore verso destra, si ruota la lente in senso anti-orario
con il numero di gradi indicati, fino ad un massimo di  360°. Spostando questo
selettore verso sinistra, si ruota la lente in senso orario con il numero di gradi
indicati, fino ad un massimo di  -360°. Questa opzione è attivabile solo per lenti
circolari.

• Turns - Definisce il numero di giri completi della lente. Spostando questo
selettore verso destra, aumenta il numero di giri  in senso anti-orario mentre
verso sinistra, aumenta il numero di giri  in senso orario. Questa opzione è
attivabile solo per lenti circolari. Cambiando il numero di giri su differenti
Keyframe dà come risultato una sezione circolare rotante durante la
riproduzione del filmato.

Wave



       Video Action RT

______________________________

105

Questo filtro crea delle onde sulla transizione. Il tipo di distorsione dipende dal tipo
di onda selezionato(es.Sinusoidale(sine),Quadrata ((square)o triangolare). Potete
impostare onde multiple e l’intervallo per l’ampiezza e il periodo. L’intensità di
questo effetto può essere interpolato

Wave Controls:

• Wave Form:- Seleziona una delle seguenti onde: Sinusoidale, quadrata o
triangolare.

• Parameter For Directions:- Seleziona i controlli per le onde Orizzontali e
Verticali.

• Number of Waves- Determina il numero di onde da generare nella direzione
selezionata. Assegnate a zero questo selettore per non generare alcun onda
nella direzione correntemente selezionata.

• Speed- Determina la velocità del passaggio delle onde sullo schermo. Può
variare nell’intervallo tra 0 e 200. Il numero assegnato è un numero relativo.

• Intensity Range – Determina l’intervallo di ampiezza(in altezza) permesso per
la generazione delle onde.Il valore min assegna il limite inferiore, il valore max
assegna il limite superiore per l’altezza delle onde.

• Wavelenght Range – Determina l’intervallo di lunghezza d’onda permesso per
la generazione delle onde. Il valore min assegna il limite inferiore, il valore max
assegna il limite superiore di lunghezza d’onda.

• Effect Strenght – Determina l’intensità dell’effetto. Al valore min 0% non c’è
effetto. Spostando questo selettore verso il valore max di 100% l’effetto diviene
più forte.

• Predictability – Determina la precisione d’ordine di creazione e combinazione
delle onde.  Per un aspetto simmetrico, selezionate More. L’opzione Less
fornisce uno schema di onde senza ordine.

Esempio: Personalizzazione di una
transizione RT
1 Mettete un RVA su V1 e un RVA su V2. Sovrapponeteli per ottenere una

dissolvenza.
2 Il doppio click sulla transizione aprirà il relativo pannello. Cliccate su Pattern,

andate sulla pagina 2, selezionate la transizione SLIME (numero14).
3 Cliccate sul pulsante Customize per aprire i controlli per i Keyframe.
4 Cliccate sul piccolo riquadro posto alla destra del selettore border (così potrete

impiegare i Keyframe anche su Border).
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5 Un Doppio click sul Riquadro Colore(Color Box), selezionate il Rosso come
colore di bordo. Portate il selettore Border fino a 140.

6 Spostatevi sull’ultimo Keyframe(Potete cliccare sulla freccia posta alla
estremità destra della barra graduata dei Keyframe.)

7 Cliccate sul riquadro di attivazione Reverse.
8 Cliccate sul pulsante Design Transition.
9 Cliccate su Add Filters. Doppio click sul filtro Wave(sul fondo dell’elenco dei

filtri disponibili).
10 Spostate il selettore”Number of Waves” fino a 9. Nella sezione Predictability

selezionate “Less”. Cliccate su OK per tornare alla finestra di selezione dei
filtri, ancora su OK per tornare al pannello Design Transition.

11 Il riquadro “apply Filters” sarà attivato automaticamente dopo aver selezionato
un filtro. Accertatevi che sia abilitato. Cliccate su OK per tornare sul pannello
RT Transition.

12 Cliccate il pulsante Play per vedere la transizione appena personalizzata.
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Costruire delle proprie transizioni RT
Oltre alle 200 transizioni predefinite incluse con VideoAction, potrete generare delle
proprie transizioni tramite un file d’immagine per definire una tendina a gradienti.
Sulla prima pagina del pannello RT Transition, in basso a
destra, è posta l’icona Custom Transition. Se cliccate su
questa icona vi sarà chiesto di selezionare un file
d’immagine. Questo file d’immagine sarà utilizzato per
generare un file WFX che sarà usato per la vostra
transizione. Il file d’immagine selezionato potrà essere di
qualsiasi dimensione. Se non è esssattamente delle
ddimensioni di un fotogramma video(NTSC 720x486/ PAL
720x576) sarà espanso fino alle dimensioni dello schermo.
Una tendina a gradienti si basa sulla scala di grigio delle vostre immagini  per
determinare l’ordine di progressione in cui le aree della prima clip diverranno
trasparenti fino a mostrare la seconda. Le aree nere diverranno trasparenti per
prime, seguite da quelle meno scure, fino alle aree bianche che diverranno
trasparenti per ultime.
Potrete utilizzare sia immagini a colori che a toni di grigio per generare le vostre
transizioni a gradienti, tuttavia solo le informazioni relative alla scala di grigio
sarranno usate per la generazione della transizione. Per aiutarvi a determinare
l’influenza della vostra immagine a colori quando sarà usata per generare la
tendina a gradienti, potreste importare l’immagine prescelta in un programma di
disegno o di foto-ritocco e convertirla in scala di grigio. Quindi potreste regolarne la
luminosità e il contrasto per produrre la transizione desiderata.

Esempio: Creazione di una transizione
partendo dal logo DPS
Il logo DPS è stato usato per generare la transizione presente nel gruppo delle
transizioni “Shapes”(ultima riga in basso sulla seconda pagina). Questo esempio
spiegherà un metoto per la sua creazione.
Per creare questa transizione sono stati impiegati due gradienti a toni di grigio.
Un gradiente sfumato è indispensabile se desiderate ottenere un bordo che si
muove fluidamente. Potreste impiegare un programma di disegno per crare questi
gradienti sfumati. Tuttavia, potreste decidere di impiegare il Gradient Wizard di
Video Action per creare i vostri gradienti. Per questo esempio collezionate
un’immagine di colore bianco nella Gallery, posizionatela sulla Timeline, quindi
dopo aver applicato il Gradient Wizard(tramite il pulsante FX sulla barra degli
strumenti e cliccando il pulsante Gradient Wizard) usate la funzione “Make a single
frame” per creare i file tif necessari.
Per creare un gradiente circolare con una scala da nero a grigio usando il Gradient
Wizard:
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Una volta ottenuto il gradiente desiderato cliccate su OK e tornate sulla Timeline.
Sempre sulla Timeline, posizionate il cursore sulla clip su cui è applicato l’effetto
Gradient Wizard e usate la funzione usate la funzione “Make a single frame”.
Ricordate che le impostazioni usate(il tipo di file,dimensioni etc.)sono assegnate
tramite la finestra Movie Settings nella sezione “Images”. Normalmente è creato un
file di tipo BMP. Noi useremo il tif.
Nello stesso modo abbiamo creato un gradiente da bianco a grigio (tramite il
pulsante “To Color” e assegnando i valori RGB a 145 per il grigio) e lo abbiamo
salvato come file tif. Sappiate che non erano stati usati gli stessi valori RGB.
Nero a Grigio(RGB=110)        Bianco a Grigio(RGB=145)

Successivamente questi due gradienti, insieme ad un logo nero della DPS su
sfondo bianco, sono stati aperti in un programma di disegno. Il logo è stato adattato
alle dimensioni dello schermo(NTSC 720x486/ PAL 720x576). Dopo aver
selezionato l’area bianca, esterna al logo, l’area è stata copiata ed incollata sul
gradiente da bianco a grigio. Così è stato creato il logo della DPS con il gradiente,
che si evolve dal centro scuro al bordo chiaro.

Trascinate  della
Trasparenza fino a
100%
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DPS LOGO Ridimensionato                         DPS LOGO - Gradient

Poi è stata selezionata l’area non completamente bianca del logo grigio della
DPS(Selezionanando l’area bianca e invertendo la selezione) che è stata
successivamente copiata e incollata sul gradiente nero-grigio. Ciò ha prodotto il file
definitivo “DPS.tif”  usato per creare la nostra transizione con la funzione Custom
RT Transition.

Ogni volta che questo file è impiegato dalla funzione Custom RT Transition, sarà
creato un file DPS.wfx. Questo file sarà a sua volta impiegato quando si esegue
custom Rt transition.
Quando si riproduce questa transizione le aree scure diventano trasparenti per
prime permettettendo alla seconda clip di essere visualizzata attraverso la prima
I bordi neri definiti dal file diventano trasparenti e la tendina si sposta gradualmente
verso il centro lasciando visualizzare il logo DPS. C’è una breve pausa durante la
visualizzazione del logo DPS(Ricordate:sono stati creati due gradienti con toni di
grigio diverso) Poi il gradiente usato per creare il logo DPS spazza via dallo
schermo il logo partendo dal centro più scuro verso i bordi più chiari.

Suggerimento:Il formato di file da usare con Custom RT Transition.

Usate il formato BMP,TIF o TGA per creare le vostre transizioni personalizzate.
Non usate i file in formato JPG. I bordi deidelle immagini JPG presentano piccole
variazioni cromatiche che possono produrre un fastidioso tremolio del bordo della
transizione.
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Rendering di una Transizione RT
Potrebbe succedere di voler sovraimporre un titolo in tempo reale su una
transizione RT. Un sistema a doppio stream in tempo reale può gestire 2 stream
video alla volta, e non può gestirne 3, così la sezione della Timeline che presenta
più di 2 stream video avrà bisogno di rendering.
Un altra possibilità è quella di ottimizzare la transizione RT. Questa funzione
trasforma una transizione a doppio stream (RT) in un unico file, in modo da
impegnare solo uno stream. In effetti, essa renderizza la transizione RT
realizzando un nuovo file. Ciò libera il 2° stream, permettendo la sovrapposizione di
un titolo in tempo reale sopra una transizione ottimizzata.
L’opzione Optmize RT Transition è presente nel menù a comparsa attivabile
tramite la pressione del tasto destro su una transizione RT. Quando si ottimizza
una transizione RT appare un punto bianco nell’angolo in alto a sinistra del
rettangolo che rappresenta la transizione sulla timeline. Se si altera una transizione
ottimizzata sarà necessaria una nuova ottimizzazione. Pertanto si dovrebbe
ottimizzare una transizione solo quando avete finito di posizionarla o modificarla.
Durante il processo di ottimizzazione appare una barra con l’indicatore di
progressione. Potrete premere il tasto ESC per interrompere il processo.
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Elenco delle Transizioni RT
Video Action dispone di 200 e più transizioni in tempo reale già predefinite. Sono
state divise in 5 gruppi per aiutarvi nella loro ricerca.

Simple
Il gruppo di transizioni “Simple” comprende la transizione di default( Dissolvenza
incrociata(Fade fromA to B))e altre semplici tendine.

Shapes
Il gruppo di transizioni “Shapes” comprende una pagina di semplici forme
geometriche e una pagina di forme basate su maschere complesse.
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Patterns
Il gruppo di transizioni “Patterns” comprende una varietà di Vortici, scacchiere,
zigzag, fluidi e frantumazioni.

Misc1
Il gruppo di transizioni “Misc1” comprende due pagine di transizioni completamente
differenti.
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Misc2
Il gruppo di transizioni “Misc2” comprende tre pagine di transizioni completamente
differenti.
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Le Transizioni da Renderizzare
Video Action offre una vasta gamma di transizioni predefinite che necessitano di
rendering prima di essere visualizzate in un filmato. Se non riusciste a trovare la
transizione che cercavate nel pannello delle transizioni RT, molto probabilmente la
troverete tra le transizioni da renderizzare o potreste costruirla da soli con Alpha
Channel Mask Wipe o il Transition Wizard. Le transizioni RT possono essere
impiegate esclusivamente con i file RVA e RVD. Le transizioni da renderizzare
possono essere impiegate su qualsiasi tipo di file supportato da Video Action.
Per selezionare una delle transizioni predefinite darenderizzare cliccate con il tasto
destro del mouse sulla transizione da modificare e selezionate sul menù a
comparsa Rendered Transitions. Le prime quattro voci indicano i gruppi di
transizioni A-D che raggruppano molte delle transizioni più comunemente usate.
Cliccando su uno dei gruppi, aprirete una finestra che mostrerà le icone animate
delle transizioni disponibili in quel gruppo.

Il doppio click sulla transizione prescelta aprirà la finestra Transition Viewer,
permettendovi di impostare la transizione e visualizzare una rapida anteprima
senza avviare il rendering della transizione.
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Transition Viewer(Transizioni da Renderizzare.)
La finestra Transition Viewer si aprirà ogni qualvolta selezionate una transizione.
Per aprire nuovamente la finestra Transition Viewer, per regolare o avere una
anteprima di una transizione preesistente, sono sufficienti il doppio click(Nota:il
doppio click è sempre sinistro) o il click destro sulla transizione e selezionate
Rendered Transition Viewer.

Suggerimento Rapido

Potete modificare una transizione tramite il doppio click sulla transizione stessa.
Aprirete il Transition Viewer dove potrete fare le vostre regolazioni.
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La finestraTransition Viewer permette di assegnare alcune opzioni sulla transizione
prescelta e agisce come strumento di anteprima.

Schermate di Anteprima
Il Transition Viewer visualizza tre schermate di anteprima. La prima schermata a
sinistra visualizza l’effetto che è mostrato all’inizio della transizione. L’ultima
schermata a destra visualizza l’effetto che è mostrato alla fine della transizione. La
schermata centrale visualizza le vari fasi della transizione stessa dall’inizio alla fine.
Sopra le schermate di anteprima sono visualizzati i tempi relativi all’inizio della
transizione, al fotogramma(può essere cambiato spostando il suo selettore)
mostrato nella schermata centrale e alla fine della transizione. Potete regolare il
ritardo di inserimento dell’effetto(quando inizia la transizione) spostando il selettore
sotto la schermata a sinistra. La percentuale indicata vicino alla voce “Start Effect”
potrà variare da 0% a 50% in relazione a dove si sposta il selettore. Normalmente il
selettore è completamente sulla sinistra pari a 0%, cosìcchè l’effetto inizia
contemporaneamente alla transizione. Nello stesso modo è possibile regolare
come deve procedere l’effetto quando termina la transizione spostando il selettore
posto sotto la schermata destra. La percentuale indicata vicino alla voce “End
Effect” potrà variare da 100% a 50% in relazione a dove si sposta il selettore.
Normalmente il selettore posto sotto la terza schermata è completamente a destra,
indicando 100%, cosìcchè l’effetto finisce contemporaneamente alla transizione.

Show Effect
Cliccando su questo pusante aggiornate la schermata di anteprima. Il punto
specifico della transizione da visualizzare è basato sulla posizione di tutti i selettori
posti sulle barre di scorrimento.

Riproduzione Veloce(Quick Play)
Cliccate su questo pulsante per creare una rapida anteprima della transizione. Un
indicatore visualizzerà in percentuale l’andamento del processo. Completato il
processo, l’anteprima sarà visualizzata nella schermata centrale. L’anteprima della
transizione è visualizzata secondo il numero di cadenza selezionato nel riquadro
Play Steps (Il valore predefinito è 10). Durante la visualizzazione dell’anteprima il
pulsante Quick Play cambia indicazione con “Stop”.
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Borders
Ci sono molte transizioni che permetteno di aggiungere un bordo. Sono disponibili
quattro differenti assegnazioni, attivabili nel riquadro “Border”: No Border(Nesun
Bordo); Border(Bordo); Edge-Antialiasing(Smussatura Bordi); Blend at Border
(Sfocatura ai bordi).
Quando selezionate Border, potete cambiare lo spessore(thickness) e la
sfumatura(softness) spostando i relativi selettori. Quando aumentate la sfumatura,
il bordo si fonderà gradualmente nell’immagine.
Per cambiare il colore del bordo, un doppio click sul quadrato colorato. Apparirà
una palette di colori che vi consentirà di sceglierne uno o di crearne altri.

Custom Area
Nella parte centrale della finestra potrebbero essere visualizzati delle impostazioni
addizionali. Per esempio, per molte transizioni è disponibileun riquadro al centro
dello schermo  che permette il controllo della direzione del movimento durante la
transizione(up(sopra)-down(sotto),left(sinistra), right(destra))

Show Actual Source
L’abilitazione di questo riquadro consente di vedere le clip nella schermata centrale
di anteprima. Per aumentare la velocità di anteprima, potreste preferire di non
vedere le clip sorgenti, disabilitando questa opzione. L’anteprima sarà visualizzata
come le icone animate che appaiono nei vari gruppi di transizioni.

Backward
Questa opzione scambia le clip e inverte la direzione della transizione

More Anti-Aliasing
Quando questo riquadro è attivo la transizione subirà una ulteriore smussatura.
Questo pulsante rimarrà scolorito se non è disponibile/attivabile.

Ok/Cancel
Cliccando Ok si accetta la transizione ele sue regolazioni. La nuova transizione
apparirà sulla traccia Xsostituendo la precedente. Cliccando cancel si ritorna
allTimeline senza cambiamenti.
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Rendered Transition Groups A-D
Video action dispone di quattro grupppi di transizioni da renderizzare che sono
accessibili dal menù Transition. Ogni gruppo visualizza delle icone animate per
aiutarvi nella ricerca della transizione desiderata. Questi gruppi includono le
transizioni più comunemente usate

Transition Group A
Le icone animate del Gruppo A                                    Gruppo A Codici

Il gruppo A consiste di semplici tendine 2D. Si possono definire i bordi. Per molte di
queste transizioni potrete definire la direzione o l’uscita. Per le transizioni a
scacchiera potrete definire il numero di colonne e di righe.
A1: Squeeze to Line
A2:Shrink
A3:Shrink and Fly Away
A4:Shrink at Center
A5:Shrink Vertically
A6:Shrink Horizzontally
A7:Slide Out
A8:Line Wipe Diagonal
A9:Line Wipe
A10:Wipe and Shrink
A11:Wipe and Fly Away
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A12:Wipe by  Shrink at Center
A13:Diagonal Slices
A14:Diagonal Slice Wipe
A15:V Wipe
A16:V Wipe Double
A17:Checkerboard
A18:Checkerboard Random
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Transition Group B
Le icone animate del Gruppo B                                 Gruppo B Codici

Il gruppo B consiste di tendine radiali, ad orologio e a blocchi. Su tutte si possono
definire i bordi. Per molte di queste transizioni potrete definire la direzione della
tendina o il punto di origine. Potrete usare il campo BackWard per invertire la
direzione del movimento. Le tendine a blocchi permettono di definire il numero di
righe e colonne o il numero di sezioni.
B1:Radial Wipe Pattern 1
B2:Radial Wipe Pattern 2
B3:Radial Wipe Pattern 3
B4:Radial Wipe Pattern 4
B5:Radial Wipe Pattern 5
B6:Radial Wipe Pattern 6
B7:Clock Wipe
B8:Radial Wipe Pattern 7
B9:Radial Wipe Pattern 8
B10:Radial Wipe Pattern 9
B11:Radial Wipe Pattern 10
B12:Radial Wipe Pattern 11
B13:Radial Wipe Pattern 12
B14:Radial Wipe Pattern 13
B15:Radial Wipe Pattern 14
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B16:Radial Wipe Pattern 15
B17:Block Wipe Zig Zag
B18:Block Wipe Parallel
B19:Block Wipe Radiate
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Transition Group C
Le icone animate del Gruppo C                       Gruppo C Codici

Il gruppo C consiste di tendine a iride, di transizioni basate su maschere, tendine a
matrice e a taglio. Sulle tendine a iride e sulle transizioni basate su maschere sono
presenti delle regolazioni aggiuntive. Queste transizioni sono indicate nell’elenco
seguente da un asterisco * o da una croce +. Le regolazioni aggiuntive sono
illustrate alla fine di questa sezione.
C1:Iris Round
C2:Iris Diamond +
C3:Iris Cross
C4:Iris star and Polygon +
C5:Mask Based Iris *
C6:Mask Based Wipe *
C7:Mask Based Sequence *
C8:Cross Zoom
C9:Rectangle Matrix
C10:Diamond Matrix
C11:Venetian Blinds Vertical
C12:Venetian Blinds Horizontal
C13:Diamond Vertical
C14:Diamond Horizontal
C15:Split Wipe
C16:Center Split Into Two
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C17:Swap
C18:Center Split Into Four
C19:Louver
C20:Cut
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Iris Diamond(C2) and Iris Star(C4) Transitions

Il doppio click su Iris Diamond o Iris Star si aprirà una finestra che consentiràdi
controllare la forma e l’orientamento del Diamante o della Stella usata nella
transizione

Figura

Ratio of Inner to Outer Circle Radius: Regola la lunghezza delle punte sporgono dal
centro della stella o del Diamante. Se si imposta un rapporto basso, le punte si
allungheranno.
Angle:Regola l’ammontare di rotazioni in senso orario dell’Iride rispetto alla sua
posizione normale.

Mask Based Transition (C5,C6, C7)

Una transizione è basata su maschera, quando l’effetto usato per processare i due
filmati è basato su una maschera definita dall’utente. Una maschera può essere
costituita da un singolo file di immagine o da una sequenza. Quando usate le
transizioni basate su maschera sarà accessibile una finestra aggiuntiva che vi
permetterà di assegnare i parametri prima di aprire la finestra Transition Viewer.
Nel gruppo C sono disponiubili tre transizioni basate su maschera:
C5:Mask Based Iris Effects
Video Action genera un iride basato sulla vostra maschera. La maschera può
essere un’immagine o una sequenza di immagini definita dall’utente, che
allargandosi visualizza la clip B sotto la Clip A
C6:Mask Based Wipe Effects
Video Action genera una tendina basata sulla vostra maschera. La maschera può
essere un’immagine o una sequenza di immagini definita dall’utente, che
muovendosi sulla clip A  visualizza la Clip B come se fosse una normale tendina.
Video Action ridefinisce automaticamente le dimensioni dell’immagine usata per la
maschera per adattarle alle clip. Allo 0% la maschera è posizionata appena al di
fuori del bordo di partenza del fotogramma precedente l’inizio della tendina. Al
100% la maschera è posizionata all’esterno del bordo opposto del fotogramma
immediatamente successivo al completamento della tendina.
C7:Mask Based Sequence Effect
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Video Action genera una transizione basata su una maschera ottenuta tramite una
sequenza di immagini.

Come Impostare un Effetto Iride Basato su Maschera.

Prima di generare un effetto iride basato su maschera dovete creare il file di
immagine o la sequenza di immagini  che si desidera usare come maschera. Il file
può essere creato con qualsiassi programma di disegno pittorico. Create
un’immagine che presenta almeno due aree di tinta unica che possono essere
impiegate per definire l’iride. Conferite una forma che può crescere fino a
comprendere l’intera traccia video. Video Action espanderà l’intera forma dell’iride
partendo dal centro dell’immagine, tuttavia, una volta aperta la finestra Transition
Viewer,potrete spostare il centro dell’iride su qualsiasi punto della clip video.
Se dovete creare una sequenza di immagini da usare come maschera,
raggiungerete un risultato morbido se il centro dell’iride non cambia posizione. Ad
esempio, se usate un uccello che sbatte le ali non spostate il suo corpo. È
sufficiente muovere le ali cosicchè il vostro iride sembrerà un uccello che vola fuori
dallo schermo. Qualunque sia la foma che voi usiate, la transizione inizierà al
centro dello schermo con un piccolo punto che crescerà fino a riempire lo schermo.
Se intendete creare una maschera che abbia più di due colori, per definire l’iride
avrete bisogno di conoscere come la transizione gestirà i colori aggiuntivi.

• Retain Other Color

• Ignore Other Colo

• Other Color Blend Inputs

Una volta creata la vostra maschera sarete pronti per usarla con questa
transizione.
1 Cliccate con il tasto destro sulla transizione, selezionate il gruppo C, eseguite

un doppio click su C5. Adesso si aprirà la finestra Mask Based Iris Setting
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2 Individuate un file da usare come maschera, selezionatelo, e cliccate sul
pulsante Add. Una piccola anteprima dell’immagine sarà mostrata nel riquadro
posto nell’angolo in basso a destra.  Se intendete impiegare una sequenza di
immagini potete aggiungere più di una immagine. Se volete cancellare un
immagine evidenzata nel riquadro Files selected, cliccate sul pulsante Delete.

3 Cliccate sul pulsante Pick Start Track Color e usate l’icona eyedropper per
selezionare il colore dell’immagine che sarà sostituito dalla clip iniziale. Se
state usando una sequenza di immagini questo colre sarà usato per tutte le
immagini.

4 Cliccate sul pulsante Pick End Track Color e usate l’icona eyedropper per
selezionare il colore dell’immagine che determinerà la forma dell’iride. Questo
colore sarà sostituito dalla clip finale, crescendo fino a riempire lo schermo. Se
state usando una sequenza di immagini questo colre sarà usato per tutte le
immagini.

5 Selezionate il tipo di gestione del colore da usare
6 Se avete utilizzato una sequenza di immagini, potreste voler regolare la

sezione  Multiple Image Files Options posta nell’angolo in alto a destra della
finestra. Questa vi permette di definire la ciclicità della sequenza. Se cambiate
il numero dei cicli di una sequenza il numero dei fotogrammi usati per ciascuna
immagine sarà ricalcolato automaticamente.
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7 Una volta inserito tutte le impostazioni desiderate cliccate su Ok, si aprirà la
finestra Transition Viewer.Potrete spostare il centro dell’iride, aggiungere un
bordo, invertire l’andamento della transizione e visualizzare l’anteprima con il
pulsante Quick Play.

L’utilizzo delle impostazioni mostrate in questo esempio ha prodotto il seguente
effetto:
La Maschera: La Transizione al 25%:

PICTURE n.1 PAG.126

Prestate attenzione; la clip 2 viene mostrata attraverso la clip 1 nella sua parte nera
che è stata definita come iris.

Come Impostare l’effetto “Mask Based Wipe Effect”
(tendina basata su una maschera) (C6)
L’effetto “Mask Based Wipe Effect” utilizza una maschera per creare un effetto
personalizzato. Uno dei colori della maschera viene definito per essere rimpiazzato
dalla clip di partenza, mentre un altro colore della maschera viene definito per
essere rimpiazzato dalla clip di chiusura. La maschera spazza poi lo schermo
utilizzando i suddetti colori per determinare la forma dei bordi della tendina.
L’impostazione dell’effetto “Mask based wipe” prevede molti dei passaggi spiegati
nel paragrafo precedente. IL primo passo è quello di creare una maschera
appropriata da utilizzare per effetto. La maschera dovrebbe avere due blocchi solidi
di colore da poter utilizzare per definire i bordi della tendina. Non vi dovete
proccupare delle dimensioni dell’immagine dal momento che Video Action lo
espanderà automaticamente a pieno schermo. Potete anche utilizzare una
sequenza di immagini per definire la vostra maschera se volete che il bordo della
tendina sia animato o se volete animare gli altri colori presenti nell’immagine.
Quando cliccate due volte sulla transizione C6, vi apparirà una finestra per le
impostazioni che vi permetterà di definire la vostra tendina. Una volta che avete
fatto queste impostazioni cliccate su OK in modo che l’effetto venga mostrato nel
Transition Viewer. Fate attenzione: potete utilizzare il menù a scomparsa al centro
della finestra per cambiare la direzione del movimento della tendina (sopra, sotto,
destra, o sinistra).
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Considerate gli esempi seguenti:

(Nota: Ignore Other Colors utilizza tutti i colori non selezionati per la traccia di
partenza come colori per la traccia finale.)
In questo esempio la maschera si muove verso l’alto. I fiori vengno mostrati poiché
Retain Other colors è stato selezionato nell’area Color Handling Option.

Selezionate le opzioni
di gestione dei colori

Selezionate il file
d’immagine che volete
utilizzare come
maschera.

Se state utilizzando
una sequenza di
immagini, determina le
opzioni di
looping(ripetizione
ciclica)

Seleziona il colore
utilizzato per definire la
forma della vostra
maschera

La Clip B
appare
mentre la
maschera si
muove
verso l’alto.
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Come impostare l’Effetto “Mask Based Sequence” (Effetto
basato su una maschera costituita da una sequenza di file
d’immagine) (C7)
L’ effetto “Mask Based Sequence” utilizzza una sequenza di file d’iimmagine per
creare un effetto personalizzato. Uno dei colori della sequenza di file viene definito
per essere rimpiazzato dalla clip di partenza, mentre un altro colore della viene
definito per essere rimpiazzato dalla clip di chiusura. Duranta le riproduzione della
sequenza, ogni animazione nei colori selezionati verrà utilizzata per creare la
vostra transizione.
L’impostazione dell’effetto “Mask Based Sequence” prevede molti dei passaggi
illustrati nei paragrafi precedenti. Come per gli effetti basati su maschere, Il primo
passo è quello di creare una sequenza appropriata da utilizzare per effetto. La
differenza rispetto ai due effetti illustrati in precedenza è che l’immagine utilizzata
per la maschera non crescerà (come fa nella transizione iris) e non si muoverà
(come fa nella tendina). Ogni movimento in questa transizione sarà dovuto alla
sequenza di immagini che avete selezionato. Mentre questo vi fornisce il massimo
del controllo durante l’arco dela transizione, avrete bisogno di considerare
esattamente quanto sarà lunga la transizione e di quante immagini avrete bisogno
per nella vostra sequenza di immagini per realizzare movimenti privi di scatti.
La maschera dovrebbe avere due colori da poter utilizzare per definire dove è
mostrata la clip1 e dove è mostrata la clip 2. Non vi dovete proccupare delle
dimensioni dell’immagine dal momento che Video Action lo espanderà
automaticamente a pieno schermo, sebbene è importante che il rapporto
altezza/larghezza sia corretto, in modo che l’mmagine non appaia deformata.
Una volta che avete creato la sequenza di immagini che volete utilizzare con
questa transizione, cliccate due volte su C7 per aprire la finestra Mask Based
Sequence Settings. Selezionate la vostra sequenza di immagini, selezionate i colori
che volete utilizzare per la clip di partenza e quella finale, selezionate le opzioni di
gestione del colore desiderate, e selezionate il numero di volte di riproduzione della
vostra sequenza. Cliccate su OK quando avete terminato e l’effetto sarà aperto nel
Transition Viewer. Visionate l’anteprima della transizione e quando siete soddisfatti
cliccate su OK.



       Video Action RT

______________________________

130

Gruppo D delle transizioni
Icone animate del gruppo D Numeri del Gruppo D

Il gruppo D delle transizioni consiste di 8 voltapagina, apertura di porte, una
rotazione di un cubo, tendine, un effetto a goccia d’acqua, e due dissolvenze,
inclusa quella di base. Il voltapagina e la goccia d’acqua hanno pagine addizionali
per l’impostazione, che vengono analizzate alla fine di questo paragrafo.
D1: PAGE FLIPPING (Piegamento di una pagina)

 Un angolo della clip A si solleva e si piega lungo lo schermo per rivelare la clip B.
D2: Book Flipping (Piegamento di una pagina di un libro)

Un angolo della clip A si solleva e si piega lungo lo schermo per rivelare la clip B
D3: PAGE TURNING (Voltapagina)

Un angolo della clip A si solleva e si pega lungo lo schermo per per rivelare la clip
B sulla parte retrostante della clip A.
D4: Page Roll Both Corners (Arrotolamento di due angoli della pagina)

La clip A si arrotola per mostrare la clip B.
D5: Page Roll Corner

La clip A si arrotola a partire dall’angolo in basso a sinistra, per rivelare la clip B
D6: Page Roll Single Edge

La clip A si arrotola partendo da un bordo, per mostrare la clip B.
D7: Page Roll Both Edges

La clip A si arrotola da entrambi i bordi destro e sinistro, poi si srotola per
mostrare la clip B.
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D8: Page Roll with Turn
La clip A compie una rotazione mentre si arrotola sia dal bordo sinistro che da

quello destro , poi si srotola per mostrare la clip B.
D9: Door Double

Due parti di un piano in prospettiva, contenti la clip B, ruotano per celare la clip A
con la clip B.
D10: Door Swing Forward

La Clip B ruota in avanti per coprire la clip A.
D11: Door Swing Backward

La Clip B ruota all’indietro per coprire la clip A.
D12: Funnel Shrink

La Clip A viene spinta verso un lato in un imbuto, rivelando la clip B.
D13: Cube Spin

Le clip A e B vengono mappate su due facce di un cubo; la clipA ruota al di fuori
dello schermo rivelando la clip B.
D14: Band Slide.

Barre della clip B scivolano sulla clip A da due direzioni opposte, celandola.
D15: Band Wipe

Barre di area visibile della clip B scivolano sulla clip A.
D16: Sliding Boards

Bande della clip B scivolano sulla clip A.
D17: Sliding Board Wipe

Bande di area visibile della clip B scivolano sulla clip A.
D18: Water Drop Transition (Goccia d’acqua)

Increspature di una goccia d’acqua si espandono da un punto per rivelare la clip
B sulla clip A.
D19: Additive Dissolve

La clip A si dissolve nella clip B in maniera additiva.
D20: Non-Additive Dissolve

La Clip A si dissolve nell’immagine B in maniera non additiva. Questa
rappresenta la transizione base di Video Action
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Effetti di Voltapagina (D1-D8)
I voltapagina sono costituiti da immagini video mappate su realistiche pagine
tridimensionali che si piegano o si arrotolano. Quando selezionate una di queste
transizioni (cliccando due volte sull’icona della transizione), si aprirà una finestra
per la loro personalizzazione, chiamata Page Based Effect.

Le transizioni voltapagina sono otto. CI sono tre opzioni principali: il colore della
parte posteriore della clip, l’immagine della parte posteriore, e l’angolo di
arrotolamento. Solo alcune di queste opzioni sono disponibili per ogni transizione.
Quando un’opzione non è disponibile appare in grigio.
Sia per la parte posteriore della pagina, sia per lo sfondo (background), potete
selezionare un colore od una clip da utilizzare. In alcune transizioni potete avere
sia gli effetti per la parte posteriore della pagina, sia per il background. Per le
transizioni D1 e D2 l’immagine per la la parte posteriore può essere la anche la clip
di partenza o la la clip di chiusura. Per cambiare il colore, cliccate due volte sul
riquadro colorato. Per selezionare una clip od un’immagine cliccate sul pulsante
File dell’opzione Selected Clip, e scegliete un file.
Per le transizioni D4 e D5 potete definire l’angolo della pagina che si arrotola, da -
60 a +60 gradi.
Una volta che avete portato a termine le vostre impostazioni, cliccatesu OK per
aprire l’effetto nel Transition Viewer. La maggiorparte delle transizioni voltapagina

Utilizzata da tutte le
transizioni D3 esclusa, per
definire il colore o la clip
da mostrare sulla parte
posteriore del voltapagina.
Queste due opzioni
addizionali sono disponibili
per le transizioni D1 e D2
per definire la clip
mostrata sul retro del
voltapagina.

Utilizzate con D3,4,7 ed 8
per definire il colore o la
clip mostrate come sfondo
(background).

Utilizzate con D4 eD5 per
definire l’angolo della
pagina che si arrotola.
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sono dotate di bordo, di cui potete regolare lo spessore e il colore nel Transition
Viewer. Quando siete soddisfatti dei risultati cliccate su OK.

La Transizione Water Drop ( Goccia
d’Acqua )
Questo effetto è simile al lancio di un sasso in uno stagno; guardando le onde
appare poi un’altr immagine. Le increspature d’acqua si espandono da un punto
per far apparire la clip B sulla clip A. Quando selezionate la transizione Water Drop
(cliccando due volte sulla sua icona) appare una finestra per le impostazioni.

.

Quando siete soddisfatti delle vostre impostazioni cliccate su OK per aprire l’effetto
nel Transition Viewer. Al suo interno potete cambiare il centro delle onde
trascinando il bersaglio posto nello schermo centrale di preview.

Altezza delle onde.

Distanza tra le onde.

Numero di increspature che
compone l’effetto

Muovete il bersaglio bianco e rosso
per cambiare il punto centrale della
transizione



       Video Action RT

______________________________

134

Transizione Alpha Channel Mask Wipe
Potreste utilizzare i vostri file d’immagine personali per creare una vostra
transizione alpha channel mask, selezionando la transizione sulla Timeline e
Transition> Alpha Channel Mask Wipe dal menù principale.
Una maschera Alpha hannel utilizzaun file d’immagine per determinare le aree di
trasparenza della prima clip, in modo da rendervi visibile attraverso la clip B.
Utilizzando un file d’immagine come maschera, le aree scure dell’immagine
diventano trasparenti per prime, seguite dalle arre progressivamente più luminose,
fino a che la seconda clip non viene appare per intero.
Di solito le immagini utilizzate per definire l’alpha channel sono immagini con 8 bit
di sfumatura del grigio, create da vari programmi o strumenti. Ad ogni modo, Video
Action accetterà qualsiasi colore, scala di grigio o immagine video come Alpha
Channel. Se utilizzate un’immagine a colori la luminosità dei colori sarà utilizzata
per determinare la percentuale di trasparenza.

PICTURE n.1 PAG.133

Una volta che avete selezionato la transizione Alpha Channel Mask
Wipe, l’icona mostrata sulla vostra Timeline diventerà una freccia.

Selezionate il
file che
desiderate
utilizzare
come
maschera
alpha
channel.

Abilitate il
preview per
vedere
un’animazione
della
transizione che
utilizza il file
selezionato
come
maschera.
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Transition Wizard (Mago della Transizione)
Il transition wizard vi permette di produrre le vostre transizioni e di personalizzare
gli effetti. Questo strumento può essere utilizzato unicamente sulle trnasizioni che
necessitano di rendering.
Per aprire il Transition Wizard, cliccate con il tasto destro su una transizione
preesistente, e selezionate Transition Wizards, oppure utilizzate il menù principale
per selezionare Transition> Transition Wizard. VI si aprirà un Transition Viewer
speciale, con poche opzioni in più del normale Transition Viewer.

Visionate l’anteprima della transizione:
Show Effect mostra il fotogramma alla locazione del cursore
Quick play realizza un preview nel piccolo schermo che
riproduce il numero di fotogrammi mostrato nel riquadro Play
steps.

Apre la finestra che permette di
applicare gli effetti alla clip A

Questa slider imposta il tempo
in cui la Clip B appare al di
sopra di quella A.

Seleziona la clip utilizzata come
background.

Carica un esempio di una
transizione realizzata con il
Transition Wizard

Apre il vostro catalogo
Personale

Aggiunge una
transizione al
vostro catalogo
personale

Apre la finestra che
permette di applicare
gli effetti a tutta la
transizione

Apre la finestra che
permette di applicare
gli effetti alla clip B.

Salva la vostra
transizione o carica
una transizione
salvata in
precedenza.

Questo riquadro
deve essere
selezionato se volete
utilizzare una clip di
sfondo

Apre il catalogo delle
1000 Transizioni.
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Esempio del Transition Wizard
Questo paragrafo descriverà i passaggi che sono stati utilizzati per la realizzazione
della transizione che viene caricata quando premete il tasto Example.
1. Selezionate una transizione, cliccateci sopra con il tasto destro e scegliete dal

menù Transition Wizard. Cliccate sul pulsante Exemple posto nella parte
bassa della finestra per caricare l’esempio.

2. Cliccate sul pulsante FX on A Clip. Questo aprirà la finestra Apply effect. Effetti
utilizzati comunemente oer le transitioni sono Transparency Assignment, Page
Effect, il filtro Explosion, ed il Video Screen Animation (VSA). Per la
realizzazione di questo effetto è stato utilizzato l’Advanced VSA. Per vedere
l’effetto che è stato utilizzato, cliccate due volte sulla voce Advanced VSA
posto nella lista degli effetti selezionati.

3. Nella finestra Advanced VSA potete vedere che la clip A comincia a pieno
schermo e si rimpicciolisce mentre vola nell’angolo in alto a sinistra. (Per
maggiori nformazioni circa l’utilizzo del Video Screen Animation consultate il
Capitolo 9.)

4. Chiudete la finestra dell’AVSA e la finestra Apply Effect senza apportare
modifiche cliccando sul pulsante Cancel.

Il doppio click
sull’effetto appre la
finestra AVSA
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5. Cliccate sul pulsante Fx on B Clip. Questo aprirrà la finestra Apply Effects per
la clip B. In questo esempio è stato utilizzato lo stesso tipo di effetto AVSA
sulla clip B, con la differenza che la clip B comincia come un sottile rettangolo
nell’angolo in alto a destra che cresce per riempire l’intero schermo mentre
vola verso il centro. Potete visionare questo effetto nella finestra AVSA e
cliccare sul pulcante Cancel per ritornare al Transition Wizard.

6. Cliccate sul pulsante FX on Transition. Ciò farà aprire la finestra Apply Effects
per l’intera transizione. In questo esempio è stato utilizzato l’effetto twirl. Potete
visionare questo effetto cliccando due volte sulla voce Twirl/Lens/Rotate nella
lista degli effetti selezionati. Utilizzate il cursore dei keframes per visualizzare i
vari stadi in cui si evolve l’effetto. Per rendervi conto del modo in cui è stato
realizzato l’effetto, prestate particolare attenzione alle impostazioni nei
keyframes. Cliccate su Cancel per tornate al Transition Wizard.

7. Questo esempio utilizza uno sfondo di nuvole. Per selezionare un background
cliccate sul pulsante Background Clip.

8. Prestate attenzione al cursore del Compositing. Normalmente una transizione
comincia con la Cliop A in alto e termina con la clip B in alto. Come e quando
accade questo scambio aiuta a definire la transizione. In questo caso lo
scambio avviene al 50% della transizione.

9. Per visionare in anteprima la transizione, utilizzate il pulsante Quick Play,
oppure utilizzate il cursore posto al di sotto della finestra centrale della
transizione per visionare nel dettaglio la transizione.

Prima che proviate a realizzare le vostre transizioni personalizzate, può essere
molto utilie analizzare le transizioni realizzate utilizzando differenti tipi di effetti. Per
vedere più esempi di transizioni realizzate utilizzando il Transition Wizard, potete
caricare una qualsiasi delle 1000 transizioni che sono fornite a corredo nel CD di
Video Action. (Seguite la lista degli esempi nel prossimo paragrafo.) Quando
caricate una transizione dal catalogo delle 1000 presenti nel CD, gli effetti che sono
stati utilizzati per realizzare queste transizioni si trovano anchessi nel Transition
Wizard. Potete utilizzate queste transizioni così come sono, oppure potete
analiazare questi effetti e modificarli per soddisfare le esigenze di un vosto
particolare progetto. Quando state utlizzando transizioni già pronte è spesso utlile
cambiare la clip di sfondo, i keyframes immagine o le intensità degli effetti.
Una volta che vi trovate a vostro agio col Transition Wizard potete anche realizzare
da zero le vostre rtansizioni. Ricordatevi di salvare tutte le transizioni che avete
creato che pensate di poter utilizzare nuovamente in futuro.
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1000 Transitions
Il CD di Video Action Contiene una directory che contiene più di 1000 transizioni
già pronte per l’uso che possono essere aperte dall’interno del Transition Wizard,
per accedere a queste transizioni, inserite il CD di Video Action nel lettore CD
ROM. Cliccate con il tasto destro su una transizione posta sulla Timeline e
selezionate Transition Wizard dal fondo del Menù. Cliccate sul pulsante Catalog
posto in basso a sinistra della finestra per aprire il catalogo delle transizioni.
Il catalogo delle transizioni è diviso in 17 gruppi, ognuno contenente tra le 16 e le
124 transizioni:

• 3D Cones (Coni Tridimensionali), 20 Transizioni

• 3D Cubes (Cubi tridimensionali), 16 Transizioni

• 3D Cilinders (Cilindri tridimenzionali), Transizioni

• 3D Pyramdis, 21 transizioni

• 3D Sheres (Sfere Tridimensionali), 37 Transizioni

• Animals, 34 Transizioni

• Crazy Pages (Pagine Pazze), 42 Transizioni

• Dynamic Wipes (Tendine dinamiche), 124 Transizioni

• Flying Things (Oggetti volanti), 119 Transizioni

• Gradient Wipe Group (Gruppo delle tendine a gradienti), 98 Transizioni

• Miscellaneus Transitions (transizioni Varie), 98 Transizioni

• Occasion and Greetings (Ricorrenze e Stagioni), 107 Transizioni

• Shifty Shapes, 91 Transizioni

• Sports, 69 Transizioni

• Transportation, 56 Transizioni

• Animated Tiles (Caselle animate),55 Transizioni

• BONUS Transitions, 38 Transizioni
Utilizzate il Menù a scomparsa per selezionare un gruppo. Scorrete verticamente la
lista delle transizioni per trovarne una che vogliate utilizzare. Cliccate due volte
sulla sua icona per aprirla nel Transition Wizard. Selezionate la clip e premete il
pulsante Add to Favorites per aggiungere la clip transizione alla lista delle vostre
favorite. Potete accedere a queste transizioni tramite il pulsante Favorites posto nel
Transition Wizard.
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Esempi di transizioni realizzati utilizzando diversi tipi di effetti sono:

• Animali> Bird 01 utilizza l’effetto Transparency Assignment

• Crazy Pages> Pages 01 utilizza il Page Effect

• Dynamic Wipes> T1 basket utilizza l’effetto Texturize

• Flying Things> Explosion 1000 utilizza un effetto d’esplosione

• Gradient Wipe Group> Gradient 2 utilizza l’effetto Gradient Wizard
Miscellaneous Transitions> Dream 100 utilizza il Blur, 2 utilizza gli effetti Waves
(onde) e Transparency (Trasparenza).

Suggerimento: Disabilitazione dell’Autorun del CD

Potreste aver voglia di disabilitare la caratteristica di Autorun del CD di Video
Action in modo che possiate utilizzare il CD per il catalogo delle 1000 transizioni
senza che l’installazione di Video Action si avvii ogni volta che viene inserito il CD
nel lettore.

Per disabilitare l’AutoRun, editate il file WIN.INI in un editor di testo ed aggiungete:

[PerceptionRT]
AutoRun=False
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Custom Transition Groups
Se create e salvate le vostre transizioni utilizzando il transition wizard,
probabilmente vorrete organizzarele in modo da potervi accedere in modo rapido e
semplice. Potete creare i vostri gruppi di transizioni che verranno aggiunti al menù
delle transizioni. Selezionate

I nomi dei gruppi da voi creati in questo modo recano un’estensione .FXC (questa
estensione viene assegnata automaticamente da Video Action). E’ necessario che
introduciate un titolo per il nuovo gruppo. Questo sarà il nome mostrato nel menù
delle transizioni delle “Custom Transitions”.

Le transizioni che aggiungete nel vostro gruppo possono essere effetti Macro (file
con suffisso .FLT) o Macro Transition Wizard (file con estensione .XWZ). Il numero
massimo di filtri che possono essere posti in un gruppo di transizioni è 20. Il titolo e
la descrizione assegnati durante il salvataggio saranno mostrati quando una

Secondo Passo:

• Selezionate fino
a 20 Transizioni
da includere nel
nuovo gruppo e
premete il tasto
Add (Aggiungi)

Primo Passo:

• Premete il tasto
Group Name e
date un nome al
file del .vostro
gruppo.

• Digitate un Titolo

• Digitate una
descrizione

Terzo Passo:

• premete il tasto
Create/Play
Icons per creare
le icone animate
per il vostro
gruppo
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transizione viene selezionata. Per rimuovere un file dal vostro gruppo selezionatelo
e premete il tasto Canc.
Una volta che avete aggiunto tutte le transizioni al vostro gruppo, cliccate sul tasto
Create/Play Icons per generare le icone animate che rappresenteranno le vostre
transizioni personalizzate. Cliccate su OK per creare il gruppo di transizioni
personalizzate. Per editare un gruppo di transizioni preesistente selezionate
Transitions> Edit Custom Transition Group> Edit dal menù principale.
Ciò farà apparire una finestra identica a quella utilizzata per creare un nuovo
gruppo. Potete cancellare un gruppo personalizzato selezionando Transitions>
Edit Custom Transition Group> Delete  dal menù principale. Ciò farà apparire
una finestra che vi permette di selezionare un gruppo di transizioni create in
precedenza e di rimuoverlo premendo il pulsante Delete.
Custom Transition Groups
Video Action dispone di altre 114 transizioni predefinite divise in 6 gruppi di
transizioni custom. Queste transizioni sono accessibili tramite la pressione del tasto
destro su una transizione e selezionando Rendered Effects>Custom Transition
Group dal menù a comparsa o scegliendo Transition>Custom Transition Group dal
menù principale. I sei Gruppi sono:

• Flying Video Group 1

• Flying Video Group 2

• Flying Video Group 3

• Trasparency

• Brightness

• Miscellaneous
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Capitolo 7: Filtri

Introduzione

Video Action fornisce una grande selezione di filtri video a risoluzioni indipendenti
che permettono di aggiungere effetti spettacolari alle vostre immagini e filmati. Per
esempio, possono essere simulate ed aggiunte ad un filmato la riflessione di una
lente vista attraverso l’obbiettivo di una videocamera e contemporaneamente
vedere delle intense sorgenti di luce. Oppure può essere aggiunta una goccia di
acqua increspata con la sua rifrazione naturale. I filmati possono essere modificati:
sfocando i colori su tutti i fotogrammi; convertendo ogni fotogramma in immagini
simili a dipinti; distorcendo e simulando effetti visuali come lo zoom e la
panoramica di una macchina fotografica; l’ingrandendo mediante una lente ottica;
generando le onde in una piscina o effetti di ombreggiatura.
Ciascun filtro è personalizzabile usando fino a 100 keyframe per applicazione.
Questi comandi forniscono un metodo per cambiare il modo in cui un filtro ha
effetto sul filmato in un qualsiasi punto del video. I vostri cambiamenti
personalizzati possono essere combinati e salvati usando le macro degli effetti per
applicazioni ad altri filmati e futuri passaggi. Questo capitolo descrive come usare
gli effetti video per cambiare aspetto e atmosfera dei vostri filmati.
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I 58 filtri descritti in questo capitolo sono effetti renderizzati. Essi devono essere
elaborati prima che vengano inseriti in un filmato. La sezione finale di questo
capitolo descrive gli effetti in tempo reale che sono disponibili quando la scheda
opzionale R3DX è stata installata.

Assegnare un filtro ad un filmato
1 Selezionate un filmato sulla timeline. I filtri possono essere aggiunti ad un

filmato alla volta.
2 Sono disponibili tre possibilità: cliccando sul pulsante FX presente sulla barra

degli strumenti; selezionando Tools > Video Effects & Titler dal menu
principale; cliccando con il tasto destro del mouse sul filmato e selezionando
“Video Effects”. Successivamente si aprirà la finestra “Apply Effects”. Il lato
sinistro della finestra mostra un elenco dei filtri disponibili (Aivalable Filters)
basato sulla categoria dei filtri selezionati (Filter Category). (Se state usando
dei filtri aggiuntivi avrete degli elementi supplementari nell'elenco dei filtri
disponibili.) Il lato destro della finestra mostra l'elenco dei filtri attualmente
selezionati da aggiungere al filmato.

3 Cliccate sul pulsante >>ADD>> per applicare il filtro “highlighted”(massima
luce) al filmato selezionato (oppure cliccate due volte sul filtro highlighted).
Quando aggiungete un filtro si aprirà la sua finestra di controllo. Ogni filtro ha
una sola finestra di controllo che controlla quel particolare effetto video.



       Video Action RT

______________________________

144

Bisogna fare attenzione quando si aggiunge più di un effetto al filmato poiché i
filtri saranno elaborati in cascata dall’inizio alla fine dell’elenco. Perciò l’ordine
dei filtri può cambiare l’aspetto finale. Se volete cambiare l’ordine dei filtri potete
spostare gli elementi nell’elenco per riordinarli.

4 Dopo aver deciso le vostre impostazioni, cliccate sul pulsante OK ed il filtro
sarà aggiunto alla fine dell’elenco degli effetti selezionati (Effects Selected).

Ci sono dei controlli aggiuntivi nella finestra “Apply Effects”:

• Delete: Rimuove il filtro highlighted dall’elenco degli effetti selezionati.

• Options: Riapre la finestra di controllo del filtro highlighted  nell’elenco degli
effetti selezionati per cambiamenti. (Potete anche cliccare due volte sul filtro
per riaprire la finestra di controllo.)

• Save FX Macro: Salva tutti i filtri nell’elenco dei filtri selezionati con tutte le loro
impostazioni in un file di tipo .flt per usi futuri. Ciò vi permette di salvare effetti
complessi da applicare ad altri filmati.

• Load FX Macro: Recupera gli effetti del video salvato in file macro di tipo .flt e
li applica al filmato attuale. Si possono trovare alcuni esempi nella directory
Video Action/Samples/Filters.

• Cancel: Lascia la finestra “Apply Effects” senza fare alcun cambiamento.

• OK: Lascia la finestra “Apply Effects” salvando le scelte effettuate.
Nota: i pulsanti degli effetti presenti nella finestra “Apply Effects” (Transparency
Assignment, Chroma/Luma Keying, Gradient Wizard, Page Effect, Border/Shadow
Effect, Title Generator, Video Screen Animation e Advanced VSA) sono spiegati
nel prossimo capitolo.

SUGGERIMENTO VELOCE

Quando aggiungete un filtro ad un filmato potreste attendere qualche secondo per
accedere alle informazioni video. Durante questo periodo di tempo potete sempre
premere Enter o il tasto “o” per applicare il filtro con le impostazioni correnti o di
default. Oppure potete premere ESC o il tasto “n” per uscire senza applicare il filtro.
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Filtri aggiuntivi (Plug-In)
I filtri aggiuntivi rappresentano il terzo tipo di effetti speciali che si possono
utilizzare con i filtri esistenti. Video Action può ospitare la maggior parte dei plug-in
standard. Utilizzate le istruzioni di installazione che sono descritte con i filtri.
Aggiornate il file vapront.ini nella directory di Windows ed applicate le istruzioni
seguenti:
[plugin]
plugindirectory=(percorso completo della vostra directory plug-in)
Per esempio, se avete istallato nuovi filtri in una directory chiamata c:\plugins
dovreste scrivere:
[plugin]
plugindirectory=c:\plugins
Tutti i filtri aggiuntivi presenti nelle directory assegnate compariranno come un
elemento separato nell’elenco “Filter Categories” che avete trovato nella finestra
“Apply Effects”.
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Preferenze di Visualizzazione degli Effetti

Le Preferenze di Visualizzazione degli Effetti (View Effect Preferences) si possono
utilizzare con tutti i filtri. Per aprire la finestra, cliccate con il tasto destro all’interno
di ogni finestra di controllo dei filtri. Le Preferenze di Visualizzazione degli Effetti
hanno tre aree principali:
Quick Play Steps – Permette di impostare il numero di fotogrammi che volete
utilizzare durante l’anteprima.
Alpha Channel View Options – Definisce come combinare il filmato in background e
quello in primo piano durante il rendering dello stesso. Il filmato di background è
rappresentato dal colore nero e quello in primo piano dal bianco. Il grado di oscurità
(cioè il livello della scala dei grigi) nel canale alfa rappresenta la rilevanza che si
vuole dare al filmato in background durante il rendering. Dare maggior risalto al
filmato in background significa darne di meno a quello in primo piano.

• Show composite result – Visualizza l’immagine di default che apparirà
istantaneamente oppure quando cliccate sul pulsante “Show Effect”. Esso
mostrerà quale sarà l’aspetto del filmato con l’applicazione dell’effetto.

• Use color to show alpha channel – Questa opzione colora temporaneamente il
background di ogni fotogramma per mostare il canale alfa. Il processo di
coloritura è solo di anteprima e non comparirà nel lavoro finito. Il cursore
“Transparency” permette di applicare diversi livelli di tinte del colore da
visionare con il canale alfa. Potete selezionare il colore da utilizzare sullo
sfondo cliccando due volte nel riquadro dei colori.

• Show all levels – Questa opzione suddivide lo schermo in quattro sezioni.
Questa procedura è solo di anteprima e non comparirà nel lavoro finito. Le
quattro sezioni corrispondono al riquadro che compare nella finestra di dialogo.
La sezione in alto a sinistra rappresenta il filmato in primo piano. Quella in alto
a destra rappresenta il filmato in background. La sezione in basso a sinistra
mostra il canale alfa e quella in basso a destra l’immagine composita.
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• Esempio - Utilizzate questa scelta per visionare un esempio di come l’opzione
“Show all level” definisce ogni zona dello schermo.

Feedback – Permette di impostare come viene caricata la finestra centrale di
anteprima.

• Instant – La finestra “View Effects” viene aggiornata mentre state cambiando le
impostazioni. (Default)

• None – Dovete cliccare sul pulsante “Show Effect” per agiornare la finestra
“View Effect”.

Ignore Alpha Channel – Se usate un file a 32 bit con il canale alfa abilitando questo
riquadro il canale alfa sarà ignorato. Qualsiasi effetto che applicherete riguarderà
l’intero fotogramma mostrato e non solo l’area definita dal canale alfa.

Usare i Keyframes con i Filtri
Tutti i filtri permettono di personalizzare l’effetto usando i keyframes. Alcuni filtri
richiedono l’uso dei keyframes. Tutti i controlli dei keyframes in ogni finestra “Filter
Setting” hanno caratteristiche simili a quelle mostrate in questa sezione. La finestra
“Filter Setting” contiene anche una finestra d’anteprima per mostrare l’immagine
corrente.
Per aprire la finestra “Keyframe Controls” cliccate sul pulsante Keyframes>> che
trovate nella finestra “Filter Setting”. Quando la finestra “Keyframe Controls” sarà
aperta questo pulsante si trasformerà in <<No Keyframes per permettere di
chiudere la finestra e rimuovere tutti i keyframe.

Cliccate sul pulsante
Keyframes per aprire
i controlli dei
Keyframes
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Comandi dei Keyframe (Keyframe controls)
Add KF: Aggiunge un keyframe alla pozione attuale del cursore posto sulla riga
percentuale. Il keyframe di inizio e quello di fine sono posizionati automaticamente
sulla riga quando la finestra “Keyframe Controls” è stata aperta. Potete aggiungere
un solo keyframe alla volta nella ubicazione attuale del cursore.
Delete KF: Elimina un keyframe posto sulla riga percentuale. Il keframe di inizio e
quello di fine non saranno eliminati. Potete eliminare un keyframe solo quando il
cursore della riga percentuale è posto sul keyframe.
Copy Settings: Copia le impostazioni del keyframe attuale. (Il keyframe attuale è
marcato in blu sulla riga percentuale.)
Paste Settings: Applica le impostazioni salvate al keyframe attuale usando il
pulsante “Copy Settings”. Quando si utilizza la funzione “Paste Settings” su un
keyframe le impostazioni saranno automaticamente salvate in quel keyframe.
“Multiple Paste Settings” può essere eseguito da una copia.
Enable/Disable: Quando un keyframe viene disabilitato l’effetto non è più attivo tra
questo ed il prossimo keyframe. Durante questo intervallo il filmato viene mostrato
come era originariamente senza l’effetto. Questo intervallo viene evidenziato da
una linea marrone sotto la riga percentuale. (Invece viene mostrata una linea rossa
quando l’effetto è abilitato.) Questo comando è molto utile quando volete che una
porzione del filmato sia mostrato come era in origine, mentre applicate il filtro ad
altri segmenti di filmato.

La chiave rossa
indica che il cursore
è posizionato su un
Keyframe

Indicatore di posizione
del cursore

Timecode
Iniziale

Timecode
finale

I piccoli quadratini gialli
mostrano la posizione
dei Keyframes
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Option: Apre la finestra delle Opzioni di Interpolazione (Interpolation Options) che
permette di impostare il tipo di interpolazione da usare tra i keyframe.

• Discontinuous: Usa le stesse impostazioni del keyframe precedente fino al
prossimo. C’è un improvviso cambio di stato ad ogni keyframe.

• Linear Interpolation:  Applica una interpolazione lineare del keyframe
precedente a quello successivo. Questa impostazione genera un improvviso
cambio di parametri ad ogni keyframe.

• Spline-Based Smoothing: Applica una interpolazione basata su spline del
keyframe precedente al successivo. Questa impostazione conferisce un
passaggio morbido da un keyframe all’altro.

Cancel: Elimina tutti i cambiamenti fatti da quando avete aperto la finestra. Se era
stato già applicato un filtro al filmato selezionato, sarà mantenuto lo stato
precedente. Se il filtro non era stato ancora applicato al filmato selezionato, questo
pulsante rimuoverà tutti gli effetti del filtro dal filmato.
OK: Applica il filtro e le impostazioni selezionate. Questo filtro comparirà nella lista
“Effects Selected”.
Keyframe Mover Cursor: Il cursore a doppia freccia vi permette di spostare un
keyframe tra due keyframe adiacenti. Il keyframe di inizio e quello di fine non
possono essere spostati. Posiziona il cursore sopra un keyframe per trasformarlo
nel cursore visibile a destra.
Red Keyframe Indicator: Questa chiave viene mostrata per indicare che il cursore
si trova su un keyframe. Questa indicazione risulta utile quando state cercando di
aggiustare le impostazioni dei keyframe o quando volete spostare il cursore della
riga percentuale fino al keyframe desiderato.

Filtri
Le pagine successive descrivono ogni filtro di Video Action. I filtri sono elencati in
ordine alfabetico.

SUGGERIMENTO SULLA REGOLAZIONE DEI FILTRI

I cursori del filtro possono essere aggiustati trascinandoli con il puntatore del
mouse e dopo possono essere regolati meglio usando i tasti PAGE UP e PAGE
DOWN. Potete anche cliccare sul cursore a barra su entrambi i lati per aumentare
o diminuire il cursore a partire dal minimo valore. ****



       Video Action RT

______________________________

150

Binary Color

Il filtro “Binary Color” converte il colore di un filmato in 3 colori primari, 3 colori
secondari, il bianco e nero confrontando ogni componente del colore ad una soglia
definita dall’utente. Il valore di soglia corrisponde alla scala RGB compresa tra 0 e
255.
Comandi di Binary Color (i valori usati sono numeri relativi):
Threshold – Tutti i colori posti al di sopra della soglia (threshold) impostata sono
modificabili fino al valore massimo di 255. Tutti i colori posti al di sotto della soglia
sono modificabili fino al valore minimo di 0. L’effetto risultante è che i filmati
saranno composti solo dai colori primari, secondari e dal bianco/nero senza alcuna
sfumatura di colore intermedia. Con la soglia posta vicino allo 0, la maggior parte
dei colori del filmato sono accresciuti fino ai loro valori massimi. Perciò l’immagine
risulterà più bianca. Intorno al centro i colori sono divisi in due parti: alcuni
aumenteranno fino al loro massimo, mentre altri diminuiranno fino a 0. Quando la
soglia è vicina a 255, la maggior parte dei colori diminuirà fino al loro valore minimo
di 0 e l’immagine risulterà più scura.
Seguite questi passi:
1 Impostate la soglia (threshold) al suo valore minimo di 0 (“tutto bianco”),
2 Cliccate sul pulsante Keyframes>>, i keyframe di inizio e di fine avranno le

impostazioni correnti di soglia quando saranno abilitati,
3 Fate scivolare il cursore sulla riga percentuale dallo 0% (tempo di inizio) al

100% (tempo di fine), così che possano essere aggiustati i parametri alla fine
del keyframe,
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4 Portate il threshold al suo valore massimo di 255 (tutto nero) per il keyframe
finale,

5 Selezionate Quick Play per un’anteprima rapida a 10 fotogrammi. Ciò
mostrerà il filmato elaborato dal filtro “Binary Color” partendo dalla
impostazione di threshold pari a 0 e finendo alla impostazione di threshold pari
a 255.

Black/White Balance

Lo scopo principale di questo filtro è di aggiustare i livelli di bianco e nero di un
filmato. Comunque è possibile avere vari modi di inversione del colore cambiando
creativamente i comandi.
Comandi di Black/White Balance:
Questi comandi forniscono capacità differenti dovute al modo in cui essi sono
impostati l’uno rispetto all’altro. Si possono avere tre possibilità:
Se il livello del “White Balance” è più alto di quello del “Black Balance” (caso
normale): facendo scivolare il cursore del “White Balance” a partire dal 100% i
bianchi nel filmato diventano più luminosi. Mentre facendo scivolare il cursore del
“Black Balance” a partire dallo 0% i neri risulteranno più scuri.
Se il livello del “White Balance” è uguale a quello del “Black Balance”: i colori sono
divisi tra i livelli di massimo e di minimo. L’immagine è composta solo dai colori
primari.
Se il livello del “Black Balance” è più alto di quello del “White Balance”: i colori sono
invertiti nell’intervallo compreso tra i livelli del Bianco e Nero. Se la differenza viene
aumentata, l’inversione dei colori del filmato subisce un ulteriore aumento.
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Seguite questi passi:
1 Impostate il “White Balance” al 100%,
2 Impostate il “Black Balance” al 100%,
3 Premete il pulsante Keyframes>>,
4. Spostate il cursore posto sulla riga percentuale dallo 0% al 100%
5. Impostate il “White Balance” allo 0%,
6. Impostate il  “Black Balance” al 100%,
7. Premete il pulsante Quick Play per un’anteprima rapida a 10 fotogrammi.

Blur

Questo filtro produce una leggera sfocatura con quattro tipi di simulazione: (1)
rotazione radiale (2) zoom radiale (3) motion, e (4) sfocatura gaussiana. L’utente
può controllare il punto centrale della sfocatura come pure il grado di sfocatura.
Possono essere utilizzati dei keyframe per muoversi gradualmente verso l’obiettivo
di sfocatura e possono essere interpolati tra diversi valori di sfocatura.
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Comandi di Blur:

• Radial Spin – Sfoca un filmato simulando una rotazione oraria o antioraria. Il
centro di rotazione è definito dall’obiettivo di sfocatura.

• Radial Zoom – Crea una sfocatura simulando un moto veloce di zoom. Il
centro dello zoom è definito dall’obiettivo di sfocatura.

• Motion – Sfoca nella direzione di moto definita dall’utente. L’obiettivo di
sfocatura non si applica nel moto di sfocatura poiché l’intera schermata si
muove all’unisono.

• Gaussian – Sfoca l’intera immagine/filmato uniformemente. L’obiettivo di
sfocatura non viene applicato.

• Direction of Spin Controls – Definisce la direzione di rotazione nella sfocatura
“Radial Spin”. Scegliete tra la direzione oraria e quella antioraria selezionando
uno dei pulsanti radio.

• Direction of Motion – Definisce la direzione del moto nella sfocatura “Motion”.
A 0° (0 deg.), la direzione del moto è diretta nel verso della mano destra.
Come questo cursore viene spostato verso destra, l’angolo aumenta e la
direzione del moto cambia nel senso antiorario. Per esempio, spostando il
cursore fino a +90° (+ 90 deg.) si avrà una direzione di sfocatura lineare
crescente. Invece, se il cursore viene spostato verso sinistra, l’angolo
diminuisce e la direzione del moto cambia in senso orario. In questo caso, a –
90° (-90 deg.) la direzione di sfocatura risulterà lineare decrescente. Notate
che l’intervallo di rotazione varia da -360 a +360° permettendo la piena
rotazione in senso orario ed antiorario.

• Blur Effect – Definisce l’intensità di applicazione dell’effetto di sfocatura. Al
punto di minimo (min) non avviene niente. Non appena si aumenta questo
valore e ci si avvicina al punto di massimo (max), si provoca un valore più
grande di sfocatura. Il valore di sfocatura è un numero relativo.
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• Outside Edge Options – Viene utilizzato per definire l’informazione usata fuori
dello schermo per il “Radial Spin” e il “Motion”. In entrambi i casi, questo effetto
richiede informazioni dell’immagine al di fuori dello schermo da utilizzare
durante il processo di sfocatura. Usate “Transparent Background” per ampliare
il bordo e il “Solid Color” per generare un bordo di un solo colore.

• Blur Target – Comanda il punto centrale di sfocatura per le sfocature Radial
Spin e Radial Zoom. Esso è rappresentato da un obiettivo rosso presente sullo
schermo di anteprima. L’obiettivo può essere spostato cliccando e
trascinandolo con il puntatore del mouse. Cliccando due volte in qualsiasi
punto dello schermo si nasconderà l’obiettivo per permettere una visione
sgombra del filmato. Cliccando di nuovo due volte permetterà di rivedere
l’obiettivo.

Seguite questi passi:
1 Selezionate come tipo di sfocatura (Blur Type) quella chiamata “Motion,”
2 Impostate la direzione del moto (Direction of Motion) a 0°(0 deg.),
3 Impostate l’effetto di sfocatura (Blur Effect) a 80%,
4 Selezionate nell’opzione “Outside Edge”: “Transparent Background”,
5 Selezionate Keyframes>>,
6 Spostate il cursore sulla riga percentuale dallo 0% al 100% così che le variabili

di sfocatura possano essere applicate al keyframe finale (i keyframe di inizio e
di fine sono definiti con le impostazioni della variabile attuale quando sono
attivati i keyframe).

7 Impostate l’effetto di sfocatura (Blur Effect) allo 0%
8 Cambiate la direzione di moto a +360° (facendo scivolare il cursore di

“Direction of Motion” verso destra). Poiché il keyframe di inizio rimane a 0°, la
direzione del moto verrà interpolata dal punto in alto a destra al punto in basso
a sinistra ed alla fine di nuovo a destra durante la durata del filmato.

9 Premete il pulsante Quick Play per un’anteprima rapida a 10 fotogrammi.
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Brightness and Contrast

Questo filtro permette di definire la luminosità ed il contrasto dell’immagine. La
regolazione di luminosità (Brightness) cambia l’intensità dei colori; la regolazione
del contrasto (Contrast) cambia la separazione relativa tra le aree più scure e
quelle più chiare. Ogni colore può essere controllato separatamente. I valori
utilizzati sono numeri relativi.
Comandi di Brightness e Contrast:

• Color – Definisce il canale del colore al quale devono essere applicati i
comandi di Brightness e Contrast. Scegliete tra il rosso, il blu, il verde o tutti
(all).

• Brightness – Applica il livello di luminosità ai colori selezionati. Questo
comando vi permette di scurire un filmato facendo scorrere il cursore verso il
minimo (min) oppure permette di aumentare la luminosità facendo scorrere il
cursore verso il massimo (max). Al minimo, non rimane nessun colore tra quelli
selezionati del canale. Al massimo, il colore selezionato viene rappresentato al
suo valore pieno. Questo comando può essere usato con i keyframe per
creare una dissolvenza nera per una transizione.

• Contrast – Definisce il livello del contrasto per il canale selezionato. Aumentare
il contrasto significa differenziare gli oggetti con una luminosità più
pronunciata. Invece diminuendo il contrasto si rende ogni elemento più simile,
fino al punto che tutto lo schermo diventa grigio.



       Video Action RT

______________________________

156

Channel Map

Questo filtro assegna i canali del colore ai canali rosso, verde e blu di un video.
Potete scegliere tra i canali rosso/verde/blu o grigio per correlarli ad ognuno dei tre
canali di uscita.
Comandi di Channel Map:
Color Input Selections – Seleziona un particolare canale che deve essere correlato
ai canali rosso, verde e blu (per esempio “To Red Channel”). Correlando tutti e tre
canali a se stessi il filmato risulterà come quello originale. Selezionando “none” in
un particolare canale, quest’ultimo risulterà rimosso dal filmato.

Color Balance
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Le percentuali di rosso, blu e verde possono essere aumentate o diminuite per
cambiare il loro ammontare di colore con questo filtro. Questo filtro può essere
utilizzato in una varietà di modi per dare maggiore o minore risalto ai colori.
Color Balance Controls:
RGB Color Controls – Al 100% il colore rappresenta l’immagine o il video originario.
Aumentando al di sopra del 100% si aggiunge più colore al filmato, mentre
diminuendo al di sotto del 100% decresce il livello del colore. Alla impostazione più
elevata, il colore selezionato si trova al suo valore massimo di 255. Alla
impostazione più bassa, il colore selezionato viene rimosso per intero dal filmato.

Color Filter

Questo filtro fornisce un modo veloce per far rimanere nel filmato soltanto il colore
secondario o primario. Selezionate il colore che volete mantenere dalla finestra tra
rosso, verde, blu, ciano, magenta e giallo (Red, Green, Blue, Cyan, Magenta e
Yellow). Tutte le altre componenti di colore saranno eliminate.
Comandi di Color Filter:
Color Buttons – Seleziona quale colore lasciare nel filmato. Scegliendo uno di
questi colori si deseleziona ogni precedente colore selezionato.
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Color Frame

Questo filtro fornisce un modo rapido per creare un filmato colorato uniformemente
sulla timeline. Applicando questo filtro il filmato selezionato si riempirà del colore
impostato nel riquadro presente nella finestra. Questo filtro è più utile con immagini
fisse perché esse possono essere ampliate a lunghezze illimitate. Esso può essere
ultilizzato anche come colore uniforme di background.
Comandi di Color Frame:
Color Box – Seleziona quale colore deve essere applicato al filmato. Cliccando due
volte nel riquadro del colore si aprirà una palette per selezionare un colore.
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Color Offset

Questo filtro sposterà le componenti del colore ad una distanza specificata. Ogni
componente del colre Rossa/Verde/Blu (Red/Green/Blue) può essere riposizionata
sia nella direzione orizzontale che verticale.
Comandi di Color Offset:
RGB Sliders – I cursori scorrevoli orizzontali (Horizontal) spostano i colori nella
direzione x e quelli verticali (Vertical) nella direzione y. Per esempio, se volete
spostare la componente del rosso verso destra, dovete spostare il cursore
orizzontale rosso (red)  verso destra. Se volete spostare la componente del rosso
verso il basso, dovete spostare il cursore verticale rosso verso il basso.
Analogamente, le posizioni degli altri colori possono essere modificate sia in
orizzontale che in verticale. I valori di spostamento sono numeri relativi. Queste
modificazioni sono tutte interpolabili.
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Color Pass

Questo filtro permetterà di visualizzare solamente il colore selezionato. Se
scegliete un colore (Pick Color) e selezionate una tolleranza (Color Tolerance), tutti
i pixel contenuti in quell’intervallo saranno lasciati immutati, mentre tutti quelli che si
trovano al di fuori diventeranno neri. Per esempio, questo filtro può essere usato
per separare un oggetto dal background quando questi sono di colori diversi. Il
valore di tolleranza è un numero relativo.
Comandi di Color Pass:

• Pick Color – Seleziona il colore da utilizzare. Usate il pulsante Pick Color per
attivare il selettore del colore a contagocce. Spostate il contagocce sul colore
che volete utilizzare e cliccate con il pulsante sinistro del mouse. Oppure
potete cliccare sul riquadro del colore che farà aprire una palette contente una
selezione completa di colori per una scelta più precisa.

• Color Tolerance – Una tolleranza più stretta permette di visualizzare meno
colori (cioè solo quei colori che sono molto vicini al colore selezionato). Una
tolleranza più ampia permette di visualizzare molti colori. Questo comando
lavora in congiunzione con il comando “Saturation Tolerance” per definire una
regione di colore da utilizzare. Il valore di tolleranza è un numero relativo.

• Saturation Tolerance – Una tolleranza più stretta permette di far passare livelli
di saturazione più bassi (cioè solo quei colori che hanno un livello di
saturazione molto vicino al vecchio colore). Una tolleranza più ampia permette
di visualizzare colori con livelli di saturazione più alti. Questo comando lavora
in congiunzione con il comando “Tolerance Control” per definire una regione di
colore da visualizzare.
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• Reverse – Visualizza ogni cosa che non era stata selezionata con le
impostazioni originali e nasconde ciò che originariamente era stato
visualizzato.

Seguite questi passi:
Usate una immagine semplice con il primo piano ben contrastato e dei colori in
background.
1 Premete il pulsante Pick Color ed usate il contagocce per selezionare il colore

di primo piano,
2 Spostate il “Color Tolerance” verso un valore basso come 30,
3 Premete il pulsante Show Effect, per vedere se il background è stato rimosso

ed è diventato nero,
4 Ripetete le modifiche con il “Color Tolerance” e “Saturation Tolerance” usando

il pulsante “Show Effect” fino a quando non sarete in grado di separare il primo
piano con il background. Notate che, poiché il filtro “Color Pass” rimuove
selettivamente dei colori, alcune parti del background possono anche non
essere rimosse se i valori dei colore non sono contenuti all’interno dei livelli di
tolleranza impostati. Con la pratica dovreste essere in grado di stabilire
quando applicare questo filtro per creare delle zone prive di colore.

Color Replacement
Questo filtro permette di sostituire in un filmato un colore con un altro.
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Comandi di Color Replacement:

• Old Color – Serve a scegliere il colore che deve essere sostituito. Premete il
pulsante “Old Color” per attivare il selettore del colore a contagocce. Spostate
il contagocce sul colore che volete cambiare e cliccate con il pulsante sinistro
del mouse. Oppure potete cliccare sul riquadro del colore che farà aprire una
palette contente una selezione completa di colori per una scelta più precisa.

• New Color – Serve a scegliere il nuovo colore che deve sostituire quello
vecchio. Applicate la stessa procedura descritta sopra per selezionare il
colore.

• Color Tolerance – Una tolleranza più stretta permette di sostituire meno colori
(cioè solo quei colori che sono molto vicini al vecchio colore). Una tolleranza
più ampia permette di sostituire molti colori. Questo comando lavora in
congiunzione con il comando “Saturation Tolerance” per definire una regione
di colore da sostituire. Il valore di tolleranza è un numero relativo.

• Saturation Tolerance – Una tolleranza più stretta permette di sostituire colori
con livelli di saturazione più bassi (cioè solo quei colori che hanno un livello di
saturazione molto vicino al vecchio colore). Una tolleranza più ampia permette
di sostituire colori con livelli di saturazione più alti. Questo comando lavora in
congiunzione con il comando Tolerance Control per definire una regione di
colore da sostituire.

• Maintain Relative Shade – Sostituisce il colore impostato in modo che siano
conservate le sfumature originali. Così che queste caratteristiche del filmato
originali siano mantenute anche in quello modificato.
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Color to Gray

Converte il colore di un filmato in colori della scala dei grigi. Non c’è nessun
comando specifico in questo filtro. Comunque si possono usare i keyframe per
disattivare questo filtro in parte del filmato.

Convolution

Questo filtro permette di creare un filtro personalizzato mediante dei calcoli
matematici. Esso utilizza una matrice 5x5 per elaborare ogni pixel dell’immagine.
Potete scrivere nella matrice valori sia negativi che positivi fino al valore massimo
di 999. I valori dipendono dalle variazioni che desiderate fare e che possono essere
usati per aumentare la nitidezza, la sfocatura, il rilievo e molti altri effetti. La formula
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utilizzata è la moltiplicazione di ogni valore della matrice per il pixel corrispondente,
la somma dei prodotti, la divisione della somma per il valore di scala, la somma del
valore di scarto, ed infine l’applicazione del risultato ottenuto come valore del
nuovo effetto al pixel che è stato calcolato.
Comandi di Convolution:
1. Celle della matrice – Ogni cella della matrice 5x5 deve essere riempita da un

valore. I numeri che vi vengono inseriti servono a determinare il contributo di
ogni pixel che circonda il pixel centrale.

2. Reset – Riporta la matrice al suo stato iniziale “privo di effetti”.
3. Scale – Si usa per normalizzare la matrice così che questo filtro non abbia

effetto con la luminosità totale dell’immagine. Questo valore viene calcolato
automaticamente, ma non può essere annullato dall’utente.

4. Offset – Si usa una costante di compensazione aggiunta al valore calcolato.
Questo valore può illuminare o oscurare con efficacia un’immagine.

Provate questo:

Usate un filmato ad alto contrasto.

Questi valori creeranno un filtro con
sfocatura orizzontale

Questi valori creeranno un filtro con
effetto di rilievo.
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Crystallize

Questo filtro viene usato per accentuare colori simili per creare un effetto simile al
ghiaccio. Questo filtro organizza un’immagine in celle di forma irregolare. Si
possono utilizzare i keyframe con celle di grandezza diversa per creare un effetto
ghiacciato o cristallizzato.
Comandi di Crystallize:
Cell Size – Modifica la misura dei cristalli usati per creare l’effetto. Vicino al valore
minimo (min), i cristalli sono molto piccoli. Vicino al valore massimo (max) vengono
formati blocchi di cristalli più grandi. Il valore che rappresenta la misura della cella è
un numero relativo.

Cut Out
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Il filtro Cut Out definisce un metodo per applicare effetti ad aree selezionate di un
filmato.
Usate questo filtro per aprire un file costituito dalla zona ritagliata. I filtri posizionati
sulla lista “Effects Selected” prima del filtro “Cut Out” avranno effetto solamente
sulle zone definite con le aree ritagliate segnate in bianco.
Prima di usare questo filtro avrete bisogno di creare una cut-out mask. Questa può
essere un qualsiasi file bitmap bianco/nero. Potete creare le cut-out mask dai
filmati che sono stati posti sulla timeline selezionando il filmato e selezionando
Tools > Make Cut-out Mask dal menu principale. Per definire la zona da ritagliare
cliccate sull’immagine, in questo modo si stabilisce il punto di partenza.
Continuando a cliccare sull’imagine creerete dei punti che sono uniti da linee diritte.
Per finire l’operazione cliccate due volte. L’ultimo punto verrà unito al primo e la
zona da ritagliare verrà evidenziata da una linea rossa e bianca. Quando sarete
soddisfatti della forma ritagliata potete cliccare sul bottone “Save”.

Comandi di Cut Out:
Pick File: Seleziona un file da ritagliare. Potete usare questo pulsante anche per
visionare il filmato attuale che si sta utilizzando. Viene generato per primo un
ritaglio in bianco e nero con l’aiuto del comando cutout presente nel menu “ Tools
Menu ”. Alle aree bianche vengono applicati altri filtri, mentre le aree nere vengono
prese direttamente dal filmato originale. Per usare il comando cutout, impostatelo
sotto il “Tools Menu” e disegnate l’area da ritagliare. Dopo averla salvata, usate
questo filtro per portare nel file da selezionare l’area ritagliata. I filtri presenti nella
lista “Effects Selected” prima del filtro “Cut Out” avranno effetto solo sulle zone
definite dal ritaglio bianco.
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Displacement

Questo filtro riposiziona ogni pixel grazie ad un indice basato su una maschera di
riposizionamento. Il risultato è un’immagine distorta basata su questa maschera.
Comandi di Displacement:

• File – Seleziona la maschera di riposizionamento desiderata. Può essere il file
di una immagine, di una animazione o un filmato in formato AVI.

• X Displacement – Definisce quanti pixel devono essere spostati nella direzione
orizzontale. Il valore di “X displacement” è un numero relativo.

• Y Displacement – Definisce quanti pixel devono essere spostati nella direzione
verticale. Il valore di “Y displacement” è un numero relativo.
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Edge Detection

Evidenzia tutti i bordi secondo una direzione definita nel filmato. Potete scegliere
una delle nove diverse direzioni possibili.
Comandi di Edge Detection:
Pusanti di Direzione – Definiscono in quale direzione viene effettuato
l’evidenziamento. Premendo un pulsante si deseleziona quello impostato
precedentemente. Sperimentate su di un filmato diverse direzioni per ottenere il
risultato migliore.

Emboss
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Crea un effetto in rilievo. Questo filtro normalmente opera meglio con valori bassi di
spostamento (displacement) orizzontale e verticale.
Comandi di Emboss:

• Pick Base Color – Attiva il contagocce per selezionare il colore. Spostate il
contagocce sul colore che volete che sia di base per il rilievo e cliccate il
pulsante sinistro del mouse. Oppure cliccate due volte sul riquadro dei colori,
in questo modo si aprirà una finestra di dialogo dove è rappresentata tutta la
gamma di colori per una scelta più precisa. Il colore di base può essere
cambiato usando i keyframe.

• Offset (Horizontal e Vertical) – Iniziate variando l’offset sia in orizzontale che in
verticale di uno o due pixel fino a che è stato raggiunto il risultato desiderato.
Cambiando l’offset orizzontale in valori positivi (partendo dal centro della
barra) si crea un rilievo ed un effetto spostato verso destra. Questi valori
rappresentano l’ammontare attuale dello spostamento dei pixel.

Explosion (Deluxe Filter Group)
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Questo filtro suddivide il filmato in tanti pezzi e li sparpaglia in direzioni casuali. I
pezzi sono stabiliti dall’utente sulla base di una mappa di frammentazione
(Fragmentation Map). Il centro dell’esplosione è controllato dall’obiettivo rosso
presente sullo schermo d’anteprima. Dovete usare i keyframe per cambiare il
periodo (Phase) di visione dell’effetto di esplosione.
Comandi di Explosion:

• Average Rotation – Controlla la velocità di rotazione media dei frammenti
esplosi. Al valore minimo (min) di 0, avviene una piccola rotazione. Al valore
massimo (max) di 100, ogni frammento ruota fino all’ampiezza massima.

• Speed Variation – Controlla la variazione di velocità dei frammenti esplosi.
Tutti i pezzi volano via a partire dal centro dell’esplosione definito dall’obiettivo
rosso. Ponendo una velocità di rotazione pari a 0 tutti i pezzi si allontaneranno
dal centro alla stessa velocità. Ponendo il valore massimo pari a 100 i
frammenti si allontaneranno dal centro in molte velocità differenti.

• Phase – Determina la totalità dell’esplosione (cioè quanto sono lontani i pezzi
gli uni agli altri). Potete variare questi valori usando i keyframe per produrre un
effetto esplodente. Per esempio, partite da un valore pari a 0 per il primo
fotogramma ed impostate il valore 100 per l’ultimo. Oppure per fare implodere i
pezzi insieme, cominciate con un periodo più grande e finite con uno più
basso.

• Seed – Questo è un numero casuale, il filtro ne ha bisogno per i suoi calcoli.
Cambiandolo si altereranno i percorsi dei pezzi che si spostano. Variate a
piacimento questo numero per verificare come cambiano gli effetti fino a
quanto non avrete trovato quello desiderato. Lo stesso numero fornirà sempre
lo stesso risultato (lasciando immutati anche gli altri comandi).

• Blast Z Direction – Questo riquadro serve a definire in quale direzione deve
avvenire il movimento lungo l’asse Z (cioè se deve venire verso lo schermo o
allontanarsi da esso). Scegliendo “Random” (casuale), alcuni pezzi saranno
sparati verso le schermo ed altri se ne allontaneranno.

• Fragmentation Map File – Questo è un file di immagine di un formato
supportato da Video Action e che definisce come il filtro di esplosione
suddivide lo schermo in pezzi. I valori del grigio nel “map file” sono utilizzati per
definire quale zona del video suddividere. Per esempio: se l’immagine del
“map file” è blu sul lato sinistro dello schermo e rossa sul lato destro, lo
schermo sarà diviso in due parti durante la sequenza dell’esplosione. Più colori
ha il “map file” in più parti sarà suddiviso lo schermo. Potete creare il “map file”
usando il vostro programma di fotoritocco preferito. Sperimentate diverse
situazioni quando create i “map file”. I colori sono riconosciuti dal loro valore
RGB.

• Antialiasing – Durante l’effetto di esplosione, i lati dei pezzi possono apparire
frastagliati o come erano originariamente. L’Antialiasing levigherà gli spigoli
per fare apparire i tagli più netti. Comunque questa opzione aumenterà il
tempo richiesto per elaborare l’effetto.
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• Fragment Motion – Comanda le proprietà del moto e della rotazione del
frammento. I pulsanti consentono la scelta abilitato/disabilitato. Un pulsante è
abilitato se è premuto. Riguardo alla rotazione, con lo stato di abilitazione si
intende che i pezzi ruoteranno intorno a quell’asse. Invece riguardo al moto,
quando un pulsante è premuto si intende che i pezzi si sposteranno lungo
quell’asse.

Firework - Automatic (Deluxe Filter Group)

Simula sullo schermo dei fuochi artificiali di vari colori. Si usa una zona rettangolare
nella schermata di anteprima per definire dove devono apparire gli effetti.
Comandi di Firework:

• Style of Firework – Seleziona il tipo di fuoco artificiale: “circolare” (ring),
“sferico” (spherical), “casuale” (random). Il tipo “circolare” esplode da un
origine circolare, mentre il tipo “sferico” esplode da un punto centrale e si
diffonde in tutte le direzioni.
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• Explosions – Determina il numero di fuochi artificiali da far esplodere: Notate
che il numero massimo di esplosioni dipende dal fatto che l’opzione
“Simultaneous Fire” sia selezionata o meno.

• Duration – Determina quanto deve durare l’effetto. Se il valore impostato è
100, l’effetto comprenderà l’intera durata del filmato per completare
l’esplosione.

• Trail Length – Determina la lunghezza delle scie dei fuochi artificiali.
Impostando un valore pari a 0 le esplosioni sembreranno delle scintille.
Impostazioni maggiori danno scie più lunghe.

• Trail Quality – Al valore minimo pari a 0, la qualità della scia è scadente ed il
numero risulta basso. Al valore massimo pari a 100, la qualità è alta con una
densità elevata di scie.

• Simultaneous Fire at % Delay – Fa avvenire tutte le esplosioni
contemporaneamente. Dopo aver selezionato questa opzione, modificate la
riga percentuale (%Delay) per stabilire quando deve avvenire l’esplosione. Per
un valore pari a 0% tutte le esplosioni avvengono immediatamente, mentre per
un valore pari al 50% tutte le esplosioni terminano a metà del filmato. Se
l’opzione non è selezionata ogni fuoco artificiale dura un periodo casuale.

• Random Color – Sceglie casualmente colori differenti per i fuochi d’artificio.

• Seed – Fornisce un modo per cambiare l’effetto utilizzando un numero
casuale. Usate diversi valori per cambiare l’effetto fino a quando non
raggiungete il risultato desiderato.

• Color Variation – Definisce quantitativamente la variazione di colore accettata
durante l’effetto. Si può utilizzare quando l’opzione “Random Color” non è
attivata.

• Starting Color – Determina quale deve essere il colore di partenza. Impostate
un valore per “Color Variation” pari a 0 se volete che tutti i fuochi artificiali
siano di questo colore. Si può utilizzare quando l’opzione “Random Color” non
è attivata.

• Explosion Region – Definisce la zona dove far esplodere il primo fuoco
artificiale. Spostate il rettangolo rosso (che serve ad indicare questa zona) fino
alla posizione di partenza dell’esplosione trascinando il nodo. Con
l’avanzamento dei fuochi d’artificio le scie dell’esplosione sono portate fuori
della zona di partenza.
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Firework – Single

Simula un singolo fuoco d’artificio di tipo “circolare” o “sferico”. Una regione
circolare nella schermata d’anteprima definisce dove deve essere posizionata
l’esplosione. La rotazione in 3D può essere utilizzata con il fuoco artificiale di tipo
“circolare” per fornire un senso maggiore di profondità.
Comandi di Firework:

• Style of Firework – Seleziona il tipo di fuoco artificiale: “circolare” (ring) o
“sferico” (spherical). Il tipo “circolare” esplode da un origine circolare, mentre il
tipo “sferico” esplode da un punto centrale e si diffonde in tutte le direzioni.

• Starting Time – Definisce quando deve iniziare l’esplosione. Impostando un
valore pari a 0%, l’esplosione avviene all’inizio del filmato. Con un valore pari
al 50%, l’esplosione avviene a metà del filmato; ecc.

• Duration – Determina quanto tempo deve durare l’effetto dopo l’esplosione.

• Length of Trail – Determina la lunghezza delle scie dei fuochi artificiali.
Impostando un valore pari a 0 le esplosioni sembreranno delle scintille.
Impostazioni maggiori danno scie più lunghe. Con un valore pari a 100, le scie
rimangono per l’intera lunghezza dal centro dell’esplosione fino al margine più
esterno.
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• Trail Quality – Definisce come deve apparire la scia. Al valore minimo pari a 0,
la qualità della scia è scadente ed il numero delle scie risulta basso. Al valore
massimo pari a 100, la qualità è alta con una densità elevata di scie.

• Orientation (solo per fuochi artificiali di tipo “circolare”) – Comanda
l’orientamento dei fuochi d’artificio di tipo “circolare”. Con un valore di x pari a
0°, il fuoco artificiale è parallelo al piano del terreno. Per valori crescenti il
cerchio ruota dalla sua posizione orizzontale piana verso una posizione
verticale. I valori di y e z operano allo stesso modo lungo le rispettive direzioni.

• Seed – Fornisce un modo per cambiare l’effetto utilizzando un numero
casuale. Usate diversi valori per cambiare l’effetto fino a quando non
raggiungete il risultato desiderato.

• Starting Color – Definisce il colore del fuoco artificiale durante l’esplosione
iniziale.

• Ending Color - Definisce colore del fuoco artificiale alla fine dell’esplosione.

Flip filter

Ruota un filmato orizzontalmente, verticalmente, o in entrambe le direzioni.
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Freeze Video Frame

Questo filtro blocca ogni fotogramma dall’inizio alla fine del filmato. Usate il
keyframe per selezionare il fotogramma da bloccare.

Highlight

Questo effetto fornisce al filmato dei punti di massima luce. Ne esistono di due tipi
(da selezionare tramite “Parameter Adjustment For”): luccichio (sparkle) e bagliore
(flare). Lo “sparkle” dà un effetto simile ad una stella che brilla nel cielo, mentre il
“flare” è un effetto circolare piano. Ogni effetto ha numerose regolazioni che
possono essere utilizzate per ottenere il risultato desiderato. La rivelazione
automatica del punto di massima luce fornisce un facile modo per trovare i punti
luminosi di un filmato e per posizionare un punto di massima luce.
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Comandi di Highlight:

• Parameter Adjustments For – Seleziona a quale tipo di effetto applicare i
comandi successivi. Le due scelte avvengono tra: luccichio (sparkle) e lampo
(flare).

• Enable – Consente di utilizzare entrambi gli effetti. Notate che sia lo sparkle
che il flare possono essere attivati e disattivati separatamente.

• Add Lower Intensity Arms (solo per lo sparkle) – Crea nei luccichii dei raggi più
piccoli e deboli da inserire tra quelli più grandi.

• No Decay (solo per il flare) – Comanda  se il lampo decade quando è distante
dal centro.

• Outer Ring (solo per il flare) – Abilita/disabilita (Enables/disables) la
generazione di un anello esterno ai bagliori.

• Outer Color – Comanda il colore esterno dei luccichii e dei bagliori. Cliccando
sul pulsante comparirà un contagocce che può essere utilizzato per scegliere il
colore desiderato. Cliccando due volte sul riquadro dei colori si aprirà una
finestra di dialogo dove è rappresentata tutta la gamma di colori per una scelta
più precisa.

• Inner Color – Definisce il colore interno dei luccichii e dei bagliori. Cliccando
sul pulsante comparirà un contagocce che può essere utilizzato per scegliere il
colore desiderato. Cliccando due volte sul riquadro dei colori si aprirà una
finestra di dialogo dove è rappresentata tutta la gamma di colori per una scelta
più precisa.

• Intensity – Definisce la brillantezza dei luccichii e dei lampi. Questo comando
opera in un intervallo di numeri relativi compresi tra 0 e 100. Vicino al valore di
0, non c’è nessun effetto. Selezionando valori vicini a 100, vengono generati
dei punti molto brillanti. Se impostate il valore massimo, l’intero schermo si
potrà coprire di punti di luce brillanti.

• Number of Arms (solo per lo sparkle) – Definisce il numero di raggi da
generare nei luccichii.

• Angle of Rotation (solo per lo sparkle) – Determina l’angolo di rotazione
antiorario da applicare sui luccichii generati. L’angolo è espresso in gradi.

• Max Number – Definisce il numero massimo di luccichii o lampi che si possono
generare con il computer. Con il cursore tutto spostato a sinistra il numero
massimo di punti luce generati corrisponde a 1. Quando il cursore viene
spostato tutto a destra, è possibile generare un numero massimo di 20 punti
luce.

• Threshold – Definisce la sensibilità della rivelazione automatica del punto di
massima luce. Quando il cursore è spostato tutto a sinistra, il suo valore è pari
a 0 e la sensibilità è più grande. Potenzialmente viene generato un numero
massimo di punti luce. Quando il cursore è vicino al valore massimo pari a 100
(cioè è tutto spostato a destra), la rivelazione automatica del punto di massima
luce è meno sensibile creando dei punti luce solo nelle parti più chiare
dell’immagine. Il valore numerico utilizzato da questo comando è un numero
relativo.
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• Min Distance – Definisce la distanza minima tra due punti luce vicini. Quando il
cursore è tutto spostato a sinistra al suo valore minimo di 0, i punti di massima
luce generati sono molto vicini. Quando il cursore è tutto spostato a destra al
suo valore massimo di 100, i punti di massima luce generati sono posti a
grande distanza tra loro. Il valore numerico utilizzato da questo comando è un
numero relativo.

• Enable Auto Highlight Detection – Se si seleziona questo comando si aziona la
rivelazione automatica del punto di massima luce.

• Manually Insert Highlight – Se si seleziona questo comando l’utente può
posizionare un singolo punto di massima luce sullo schermo. Quest’ultimo
viene posizionato trascinando l’obiettivo del punto luce (il cerchietto rosso che
compare sullo schermo) nella posizione desiderata. Il punto luce generato
dipende da quale tipo è stato impostato (luccichio, lampo o entrambi).

• Highlight Target – Appare solo quando si imposta “Manually Insert Highlight”.
Sullo schermo compare l’obiettivo rosso che può essere posizionato cliccando
e trascinandolo con il mouse.

Seguite questi passi:
1. Selezionate da “Parameter Adjustment for”: “Sparkle” (luccichio)
2. Selezionate “Enable” nella finestra di “Sparkle” (se non è stato già fatto)
3. Impostate “Intensity” al valore minimo di 0 spostando il cursore tutto a sinistra
4. Impostate il numero di raggi pari a 4 (number of arms)
5. Impostate l’angolo di rotazione pari a 0° (angle of rotation)
6. Impostate il numero massimo pari a 0 (max number)
7. Impostate “threshold” pari a 50
8. Assicuratevi che l’opzione “Enable auto highlight detection” sia selezionata
9. Premete il pulsante Keyframes>>
10. Spostate il cursore sulla riga percentuale dallo 0% al 100% dove c’è il

keyframe finale,
11. Impostate l’intensità (intensity), la quale attualmente dovrebbe avere un valore

pari a 0 per il passo 4, ad un valore pari a 45,
12. Cambiate l’angolo di rotazione (angle of rotation) con un valore pari a 20°,
13. Premete il pulsante Quick Play per visionare un'anteprima di dieci fotogrammi.
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Hue and Saturation

“Hue” indica il colore e “saturation” indica il livello di intensità. Quando applicate
“Hue” tutti i colori cambieranno in maniera simile. Potete creare un’immagine
sbiadita riducendone la saturazione (saturation), così che i colori siano a mala pena
visibili, oppure potete aumentare la saturazione rendendo i colori molto intensi.
Comandi di Hue and Saturation:

• Hue Rotation – Impostando un valore di 0° si conserveranno i colori originali.
Se lo spostamento del cursore è positivo (cioè spostandolo verso destra), i colori
saranno modificati in questo modo: …  rosso à verde à blu à  rosso…  Quindi il
rosso diventa verde, il verde diventa blu ed il blu diventa rosso.
Se la rotazione è negativa (cioè spostando il cursore verso sinistra), i colori
saranno modificati nella direzione opposta: …  rosso à blu à  verde à  rosso …

• Saturation – Spostando il cursore verso il valore minimo (min) si fornisce
all’immagine meno colore. Spostando il cursore verso il valore massimo (max)
l’intensità del colore aumenta.
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Invert

Questo filtro inverte la luminosità ed il colore in un filmato. Non esistono specifiche
impostazioni da applicare, comunque si possono utilizzare i keyframe per rendere
operativo l’effetto.

Kaleidoscope

Questo effetto prende un settore dello schermo di forma indefinita di 45° e lo
riproduce sull’intera immagine per  realizzare un effetto caleidoscopio. Si possono
realizzare interessanti disegni in movimento quando lo applicate ad un video.
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Comandi di Kaleidoscope:
Select Reflected Region – Seleziona una degli otto settori da riflettere/riprodurre
attivando i corrispondenti radio-pulsanti.

Kaleidoscope - New (Deluxe Filter Group)

Genera altri effetti di caleidoscopio. La flessibilità a disposizione dell’utente è
enfatizzata in questa nuova versione del filtro. Questo effetto simula un reale
caleidoscopio creando due bordi riflettenti e riproducendo l’immagine tra essi in
modo simmetrico. L’ubicazione del punto centrale e dei bordi riflettenti sono
entrambi definiti dall’utente. Sia la regione d’origine che quella di destinazione
possono essere impostate e cambiate in seguito usando i keyframe.
Comandi di Kaleidoscope:

• Number of Sectors – Definisce il numero di regioni d’origine e destinazione.
Più settori avete, più piccole saranno le regioni d’origine e destinazione.

• Source Angle – Determina l’angolo del settore d’origine. Esso può essere
modificato anche direttamente dall’immagine ruotando la linea rossa sullo
schermo, che rappresenta il confine del settore.

• Destination Angle – Determina l’angolo del settore di destinazione. Esso può
essere modificato anche direttamente dall’immagine ruotando la linea rossa
sullo schermo, che rappresenta il confine del settore.

• Display Source/Dest Angle – Permette di scegliere tra l’angolo di origine e
quello di destinazione.

• Source/Destination Region Controls – Seleziona l’ubicazione del settore e la
misura per le regioni d’origine e destinazione. Spostate il punto centrale nella
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posizione desiderata trascinandolo con il mouse. Anche l’angolo del settore
può essere aggiustato con il mouse.

Lens reflection

Simula riflessioni multiple di luce generate da un sistema di lenti di una telecamera
quando incontrano fonti di luce. L’obiettivo rosso insieme ai keyframe fornisce un
metodo per spostare la riflessione delle lenti durante il filmato.
Comandi di Lens Reflection (tutti i valori sono numeri relativi):

• Intensity – Definisce la luminosità della riflessione delle lenti. In prossimità del
valore minimo (min) risulterà una debole riflessione. In prossimità del valore
massimo (max) si creerà un punto di riflessione molto brillante.

• Size – Definisce il diametro degli anelli di riflessione creati. In prossimità del
valore minimo (min) non apparirà nessun riverbero. Vicino al valore massimo
(max) si creerà un riverbero molto ampio.

• View Lens Reflection Only – Permette di vedere solo la riflessione delle lenti
senza il filmato in background. Questo aiuta nel fare piccoli aggiustamenti
prima di aggiungere l’effetto al filmato.

Seguite questi passi:
1. Impostate l’intensità (intensity) a 50,
2. Impostate la misura (size) a 50,
3. Sposate il puntatore del cursore nel mezzo dello schermo dove si trova

l’obiettivo e trascinatelo (l’obiettivo diventa una mano) nel punto più in basso a
destra dello schermo,
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4. Premete il pulsante Keyframes>> per attivare i keyframes,
5. Spostate il cursore posto sulla riga percentuale dalla posizione iniziale pari a

0% fino al valore di 50%,
6. Premete il pulsante Add KF per aggiungere un keyframe nella posizione pari

al 50% del tempo totale,
7. Usando il mouse, spostate l’obiettivo nell’angolo in basso a sinistra per salvare

la posizione al nuovo keyframe,
8. Spostate il cursore posto sulla riga percentuale dalla posizione iniziale pari a

50% fino al valore di 100%, punto dove si trova l’ultimo keyframe
9. Usando il mouse, spostate l’obiettivo dall’angolo in basso a destra (questa

posizione era già preimpostata nel passo 4 quando i keyframe erano stati
attivati), fino all’angolo in alto a sinistra

10. Impostate l’intensità (intensity) al 75%,
11. Impostate la misura (size) al 100%
12. Selezionate Quick Play (riproduzione Rapida) per visionare un'anteprima di

dieci fotogrammi. La riflessione delle lenti è sovrapposta e spostata all’inizio
del filmato.

Lightning (Deluxe Filter Group filter)

Questo filtro realizza un fulmine tra due punti definiti dall’utente. Il fulmine si può
diramare e variare in intensità e durata.
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Comandi di Lightning:

• Branch – Definisce in quanti rami si deve dividere il fulmine. Con un valore pari
a 0 si intende che verrà creato solo il fascio di luce principale. Potete
aggiungere fino a 10 rami che si diramano dal fascio di luce principale.

• Primary Intensity – Cambia l’intensità del colore primario.

• Secondary Intensity - Cambia l’intensità del colore secondario.

• Primary Color – Definisce il colore primario (il più interno) del fulmine. Questo
sarà il colore dominante.

• Secondary Color – Definisce il colore secondario (il più esterno) del fulmine.
Questo sarà mostrato come contorno di quello primario.

• Seed – Questo è un numero casuale, il filtro ne ha bisogno per i suoi calcoli.
Cambiandolo il fulmine assume forme differenti.

Mirror

Divide lo schermo a metà e riflette l’immagine nell’altra metà. Applicando questo
filtro al filmato se ne creerà uno simmetrico nell’altra metà dello schermo.
Comandi di Mirror:

• Ogni pulsante radio rappresenta metà dello schermo. Il pulsante posto in alto
seleziona la metà in alto dello schermo, il pulsante a destra seleziona la metà
destra, ecc…

• Scegliete una delle quattro metà utilizzabili per applicare l’effetto all’altra metà.
Per esempio, se si seleziona il pulsante a sinistra (cioè LàR), la metà sinistra
dell’immagine viene copiata nel lato destro.
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Mosaic

Ricostruisce l’immagine mediante dei quadratini che danno un effetto simile alle
piastrelle di un mosaico.
Comandi di Mosaic:

• Normal – Utilizza un quadratino standard per ricostruire l’immagine.

• Mosaic Special – Utilizza un quadratino con margini accentuati per ricostruire
l’immagine.

• Block Size – Definisce la misura dei quadratini nella realizzazione del mosaico.
In prossimità del valore minimo (min), i quadratini sono molto piccoli e
l’immagine apparirà molto simile a quella originale. In prossimità del valore
massimo (max) i quadratini prenderanno una larga parte dello schermo e
l’immagine risulterà irriconoscibile.

Seguite questi passi:
1. Impostate la misura del quadratino al valore massimo (max),
2. Premete il pulsante Keyframes>> per attivare i keyframe,
3. Sposate il cursore posto sulla riga percentuale dalla sua posizione iniziale allo

0% fino al keyframe finale al 100%,
4. Impostate la misura del quadratino al valore minimo (min),
5. Selezionate Quick Play (riproduzione Rapida) per visionare un'anteprima di

dieci fotogrammi.
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Multiple Prism (Deluxe Filter Group)

Crea delle immagini multiple ripetute che circondano la zona centrale. L’effetto è
simile a ciò che si vede attraverso lenti multiple prismatiche. I comandi di rotazione
servono a ruotare le immagini posizionate intorno al centro selezionato.
Comandi di Multiple Prism:

• Surrounding Images – Determina il numero di immagini ripetute che
circondano l’immagine centrale.

• Rotation Turn – Impostando con il cursore un valore pari ad 1 le immagini
multiple ruoteranno di 360°. Cambiando questo valore successivamente con i
keyframe le immagini multiple ruoteranno intorno all’immagine originale.
Ruotate le linee nello schermo d’anteprima trascinandole e cliccando per
cambiare l’angolo. ****

• Image Displacement – Definisce la distanza dal punto centrale delle immagini
che lo circondano. Aumentando il valore dal minimo (min) al massimo (max), le
immagini che circondano il centro vengono posizionate più lontane da esso.

• Center – Un modo veloce per centrare l’effetto del prisma multiplo.

• No Center Image – Rimuove l’immagine centrale lasciando solo quelle che la
circondano.

• Angle – Mostra l’angolo di rotazione.
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Noise Color

Aggiunge un disturbo all’immagine variando casualmente il colore selezionato.
Comandi di Noise Color (tutti i valori sono numeri relativi):

• Color – Permette la scelta tra rosso/verde/blu/giallo/magenta/ciano
(red/green/blue/yellow/magenta/cyan) o tutti i colori per realizzare l’effetto. Per
esempio, scegliendo il rosso risulterà disturbato il canale rosso. Cioè il valore
della componente rossa sarà sia aumentata che diminuita casualmente. E’
importante notare che quando un colore viene diminuito, la sua componente
complementare diventerà più distinta. Il disturbo sul canale rosso determinerà
un aumento di verde-blu (ciano).

• Color Variation – Determina il valore del disturbo generato per il colore
selezionato. In prossimità del valore minimo (min) accadono pochi
cambiamenti. In prossimità del valore massimo (max) il colore viene variato di
un intervallo più ampio.
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Noise Diffusion

Sposta i pixel di un’immagine diffondendoli come una esplosione. Utilizzate i
keyframe congiuntamente ai vari comandi per creare interessanti effetti di disturbo.
Comandi di Noise Diffusion (tutti i valori sono numeri relativi):

• Noise Density – Determina la densità della nube di disturbo risultante. In
prossimità del valore minimo (min), appare una nube poco fitta vicino agli
oggetti. Non appena si aumenta il valore la nube diviene molto densa.

• Diffusion Distance – Determina quanto deve essere vicino il disturbo
all’oggetto nel filmato. In prossimità del valore minimo (min), il disturbo si trova
vicino all’oggetto. Non appena si aumenta il valore il disturbo si allontana
dall’oggetto originale.

• Shift Color Components – Quando è selezionato i singoli colori varieranno per
il disturbo che viene generato.
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Old Movie

Questo effetto dà l’aspetto al filmato di un vecchio film aggiungendo graffi,
pulviscolo e sfarfallio. Utilizzate con il filtro Color la scala dei grigi (Grayscale) per
creare un vecchio film in bianco e nero.

Pan-Zoom
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Fornisce la possibilità di effettuare zoom. Combinando questo filtro con i keyframe,
la finestra dello zoom può essere spostata per creare effetti di panoramica e zoom.
Comandi di Pan-Zoom:

• Pan-Zoom Window – Definisce l’area cui applicare l’effetto. Essa può essere
definita cliccando e trascinando un angolo qualsiasi del riquadro. Se non si
mantengono i rapporti tra le distanze dell’immagine originale (original aspect
ratio), il filmato può essere deformato sia in orizzontale che in verticale, oppure
può essere schiacciato o stirato. Spostate il riquadro per definire l’area della
panoramica/zoom trascinando l’obiettivo centrale. Questo riquadro e l’obiettivo
possono essere rimossi (e ripristinati), allo scopo di vedere l’effetto, cliccando
due volte con il mouse in una zona qualsiasi dello schermo di anteprima.

• Full Image – Definisce il riquadro per la panoramica/zoom a schermo intero.
Questo pulsante fornisce un modo conveniente per selezionare l’intera
schermata di input per utilizzarla come output.

• Quarter Image – Definisce il riquadro per la panoramica/zoom con una misura
pari ad un quarto dello schermo. Questo pulsante fornisce un modo
conveniente per ingrandire un’area pari ad un quarto della schermata di input.

• Keep Aspect Ratio – Blocca il rapporto tra l’ampiezza e l’altezza del riquadro
della panoramica/zoom. Disabilitate questa opzione per schiacciare o stirare il
vostro filmato modificando la forma e la misura del riquadro.

• Movie Quality – Selezionate questa opzione per dare all’immagine di
anteprima una qualità molto elevata. Il tempo di elaborazione aumenta quando
viene attivata questa opzione.

Parallel Images
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Dopo aver definito un’area compresa tra due linee parallele, questo filtro replicherà
l’immagine verso un margine del filmato. L’immagine comincerà grande e poi
diverrà via via più piccola ad ogni ripetizione. Questo filtro dà un effetto simile a
quello dato quando si pone un immagine tra due specchi, con la differenza che il
numero di ripetizioni è finito.
Comandi di Parallel Images:

• Rotation Turn – Portando il cursore al valore di 1 le linee parallele ruoteranno
di 360°. Ruotate le linee nella schermata d’anteprima cliccandole e
trascinandole.

• Facet Width – Modifica la distanza tra le due linee parallele, definendo una
immagine sorgente più grande o più piccola.

• Image Displacement – Determina quanto devono essere spostate le immagini
parallele da quella originale. Se il valore impostato è pari a 0 non ci sarà
nessun effetto apparente, valori più alti aumenteranno la distanza tra le
immagini parallele.

• Angle – Definisce l’angolo di rotazione.

• Line Center Target – Definisce la posizione del centro delle linee parallele.

• Align Horizontal – Allinea le linee parallele orizzontalmente.

• Align Vertical – Allinea le linee parallele verticalmente.

• Flip – Ruota le linee parallele di 180°.
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Picture in Picture

Il “Picture in Picture” vi permette di porre un filmato in primo piano su uno in
secondo piano per creare un effetto immagine nell’immagine. La finestra vi
permette di decidere a piacimento la misura del filmato in primo piano.
Comandi di Picture in Picture:

• Full Image – Imposta a pieno schermo la finestra del “Picture in Picture”.
Questo pulsante fornisce un modo conveniente per selezionare l’intera
schermata di input per utilizzarla come output.

• Half Image – Imposta rapidamente a metà schermo (orizzontale) le dimensioni
della finestra del “Picture in Picture”.

• Quarter Image – Imposta rapidamente ad un quarto di schermo (orizzontale) le
dimensioni della finestra del “Picture in Picture”.

• Keep Aspect Ratio – Blocca il rapporto tra l’ampiezza e l’altezza della finestra
del “Picture in Picture”. Disabilitate questa opzione per schiacciare o stirare il
vostro filmato modificando la forma e la misura della finestra.

• Movie Quality – Selezionate questa opzione per dare all’immagine di
anteprima una qualità molto elevata. Il tempo di elaborazione aumenta quando
viene attivata questa opzione.

• Picture in Picture Window – Questo riquadro definisce l’area che deve
contenere l’immagine in primo piano. Essa può essere modificata portando il
cursore su un angolo del riquadro e trascinandolo per dargli una nuova forma.



       Video Action RT

______________________________

192

Se non si mantengono i rapporti tra le distanze dell’immagine originale (original
aspect ratio), il filmato può essere deformato sia in orizzontale che in verticale,
oppure può essere schiacciato o stirato. Potete spostare il riquadro
trascinando l’obiettivo centrale. Questo riquadro e l’obiettivo possono essere
rimossi (e ripristinati), allo scopo di vedere l’effetto, cliccando due volte con il
mouse in una zona qualsiasi della finestra.

• Border – Spostando il cursore si determina lo spessore del bordo. Cliccando
sul riquadro dei colori si può utilizzare un colore definito dall’utente.

• Shadow – Definisce l’offset lungo l’asse X ed Y, per creare un’ombra, e la sua
profondità.

Pointillist

Questo filtro crea un effetto simile ai dipinti divisionisti (cioè crea dei puntini di
colore su uno sfondo bianco).
Comandi di Pointillist (i valori numerici sono espressi in numeri relativi):

• Dot Spacing – Definisce la distanza tra due puntini presenti nell’effetto. In
prossimità del valore minimo (min) i puntini creati sono molto vicini tra loro. Se
ci si avvicina la valore massimo (max), i puntini incominciano a divenire
sempre più lontani.

• Dot Size – Definisce il diametro dei puntini. In prossimità del valore minimo
(min) i puntini creati sono molto piccoli. Se ci si avvicina la valore massimo
(max), i puntini incominciano a divenire sempre più grandi. Se il valore del “
Dot Spacing” è vicino a quello del “ Dot Size”, le celle entreranno in collisione e
risulteranno di forma irregolare.
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Posterize

Riduce le sfumature di un singolo colore presente nel filmato. Il risultato è che i
singoli colori sono trasformati in aree di colori.
Comandi di Posterize:

• Level – Diminuendo il valore si riduce il numero di colori e si crea un effetto più
pronunciato. In prossimità del valore minimo (min), rimangono poche
sfumature di colore. Invece in prossimità del valore massimo (max), rimangono
quasi tutte le sfumature.

• Color – Questo comando vi permette di applicare l’effetto ad uno specifico
colore o a tutti i colori insieme.
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Rectangular-Polar

Converte le coordinate da cartesiane a polari e viceversa. Nel caso di conversione
da coordinate cartesiane a polari, il testo può essere avvolto intorno ad una forma
circolare. La conversione opposta prende una regione circolare e la svolge in una
forma lineare. Questo effetto può essere utilizzato per creare forme simmetriche da
oggetti radiali oppure può essere utilizzato per combinare insieme vari filmati per
creare interessanti effetti di distorsione.
Comandi di Rectangular-Polar:
E’ presente un obiettivo rosso di tipo circolare per definire i vari stili della
conversione. Questo obiettivo può essere posizionato trascinando il suo centro e
può essere dimensionato trascinando il cerchio esterno.

• Rectangular to Polar – Attivando questa opzione gli oggetti saranno convertiti
dalle coordinate cartesiane a quelle polari. Questo effetto modifica la
schermata tirando il margine superiore fino a quando non diventa un puntino e
stirando il margine inferiore fino a quando non diviene un cerchio. L’obiettivo
circolare viene utilizzato per definire la misura dell’effetto finale e dove deve
essere effettuato.

• Polar to Rectangular – Attivando questa opzione gli oggetti saranno convertiti
dalle coordinate polari a quelle cartesiane. La regione da convertire viene
definita dall’obiettivo circolare. L’area coperta da questo cerchio viene “svolta”
e diffusa lungo tutto lo schermo. Notate che se l’obiettivo circolare viene
posizionato o dimensionato in modo che si trovi parzialmente fuori dello
schermo, compariranno delle zone nere per compensare quelle perse.

• Angle Offset – Quando si attiva la conversione da coordinate cartesiane a
polari (Rectangular to Polar), questo comando si usa per definire come
ruotare la schermata risultante. Un valore positivo determina una rotazione
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oraria. Quando si attiva la conversione da coordinate polari a cartesiane (Polar
to Rectangular), questo comando si usa per spostare la schermata risultante
verso sinistra o destra. In questo caso aumentando il valore si sposta la
schermata verso sinistra.

Repetition

Riproduce la stessa immagine più volte lungo l’intero schermo.
Comandi di Repetition:

• Columns – Definisce il numero di colonne.

• Rows – Definisce il numero di righe.

• Movie Quality – Selezionate questa opzione per dare all’anteprima una qualità
molto elevata. Il tempo di elaborazione aumenta quando viene attivata questa
opzione.

Seguite questi passi:
1. Impostate sia le righe che le colonne al valore di 1,
2. Premete il pulsante Keyframes>>,
3. Spostate il cursore sulla riga percentuale fino al keyframe finale,
4. Portate il valore delle righe e delle colonne a 5,
5. Selezionate Quick Play (riproduzione Rapida) per visionare un'anteprima di

dieci fotogrammi.
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Repetition- 3D (Deluxe Filter Group)

Riproduce più volte la stessa immagine con un effetto 3D lungo l’intero schermo.
L’effetto è costituito da un piano infinito che può essere modificato usando i
comandi appositi. Sono forniti anche dei comandi per effettuare un volo simulato
lungo questo piano.
Comandi di Repetition:

• Angle of Plane – Ruota il piano ricoperto dalle immagini rispetto al punto di
vista. Quando il valore impostato è il minimo (min), il piano è verticale e sta
esattamente di fronte al punto di vista. Quando il valore impostato è il massimo
(max), il piano corrisponde esattamente a quello del terreno (cioè è
orizzontale).

• Velocity – Definisce la velocità di spostamento del punto di vista rispetto al
piano del terreno. Usate questo comando insieme a quello per controllare la
direzione (cioè la linea rossa)

• Elevation – Definisce l’altezza del punto di vista rispetto al terreno.
Aumentando questo valore il punto di vista si allontana dal piano del terreno.

• Antialiasing – Aggiunge un effetto di smussamento. Usatelo quando avete
necessità di bordi più morbidi. L’utilizzo di questa opzione richiede tempi di
elaborazione più lunghi.
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Shading

Converte i colori di un filmato per dargli una diversa altezza superficiale (cioè dà
profondità all’immagine) ed applica una fonte di luce da mostrare sfumata. Con
questo filtro si possono creare belli effetti come oggetti 3D e cromature. Per
esempio, si possono generare delle scritte piane che sporgono con un effetto 3D.
Comandi di Shading:

• Surface Shape – Definisce come deve essere creata la forma della superficie.
L’opzione “Use Original Clip” utilizza il colore del filmato annesso per
determinare l’altezza della superficie (cioè la forma). Altrimenti usate il
pulsante “File Selected:” per selezionare un altro filmato cui applicare questo
comando.

• Surface Color – Definisce come applicare il colore alla nuova superficie.
L’opzione “Use Original Clip” utilizza il colore del filmato annesso sulla
superficie. L’opzione “Use Original Clip” conferisce alla superficie un colore
uniforme cosicché le differenti sfumature sono create solo mediante la fonte di
luce.

• Lighting – Determina il tipo di luce e la distanza che si deve usare per dare la
sfumatura alla superficie. L’opzione “Parallel” serve a definire la superficie che
deve essere illuminata dalla luce del sole. L’opzione “Point” serve a definire la
superficie che deve essere illuminata da luce artificiale. La distanza (distance)
determina quanto è lontana la superficie dal punto luce.

• Shading Brightness – Modifica il livello di luminosità della sfumatura creata.
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• Surface Depth – Modifica il valore corrispondente all’altezza superficiale del
colore selezionato. Da una maggiore profondità superficiale conseguono
superfici che sembrano allontanarsi di più.

• Light Source – Modifica il colore della fonte di luce. Cliccate due volte sulla
finestra del colore (Color) per ottenere una finestra di dialogo con un’ampia
selezione di colori.

• Ambient Light – Definisce il colore e l’intensità della luce circostante. Cliccate
due volte sulla finestra del colore (Color) per ottenere una finestra di dialogo
con un’ampia selezione di colori. Il cursore dell’intensità (Intensity) definisce il
valore della luce circostante selezionata. Se non esiste luce circostante (cioè il
cursore è tutto spostato a sinistra) tutta l’illuminazione proverrà dalla fonte di
luce.

• Surface – Definisce il livello di riflessione e lucentezza della superficie. Le
superfici lucide danno luogo zone illuminate più piccole, mentre le superfici
non lucide danno luogo a zone illuminate più ampie.

• Light Source Position – La posizione della fonte di luce viene indicata
dall’obiettivo rosso, essa è indicata relativamente al centro del filmato. Notate
che viene utilizzata una scala “ingrandita” coscché quando l’obiettivo è
posizionato vicino ad un bordo, la fonte di luce parte molto oltre il centro.
Cliccate due volte sulla schermata di visione per rimuovere questo comando.

Seguite questi passi:
Fate queste operazioni con un filmato contenente degli oggetti semplici e lisci (cioè
una palla, una tazza, una penna, etc.). Notate che con questo filtro si possono
ottenere notevoli risultati dopo aver preso un po’ di pratica. Iniziando con degli
oggetti semplici potete avere un’idea di come ogni comando modifica il filmato,
prima di impegnarsi in lavori più complessi.
1. Impostate la forma della superficie con l’opzione “Use Original Clip”,
2. Impostate il colore della superficie con l’opzione “Use Original Clip”,
3. Impostate l’opzione “Lightning” con “Point” il valore della distanza (distance)

pari a 100,
4. Impostate il valore della luminosità (shading brightness) a 100,
5. Impostate la profondità della superficie (surface depth) a 50,
6. Cliccate il pulsante Advanced>> per ottenere dei comandi aggiuntivi,
7. Modificate la posizione della luce trascinando l’obiettivo rosso.
I comandi aggiuntivi includono i seguenti tipi di effetti versatili:

• 3D Sculpture Effect – Utilizza il filmato originale sia per la forma che per il
colore della superficie.

• Chrome Effect – Utilizza il filmato originale per la forma della superficie e usa
una tinta unita (cioè il vostro colore preferito) per il colore della superficie.
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• Raised 3D Text Effect – Utilizza il bianco con un testo nero e bordi grigi come
forma della superficie. Mentre utilizza una tinta unita per il colore della
superficie.

• 3D Tile/Water on Glass Effect – Utilizza 2 filtri, il “Displacement” seguito dallo
“Shading”. Entrambi i filtri usano lo stesso file maschera che presenta zone
nere su sfondo bianco e bordi di un grigio sfumato. Attribuendo un giusto
valore al grigio del bordo si possono produrre degli effetti visivi quali gocce
d’acqua su un vetro, tegole di ceramica in 3D, ecc.

Sharpen

Aumenta la nitidezza di un filmato accentuando i bordi.
Comandi di Sharpen:

• Level – Definisce il grado di nitidezza da realizzare nel filmato. Assumendo un
valore in prossimità del minimo (min) c’è un effetto minimo o addittura nullo.
Non appena si porta questo valore verso il massimo (max), i margini diventano
più pronunciati. Il valore numerico è un numero relativo.
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Smoothen

Diminuisce la definizione del filmato. Non appena si aumenta il valore l’immagine
sembra più omogenea, o meno definita.
Comandi di Smoothen:

• Level – Definisce il grado di finitura. In prossimità del valore minimo (min), non
è applicato nessun effetto al filmato. Non appena ci si avvicina al valore
massimo (max), l’immagine diviene sfocata poiché tutti i contorni divengono
meno evidenti. Il valore numerico è un numero relativo.
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Snow

Simula la neve che cade generando casualmente dei fiocchi di neve. La neve può
cadere in una direzione definita dall’utente simulando il vento e la gravità.
Snow Controls:

• Heaviness – Definisce l’intensità della neve. Un valore pari allo 0% significa
che non cade neve, mentre un valore pari al 100% simula una tormenta
virtuale.

• Distance – Definisce quanto deve essere lontana la neve dal punto di vista di
colui che sta guardando. Quando il valore è pari al 100%, alcuni fiocchi
sembreranno cadere più veloci degli altri simulando dei fiocchi a distanza
diversa (alcuni più vicini ed altri più lontani). Mentre se il valore è pari allo 0%,
tutti i fiocchi sembreranno cadere dalla stessa distanza.

• Direction – Spostando l’obiettivo rosso potete cambiare la direzione dalla quale
cade la neve. Se l’obiettivo si trova proprio sotto il centro dello schermo (cioè a
270°) la neve cadrà esattamente diritta dall’alto verso il basso. Se spostate
l’obiettivo verso destra (300°) la neve non cadrà più diritta, ma spostata verso
destra, come se fosse spinta dal vento in quella direzione. Allo stesso modo si
può far cadere la neve dal basso verso l’alto.

• Seed – Questo valore è un numero casuale del quale il computer ha bisogno
per effettuare i suoi calcoli. Cambiandolo si faranno apparire i fiocchi di neve in
differenti configurazioni.
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Solarize

Questo filtro produce una inversione selettiva delle componenti del colore in un
immagine o in un fotogramma di un filmato. Esso crea una miscelazione tra
l’immagine positiva e quella negativa dell’originale. I colori di un filmato sono
invertiti selettivamente.
Comandi di Solarize:

• Level – Definisce il livello limite di inversione dei pixel. Tutti i pixel che hanno
un valore inferiore a quello definito sono invertiti, mentre quelli che si trovano
al di sopra rimangono identici. Questo valore è identico all’intervallo RGB da 0
a 225. Con un livello pari a 255 si intende che tutte le componenti del colore
sono invertite. Con un livello pari a 0 non si compie nessun cambiamento nelle
componenti del colore.
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Star Field

Questo filtro crea un effetto simile ad un viaggio spaziale a varie velocità attraverso
un campo di stelle.
Comandi di Star Field:

• Density – Definisce quanto deve essere affollato il campo stellare.

• Speed – Definisce con quale velocità devono apparire le stelle durante il volo.
Con un valore pari allo 0% si intende che non ci sarà nessun movimento,
mentre con un valore del 100% si ha una curvatura del campo stellare a causa
della forte velocità.

• Seed – Questo valore è un numero casuale del quale il computer ha bisogno
per effettuare i suoi calcoli. Cambiandolo si faranno apparire le stelle in
differenti configurazioni.
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Star Highlight

Questo filtro crea una singolo lampo di luce a forma di stella. La differenza tra la
luce creata con questo filtro e quella del filtro “ Highlight” è che la densità dei raggi
della stella possono essere controllati e cambiati creando effetti interessanti
quando vengono combinati con i keyframe.
Comandi di Star Highlight:

• Intensity – Definisce il livello di luminosità della luce. Per un valore pari a 0 non
esiste l’effetto. Per un valore pari a 100, viene creata un grande luce bianca a
forma di stella.

• Number of Arms – Determina il numero di raggi che devono essere generati
per la stella. L’intervallo varia da 2 a 10.

• Angle of Rotation – Determina come viene ruotata la stella nella direzione
oraria. Impostando questo valore a diversi keyframe si avrà un effetto di
rotazione.

• Thickness of Arm – Definisce la densità dei raggi della stella. Per un valore
pari a 0 verrà creato un raggio molto sottile. Alla impostazione massima di 100,
la base del raggio diviene molto larga.

• Star Location Target – Definisce l’ubicazione e la misura della stella. Cliccando
due volte sullo schermo di visione si rimuoverà l’obiettivo per avere una visione
più chiara. Cliccando di nuovo due volte riapparirà l’obiettivo.
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Texturize

Questo filtro prende il filmato principale e vi aggiunge un testo da un filmato
secondario. Grazie ai keyframe, i testi possono essere introdotti gradualmente e
selettivamente nel filmato.
Comandi di Texturize:

• File... – Con questo pulsante si apre una finestra di dialogo contenente una
selezione di file così che una immagine o un filmato può essere scelto come
testo. Questo pulsante può essere utilizzato anche per visionare un filmato
precedentemente selezionato (cioè selezionate l’opzione “play” nella finestra di
dialogo conseguente).

• Effect Strength – Definisce il grado di influenza che il filmato rappresentante il
testo ha sul filmato principale. In prossimità del valore minimo (min), il testo
non apparirà proprio. In prossimità del valore massimo (max) il filmato del testo
diventa dominante. Il valore numerico è un numero relativo.
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Three-D

Crea un effetto tridimensionale che può essere visto con occhiali 3D. Per creare un
effetto tridimensionale, il filmato principale e quello selezionato dovrebbero essere
registrati nello stesso momento con prospettive leggermente diverse.
Comandi di Three-D:

• File... – Seleziona l’altro filmato che serve a completare l’effetto 3D.
Generalmente quest’ultimo è identico al filmato principale, solo che viene
registrato da una prospettiva leggermente diversa.

Tint
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Questo filtro fa apparire l’immagine come se fosse vista attraverso degli occhiali
colorati. Il colore selezionato passa attraverso le lenti, mentre tutti gli altri vengono
bloccati.
Comandi di Tint:

• Pick Color – Usate questo pulsante per attivare il selettore a contagocce.
Spostate il contagocce sul colore che volete scegliere e cliccate con il pulsante
sinistro del mouse. Oppure cliccate due volte sul colore e comparirà una
finestra che vi permetterà una scelta più precisa tra una intera selezione di
colori.

Tone Adjustment

Modifica le sfumature di colore di un filmato in riferimento a quattro diagrammi, uno
per il rosso, uno per il verde, uno per il blu e l’ultimo per tutti i colori rimanenti. Gli
assi orizzontali rappresentano il valore in ingresso, mentre gli assi verticali quelli in
uscita. Una linea sottile, che parte da un punto in basso a sinistra e giunge in alto a
destra, rappresenta le sfumature che non sono state modificate.
Il grafico rappresenta come viene rilevato il colore in ingresso rispetto allo stesso
colore in uscita. La scala orizzontale rappresenta il colore in ingresso con un
intervallo che va da 0 a 255. Quella verticale rappresenta il colore in uscita con un
intervallo che va da 0 a 255.
Comandi di Tone:

• Control Handles – I nodi presenti sul grafico possono essere spostati allo
scopo di effettuare modifiche alla curva

• Color – Seleziona il canale che deve essere modificato. Le possibilità di scelta
sono tra il rosso, il verde, il blu e tutti gli altri colori (grigio).
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• Histogram Scale – Aumenta la dimensione dell’istogramma per renderlo più
facilmente visibile e per lavorare meglio.

Twirl, Lens, and Rotate

Questo filtro fornisce cinque tipi diversi di effetti di distorsione basati sulle
caratteristiche delle lenti ottiche. In ogni effetto si possono modificare la
concavità/convessità e la distanza dal filmato. In aggiunta si possono applicare la
rotazione ed il vortice (twirl) a lenti di tipo circolare. Applicando i keyframe e
spostando la lente, così come modificando la sua misura e la rotazione, si possono
creare sequenze emozionanti.
Comandi di Twirl and Lens:

• Circular Lens Custom Size – Provoca un effetto simile a quello di una vera
lente circolare quando viene posta di fronte ad una immagine. Modificate la
misura della lente usando il puntatore del mouse e spostando il suo margine
esterno. Spostate la lente trascinando il suo centro.

• Circular Lens Fit to Frame – Questa lente conferisce lo stesso risultato del
“Circular Lens Custom Size” quando essa presenta una misura pari all’intero
schermo.

• Pinch – Tira la parte d’immagine che si trova sotto la lente, mentre i margini
dell’immagine restano nella stessa posizione grazie ad un cerchio immaginario
grande quanto lo schermo. Modificando i valori della concavità/convessità
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sembrerà che la parte centrale dell’immagine esce fuori verso colui che guarda
oppure viene spinta all’interno dello schermo.

• Custom Pinch – Questo comando conferisce lo stesso risultato dell’effetto
“Pinch”, con l’aggiunta di un controllo della misura e della posizione della lente.

• Rectangular Pinch – Anche questo comando è simile al “Pinch”, con la
differenza che i margini dell’immagine restano nella stessa posizione grazie ad
un rettangolo immaginario. Si può applicare la concavità e convessità. Questa
lente non supporta la distanza, la rotazione ed il vortice (twirl).

• Outside Edge Options – Alcuni comandi richiedono delle informazioni che
riguardano la zona esterna a quella da applicare l’effetto. Per esempio, questo
può riguardare se la distanza della lente dallo schermo è aumentata o se la
lente è concava. Esistono due possibilità quando vi sono questi casi. L’opzione
“The Use Mirrored Tiles” utilizza le informazioni del filmato originale per
applicarle all’esterno dei margini. In questo modo si ha un effetto che sembra
più naturale. L’opzione “Use Solid Color” permette di scegliere una tinta unita
da usare nella zona esterna. Quando si sceglie questa opzione, cliccando due
volte sul riquadro del colore si aprirà una finestra di dialogo che permette una
scelta più precisa.

• Concavity/Convexity – Definisce come deve essere il profilo della lente.
Spostando il cursore verso destra si aumenta la concavità della lente con un
effetto di ingrandimento. Spostando il cursore verso sinistra aumenta la
convessità e si ha l’effetto opposto. Quando il cursore è posizionato su “none”
(cioè 50), non vi è deformazione del filmato attraverso l’ingrandimento (si
possono applicare la rotazione ed il vortice per creare effetti interessanti). I
valori usati per rappresentare la concavità e la convessità sono numeri relativi.

• Distance – Definisce la distanza tra la lente e lo schermo. Aumentando la
distanza, sia per la concavità che per la convessità, si ha un effetto di
ingrandimento o riduzione maggiore. I valori usati per rappresentare la
concavità e la convessità sono numeri relativi.

• Twirl – Determina come deformare un’immagine quando viene ruotata.
Esistono due casi. Quando l’opzione non è selezionata, l’angolo (Angle) e la
rotazione (Turns) ruotano semplicemente la zona sotto la lente. Quando
l’opzione è selezionata, l’angolo (Angle) e la rotazione (Turns) creano un
effetto vortice nel quale la zona centrale  subisce una rotazione maggiore
rispetto alla periferia. Questo comando vale solo per la lente di tipo circolare.

• Angle – Definisce l’angolo di rotazione. Spostando il cursore verso destra la
lente ruota in senso antiorario per un valore pari a quello indicato, fino a 360°.
Spostando il cursore verso sinistra la lente ruota in senso orario per un valore
pari a quello indicato, fino a 360°. Questa opzione è attiva solo per la lente di
tipo circolare.

• Turns – Definisce il numero di rotazioni complete da applicare alla lente.
Spostando il cursore verso destra aumenta il numero di rotazioni in senso
antiorario, mentre spostandolo verso sinistra aumenta il numero di rotazioni in
senso orario. Questa opzione è attiva solo per la lente di tipo circolare.
Variando il numero di rotazioni a diversi keyframe consegue una sezione
circolare girevole presente nel filmato.
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• Lens Position and Size – Questo comando rappresenta l’area della lente,
definita da un cerchio rosso e posizionata sullo schermo d’anteprima.
Modificate la posizione della lente trascinando l’obiettivo. La misura della lente
può essere cambiata trascinando la circonferenza.

Water Drop

Crea un’onda dovuta ad una goccia d’acqua come se il filmato fosse posizionato
sotto una piscina e vi fosse gettato dentro un sasso che causa una onda in
graduale espansione.
Comandi di Water Drop:

• Wave Amplitude – Definisce quanto sono alte le onde. In prossimità del
minimo (min), le onde sono molto deboli. Mentre avvicinandosi al valore
massimo del 100%, le onde divengono più distinte. Il valore numerico usato da
questo comando è un numero relativo.

• Wavelength – Definisce quanto deve essere lunga ogni onda. In prossimità del
minimo (min), le onde sono molto corte. Mentre avvicinandosi al valore
massimo del 100%, le onde divengono molto ampie. Il valore numerico usato
da questo comando è un numero relativo.

• Number of Waves – Definisce il numero di onde da generare. L’intervallo è
compreso tra 1 e 20.

• Wave Diameter – Determina il diametro interno dell’onda circolare. In
prossimità del minimo (min), le onde non sono visibili poiché sono tutte
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concentrate nel centro. Mentre avvicinandosi al valore massimo del 100%, il
diametro delle onde aumenta fino a divenire più grande dello schermo.

• Outside the Edge Options – Poiché le onde d’acqua possono riflettere la luce
delle zone circostanti, si devono fornire delle informazioni riguardanti i margini
del filmato per avere effetti supplementari. L’opzione “Use mirrored tiles”
conferisce l’effetto di estendere i margini dello schermo usando la riflessione
del filmato. Altrimenti potete usare un colore a tinta unita selezionando
l’opzione “ Use Solid Color” e cliccando due volte sul riquadro del colore.
Apparirà un selettore per una completa scelta del vostro colore.

• Wave Target – L’obiettivo è rappresentato da un cerchio rosso sullo schermo
d’anteprima, esso viene utilizzato per definire la posizione del centro dell’onda.
La posizione può essere cambiata trascinando l’obiettivo con il mouse.
L’obiettivo può anche essere rimosso per avere una visione dell’effetto non
ostruita dall’obiettivo, cliccando due volte in un posto qualsiasi della finestra
d’anteprima. Cliccando due volte si riattiverà di nuovo l’obiettivo.

Seguite questi passi:
1. Impostate “Wave Amplitude” al 100%,
2. Impostate “Wavelength” al 40%,
3. Impostate “Number of Waves” a 10,
4. Impostate “Wave Diameter” allo 0%,
5. Ora premete il pulsante Keyframes>> per accedere ai comandi del keyframe,
6. Spostate il cursore della riga percentuale, che si trova allo 0%, fino

all’indicatore del 100%,
7. Impostate “Wave Amplitude” a 40,
8. Impostate “Wave Diameter” a 100,
9. Selezionate Quick Play (riproduzione Rapida) per visionare un'anteprima di

dieci fotogrammi.
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Wave

Sposta aree di un filmato avanti o indietro. Il tipo di distorsione dipende dal tipo di
onde scelte (cioè onde sinusoidali, quadrate o triangolari). Potete selezionare onde
multiple, gli intervalli del periodo e dell’ampiezza. La forza di questo effetto è che
può essere interpolato.
Comandi di Wave:

• Wave Form: - Imposta una delle onde seguenti: Sinusoidale (Sine), Quadrata
(Square) o Triangolare (Triangle).

• Parameters For Direction: - Imposta i comandi sia per le onde orizzontali che
verticali. Le onde orizzontali e verticali sono attive contemporaneamente.
Potete disattivare una o entrambe le onde impostando il comando “number of
waves” a 0. Notate che un’onda orizzontale è un’onda che si sposta nella
direzione orizzontale. Cioè l’immagine viene spostata su e giù come se fosse
attraversata da un’onda.

• Number of Waves – Definisce il numero di onde da generare per la direzione
selezionata. Impostate il valore 0 per disattivare l’onda in una particolare
direzione.

• Speed – Definisce la velocità di passaggio dell’onda. Il valore di questo
parametro va da un minimo di 0 (cursore tutto spostato a sinistra) ad un
massimo di 200 (cursore tutto spostato a destra). Al valore minimo (min),
l’onda impiega più tempo ad attraversare lo schermo, mentre in prossimità del
valore massimo (max), le onde vanno più veloci. Il valore utilizzato in questo
comando è un numero relativo.
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• Intensity Range – Definisce l’intervallo dell’ampiezza (altezza dell’onda),
permesso nella generazione dell’onda. Il valore minimo (min) rappresenta il
limite minimo per l’intensità dell’onda, mentre il valore massimo (max)
rappresenta il limite massimo per l’intensità dell’onda.

• Wave Length Range – Definisce l’intervallo lunghezza dell’onda (wavelengths),
permesso nella generazione dell’onda. Il valore minimo (min) rappresenta il
limite minimo della lunghezza dell’onda, mentre il valore massimo (max)
rappresenta il limite massimo della lunghezza dell’onda.

• Outside the Edge Options – Poiché le onde d’acqua possono riflettere la luce
delle zone circostanti, si devono fornire delle informazioni riguardanti i margini
del filmato per avere effetti supplementari. L’opzione “Use mirrored tiles”
estende i margini dello schermo usando le informazioni della schermata.
Altrimenti potete usare un colore a tinta unita selezionando l’opzione “Use
Solid Color” e cliccando due volte sul riquadro del colore. Apparirà la palette
per una migliore scelta del colore.

• Effect Strength – Definisce l’intensità del l’effetto onda. In prossimità del valore
minimo pari allo 0%, non c’è nessun effetto. Non appena si avvicina il cursore
al valore massimo pari al 100%, l’effetto diventa più forte.

• Predictability – Definisce come devono essere ordinate e combinate le onde.
L’opzione “less” fornisce uno schema meno ordinato. Per un aspetto
simmetrico selezionate “More”.

Seguite questi passi:
1. Impostate “Wave Form” con “Sine”,
2. Impostate “Parameter For Direction” con “vertical”,
3. Impostate “Number of Waves” a 0 (disattivate l’onda verticale),
4. Impostate “Parameter For Wave Direction” con “horizontal”,
5. Impostate “Effect Strength” al 100%,
6. Selezionate Quick Play (riproduzione Rapida) per visionare un'anteprima di

dieci fotogrammi.
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Real Time Effects
Se avete istallato la scheda opzionale DPS R3DX potete aggiungere degli effetti in
tempo reale ai vostri filmati. Selezionate il filmato al quale volete aggiungere un
effetto e premete il pulsante FX, in questo modo si aprirà la finestra “Apply Effects”

Potete aggiungere dei filtri in tempo reale e dei filtri normali allo stesso filmato.
Comunque appena aggiungete un filtro normale al filmato, esso dovrà essere
renderizzato prima che possa essere visionato.
La lista dei filtri in tempo reale include gli otto effetti che possono essere utilizzati
per creare transizioni  3D. Leggete la pagina 124 per avere maggiori spiegazioni di
questi effetti. Esistono due effetti in tempo reale aggiuntivi. Il primo è “Alpha Key”
che serve ad usare una immagine a 32 bit con un canale alfa interno e può essere
trovato nell’effetto “RT Keys Borders”. Il secondo effetto aggiuntivo è “RT Proc
Amp”. Quando aggiungete questo filtro ad un filmato sarà possibile regolare
l’uscita del processore di amplificazione (proc amp) attribuendo ad ogni filmato un
valore indipendente.

SUGGERIMENTO: EFFETTI SOLO PER LA RIPRODUZIONE IN TEMPO REALE
(PLAYBACK ONLY)

Tre degli effetti in tempo reale (Freeze, Trail/Shadow e Transparency) non possono
essere renderizzati. Essi possono essere usati solo per una riproduzione in tempo
reale.

Usate il menu a
tendina per scegliere
il tipo di filtro in
tempo reale (RT
Filters)

Selezionate un
effetto in tempo reale

Il simbolo RT indica che
l’effetto che si sta
usando in questo
momento opera in tempo
reale.

Potete salvare i vostri
effetti o caricare quelli
precedentemente salvati.

Potete riordinare i vostri
effetti spostandoli in una
posizione diversa della
lista.
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Alpha Key
L'effetto “Alpha Key” vi permette di applicare una chiave sul canale alfa ad un file
d'immagine a 32 bit. (I file TGA che create con Inscriber CG sono esempi di questo
tipo di file.) Una volta che avete applicato la chiave al canale alfa, potete
aggiungere ulteriori effetti RT e l'immagine continuerà ad essere riprodotta in tempo
reale.

Threshold:
Come nelle altre chiavi, “threshold” definisce la soglia che determina la trasparenza
dell'area selezionata. Con un valore pari a 0 tutte le zone della chiave alfa sono
opache. A valori bassi le zone specificate saranno poco trasparenti. Se si
impostano valori alti, l’intera immagine diventerà trasparente.
Softness:
Questa impostazione definisce il valore di sfocatura da applicare ai margini della
zona “chiave”. Per avere i migliori risultati con ombre semitrasparenti mantenete
questo valore basso (0 – 4).
Invert:
Quando attivate questa opzione le aree trasparenti e quelle opache sono invertite.
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Downstream Alpha Keying
La scheda DPS R3DX possiede anche un canale grafico addizionale (downstream
alpha key). Ciò significa che  potete riprodurre simultaneamente in tempo reale fino
a due filmati e due file d’immagine, uno che usa il “downstream alpha key” e l’altro
che usa il canale DVE  della R3DX.
Esempi
Posizionate i filmati su V1 e su V2 con una transizione tra loro. Usate per questo
esempio una tendina 2D. Create almeno due titoli con Inscriber CG e mettetene
uno su V4. Video Action ne rileverà automaticamente il canale alfa, ed utilizzerà il
“downstream alpha key” ed il titolo potrà essere riprodotto in tempo reale. Notate
che questo è valido per i titoli statici, in roll (scorrimento verticale) o in crawl
(scorrimento orizzontale) .

Aggiungete un secondo file TGA in V3. Notate che inizialmente l’area coperta da
questo secondo file sarebbe da renderizzare.

Barra di rendering: notate
che tutte le aree sono
verdi

RVA

File TGA (titolo):
downstream alpha key
applicato

RVA

Transizione in tempo reale

Barra di rendering: notate
l’area bianca non
renderizzata

Aggiungete un secondo
file TGA nella traccia V3
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Selezionate la clip posta in V3. Cliccate il pulsante FX per aprire la finestra “Apply
Effects”. Scegliete RT Filters dal menù a scomparsa, e applicate uno qualsiasi degli
effetti RT. L’effetto più utilizzato comunemente dovrebbe essere “Alpha Key” che si
trova nel filtro “RT Keys Borders”. Cliccate sul pulsante OK per salvare le vostre
impostazioni e ritornare alla Timeline. Notate che l’area coperta dal file TGA in V3
ora è renderizzata e può essere riprodotta.

Se visionate in anteprima questo effetto potrete vedere il filmato in V2 e le due
immagini in V3 e V4.

Alla clip posta in V4 potete attivare l'opzione TGA Auto Fade, in modo da dargli
assolvenza e dissolvenza automatiche cliccando con il tasto destro del mouse sulla
clip stessa e selezionando la voce corrispondente dal menù che appare. A questo
punto potete anche aggiungere degli effetti in tempo reale alla clip posta in V3 e
riprodurre ancora il tutto in tempo reale.

SUGGERIMENTO: ASSEGNAZIONE AL FILMATO DEL TITOLO IN TEMPO
REALE

I titoli che usano il “downstream alpha key” devono essere posti sulla traccia video
con il numero più alto in uso di quel segmento. Se ponete un titolo che usa gli
effetti 3D su una traccia con un indicativo numerico maggiore rispetto a quello che
usa il “downstream alpha key”, quel segmento della timeline dovrà essere
renderizzato.

Barra di rendering: notate
che tutte le aree sono
renderizzate

Notate che “1 FX” indica
che è stato applicato un
effetto in tempo reale

Immagine in V3 (usando il
canale degli effetti della
R3DX)

Filmato in V2

Immagine in V4 (usando
downstream alpha key)
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Notate che se applicate gli effetti in tempo reale a due immagini dovrete
renderizzare quella sezione della timeline prima che possiate riprodurla. Potete
utilizzare il “downstream alpha key” su un solo file TGA ed applicare gli effetti in
tempo reale ad un altro filmato (un’immagine, un filmato o una transizione) se
volete riprodurlo in tempo reale.

Notate che potete usare dei titoli ICG che si muovono in roll o crawl invece dei titoli
statici. Il “downstream alpha key” sarà automaticamente applicato al titolo.

Immagine in V4 (usando
downstream alpha key)

FD indica che è stato
applicato un TGA Auto
Fade (assolvenza/
dissolvenza)

Barra di rendering: notate
che tutte le aree sono
renderizzate

2FX indica che sono stati
applicati due effetti in
tempo reale

3FX indica che sono stati
applicati tre effetti in tempo
reale

Barra di rendering:notate
che una sezione (bianca)
non è renderderizzata

Un titolo che si sposta
lentamente (un file ICG a
32 bit creato con Inscriber)
può usare il canale
“downstream alpha”

Barra di rendering: notate
che tutte le aree sono
renderizzate



       Video Action RT

______________________________

219

Se utilizzate una transizione 3D dal filmato in V1 a quello in V2 dovrete usare gli
effetti 3D in tempo reale per generare la transizione. Per questo motivo, se
aggiungete un titolo a cui sono associati effetti 3D in tempo reale, l’area coperta sia
dalla transizione che dal titolo dovrà essere renderizzata prima che possa essere
riprodotta. Se volete aggiungere degli effetti senza rendering, gli effetti 3D in tempo
reale possono essere aggiunti solo ad un filmato per volta.

Notate che gli effetti in tempo reale della R3DX possono essere utilizzati anche su
roll e crawl. Per maggiori informazioni sui titoli Inscriber consultate il capitolo
seguente.

RT Proc Amp
Potete regolare le impostazioni di proc amp (processore d'amplificazione) delle clip
RVA ed RVD in maniera individuale. Selezionate un filmato e applicate il filtro in
tempo reale “Proc Amp”.

Questa transizione 3D usa
effetti 3D

Questa immagine usa
effetti 3D

Barra di rendering: la
sezione degli effetti 3D cui
hanno accesso due filmati
contemporaneamente
deve essere renderizzata
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Notate che potete correggere le impostazioni “proc amp” di tutta la timeline usando
la funzione: File > Preferences > RT Output Proc Amp)

Comandi di Proc Amp
Clip Based Color Correction: Potete modificare i singoli canali usando i cursori.
Waveform: Premete questo pulsante per aprire la finestra dell’analizzatore della
forma d’onda (Waveform Analyzer).
Unity: Premete questo pulsante per riportare tutti i cursori dei colori alla posizione
centrale.
Solid Color: Attivate questa opzione per sostituire il filmato con un colore a tinta
unita. Cliccate due volte sul riquadro per selezionare il colore.
Optional Reference Clip: Potete caricare un filmato di riferimento da utilizzare
come confronto quando state modificando il colore. Usate il pulsante Select per
aprire un filmato. Usate il cursore Frame per mandare avanti il filmato. Usate il
cursore Position per fare scorrere il filmato di riferimento attraverso quello
originale. Potete scegliere la funzione “Wipe In” per visualizzare un’immagine del
filmato di riferimento simulando una tendina. Oppure potete scegliere la funzione
“Slide In” per posizionare il filmato di riferimento al di sopra dell’immagine da
modificare.
Keyframes: L’effetto “Proc Amp” può utilizzare i keyframe, come un qualsiasi altro
effetto. Premete il pulsante “Keyframe” per accedere ai comandi del keyframe.
Cursore di avanzamento (%): Usate questo cursore per scorrere attraverso il
filmato. Assicuratevi che l’immagine che volete analizzare sia mostrata prima di
premere il pulsante “Waveform” per aprire l’analizzatore della forma d’onda
(Waveform Analyzer).

Waweform Analyzer
L’analizzatore della forma d’onda fornisce la maggior parte delle funzioni che si
trovano normalmente nei monitor di forma d’onda. Esso vi può aiutare nel
modificare il colore in uscita dei vostri filmati. Ricordate che state analizzando file di
immagini digitali e non segnali video, perciò non vi saranno mostrate forme d’onda
blanking orizzontale o verticale e di sincronizzazione orizzontale.
Monitor di forme d’onda: I due schermi mostrati sul lato destro della finestra sono
monitor di forma d’onda. questi monitor hanno una scala verticale tarata da –30 a
+130 unità (per lo standard NTSC questa scala è in unità IRE).
Sia per il PAL che per lo standard NTSC ad un valore pari a 100 corrisponde il
bianco. Questo è il valore corretto per le porzioni più luminose del segnale video.



       Video Action RT

______________________________

221

Per il segnale PAL ad un valore pari a 0 corrisponde il nero. Per la maggior parte
dei segnali NTSC ad un valore pari a 0 corrisponde un segnale video vuoto (o non
visualizzato). Ad un valore pari a 7.5 (indicato dalla linea punteggiata) corrisponde
il nero. Questo è il livello corretto per le porzioni più scure della maggior parte dei
segnali video NTSC.
Composite Monitor
Lo schermo in alto a sinistra è un monitor Composito. Esso mostra il segnale video
come sarà mandato all’uscita video Composita.
Notate che lo schermo Composito è stato tarato per mostrare correttamente barre
di colore del 75%. Le barre di colore sono un modello di test standard che utilizza il
75% della saturazione del colore per ogni barra di colore. In termini di valori RGB,
barre di colore del 100% dovrebbero avere una barra blu con B = 255 (100%),
mentre le barre di colore del 75% dovrebbero avere una barra blu con B = 191
(75%). I sistemi televisivi utilizzano frequentemente barre di colore del 75% perché
i picchi di crominanza elevata nelle barre di colore del 100% possono
sovraccaricare un trasmettitore.
Nell’esempio mostrato, barre di colore del 75% sono utilizzate con una barra
bianca del 100%. Notate che la barra bianca conferisce un valore pari a 100 unità,
come fanno i picchi delle barre di giallo e ciano del 75%.
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Composite: Usate questo pulsante per mostrare l’intero segnale video composito.
Luma: Usate questo pulsante per mostrare per verificare la Luminanza
dell’immagine.
Chroma: Usate questo pulsante per verificare la crominanza dell’immagine.
Add Setup: Usate questo pulsante per correggere il livello del nero sul display del
monitor di +7.5 unità per i segnali NTSC. Questo pulsante non modificherà il livello
del nero, ma solo il modo con cui viene mostrato sull’analizzatore.
Quando il “setup” viene applicato ad un segnale video esso riduce l’ampiezza
dell’intervallo riguardante le informazioni dell’immagine da 0 – 100 unità a 7.5 – 100
unità. Sia i valori della Luminanza che quelli della Crominanza sono ridotti
progressivamente allo scopo di adattarli al nuovo intervallo. Il valore di picco del
bianco rimane a 100 unità. I segnali video nordamericani NTSC utilizzano il “setup”.
I segnali video giapponesi ed il PAL non lo utilizzano. Molti segnali di test non lo
utilizzano.
Component Monitor
Lo schermo in basso mostra le singole componenti del vostro segnale video.
Parade: mostra i livelli del Luma, B-Y e R-Y contemporaneamente.
Luma: mostra solo la Luminanza.
B-Y: mostra il segnale del blu meno la Luminanza.
R-Y: mostra il segnale del rosso meno la Luminanza.
75% / 100%: seleziona un intervallo dell’ampiezza verticale pari al 75% o al 100%.
Notate che la scala verticale non cambierà, ma solo l’ampiezza della forma d’onda
mostrata.
Le impostazioni  75% / 100% consentono di cambiare la calibrazione del guadagno
della crominanza del monitor di forma d’onda per adeguarsi alle barre colore 75% o
100%.

Vectorscope
Lo schermo in alto a destra di questa finestra è un vettorscopio. Usando una
immagine con colori standard tutte le linee si dovrebbero intersecare nel centro del
grafico, come mostrato. Potete selezionare l’intervallo di ampiezza (75% o 100%),
dipende da quale modello sul test di colore state utilizzando.

Image
Lo schermo in basso a destra mostra un campo del vostro video. (In questo
esempio sono state usate strisce di colore standard del 75%).
Line Select: Potete analizzare l’intera immagine o una singola linea. Utilizzate i
pulsanti presenti sul lato destro di questa finestra per selezionare tutta l’immagine
(All Lines) o una singola linea (Single). Se volete analizzare una singola linea
dovete poi selezionare Field 1 (Semiquadro-1) o Field 2 (Semiquadro -2). Potete
scegliere esattamente la linea da analizzare usando i pulsanti sulla destra
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dell’immagine o selezionando il valore numerico corrispondente. Quando premete il
pulsante HiLite la singola linea che state analizzando sarà evidenziata allo scopo
di identificarla più facilmente.
Horizontal Magnification: Potete cambiare l’ingrandimento orizzontale della
vostra immagine da x1 a x50 per mostrare informazioni più dettagliate sulla forma
d’onda. Dopo che l’immagine è stata ingrandita potete usare la scroll bar sotto
l’immagine per selezionare la parte dell’immagine da analizzare.
Proc Amp
Potete modificare il colore usando i cursori i cursori posti sul lato in alto a destra
della finestra. Potete ripristinare la posizione standard di un singolo cursore
cliccando sul pulsante C che trovate alla fine di ogni comando. Potete resettare tutti
i cursori usando il pulsante Proc Amp All Unity presente al di sotto di tutti i
comandi.

Luma Gain: Determina il guadagno della componente Luma del segnale
video. Guardate il valore di “luma” sul monitor della forma d’onda.
Aumentando il valore si aumenta l’ampiezza dell’intervallo della forma
d’onda. Ciò è simile al comando del contrasto. Infatti le aree scure
rimangono tali e quelle luminose diventano più brillanti. Per i filmati televisivi
assicuratevi di non aumentare più di 100 unità.
Black Level: E’ il valore delle aree più scure del video. Guardate il valore di
“luma” sul monitor della forma d’onda. Aumentando il valore si sposta
l’intera forma d’onda senza che cambi la sua forma. Ogni cosa diventa più
brillante o più scura di uno stesso valore. Questo comando è simile a quello
della luminosità. Per i video in formato NTSC assicuratevi che non superino
le 7.5 IRE.
Chroma Gain: Determina la saturazione del colore. Questo comando
aumenta o diminuisce tutti i colori di uno stesso valore. Con un valore pari a
0 l’immagine è in bianco e nero, a 255 tutti i colori sono molto saturi.
B-Y Offset: Determina la parte blu del segnale. Valori più grandi danno una
immagine più blu.
R-Y Offset: Determina la parte rossa del segnale. Valori più grandi danno
una immagine più rossa.
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Uso dell’analizzatore di forme d’onda
durante la cattura
Mentre state catturando la componente del video potrete usare i comandi di “Input
Proc Amp” mediante l’analizzatore di forme d’onda. Le finestre “Quick Capture” e
“Batch Capture Settings” hanno un piccolo pulsante sotto i comandi “Input Proc
Amp” indicati con una “V”. quando premete questo pulsante l’analizzatore di forma
d’onda importerà il segnale d’ingresso corrente per modificare le impostazioni “proc
amp”.
Notate che le impostazioni “Input Proc Amp” presenti nella finestra principale
“Capture Settings” usano delle scale differenti rispetto a quelle del “proc amp”
presenti nell’analizzatore di forma d’onda ed hanno intervalli leggermente differenti.
Quando modificate una scala, Video Action calcolerà automaticamente il valore
sull’altra scala. Se superate l’intervallo permesso da una scala, Video Action vi
avviserà e vi porterà all’impostazione più vicina possibile. Per esempio, se portate il
valore del “Chroma Gain” a 0 sull’analizzatore di forma d’onda, esso sarà inferiore
al minimo permesso dal “Chroma Gain” (-100) in “ Input Proc Amp”. Video Action vi
avviserà e resetterà il valore del “Chroma Gain” al suo valore minimo di –100.

Impostazioni Proc Amp in Ingresso disponibili:

*Una impostazione della forma d’onda pari a 0 imposterà un valore in ingresso pari
a 50. Una impostazione della forma d’onda pari a 255 imposterà un valore in
ingresso pari a 149.

Luma Gain 0-200 0-230 Intervallo di forma d’onda più grande
Black level 0-200 0-255 Intervallo di impostazioni più grande
Chroma Gain -100 - +100 100-176 Intervallo di forma d’onda più grande
B-Y/R-Y -100 - +100 64-224 Intervallo di forma d’onda più grande

Impostazioni
di ingresso

Impostazioni di
forma d’onda

Note
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Un esempio: Uso dei filtri in tempo reale
per creare un filmato in bianco e nero con
un oggetto colorato in movimento
Selezionate un filmato che ha un oggetto in movimento di un unico colore. Nel
nostro caso dovrebbe essere una dovrebbe essere una donna con un rossetto
brillante, un paio di scarpe da tennis gialle, un anello d’oro oppure un qualsiasi altro
filmato con un oggetto colorato lucente.
Ponete il filmato prescelto sia su V1 che su V3. Assicuratevi che si trovino nella
stessa posizione sulla timeline (cioè partano nello stesso momento).
Applicate gli effetti in tempo reale al filmato su V1 (cliccando con il tasto destro del
mouse sul filmato e selezionando “Video Effects”). Selezionate dalla lista RT Proc
Amp. Portate il valore del “Chroma Gain” fino a 0. Tutto questo renderà il filmato in
V1 in bianco e nero.
Applicate gli effetti in tempo reale al filmato su V3. Selezionate dalla lista RT Keys
Borders. Premete il pulsante “Chroma Keying”. Premete il pulsante “Color Picker”
e cliccate sull’oggetto colorato. Spostate i cursori di “Threshold” e “Softness” fino a
che non è stato selezionato tutto l’oggetto. Selezionate l’opzione “Invert”. Ciò
selezionerà ogni cosa eccetto il vostro oggetto colorato.
Fate partire il vostro filmato. Il filmato sarà riprodotto in bianco e nero eccetto
l’oggetto colorate che avete selezionato.

Usate il filtro in tempo reale “Proc
Amp” per creare un filmato in
bianco e nero (portando il valore del
“Chroma Gain” a 0)

Usate il filtro in tempo reale “Keys
Borders” ed il “Chroma Keying” per
selezionare ogni cosa eccetto il
vostro oggetto colorato del “Chroma

Risultato finale:
Un filmato in bianco e nero con un
frisbee color magenta in movimento
eccetto il vostro oggetto colorato
del “Chroma Gain” a 0)
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Capitolo 8 : Effetti

Introduzione
Video Action vi fornisce tutti gli strumenti di cui avete bisogno per produrre
sofisticati effetti speciali. Inscriber CG è stato integrato in Video Action per
permettervi di creare effetti in tempo reale, titoli che si spostano lentamente o
ruotano. Potete applicare effetti da renderizzare ai vostri filmati usando i pulsanti
che trovate nella finestra “Apply Effects”.
Gli effetti da renderizzare presenti in questo capitolo sono:

• Keying: Chroma, Luma, and Blue/Green Screen

• Transparency Assignment

• Gradient Wizard

• Page Effect

• Title Generator

• Border/Shadow

• Trailing Effects
(L’effetto renderizzato “Video Screen Animation” viene spiegato nel Capitolo 9).
Questo capitolo spiega anche come creare titoli in tempo reale usando i file di
Inscriber CG con Video Action.
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Uso degli effetti renderizzati
Gli effetti renderizzati possono essere applicati a qualsiasi filmato. Per utilizzare un
effetto:
1. Selezionate il filmato sulla timeline.
2. Aprite la finestra “Apply Effects” premendo il pulsante FX nella barra degli

strumenti (oppure cliccate con il tasto destro del mouse sul filmato e
selezionate Video Effects oppure selezionate Tools > Video Effects and Titler
dal menu principale).

3. Usate i pulsanti sul lato in basso a sinistra della finestra per selezionare un
effetto. Ogni effetto ha i suoi comandi.

4. Dopo aver fatto le vostre impostazioni premete il pulsante OK e tornate alla
finestra “Apply Effects”. L’effetto che avete selezionato sarà mostrato nel
riquadro “Effects Selected” sul lato in alto a destra della finestra.

5. Premete il pulsante OK e ritornerete nella timeline. Il vostro filmato avrà il
simbolo “1 FX” nell’angolo in alto a sinistra.

Notate che potete applicare ad un filmato quanti effetti volete.

Selezionate un effetto
premendo uno di questi
pulsanti



       Video Action RT

______________________________

228

Collocazione del filmato
Le tracce che hanno un numero più alto sono sovrapposte a quelle che hanno un
numero più basso. Perciò il filmato in primo piano, contente il filmato o l’immagine
che deve essere sovrapposta, deve essere messo sulla traccia di sotto (che ha un
numero più alto) del filmato in background. Se si crea un video sulla traccia V1 e
V2, il filmato in primo piano deve essere messo sulla traccia V3 o più grande.
Questo filmato in primo piano userà qualsiasi filmato che si trova su una traccia in
alto come background. Se non c’è nessun filmato di background (cioè nessun
filmato è stato posizionato sulle tracce di sopra) allora il background sarà nero.

Potete avere degli strati multipli di filmati chiave. Un esempio di come usare questi
strati multipli potrebbe essere quando avete un titolo sulla traccia V6, che si
sovrappone al filmato della reporter sulla traccia V5 con una seconda immagine su
V4, un grafico su V3 e il video in background su V2.

Filmato in primo piano

Filmato in background
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Chroma/Luma Keying
Questo effetto di Video Action vi permette di selezionare un filmato ed un colore o
luminosità che diverrà trasparente così che possiate sovrapporre le immagini di un
filmato su un altro.
Notate che se avete istallato la scheda DPS R3DX potete utilizzare l’effetto in
tempo reale “Chroma keying” e “Luma keying”.

La finestra dei comandi di Chroma/Luma Keying
Selezionate il filmato di primo piano sulla timeline, premete il pulsante FX nella
barra degli strumenti ed il pulsante Chroma/Luma Keying nella finestra “Apply
Effects”. Si aprirà la finestra dei comandi di “Chroma/Luma keying” con il filmato di
primo piano selezionato.
Usate il menu a tendina posta in alto per selezionare il tipo di chiave (Key Type).
Saranno attivati dei comandi differenti secondo il tipo di chiave che selezionate.
Notate che tutti i tipi di chiave possono usare i comandi dei fotogrammi chiave
(keyframes) per personalizzare l’effetto. Premete il pulsante Keyframes>> per
aprire i comandi dei fotogrammi chiave (keyframes). Leggete il Capitolo 7 per i
dettagli sull’uso dei fotogrammi chiave.

Traccia V5: reporter

Traccia V6: Titoli

Traccia V2: background Traccia V3: grafico

Traccia V4:
Picture in Picture
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Comandi di Chroma Keying
Il “Chroma keying” rende trasparenti delle zone del vostro filmato basandosi sui
valori che avete definito del colore (hue) e della saturazione (saturation). Le aree
che non corrispondono ai valori impostati restano opache e sono mostrate in primo
piano, mentre le aree trasparenti vengono coperte dal filmato di background.

• Key Type: Per applicare l’effetto selezionate “Chroma Key” dal menu a
tendina.

• Pick Key Color: Cliccate su questo pulsante per trasformare il puntatore in un
contagocce che può essere usato per selezionare il colore chiave direttamente
dal filmato. Per esempio, se il vostro filmato di primo piano è un testo bianco
su uno sfondo blu, voi potete spostare il contagocce sull’area blu
selezionandolo come colore chiave. In questo modo tutti gli elementi colorati di
blu sul filmato di primo piano diventeranno trasparenti ed attraverso questi
sarà visibile il filmato(i) di background. Potete anche scegliere un colore
cliccando due volte sul riquadro posto vicino al pulsante “Pick Key Color”. Si
aprirà così una finestra che permetterà la scelta tra un’ampia gamma di colori.

• Hue Tolerance: Definisce la tolleranza della  tinta del colore da rendere
trasparente. Impostando un valore alto più aree con colore simile diventeranno
trasparenti. Quando il cursore si trova spostato a sinistra, è usata una
tolleranza molto stretta che dà luogo ad aree trasparenti solo in un campo di
tonalità molto preciso. Quando il cursore è tutto spostato a destra, tutte le
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tonalità diventano trasparenti. Ciò vi permette di selezionare aree intere con
colori simili.

• Saturation Tolerance: Definisce la tolleranza della saturazione del colore da
rendere trasparente. Quando il cursore si trova spostato a sinistra, sono
richiesti per la trasparenza valori vicini alla saturazione. Quando il cursore è
tutto spostato a destra, qualsiasi valore di una tonalità selezionata diventa
trasparente.

• Foreground Transparency: Modifica la trasparenza del filmato di primo
piano. Questo comando riguarda la trasparenza delle aree che restano dopo
che è stata applicata la chiave.

• Reverse: Rende trasparenti le areee opache ed opache regioni trasparenti.

Comandi di Luma Keying
In questo tipo di effetto solo la lucentezza o la luminosità è un fattore che determina
la trasparenza di un’area. Non dovrete selezionare un colore chiave poiché la
tonalità (hue) e la saturazione (saturation) non hanno alcun ruolo.

• Key Type: Per applicare l’effetto selezionate “Luma Key” dal menu a tendina.

• Luminance Threshold: Usate questo cursore per definire il livello di
luminanza usato per definire quale parte dell’immagine o del fotogramma sarà
trasparente rispetto al filmato di background.

• Foreground Transparency: Questo cursore modifica il livello di trasparenza
del filmato di primo piano. Questo comando riguarda la trasparenza delle aree
che rimangono dopo l’applicazione dell’effetto.

• Reverse: Rende trasparenti regioni opache ed opache regioni trasparenti.

Comandi di Blue/Green Screen Keying
Video Action include quest’effetto per gestire chiavi difficili come il fumo su uno
sfondo blu (o verde), dettagli sottili come capelli, ecc.
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• Key Type: Selezionate “Blue Screen” o “Green Screen” dal menu a tendina.

• Feathering Level: Definisce le caratteristiche della chiave ai confini
dell’oggetto di primo piano. Spostate questo cursore per definire con chiarezza
i margini del primo piano rispetto allo sfondo.

• Threshold: Definisce quanta tolleranza è permessa sul blu (o verde) per la
chiave. Un valore massimo renderà l’intero filmato trasparente. Per vedere gli
effetti di questo comando, cercate di applicarlo all’immagine “cloud24.jpg” che
trovate nella subdirectory “Samples\Masks” della directory principale di Video
Action”.
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Transparency Assignment
Il “Transparency Assignment” permette di scegliere tra cinque modalità per bucare
in chiave parzialmente una clip. Per ogni modalità viene fornita la possibilità di
invertire l'effetto; in questo modo le zone trasparenti vengono invertite con quelle
opache e viceversa. Ogni modalità ha i suoi comandi specifici.
Nota: se avete istallato la scheda DPS R3DX potete utilizzare l’effetto in tempo
reale “Transparency”. Per maggiori informazioni leggete pag. 137.

Uniform Transparency
Lo stile “Apply Uniform Transparency” vi permette di applicare la trasparenza ad un
intero filmato. Usate il cursore Foreground Transparency per regolare la
trasparenza sul filmato. Al valore minimo (min) corrisponde un filmato
completamente opaco. Come si sposta il cursore verso il valore massimo (max) la
trasparenza aumenta permettendo di porre un filmato qualsiasi sulle tracce più alte.

Selezionate uno dei cinque
tipi di chiave

File utilizzato con alcuni tipi
di chiave

Comandi dei Keyframes per
gli effetti

Apre il pannello
dei Keyframes

Modalità di
anteprima

Controllo
immediato del
vostro effetto

Colore utilizzato con il colore
chiave

Comando di
trasparenza
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Color Keying
Lo stile “Use Color Keying” vi permette di selezionare un colore chiave (basato sui
valori RGB) che viene confrontato alle regioni del filmato. Le zone che hanno lo
stesso colore diventano trasparenti. (Notate che con questo stile non potete
utilizzare il bianco come colore chiave nella modalità normale. Se avete bisogno di
bucare in chiave uno sfondo bianco potete selezionare l’opzione “Reverse” ed
impostare il cursore della tolleranza al valore massimo).
Per prima cosa dovete selezionare il colore chiave per la trasparenza. Premete il
pulsante “Pick Color” per attivare il selettore del colore (contagocce). Usatelo per
selezionare un colore presente nella schermata d’anteprima da rendere
trasparente. Potete anche selezionare il vostro colore chiave cliccando sul riquadro
colorato posto vicino al pulsante per ottenere una più ampia gamma di colori.
Notate che la tinta (hue) del colore chiave, la saturazione ed i valori del “luma” sono
utilizzati per determinare le regioni trasparenti (diversamente dal “chroma keying”
che usa la tinta e la saturazione ma non i valori del “luma).
Utilizzate il cursore Tolerance per definire il colore chiave come deve essere
accoppiato a quello presente sullo schermo. Una tolleranza piccola determina la
trasparenza solo per quei colori che sono molto simili a quello selezionato. Una
tolleranza ampia rende un maggior numero di colori trasparenti.
Si può utilizzare il comando Border per sfumare i margini o per aggiungere un
colore ai bordi di un oggetto chiave che possiede un gradiente di colore.
Diversamente da comandi simili, questo non viene usato per aggiungere un bordo
a zone di alto contrasto già definite nettamente.
Per provare questo comando applicate
l’effetto al file “Twirl.tif” che trovate nella
subdirectory “Samples\Masks” della directory
principale di Video Action”.  Scegliete il nero
come colore chiave. Cercate di variare la
tolleranza il valore del “border”. Provate sia i
bordi sfumati che quelli colorati.

Potete utilizzare anche il cursore Foreground Transparency per modificare il
valore di trasparenza dell’intero filmato come avviene nella modalità “Uniform
Transparency”.

Color Keying on a Mask
Questa modalità utilizza un file maschera per il colore chiave (basato sui valori
RGB). Prima di tutto si sceglie un file maschera, poi si seleziona un colore chiave
dal file maschera e lo si confronta alle aree presenti nel filmato. Se si trova
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l’abbinamento del colore selezionato e della tolleranza, allora l’area corrispondente
nel filmato diventa trasparente.
Utilizzate il pulsante “File” per selezionare il file che volete usare come maschera.
Questo file può essere un’immagine o un filmato. Sarà mostrato direttamente come
file maschera. Successivamente selezionate il colore chiave dal file maschera,
usando il pulsante “Pick Color” oppure cliccando due volte sul riquadro colorato
posto vicino al pulsante per ottenere una più ampia gamma di colori.
Utilizzate il cursore Tolerance per definire il colore chiave come deve essere
accoppiato a quello presente sullo schermo. Una tolleranza piccola determina la
trasparenza solo per quei colori che sono molto simili a quello selezionato. Una
tolleranza ampia rende un maggior numero di colori trasparenti.
Potete utilizzare anche il cursore Foreground Transparency per modificare il
valore di trasparenza dell’intero filmato come avviene nella modalità “Uniform
Transparency”.
Potete cambiare il colore chiave e la trasparenza usando anche i fotogrammi
chiave. Si può usufruire di questa possibilità per creare transizioni personalizzate
nelle quali il filmato di partenza sarà sostituito gradualmente dal filmato finale.
Anche in questa modalità si può usare il comando Border, esso fornisce un
margine per delineare l’area trasparente. Esistono due opzioni “Color” e “Soft”. Il
pulsante “Color” permette di selezionare il colore del bordo. Con l’opzione “Soft” si
genera sul bordo un leggero effetto. Il cursore determina lo spessore del bordo.
In questa modalità esiste anche il pulsante “Advanced”. Premendo questo pulsante
comparirà la finestra “Advanced Options”. Questa vi permette di avere delle
possibilità aggiuntive per modificare la maschera. Le opzioni sono:

• Rows, Columns - La maschera viene rimpicciolita e ripetuta in funzione del
numero di righe e colonne che è stato definito. Questa opzione è abilitata
quando è stato selezionato “No Mirror”.

• Mirror Effect: Horizontal or Vertical - Disabilita l’opzione precedente, utilizza
uno specchio sulla maschera o sul margine superiore (horizontal) o su quello
destro (vertical) e comprime l’immagine raddoppiata per adattarla alla
schermata.

• Offset - La maschera viene considerata come un canale alfa e i valori della
tinta utilizzati sono cambiati dal valore di “Offset”.

• Flip Horizontal, Flip Vertical - Ruota la maschera nelle due direzioni.

Alpha Channel Keying
Questa modalità utilizza un file immagine per determinare la trasparenza. Le aree
nere del file del canale alfa sono usate per definire le aree trasparenti del filmato di
primo piano. Le aree bianche sono usate per definire le aree opache del filmato di
primo piano. Alle aree grigie viene data una percentuale di trasparenza dipendente
da quanto esse sono scure.
Normalmente le immagini usate per definire le aree del canale alfa sono immagini
ad 8 bit in scala di grigio, create con vari tipi di programmi. Comunque Video Action
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accetta qualsiasi immagine a colori o in scala di grigio o video come canale alfa. Se
utilizzate un’immagine a colori, la luminosità dei colori servirà a determinare la
percentuale della trasparenza. Usate il pulsante “File” per selezionare il file che
volete utilizzare come canale alfa.
Usando questa modalità il valore di default del “Transparency Control” è pari a 50.
Spostando questo cursore da 0 a 50 le aree nere subiscono uno spostamento dallo
0% al 100% di trasparenza, mentre le aree bianche restano opache. Spostando il
cursore da 50 a 100 le aree bianche subiscono uno spostamento dallo 0% al 100%
di trasparenza, mentre le aree nere rimangono al 100% trasparenti. Potete
utilizzare questa opzione con i fotogrammi chiave per creare i vostri effetti preferiti.

Difference Keying
In questa modalità il filmato di primo piano viene confrontato con un altro filmato
(difference clip). Le aree simili sono rese trasparenti nel filmato di primo piano. Per
esempio, il filmato di primo piano contiene una persona che passeggia su un
marciapiede mentre il filmato di differenza (difference clip) contiene lo stesso
marciapiede senza la persona. Applicando questa modalità apparirà la persona che
cammina sul filmato di background invece che sul marciapiede.
Utilizzate il pulsante “File” per selezionare il file che volete usare per creare questo
effetto.
Potete utilizzare il cursore “Color Tolerance” per modificare il valore della differenza
del colore. Esso serve a definire quali aree considerare simili e quindi renderle
trasparenti.  Con un valore pari a 0 ci deve essere esattamente uno stesso colore
affinché le aree corrispondenti del filmato di primo piano vengano rese trasparenti.
Il cursore “Foreground Transparency” può essere usato per modificare la
trasparenza della parte rimasta del filmato di primo piano.
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Gradient Wizard

Il “Gradient Wizard” (Generatore di Gradienti) vi permette di creare gradienti
colorati, in movimento, dotati di trasparenza, da poter utilizzare nei vostri progetti
video. I tipi di gradiente predefiniti sono tre; lineare, circolare e conico. Utilizzando i
keyframes potete anche fare in modo che i gradienti cambino colore, direzione,
dimensione, fase, etc.

Comandi di Gradient Wizard:
• Color Model: Questo menù a tendina si riferisce al grafico presente nella

finestra sottostante (Gradient Cycle). Usate questo menu per selezionare i
seguenti modalità di colore: RGB (rosso, verde e blu), HSV (sfumatura,
saturazione e valore) oppure CMY (ciano, magenta e giallo).

• Gradient Cycle Window: Questo grafico rappresenta con quattro curve come
variano i colori dall’inizio alla fine del ciclo. Modificate i colori spostando le tre
curve corrispondenti (ognuna di queste rappresenta una componente del
colore) spostando i cinque nodi presenti su di esse. Spostando una curva
qualsiasi verso l’alto, si aumenta la componente di quel colore. La curva nera
rappresenta la trasparenza del gradiente. Innalzando questa curva viene
incrementa l'opacità del gradiente nella parte alta della clip ad esso connessa.
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• Fm Color: Fissa il colore di partenza durante il ciclo del colore. Premete
questo pulsante per aprire una finestra che permette una scelta più precisa del
colore di partenza in un gradiente. Variando questo colore tra i fotogrammi
chiave i colori cambieranno con il passare del tempo.

• To Color: Fissa il colore finale durante il ciclo del colore. Premete questo
pulsante per aprire una finestra che permette una scelta più precisa del colore
finale in un gradiente. Variando questo colore tra i fotogrammi chiave i colori
cambieranno con il passare del tempo.

• “ = ” : Un modo veloce per impostare il colore finale (“To Color”) uguale a
quello di partenza (“From Color”).

• Number of Cycles: Definisce il numero di volte che si deve ripetere il
gradiente. Quando impostate un valore pari a 0 non viene prodotto nessun
gradiente. Il numero massimo di cicli è pari a 10.

• Offset: Definisce quanto cambiare i colori del gradiente. Con un valore pari
allo 0% non viene prodotto nessun cambiamento. Non appena si aumenta
questo valore i colori del gradiente gradualmente cambiano posizione fino al
100%, quando il ciclo è completo e non c’è nessun nuovo cambiamento
apparente. Variando il valore tra fotogrammi chiave diversi si produce un
gradiente in movimento.

• Fill Style: Il menu a tendina permette di scegliere il tipo di gradiente tra
“Linear”, “Circular” e “Conic”. Questo comando permette di definire (nella
schermata d’anteprima) i confini determinati da una delle tre modalità, come si
può vedere in figura:

• Transparency Only: Quando questa opzione è attivata, i colori del gradiente
sono disattivati. E’ attiva solamente la curva nera nella finestra “Gradient
Cycle” per permettervi di rendere il background del filmato gradualmente
trasparente. Elevate la curva presente nella finestra per aumentare la
trasparenza nel punto del ciclo desiderato.

• Curve: Normalmente questa opzione è attivata, dando luogo a curve che si
intersecano nei nodi. Se l’opzione non è attivata invece vendono usate delle
linee diritte per unire i nodi.
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• Repeat Gradient Forever: Ricopre l’intero schermo con il gradiente
selezionato con il modello del gradiente ripetuto (linear) o espanso (circular
and conic).

• Alternate Direction Every Cycle: Se state utilizzando cicli multipli questa
opzione dirigerà la direzione del gradiente alternativamente verso ogni confine.
Essa può essere usata agevolmente per creare dei valori variabili.

Page Effect
Questo Effetto permette all'utente di definire in modo flessibile degli effetti di volta
pagina. Una clip può essere trasformata in un foglio di carta che sfila o si arrotola in
primo piano. Potete variare l’angolo di sfilamento o rotolamento, il suo raggio e la
fase per dare un aspetto naturale e interessante ai vostri effetti di volta pagina.
Il background deve essere posto sulle tracce che stanno sopra a quelle che
ospitano il filmato cui è stato applicato il filtro (cioè sulle tracce che hanno dei
numeri più bassi rispetto a quelle occupate).
Nota: se avete istallato la scheda DPS R3DX potete creare questi effetti in tempo
reale utilizzando gli effetti “3D Warp”. Per maggiori dettagli leggete la
documentazione relativa.
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Comandi di Page Effect
• Page Effect: Con questo menu a tendina si seleziona l’effetto “Page Flip”

oppure “Page Roll”.

• Angle: Definisce l’angolo con cui deve essere sfilata o arrotolata la pagina.
Con un valore pari a zero gradi l’effetto inizia dal fondo della pagina.
Aumentando l’angolo l’effetto si sposta in senso orario sequenzialmente dal
fondo verso destra, in alto, a sinistra. Quando il percorso si conclude si ritorna
al punto di partenza sul fondo della pagina. Potete utilizzare i fotogrammi
chiave per interpolare questo valore creando un effetto ricciolo intorno ai
margini della pagina.

• Radius: Modifica il raggio dello sfilamento o arrotolamento. Con un raggio
piccolo, la zona sfilata o arrotolata della pagina risulta più piccola. Con un
raggio grande, tutta la pagina tende ad arricciarsi.

• Phase: Modifica l’aspetto degli effetti. Con un valore pari allo 0%, la pagina
appare piana. Con un valore pari al 100%, la pagina appare completamente
arrotolata o sfilata. Se i fotogrammi chiave non sono stati attivati, questo
parametro varia automaticamente dallo 0% al 100% durante lo svolgimento del
filmato. Se attivate i fotogrammi chiave potete cambiare questo valore
successivamente per creare il vostro effetto desiderato.

• Page Backside: Con questo comando si può definire la parte posteriore della
pagina. La scelta avviene tra tre possibilità: “Solid Color” (cliccate due volte
con il mouse sul riquadro colorato per modificare il colore), “Current Clip”
oppure “Selected Clip” (un filmato scelto da voi). Se scegliete quest’ultima
opzione dovete usare il pulsante “File” per selezionare il filmato che desiderate
utilizzare.

• Border: Definisce il tipo di bordo da mettere intorno alla pagina. Potete
scegliere tra un colore a tinta unita (cliccate di nuovo sul riquadro colorato per
modificare il colore) oppure un vostro filmato. Se avete scelto “Selected Clip”
dovete usare il pulsante “File” per selezionare il filmato che desiderate
utilizzare.

• Border Thickness: Definisce la misura del bordo. Se impostate un valore pari
a zero, non viene creato alcun bordo intorno alla pagina. Quando imposte il
valore 100 viene creato un bordo molto spesso.

• Split Page: Fornisce una grande varietà di modi per suddividere la pagina in
parti più piccole. Potete effettuare la scelta fra tre misure in orizzontale,
verticale o a matrice quadrata. Questa opzione è utilizzabile solo per lo
sfilamento (flip).

• Flip Pattern: Questo comando si può utilizzare solo quando è stata
selezionata l’opzione “Split Page”. Scegliete tra un modello lineare ripetuto
(straight repeating pattern), uno specchio verticale (vertical mirror), uno
specchio orizzontale (horizontal mirror) e una combinazione dello specchio
orizzontale e verticale.



       Video Action RT

______________________________

241

• Page Size Adjuster Rectangle: Sullo schermo d’anteprima un rettangolo
rosso evidenzia la misura dell’effetto voltapagina. Trascinate gli angoli di
questo rettangolo per ottenere la misura desiderata. Notate che la misura della
pagina può essere interpolata successivamente. Cliccate due volte con il
mouse sull’anteprima per nascondere il rettangolo. Cliccando di nuove due
volte su essa lo si fa riapparire.

• Flip Target: Sullo schermo d’anteprima un obiettivo rosso indica la direzione
del moto di sfilamento o rotolamento.

• Advanced: Con questo pulsante si accede ai comandi avanzati per il controllo
dei bordi, che si trovano sul lato destro dello schermo. Potete definire la
trasparenza (Border Transparency), l’intensità della luce, ovvero la luminosità
del colore del bordo (Light Intensity), ed il profilo del bordo (la figura in 3D).

Titolazione

Video Action fornisce due possibilità per effettuare la titolazione: l’effetto
”TitleGenerator” (Generatore di Titoli), per collegare titoli renderizzati a filmati
presenti sulla timeline, e l’accesso incorporato ad Inscriber CG, per creare titoli
sotto forma di file bitmap (con un canale alfa interno) che possono essere utilizzati
come titoli in tempo reale.
Per creare titoli renderizzati generici potete accedere al Generatore di Titoli
utilizzando i pulsanti presenti nella finestra “Apply Effects”. Il Generatore di Titoli
può creare e attaccare facilmente testi scorrevoli colorati, con bordi, ombre, ecc.
per filmati multimediali. Il Generatore di Titoli può essere utilizzato con qualsiasi
font di Windows per creare interessanti e colorati titoli per i vostri video. Applicando
gli effetti di Video Action a dei font esistenti potete anche creare dei font
personalizzati. I titoli che generate in questo modo vengono considerati come degli
effetti renderizzati.
Potete utilizzare Inscriber CG per creare titoli in tempo reale cliccando due volte
con il mouse in “Gallery” e selezionando Inscriber CG dal menu. Quando salvate le
immagini prodotte con Inscriber CG esse saranno immediatamente mostrate in
Gallery. Potete anche usare Inscriber CG per creare titoli, titoli che si spostano
verticalmente o che scorrono orizzontalmente. I titoli che avete creato si possono
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sovrapporre ai vostri filmati RVA o RVD. Questi file possono anche essere usati
come titoli in tempo reale senza nessun rendering aggiuntivo. Se avete istallato la
scheda DPS R3DX i vostri titoli che si arrotolano o che si spostano lentamente
saranno riprodotti in tempo reale.

Title Generator
Lo scopo principale di questo effetto è quello di aggiungere un testo direttamente
ad un video clip. L’effetto può essere applicato allo stesso filmato più di una volta
per creare testi che scorrono in diverse direzioni. Potete aggiungere anche degli
effetti speciali ai titoli per dare un tocco d’unicità alle vostre creazioni.
Per accedere a “Title Generator” selezionate il filmato da titolare sulla timeline.
Aprite la finestra “Apply Effects” cliccando sul pulsante FX nella barra degli
strumenti (oppure selezionate Tools > Video Effects & Titler dal menu principale
e poi Video Effects).  All’interno della finestra “Apply Effects” cliccate sul pulsante
Title Generator. A questo punto si può accedere alla finestra dei comandi di base
del “Title Generator”. Questa rappresenta l’interfaccia dove il testo viene editato,
caricato o visionato rispetto al filmato cui deve essere applicato.
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Comandi di base di Title Generator
Enter Text: Questo spazio serve a scrivere il testo, a editarlo, salvarlo e
recuperarlo. Scrivete il testo che desiderate far comparire usando tutte le possibilità
offerte dal mouse e dalla tastiera per cancellare, aggiungere e cambiare il testo.
Notate che in questo momento non è necessario un perfetto allineamento del testo
poiché i relativi comandi (di cui parleremo più avanti) forniscono un facile modo per
formattare il testo presente sullo schermo. Utilizzate i pulsanti “Load” e “Save”
rispettivamente per recuperare e salvare qualsiasi file di testo. Notate che potete
usare anche un file di testo proveniente da altre fonti, purché esso sia in formato
standard ASCII.
Motion Controls: Questo comando fornisce sei modalità preselezionate di moto:

• Vertical Movement - Sposta il testo verticalmente.

• Horizontal Movement - Sposta il testo orizzontalmente da destra a sinistra in
una linea singola.

• Static - Mostra il testo fisso.

• Vanishing Horizon - Sposta il testo verso un orizzonte lontano e poi svanisce.
L’orizzonte è definito con un obiettivo rosso spostabile che si trova nello
schermo d’anteprima e può essere interpolato.

• Circular - Muove il testo in un percorso circolare. Sia la posizione del cerchio
che il suo raggio possono essere interpolati. Il punto di partenza del testo può
essere cambiato spostando il cerchio piccolo lungo il raggio del cerchio più
grande.

• Panel - Il testo fisso viene mostrato su di un pannello tridimensionale.
Prima di tutto selezionate quale tipo di moto volete realizzare, poiché i comandi di
allineamento cambiano a secondo del tipo di moto.
Speed: Esistono cinque velocità predefinite per far scorrere il testo, da quella molto
lenta a quella molto veloce. Potete anche selezionare l’opzione che permette di
personalizzare la velocità. Con questa opzione si aprirà una finestra con un cursore
che permette di scegliere la velocità in un intervallo tra 1 e 100. Un valore pari ad 1
dà una velocità lentissima, mentre un valore pari a 100 la velocità maggiore.
All’interno di questa finestra trovate anche l’opzione attivabile “Fit to Clip”. Se essa
viene attivata la selezione del cursore è ignorata e la durata del testo che scorre
dipenderà dalla lunghezza del filmato selezionato.
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SUGGERIMENTO: VELOCITA’ DI SCORRIMENTO DEL TESTO

La velocità è molto importante quando state usando un testo in movimento. Se il
suo valore è troppo basso, lo scorrimento del vostro testo non avrà nessuna
possibilità di terminare prima che il filmato sia finito, quindi non potrete vederlo
tutto. Per evitare questo problema voi utilizzerete l’opzione per personalizzare la
velocità e poi userete l’opzione “Fit to Clip” che trovate nella finestra.

Antialiased: Quando viene selezionato dà come risultato titoli statici e in
movimento privi di aliasing. Per accelerare la generazione del testo, disabilitate
questa opzione.Inoltre, quando i testi sono particolarmente sottili, il risultato
potrebbe non essere quello desiderato, dal momento che i segmenti potrebbero
essere troppo sfumati.
KF Color: Quando selezionato, questa funzione fa sì che il colore dei font sia
animabile nel tempo tramite keyframes (Esempio: il testo da rosso diventa blu, poi
verde, da 0 a 100%).
Color: Cliccando due volte sul riquadro del colore si aprirà una finestra che vi
permetterà di selezionare il colore del testo.
Align: Usatelo per stabilire l’allineamento del testo nel filmato. L’impostazione di
questo comando dipende dal tipo di moto che è stato selezionato, quindi per prima
cosa dovete specificare il moto. Per esempio, se è stato impostato il modo di
scorrimento da destra verso sinistra, allora una singola linea del testo può essere
posizionata in alto, al centro o in basso del filmato. Se avete impostato lo
scorrimento verticale, allora le linee del testo possono essere poste a sinistra, al
centro o a destra di porzioni dello schermo. Per tutti i tipi di allineamento, eccetto il
centro (center), potete modificare i margini spostando le linee rosse sullo schermo
d’anteprima.
Fonts: Premendo questo pulsante si apre la finestra per la selezione del font che vi
permette di scegliere tra qualsiasi font di windows disponibile sul vostro sistema. In
questa finestra si possono selezionare il tipo, lo stile e la misura dei font.
Show Effect: Premendo questo pulsante si crea un fotogramma d’anteprima sul
titolo. Notate che quando utilizzate lo scorrimento nessun titolo sarà presente nel
primo fotogramma poiché lo scorrimento incomincia fuori del filmato.
Quick Play: Genera una sequenza di istantanee per mostrare il testo all’interno di
un filmato. Notate che questo comando genera una sequenza di fotogrammi
distanziati uniformemente lungo l’intera durata del filmato. In filmati più lunghi o più
corti dello scorrimento del testo, il numero di fotogrammi dovrebbe essere
modificato per permettere un’adeguata visione di esso. In casi estremi, il testo può
non rientrare tra i fotogrammi d’anteprima ed essere totalmente omesso.
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More>> Apre le funzioni avanzate come i fotogrammi chiave, i bordi, ombre,
comandi di trasparenza, ecc. Spesso è più semplice preparare il testo e
determinare le caratteristiche di base come il moto, il colore e i font, prima di
accedere ai comandi avanzati. Notate che quando sono attivati i fotogrammi
chiave, tutte le impostazioni devono essere attivate e salvate su essi.

Comandi avanzati di Title Generator Controls
Cliccate sul pulsante More >> per aprire i comandi avanzati di “Title Generator”.

Keyframe Controls: Questo comando svolge la stessa funzione che aveva per gli
altri effetti video e filtri (leggete il Capitolo 7 per avere una descrizione completa dei
comandi dei fotogrammi chiave). Notate che quando sono attivi i fotogrammi chiave
si possono effettuare le interpolazioni. Questa possibilità riguarda il colore, la
trasparenza, le ombre, ecc.
Text: Permette modifiche alla trasparenza del testo. Normalmente un testo non è
trasparente (cioè il cursore della trasparenza rimane al valore dello =%).
Border: Permette di creare e modificare dei bordi al testo. Quando il valore di
“Thickness” (spessore) è pari a 0 non viene creato nessun bordo. Altrimenti
variando opportunamente i valori di “Thickness” e “Softness” viene creato un bordo
al testo. Cliccando due volte sul riquadro colorato comparirà una finestra che serve
a definire con precisione il colore del bordo.
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Shadow: Permette di creare e modificare le ombre per il vostro testo. Usate il
comando “Transparency” per creare ombre semitrasparenti che forniscono un
aspetto più integrato con il resto del filmato. I comandi di “Offset” vi permettono di
modificare la misura e la direzione delle ombre. Se entrambi i valori di “Offset” (X
ed Y) sono pari a 0 non viene creata nessun ombra. Aumentando il valore di
“Offset X”, le ombre si spostano verso destra. Diminuendo il valore di “Offset X”, le
ombre si spostano verso sinistra. Il comando “Offset Y” opera in maniera simile, ma
spostando le ombre verticalmente. Per modificare il colore delle ombre cliccate due
volte sul riquadro colorato per ottenere la palette dei colori.
Panel Controls: I controlli vengono rimpiazzati dai controlli dei pannelli.
Trasparency (Trasparenza) influenza il pannello sul quale il testo viene mostrato.
Un pannello parzialmente trasparente si comporterà come un filtro colorato che
copre una sezione dell'immagine video. Il controllo "Size" provvederà ad aumentare
o diminuire le dimensioni del pannello, mentre il controllo "Thickness" cambierà i
bordi del pannello per dargli una profondità tridimensionale differente.
Mark Start: Trovate questo pulsante al di sopra della riga percentuale posta
all’interno dei comandi dei fotogrammi chiave (Key Frames Controls). Potete
utilizzarlo per definire il momento in cui deve apparire il testo nel vostro filmato.
Spostate il cursore della riga percentuale per specificare in quale punto desiderate
far partire il testo. Quando premete questo pulsante un piccolo indicatore rosso di
forma triangolare sarà posto sotto la riga, per indicare che quello è il punto di
partenza. Notate che questo indicatore può essere posizionato in qualsiasi punto
della riga percentuale e non solo in corrispondenza di un fotogramma chiave.
Le funzioni “Mark Start” e “Disable Keyframe” forniscono un modo per creare un
testo sia statico che in movimento solo in una porzione del vostro filmato. Leggete il
Capitolo 7 per avere maggiori dettagli sui comandi dei fotogrammi chiave.

Usare Inscriber CG per creare titoli in tempo reale
Video Action è venduto insieme con Inscriber CG. Voi potete accedere a questo
programma cliccando con il pulsante destro del mouse in “Gallery” e scegliendo
“Inscriber CG” dal menu. Quando voi aprite Inscriber vi sarà mostrata il fotogramma
attuale della timeline come background per aiutarvi a posizionare il testo.
Potete utilizzare Inscriber per creare complessi titoli fissi o in movimento (come
titoli che si spostano verticalmente o che si spostano orizzontalmente). Quando
salvate un file generato con Inscriber esso sarà automaticamente collocato in
“Gallery”, così esso è pronto per essere utilizzato sulla vostra timeline.
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I titoli fissi creati con Inscriber sono costituiti da file 32 bit TGA con un canale alfa
integrato. Video Action riconosce questo canale alfa ed applica una chiave alfa
automaticamente. Questo vi permette di sovrapporre i file TGA ai file RVA o RVD
per creare titoli in tempo reale. Nella configurazione 2D della Perception RT il file
TGA utilizza uno dei canali video. In un sistema Perception RT che include la
scheda opzionale R3DX il file TGA utilizza il canale DSK (downstream key alpha
channel) della scheda R3DX, i due canali video saranno ancora disponibili per le
clip video.Quando create con Inscriber i titoli che scorrono orizzontalmente o che si
spostano verticalmente, essi saranno salvati nel formato ICG e automaticamente
saranno collocati in “Gallery”. Se avete la configurazione 2D della Perception RT
dovrete renderizzare i vostri titoli che scorrono orizzontalmente o che si spostano
verticalmente prima che possiate riprodurli. Se invece avete istallato la scheda
DPS R3DX i vostri titoli appariranno in tempo reale.
Notate che potete salvare le vostre immagini create con Inscriber usando altri
formati file selezionando File > Export > Export Image dal menu di Inscriber.
Potete salvarle nei formati: BMP, JPG, PCT, PICT, PIC, RLE o TGA con varie
intensità di colori. Se volete utilizzare un’immagine di Inscriber come immagine di
background non dovete salvarla nel formato a 32 bit TGA, per prevenire l’utilizzo
automatico del canale alfa. Invece dovreste salvarla nei formati di Inscriber HKF,
LGO, VII, o ICG per poterla utilizzare con altri file di Inscriber.

Usare titoli fissi (immagini a 32 Bit TGA)
Per utilizzare un file TGA (p.e. un titolo fisso) generato con Inscriber spostatelo
dalla “Gallery” alla timeline sulla traccia video V3 o più alta (V4, V5, ecc.). Il titolo
sarà sovrapposto al video posto su una traccia più bassa in numero (V1, V2, ecc.).
Potete cambiare la durata del titolo spostando la parte finale del filmato sulla
timeline.
Potete applicare al file TGA la dissolvenza in ingresso (fade in) o quella in uscita
(fade out). Cliccate con il tasto destro del mouse sul file e selezionate TGA Auto
Fade dal menu. Quando questa opzione è abilitata, Video Action assegna
un'assolvenza in ingresso, e una dissolvenza in uscita. E' possibile impostare il
numero di fotogrammi di assolvenza e dissolvenza nel menù File > Preferences >
Settings, premendo il pulsante "TGA Fade In/Out Default". Potete scegliere di
abilitare questa opzione ogni qual volta utilizzate un titolo di tipo TGA o IGC. Potete
anche applicare "TGA Fade In/Out Default" ad ogni filmato per impostare diversi
valori in ingresso/uscita ai vari titoli. Quando si sta usando questa opzione il file
TGA presente sulla timeline presenterà il simbolo FD nell’angolo in alto a sinistra.
Nota: un filmato che ha un numero di fotogrammi inferiore a quelli abbinati di
dissolvenza non potrà utilizzare questa opzione.
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Potete usare anche una terza parte generata con Inscriber o altri programmi per
creare file 32 bit di tipo TGA con un canale alfa interno.  Questa può essere
conservata in Gallery per usarla come titolo in tempo reale.

Uso dei titoli a scorrimento orizzontale (Crawl) o
verticale (Roll)

Potete utilizzare Inscriber per creare titoli che scorrono orizzontalmente o che si
spostano verticalmente. Mentre usate Inscriber troverete nella parte superiore della
finestra un riquadro che serve a cambiare il tipo di titolo, cioè serve a passare da
Still a Roll o Crawl. Potete scrivere varie pagine per i vostri titoli ed utilizzare la
barra di scorrimento per muovervi all'interno di queste. Se volete che la prima
parola del vostro titolo scorra da un lato all'altro dello schermo, doveteassicurarvi di
lasciare una pagina vuota all'inizio. Se volete che il titolo scorra completamente,
dovrete assicurarvi di lasciare una pagina vuota anche dopo l'ultima parola.Nota: i
titoli sia in roll che in crawl devono avere una lunghezza minima di due
pagineQuando salvate i vostri titoli in roll e crawl, saranno salvati come file ICG, e
saranno inseriti automaticamente nella Gallery. Nella Gallery la miniatura sarà
mostrata come una grafica (una "t" con una freccia), che indica il titolo a
scorrimento orizzontale o verticale. Quando cliccatesulla miniatura il titolo scorrerà
(ovviamente in miniaturizzato) nella stessa.I titoli roll e crawl sono manipolati in
modo leggermente differente tra la Perception RT versione base e la Perception
RT in aggiunta alla scheda R3DX. Nella versione base della Perception RT i vostri
titoli roll e crawl devono essere renderizzati prima di riprodurli. Quando ponete i
titoli sulla timeline essi inizialmente saranno posti dopo 3 secondi di filmato.
Trascinate la fine del filmato per cambiare la durata del vostro titolo in movimento.
Renderizzate il vostro titolo solo dopo che siete soddisfatti sulla sua posizione e
velocità.
Se avete istallato la scheda opzionale R3DX i vostri titoli roll e crawl possono
essere riprodotti in tempo reale ed in più avrete molte opzioni per manipolarli.
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Titoli a scorrimento orizzontale o verticale con la
R3DX

Se avete istallato la scheda R3DX potete riprodurre in tempo reale titoli che si
muovono in orizzontale o in verticale. Quando essi vengono spostati sulla timeline
automaticamente utilizzeranno il canale extra (downstream alpha key). I filmati
appariranno sul vostro video RVA o RVD in tempo reale.
Per accedere a tutti i comandi cliccate con il tasto destro del mouse sul titolo e
selezionate “Title Options” dal menu. Notate che il comando di velocità (speed) è
leggermente differente tra “Roll” e “Crawl”. Crawl ha anche altre opzioni di
posizionamento aggiuntive.
I comandi standard per “Roll” e “Crawl” non utilizzano il canale per gli effetti 3D
della R3DX. Ciò vuol dire che questo canale può essere utilizzato per transizioni
3D, effetti 3D su video clip oppure effetti 3D su immagini che occupano nella
timeline lo stesso segmento dei titoli. Se volete applicare degli effetti aggiuntivi
potete premere il pulsante “Use 3D Resources/Options” che si trova nell’angolo in
basso a sinistra della finestra. Ciò vi permetterà di accedere a delle opzioni
aggiuntive, però utilizzando il canale per gli effetti 3D della R3DX. Se utilizzate
questo canale su un'altra clip che si trova nello stesso segmento di timeline del
titolo, dovrete renderizzare questo segmento. (Si rimanda al Capitolo 7 per
maggiori dettagli).

Permette la scelta tra
tre velocità

Seleziona la direzione di
scorrimento del testo

Quando usate “Fit to Clip”
dovete premere anche il
pulsante “Use R3DX
Resources/Options”

Durata del titolo in
fotogrammi Opzioni di anteprima:

interruzione, riproduzione
(Play) o iterazione (Loop)

Ritarda il movimento del
testo in base al numero di
fotogrammi specificati
”
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Date uno sguardo al vostro titolo in movimento presente sulla timeline. Quando
usate le risorse della scheda R3DX, la piccola freccia posta nell’angolo in alto a
sinistra del titolo cambierà colore dal bianco al rosso.

Usate il pulsante “Custom”
per selezionare una velocità
personalizzata

Premete questo pulsante
per accedere ad opzioni
aggiuntive

Usate “Fit to Clip” se avete
messo il titolo sulla timeline
e volete che si adatti
all’intera durata del filmato

Selezionate
un'assolvenza in
ingresso “Fade up” o
una dissolvenza in
uscita “Fade down” con
il ritardo

Permette la scelta tra sei
velocità preimpostate

Utilizzate le opzioni
aggiuntive della R3DX

Posiziona il testo
crawl verticalmente
sullo schermo

Se usate “Fit to Clip” attivate
il pulsante “Use R3DX
Resources/Options”
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Per controllare la velocità del testo in movimento dovete usare “Title Options”. Se
trascinate semplicemente la fine di un titolo in movimento il testo non si espanderà
per adattarsi al filmato
Fino a che non premete il pulsante “Fit to Clip” button. Altrimenti potete selezionare
una velocità predefinita o una personalizzata. Notate che se diminuite la velocità
del titolo (dandogli una durata maggiore sulla timeline) sarete avvertiti se non c’è
sufficiente spazio nel filmato per applicare il cambiamento. Modificate la timeline
per dare uno spazio maggiore al titolo e riprovate.
Potete usare anche i filtri in tempo reale sui titoli di tipo roll e crawl. Il loro utilizzo vi
permetterà di liberare il canale extra, così potete usarlo per altri titoli fissi o in
movimento. Utilizzate la chiave alfa dell’effetto “RT Keys Borders” per vedere il
filmato di background. Utilizzate l’effetto “Transparency” per creare un’assolvenza
in ingresso o una dissolvenza in uscita oppure per controllare la trasparenza totale.
Utilizzate l’effetto “Perspective” per controllare la posizione del testo sullo schermo.

Bordi ed Ombre (Border/Shadow)
L’effetto “Border/Shadow” è stato progettato per essere usato in unione di uno o più
dei seguenti filtri o effetti che servono a generare degli oggetti sullo schermo: “Page
Effect”, “Picture-in-Picture”, “VSA”, “Advanced VSA”, “Transparency Assignment”
(con l’uso della chiave alfa).

Comandi dei bordi interni ed esterni:
• Thickness: Determina lo spessore del bordo. Impostando il valore minimo di 0

non viene creato nessun bordo. Se si sposta il cursore verso il valore massimo
di 100, viene aggiunto un bordo più grande.

Si sta usando una velocità
personalizzata - notate la freccia
rossa

Sono stati applicati due filtri in
tempo reale a questo titolo

Sono stati applicati tre filtri in
tempo reale a questo titolo fisso

 titoli posti su V3
stanno usando le
isorse della scheda

R3DX

 titoli posti su V4
stanno usando il
canale extra
downstream alpha

key)

Questo file IGC è un’immagine
fissa rossa

Questo file TGA utilizza il “TGA
Auto Fade

Questo titolo che si sposta
verticalmente utilizza il “TGA Auto
Fade”
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• Softness: Definisce fino a che punto deve essere sfuocato il bordo. Quando il
valore è vicino al minimo il bordo appare con dei margini molto distinti. Mentre
quando ci si avvicina al valore massimo di 100, il bordo ha dei margini meno
definiti.

• Color: Definisce il colore del bordo interno ed esterno. Usando il pulsante
“Pick Color” apparirà un selettore per cambiare il colore. Spostate il
contagocce sul colore che volete e premete il tasto sinistro del mouse.
Altrimenti cliccate due volte sul riquadro colorato ed avrete un’ampia possibilità
di scelta con la palette dei colori.

Comandi di Shadow
• Transparency: Per modificare la trasparenza dell’ombra spostate il cursore

verso il valore minimo per avere ombre più marcate e verso il massimo per
averle meno evidenti.

• Offset: Definisce quale deve essere la posizione dell’ombra relativamente al
bordo. Muovendo il cursore verso destra (verso “+”) l’ombra si sposterà
progressivamente verso destra. Muovendo il cursore verso sinistra (verso “-“)
l’ombra si sposterà progressivamente verso sinistra. Lo stesso discorso vale
per “Offset Y”, muovendo il cursore verso “+” l’ombra si sposterà verticalmente
verso l’alto. Mentre muovendo il cursore verso “-” l’ombra si sposterà
verticalmente verso il basso.
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Un esempio:
1. Selezionate un filmato sulla timeline, premete il pulsante “FX” per aprire la

finestra “Apply Effects”, dopodiché premete il Page Effect. In questa finestra si
applicano le impostazioni di default premendo il pulsante “OK”. Ciò vi farà
ritornare alla finestra “Apply Effects”.

2. Premete il pulsante Border/Shadow Effect. Nella finestra di “Border/Shadow”
la finestra d’anteprima verrà il vostro filmato verrà mostrato come una pagina
(dall’effetto “Page Effect”) con un bordo interno, uno esterno ed un’ombra.

Effetto Scia(Trailing Effects)

Si accede a questo effetto dal menu principale quando è attiva la timeline tramite
Tools > Trailing Effects. Si possono realizzare interessanti effetti artistici con tre
tipi di scie:

• Wind - Effetto Vento, provoca una scia lungo la direzione assegnata al vento.

• Defocus - Provoca effetti di dissolvenza/sfocatura con scie.

• Rainbow - Effetti di scia in dissolvenza attraverso lo spettro del colore.
Per applicare questi effetti devono realizzarsi tre condizioni:
1. Il filmato deve avere un canale alfa interno generato utilizzando il

“Transparency Assignment” (cioè “color”, “alpha channel”, “difference keying”,
ecc.), ”Video Screen Animation” e/o un titolo TGA a 32 bit. Questo canale alfa
viene usato per evidenziare il confine dell’oggetto utilizzato per le scie.
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2. Il filmato deve trovarsi sulla traccia V3 o più alta in numero.
3. Nelle immagini video deve essere presente del movimento, oppure il moto

deve esservi introdotto tramite “Video Screen Animation”.
Nota: quest’effetto può essere riprodotto in anteprima solo evidenziando l’intervallo
della timeline che contiene l’effetto e premendo il pulsante Display Only Preview
nella barra degli strumenti. L’anteprima vi darà un’idea approssimativa dell’effetto e
vi permette di effettuare delle modifiche prima del rendering. Dovete renderizzare
l'effetto ed effettuare il make movie prima che possiate realizzare fotogrammi
individuali mostranti l'effettoCreazione di un oggetto da utilizzare con “Trailing
Effect”

Creazione di un Oggetto a cui applicare l’Effetto Scia
Il filmato al quale volete applicare il “Trailing Effect” deve avere un canale alfa
interno. Esistono tre modi per ottenere questo con Video Action:
1. Premete il tasto destro del mouse in “Gallery” e scegliete “Inscriber CG” dal

menu. Create un file TGA a 32 bit ed utilizzate “Video Screen Animation” per
muovere il titolo.

2. Applicate l’effetto “Transparency Assignment” ed utilizzate uno dei metodi
chiave. Se la zona “chiave” non ha un moto utilizzate “Video Screen
Animation” per muovere l’oggetto.

3. Applicate l’effetto “Video Screen Animation” per definire un oggetto e per
spostarlo.

Comandi di “Trailing Effects”
Una volta creato il filmato più appropriato per il vostro effetto scia, potete
selezionarlo e scegliere Tools > Trailing Effects dal menu principale.
Trailing Styles: Scegliete uno dei tre tipi di effetto scia (“Wind”, “Defocus” e
“Rainbow”) dal menu a tendina.
Decay: Scegliete il coefficiente di ritardo dallo 0% al 100%. Un valore basso darà
luogo ad una scia più lunga, mentre un valore più alto vi darà una scia più corta.
Options: Quando scegliete lo stile “Wind” il pulsante “Options” sarà disabilitato
(cioè il pulsante rimane grigio). Quando scegliete lo stile “Defocus” il pulsante
“Options” sarà abilitato (cioè il pulsante diventa nero). Invece quando scegliete lo
stile “Rainbow” il pulsante “Options” vi permetterà di definire il coefficiente di
variazione del colore (“Hue Variation Rate”).
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Un esempio: come aggiungere l’effetto scia al testo
in movimento

(Nota: può essere utile familiarizzare con "Video Screen Animation" prima di
eseguire questo esempio. Leggete il Capitolo 9.)
Una delle applicazioni più comuni che si utilizzano con "Trailing Effects" è
aggiungere una scia ad un testo in movimento. Per creare un testo in movimento
con una scia seguite questi passi:
1. Create un titolo sotto forma di file TGA a 32 bit utilizzando "Inscriber CG".

Usate un font sufficientemente grande per riempire lo schermo. (Leggete il
paragrafo “Usare Inscriber CG per creare titoli in tempo reale”.)

2. Ponete il nuovo file TGA sulla timeline nella traccia V3. Create un filmato non
troppo lungo. (Potete anche mettere un altro filmato sulla traccia V1 o V2 da
fungere come background.)

3. Selezionate il filmato TGA cliccando su di esso e premete il pulsante "FX" nella
barra degli strumenti. Si aprirà la finestra "Apply Effects".

4. Premete il pulsante "Video Screen" presente nell'angolo in basso a sinistra
della finestra "Apply Effects". Si aprirà la finestra "Video Screen Animation".

5. Per questo esempio utilizzate l'oggetto rettangolare di default. Spostate il
primo nodo in basso a sinistra e l'ultimo nodo in alto a destra per creare un
movimento in diagonale. Premete il pulsante "OK" per salvare il vostro effetto
VSA e tornate alla timeline.

6. Assicuratevi che il vostro filmato TGA sia ancora attivo e selezionate Tools >
TrailingEffects dal menu principale. Si aprirà la finestra "Trailing Effects".

7. Selezionate lo stile "Rainbow". Spostate il cursore fino ad un valore del 30%
per fare una scia più lunga. Premete il pulsante "OK".
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8. Per visionare velocemento l'effetto evidenziate la sezione della timeline che
contiene il filmato. Sarà riprodotta un'anteprima senza effetti ("no effect”).
Premete il pulsante d'anteprima ("Preview") nella barra degli strumenti per
vedere una veloce anteprima di ciò che farà il vostro effetto.

9. Cliccate due volte sulla barra del rendering nella sezione sovrastante alla clip
sulla quale è applicato l’effetto scia. Cliccate sul pulsante render per effettuare
il rendering di questa sezione. Una volta che che è stata renderizzata, potete
utilizzare il cursore della Timeline per visionare accuratamente l’effetto.

10. Posizionate la barra gialla del movie range sulla clip alla quale avete applicato
l’effetto. (Potete variare la lunghezza della barra trascinandone le estremità.)
Selezionate Movie> Make Movie> RVA File Output dal menù principale. Una
volta che l’RVA è stato creato il VA Player lo aprirà permettendovi di riprodurre
ill il nuovo file che contiene l’effetto scia.



       Video Action RT

______________________________

257

CAPITOLO 9:
VIDEO SCREEN ANIMATION

Introduzione

Il Video Screen Animation (VSA) è un insieme di effetti estremamente potenti che
fornisce numerose funzionalità per effetti animati personalizzati. Questi strumenti
producono effetti visivi come finestre volanti, oggetti 3D volanti sulle cui superfici
vengono mappate sorgenti video, sovraimposizione di oggetti animati, picture in
picture, e transizioni personalizzate. L'utilizzo del VSA permette di  assegnare
effetti di movimento sia ad immagini video che ad immagini fisse. Il VSA utilizza
curve di Bezier  per la definizione delle traiettorie e dei bordi delle immagini video.
Video Action è dotato 2d Video Screen Animation e del 3D Video Screen
Animation. Il pacchetto 3D Deluxe Effects incluso assieme a Video Action
permette di accedere a caratteristiche 3D addizionali. Le funzioni VSA vi
permettono di utilizzare più traiettorie di movimento ed oggetti multipli in una
singola animazione.
Gli effetti VSA necessitano di essere elaborati prima che possano essere riprodotti
dalla Timeline o prima che possano far parte di un filmato.
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Concetti base del Video Screen Animation
Il Video Screen Animation permette il movimento di una clip video lungo una
traiettoria curvilinea in un intervallo di tempo. Per creare un effetto di tal tipo dovete
impostare:
1. Una traiettoria di movimento (utilizzando nodi e punti chiave)
2. La velocità del movimento (utilizzando i punti chiave e la barra del tempo

espresso in percentuale)
3. La forma del video animato (2D o 3D)
4. La dimensione e la rotazione della forma animata ad ogni keyframe
5. Un qualsiasi altro effetto di animazione specifico (come chromakey, ombre,

bordi, etc.)
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Come cominciare un VSA
Di solito in un effetto VSA vengono utilizzate due o più clip presenti sulla Timeline.
Una clip rappresenta lo sfondo mentre l'altra rappresenta la clip che sarà animata e
distorta. La clip animata si muove sulla clip di sfondo seguendo una traiettoria
definita dall'utente.

1. Posizionate la clip di sottofondo sulla Timeline in una traccia che reca un
numero più piccolo di quella da animare. Ad esempio posizionate la clip di
sottofondo sulla traccia V1 o V2, e quella da animare su V3.

2. Posizionate la clip che volete animare su una traccia della Timeline che reca
un numero più grande di quello della clip di sottofondo. Normalmente vi sarà
conveniente evitare di utilizzare la traccia V2 per la clip da animare, poiché
quando si inseriscono due clip su V1 e V2, Video Action inserisce fra esse una
transizione che appare in sovrapposizione al vostro effetto.

3. Selezionate la clip da animare (cliccandoci sopra) e poi premete il
tasto FX che si trova sulla barra degli strumenti, oppure cliccate con
il tasto destro sulla clip e scegliete Video Effect. In modo alternativo
potete anche selezionare Tools> Video Effects and Titler dal
menù principale.

4. Vi apparirà la finestra che vi permette di applicare gli effetti. Selezionate
Video Screen Animation o Advanced VSA  premendo sui rispettivi pulsanti
posti in basso a sinistra della finestra.

Clip in background

Clip Animata
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5. Apparirà la finestra Video Screen Animation.

Cliccate sui pulsanti
Video Screen
Animation o Advanced
VSA per avviare il
VSA.
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6. Impostate i parametri nella finestra Video Screen Animation così come
descritto in seguito nel corrente capitolo. Quando siete soddisfatti dei risultati
ottenuti premete su OK. Ritornerete alla Timeline, dove la clip selezionata
contiene l'animazione.

7. Se volete creare animazioni composte da numerosi livelli, questo
procedimento può essere ripetuto per ogni animazione addizionale. Per
animazioni multiple le clip animate vanno poste sulle traccie V3, V4, V5, etc.
Quando avete completato tutte le animazioni, lanciatene la renderizzazione.

Impostazione di una Traiettoria di Movimento

Nodi e Forma di una Traiettoria
La traiettoria che seguirà la vostra animazione viene rappresentata da una
traiettoria di movimento. La traiettoria è costituita da nodi, nei quali la curva o linea
che unisce i nodi può cambiare direzione e/o curvatura. Ogni nodo è dotato di due
maniglie che vi permettono di modificare la curva che connette i nodi.Il modo in cui
queste maniglie influenzano la curva dipende dalo stile dei nodi che selezionate
utilizzando Edit> Node Style dal menù. Gli stili dei nodi disponibili sono 4:

• Line: i nodi vengono uniti da linee diritte con angoli netti

• Corner: le maniglie sono completamente indipendenti, permettendo
cambiamenti netti nella direzione o curve morbide



       Video Action RT

______________________________

262

• Smooth: le maniglie sono raccordate in modo tale che la curva risultante sia
molto morbida, con l'angolo delle singole curve determinato dalla lunghezza e
dall'angole delle maniglie.

• Symmetrical: molto simile a smooth, ma entrambe le maniglie hanno stessa
lunghezza ed angolo per dar luogo ad una traiettoria più simmetrica

Se volete che un solo nodo utilizzi uno stile differente, è sufficiente che clicchiate
su di esso con il tasto destro e che selezionate lo stile del nodo dal menù che
appare.
Inizialmente la vostra animazione sarà mostrata ferma su una traiettoria
determinata da un nodo all'inizio e da un nodo alla fine, con una linea diritta che li
unisce. Per aggiungere un altro nodo, muovete il cursore sulla traiettoria finchè
esso non assume la forma di una freccia a quattro punte. Cliccate sulla traiettoria
con il tasto destro . Cliccate su "Add Node" e un nuovo nodo verrà aggiunto sulla
traiettoria. IL nuovo nodo può essere trascinato lungo lo schermo per cambiarne la
posizione.
Nota: Ogni volta che create un nuovo nodo, create un keyframe (fotogramma
chiave) ad esso associato, ed ogni volta che create un nuovo keyframe, create un
nuovo nodo. Mentre i nodi trovano utilizzo nella definizione della posizione della
traiettoria, i keyframe possono essere utilizzati  per definire sia il tempo necessario
al passaggio da un nodo all'altro, sia la trasformazione dell'oggetto da un keyframe
all'altro. (Consultate la prossima sezione per maggiori dettagli sui keyframe.)
Per muovere l'intera traiettoria, posizionate il cursore su essa, e quando assume la
forma di una freccia a quattro punte, trascinatela traiettoria in una nuova posizione.

Controlli Addizionali del Tasto destro del Mouse

Molti comandi sono disponibili attraverso il menù che appare. Molte di queste
opzioni sono le stesse dei comandi dei menù Edit, Motion ed Effect. Di seguito
sono elencati i controlli addizionali dei nodi:

• Set Curve handle - Imposta le maniglie dei nodi su lunghezza zero o non zero.
Utilizzate il tasto Shift per impostare a zero i vettori quando vi trovate su un
nodo.

• Align - Allinea i nodi correnti nella medesima posizione (orizzontale o verticale)
del nodo precedente.

• Position Numerically - Permette il posizionamento accurato del nodeo e delle
sue maniglie tramite immissione numerica. L'angolo in alto a sinistra del
schermo di produzione blue ha coordinate X=0 e Y=0, mentre l'angolo in basso
a destra ha coordinate X=320 e Y=240. I valori della X e della Y che immettete
possono essere più grandi o più piccoli di quelli detta dalo schermo blu di
produzione, per permettervi di muovere gli oggetti anche quando si trovano al
di fuori dell'area visibile. I valori del Vettore 1 e del vettore 2 sono le coordinate
dei punti terminali delle maniglie relative al nodo.
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Keyframes e Velocità di Movimento
I keyframes ed i nodi vengono sempre creati assieme, e ad ogni keyframe viene
assegnato un nodo. Trascinate il cursore dei keyframessulla posizione in cui volete
aggiungere un keyframe e premete il pulsante add keyframe. Sulla linea del tempo
apparirà un nuovo keyframe e sulla traiettoria apparirà un nuovo nodo .

I quadratini rossi possono essere trascinati lungo la linea del tempo, cambiando il
modo in cui l'animazione reagirà al nodo senza cambiare la forma della traiettoria.
Ad esempio, se volete che la vostra clip animata salga lentamente lungo il bordo
sinistro dello schermo e che poi si muova rapidamente attraverso lo schermo,
potete impostare tre keyframes/nodi.

La chiave rossa è visibile
quando il cursore si trova su
un keyframe

Cursore
Posizione
percentuale lungo
la traiettoria

Aggiunge o cancella
un keyframe

Abilita/Disabilita il VSA tra i
keyframes selezionati

Permettono di
spostarsi sul keyframe
precedente o
successivo

Abilita/Disabilita i
Keyframes

Copia o Incolla i
keyframes
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In questo esempio l'animazione impiegherà il 75% del tempo per recarsi dal nodo 1
al nodo 2 e solo il 25% del tempo per recarsi al nodo 3. L'oggetto salirà lentamente
dal nodo 1 al nodo 2 e poi si ingrandirà lungo la distanza maggiore per il nodo 3.

Traiettorie di Movimento Multiple (solo per l'AVSA)
La funzione Advanced Screen Animation è stata progettata per lavorare con oggetti
2D multipli su traiettorie di movimento multiple. Questa funzione specializzata sarà
descritta dettagliatamente nelle prossime pagine. Per addizionare una nuova
traiettoria di movimento selezionate  Motion> Motion Path> Default dal menù
principale. Ciò aggiungerà una nuova traiettoria ed un nuovo oggetto. Nota:
l'oggetto potrebbe essere 2d o 3D, a seconda del tipo di di oggetto della traiettoria
esistente, ma se aggiungete un oggetto 3D non potrete utilizzare le funzioni di
mappatura della superficie disponibili con gli oggetti 2D.
Per copiare ed incollare una traiettoria, cliccate con il tasto destro su di essa e
selezionate "Copy Path". Cliccate con il tasto destro sull'area vuota dello schermo e
selezionate "Paste Path". Potete muovere la nuova traiettoria trascinandola, oppure
cancellarla selezionandola (quando è selezionata è di colore rosso), cliccare su
essa con il tasto destro e selezionando "Delete Path".
Quando avete più di una traiettoria potete impostare quella che si trova in primo
piano cliccandoci sopra con il tasto destro e scegliendo l'ordine. Consultate la
sezione sull'AVSA di questo capitolo per maggiori dettagli.

Keyframes

Nodo 2

Nodo 1
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Scelta della Superficie e del Video
Di base, la clip video animata appare come un piccolo rettangolo bidimensionale.
Potete variare la forma di quest'oggetto in un'altra forma 2D o 3D, e l'oggetto può
ruotare ed avvitarsi mentre segue la traiettoria di movimento.
Di base, la clip animata che avete selezionato dalla Timeline per dare inizio al VSA
verrà utilizzata per mappare tutte le superfici dell'oggetto. Una qualsiasi di queste
superfici può essere rimappata con una qualsiasi altra clip o con un colore
qualsiasi. Questa funzione è disponibile sia per gli oggeti 2D che 3D. Quando
utilizzare l'Advanced VSA, potete anche cambiare la clip di sfondo.

Scelta e Modifica della Superficie
Potete scegliere una superficie 2D sleezionando  Edit> 2D Shape dal menù.
Potete selezionare un rettangolo ( la forma base), un cerchio od un'ellisse. Potete
scegliere una forma 3D selezionando Edit> 3D Shape dal menù. Potete
selezionare una sfera, un cubo, un cilindro, un cono o una piramide.
Le forme 2D possono essere
modificate trascinando i nodi che
sono stati creati con la forma e
utilizzando gli strumenti di
distorsione o i comandi dei menù.
Gli strumenti di distorsione vi permettono di ridimensionare gli oggetti 2D nelle
direzioni x ed y, di ruotare un oggetto in uno spazio tridimensionale,distorcere
l'oggetto in un parallelogramma, o di distorcere l'oggetto in un trapezio. Potete
anche aggiungere nodi addizionali ad oggetti 2D per permettervi di personalizzare
ulteriormente la forma di un oggetto. Per aggiungere un nodo cliccate con il tasto
destro sull'oggetto**** e selezionate Add Node dal menù che appare.
Le forme 3D non vengono create con nodi che possono essere trascinati, ad ogni
modo potete cambiare la loro dimensione e ruotarli in modo che si deformino
durante il loro mophing da una forma ad un'altra.
Per ridimensionare oggetti 2D e 3D in modo visivo secondo i
movimenti del vostro mouse potete utilizzare lo strumento Resize
posto a sinistra nella barra degli strumenti, oppure selezionando
Effect> 3D Resize> Freely dal menù. Con la pressione del tasto
resize potete ridimensionare gli oggetti 2D lungo gli assi x ed y, e
ridimensionare gli oggetti 3D lungo gli assi x, y e z. Potete premere
più di un pulsante per volta se volete ridimensionare un oggetto
lungo piò assi contemporaneamente. Se volete ridimensionare
l'oggetto di una percentuale ben determinata, selezionata Effect>
3D Resize> Percentage dal menù.
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Per ruotare visivamente oggetti 2D e 3D secondo i vostri movimenti
del cursore, potete utilizzare lo strumento Rotate dalla barra degli
strumenti, oppure selezionare Effect> 3D Rotate> Freely dal
menù. Potete ruotare l'oggetto lungo gli assi x, y e z premendo i
pulsanti rotate. Potete premere più di un pulsante per volta se
volete ruotare un oggetto in più direzioni contemporaneamente. Se
volete ruotare un oggetto con l'accuratezza dei giri e dei gradi,
selezionate Edit> 3D Rotate> Percentage dal menù.
Per distorcere un oggetto 2D in un parallegramma utilizzate lo
strumento Slant (inclinazione) o selezionate dal menù Effect>
Slant. Muovete il cursore sul nodo evidenziato per trasformare il
cursore in due frecce parallele, e scorrete il mouse avanti e indietro
per ottenere la forma inclinata desiderata.
Per distorcere un oggetto 2D in un trapezio utilizzate la strumento
distort o selezionate dal menù Effect> Distort. Muovete il cursore
sui nodi evidenziati  per cambiare la forma del cursore e  scorrete il
cursore sopra e sotto  per ottenere la  forma cuneiforma
desiderata.
Se cambiate forma e volete salvarla per riutilizzarla, muovetevi al keyframe
carratterizzato dalla nuova forma e selezionate dal menù Edit> Shape File> Save.
Se volete salvare una forma che è stata formata formata tra i keyframes, dovete
inserire un nuovo keyframe nel punto della traiettoria dove la forma dell'oggetto
assume quella da voi desiderata. Potete poi posizionarvi sul nuovo keyframe e
selezionare dal menù Edit> Shape File> Save. Per utilizzare la nuova forma,
portatevi sul keyframe dove volete utilizzare la nuova forma e selezionate dal menù
Edit> Shape File> Load.

Applicazione del Video alla Superficie
Quando state utilizzando la funzione VSA potreste applicare una clip qualsiasi alla
parte anteriore e posteriore del vostro oggetto 2D. Potete applicare una clip
qualsiasi alle superfici del vostro oggetto selezionando dal menùEdit> Attach to
surface. Le superfici 3D differenti vengono suddivise in differenti numeri di
facciata. Cubo e Cilindro sono dotati di 6 superfici (sopra, sotto e ai quattro lati), i
coni e le piramidi sono dotati di 5 superfici (il fondo e 4 lati) e le sfere sono dotate di
4 superfici (ai 4 lati).
Potete anche determinare il modo in cui la clip viene avvolta attorno alle superfici
3D utilizzando Effect> 3D Texture Map Option. L'impostazione di base è No
Wrap Around, che mappa ogni superficie dell'oggetto con il 100% della clip,
dandovi sino a sei ripetizioni dell'immagine (una per ogni superficie). Potete
cambiare questa opzione su  Wrap Around Mapping, che utilizzerà una clip per i
quattro lati della superficie, mentre continuerà a mappare le superfici in alto e/o in
basso con copie addizionali dell'immagine. Per la sfera (che ha 4 superfici laterali e
nessuna superficie superiore) questa opzione darà come risultato un oggetto che
mostra una sola immagine (su quattro lati). Per un cubo, (che è dotato di 6
superfici) questa opzione farà avvolgere le quattro superfici laterali da un'immagine,
ed utilizzerà delle copie dell'immagine per le superfici superiore ed inferiore,
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mostrandovi un cubo con tre immagini. Potete anche utilizzare lopzione Wrap by
Percentage, che vi consente di impostare un valore di avvolgimento dal 100% al
400%. Il valore 100% fornisce lo stesso risultato dell'opzione No Wrap Around,
mentre un valore del 400% fornisce lo stesso risultato Wrap Around Mapping. Ad
esempio, impostando il valore 200% su una sfera, darà come risultato una sfera
con due immagini mostrate sulla superficie.
Se state utilizzando l'Advanced VSA potete anche utilizzare una clip con funzione
di sfondo, coprendo la clip che è mostrata sulla Timeline. Selezionate Edit> Attach
background surface dal menù, ed utilizzate una clip di sfondo a vostra scelta.
Nota: il quadratino Enabled deve essere selezionato affinchè il vostro sfondo possa
essere impiegato nell'effetto AVSA.

Anteprima di Effetti Animati
La visione base mostra il vostro oggetto animato come una struttura reticolare
(wireframe). Questa struttura si muove e si deforma quando trascinate il cursore
del tempo posto nella parte alta dello schermo. Quando rilasciate il pulsante del
mouse, l'oggetto viene rappresentato, con la superficie mappata su esso, nel più
vicino keyframe. Ciò vi darà un'idea di come apparirà l'effetto che state creando.
Potete anche utilizzare i pulsanti di Preview per avere un'anteprima dell'effetto.

Se volete visionare l'effetto in una posizione intermedia, trascinate il cursore sulla
posizione percentuale desiderata, ed utilizzate il tasto per il Preview del singolo
fotogramma. Vi verrà mostrata una versione a bassa risoluzione del fotogramma
finale. Se volete riprodurre in anteprima il vostro effetto ad un numero di
fotogrammi/secondo ridotto, cliccate sul pulsante riproduzione anteprima. Il numero
di fotogrammi al secondo può essere modificato selezionando View> View Effect
Option.

Preview del Singolo
Fotogramma

Wireframe
Preview

Velocità di Riproduzione
dell'anteprima (attiva solo
durante la riproduzione
dell'anteprima)

Interrompe l'anteprima
(attivo solo durante la
riproduzione)

Riproduzione anteprima
Riproduzione wireframe
avanti/indietro
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Una barra di stato di colore rosso verrà mostrata durante l'elaborazione ed
inseguito l'effetto verrà riprodotto ciclicamente fintanto che non clicchere sul
pulsante rosso STOP. Se volete vedere l'animazione del vostro oggetto in
wireframe (solo la struttura; in questo modo l'elaborazione è istantanea) utilizzare il
pulsante di anteprima in wireframe. Il pulsante di wireframe posto in alto riprodurrà
ciclicamente l'effetto, mentre quello in basso muoverà l'oggetto in aventi ed indietro
lungo la traiettoria di movimento.  Mentre l'anteprima in wireframe viene riprodotta,
il pulsante assumerà le sembianze di un pusante di STOP, per permettervi di
interrompere l'antreprima. I pulsanti che vi permettono di variare la velocità di
riproduzione dell'anteprima sono attivi solo durante la riproduzione.

Altri Effetti D'Animazione

Color Key
Per realizzare semplici effetti di composizione potete utilizzare il color keying (noto
anche come chroma keying) nei vostri effetti. Ad esempio, potreste avere una
ripresa di una ragazza effettuata in bluescreen (una camera con tutte le pareti blu).
Selezionando il colore blu delle pareti come colore chiave (key) potete rendere le
pareti trasparenti. Aggiungendo una traiettoria di movimento alla ragazza, potete
poi simularne il movimento su una clip di sottofondo. Questa tecnica viene
ampiamente utilizzata nei film per produrre scene impossibili nella realtà.
Selezionate dal menù Effects> Color Keying. Si aprirà la finestra che vi permette
di impostare la chiave colore.

Nota: Quando utilizzate questo effetto su un keyframe, questo effetto sarà abilitato
su tutti i keyframes della traiettoria di movimento. Se non volete vedere l'effetto su
determinati keyframes, dovrete impostarne la trasparenza sia della clip in primo
piano che di quella di sottofondo sullo 0%.
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Tolerance: Determina il numero di sfumature del colore selezionato sullo schermo
da utilizzare come colore chiave.
Foreground Transparency: determina la trasparenza della clip in primo piano. Lo
0% indica che la clip in primo piano è completamente visibile, mentre il 100% indica
che la clip è completamente trasparente.
Background Transparency: determina la trasparenza della clip di sottofondo. Lo
0% indica che la clip di sottofondo è completamente visibile, mentre il 100% indica
che la clip è completamente trasparente.
Pulsante Color: Cliccate su questo pulsante per trasformare il cursore in un
contagocce che vi consente di selezionare il colore mostrato sullo schermo. Potete
cliccare due volte sul riquadro per aprire la tavolozza dei colori che vi consente di
cambiare colore.
Riquadro del Colore Chiave: Questo riquadro mostra il colore di sottofondo che
avete selezionato per l'operazione di chiave. Potete cliccare due volte sul riquadro
per aprire la tavolozza dei colori che vi permetterà di cambiare colore.
Enable: Questo quadratino deve essere selezionato per abilitare le funzioni di
chiave.
Apply All: Cliccate su questo pulsante per applicare le vostre selezioni sul colore
chiave a tutti i keyframes della traiettoria di movimento. Fino al momento in cui
cliccate su questo tasto, per gli altri keyframes verranno utilizzate le impostazioni di
base (colore chiave nero, Tolerance= 0, Foreground transparency=0%,
Background tansparency=100%).
Pulsante Copy: Copia le proprietà della chiave colore nella memoria del computer.
Pulsante Paste: Incolla le proprietà della chiave colore che erano state copiate
nella memoria del computer, nel keyframe su cui vi trovate.

Bordi
Potete aggiungere bordi alle vostre clip animate. I tipi di bordi disponibili sono tre e
sono: Color, 3D Color e 3D Glass.
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• Color aggiunge un bordo colorato solido ad ogni superficie.

• 3D Color border aggiunge un bordo dotato di sfumature per fornire un effetto
tridimensionale

• 3D Glass border è un bordo tridimensionale al quale è possibile dare
impostazioni di trasparenza.

Nota: Quando utilizzate un effetto bordo su un keyframe, l'effetto sarà applicato su
tutti i keyframes che si trovano sulla traiettoria di movimento. Utilizzate il tasto
Apply All per applicare lo stesso bordo su tutti i keyframes, o muovete su
keyframes individuali per applicare bordi differenti a keyframes differenti.

Feathering
La funzione Feathering vi permette di sfocare i bordi in modo da renderli più
morbidi. A valori di feathering maggiori corrispondono sfocatura e morbidezza
maggiori.

Shadows (Ombre)
La funzione Shadow consente di assegnare un'ombra al vostro oggetto. Ciò può
incrementare il senso di spazio tridimensionale, che dà alla vostra clip animata
l'apparenza di volteggiare sul sottofondo.
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Flying Transparency (Trasparenza in Movimento)
Normalmente mapperete la vostra clip animata su di un oggetto e la muoverete sul
sottofondo. L'utilizzo della Flying transparecncy espande la vostra clip, sino a
riempire lo schermo dietro lla clip di sottofondo ed anima una forma 2D che si
comporta come una finestra che segue la traiettoria di movimento lungo lo
schermo***
Abitualmente mapperete la vostra clip animata su di un oggetto e la muoverete sul
sottofondo. La Flyning Transparency vi permette di animare una maschera che
segue la traiettoria di movimento lungo lo schermo.
La realizzazione di un esempio di questo effetto potrebbe essere la seguente.
Utilizzate una clip che mostra un muro di una prigione di notte come clip di
sottofondo, e poi utilizzate come clip in primo piano, animata, una clip in cui un
galeotto si arrampica sullo stesso muro, ma di giorno. Utilizzando la funzione Flying
Transparency potete assegnare un cerchio che prima cerca il prigioniero
nell'oscurità, e poi lo trova, dando l'effetto di un faro che lo illumina.

Forme Animate (Morphing)
Così come gli oggetti che si muovono lungo lo schermo è semplice trasformare
oggetti 2D o 3D in altre forme, utilizzando i keyframes. Potete trasformare oggetti in
altri oggetti mentre sono fermi, oppure mentre seguono una traiettoria di
movimento. L'una limitazione è costituita dal fatto che non potete utilizzare oggetti
2D e 3D sulla stessa traiettoria di movimento. Ad ogni modo è possibile simulare
oggetti bidimensionali mentre si utilizza la modalità 3D, semplicemente
assegnando il valore 0 alla dimensione dell'oggetto posta sull'asse Z. Ciò vi
consentirà di effettuare effetti come l'estrusione di uno schermo piatto in un cubo.
Non è però possibile utilizzare gli effetti di inclinazione è distorsione a queste figure
pseudo-bidimensionali.
Normalmente i vostri oggetti cambieranno forma in maniera morbida da un
keyframe ad un altro. Se volete che il cambiamento sia repentino, potete
selezionare dal menù Motion> Smoothness> Discounuos. Per riportare
l'impostazione sul valore di base, selezionate dal menù Motion> Smoothness>
Continuous.
Se la vostra traiettoria di movimento è costituita da più di due keyframes, potete
trasformare l'oggetto in ogni keyframe. Se cambiate idea e decidete che il vostro
oggetto utilizzi solo la forma che avete impostato nel primo e nell'ultimo keyframe,
selezionate dal menù Edit> Re-Interpolate.
Al VSA è acclusa una trasformazione 3D, un cubo che si ingrandisce fino a
riempire lo schermo, poi si trasforma in una sfera, e che poi vola in alto e a destra,
al di fuori dello schermo. Con poco esercizio potrete creare effetti di oggetti 3D che
si trasformano, s'ingrandiscono, ruotano, si allargano e si muovono. Per fare ciò
utilizzate i nodi  per definire la traiettoria di movimento e i vostri keyframes per
impostare la forma degli oggetti. Il programma effettuerà tutte i calcoli necessari a
mostrare l'oggetto che cambia  morbidamente da una forma all'altra.
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Un Esempio di Morphing

Aggiungete tre nodi alla traiettoria di movimento base. Selezionate il primo nodo e
cliccate sul pulsante No Mot (nessun movimento) posto sulla barra degli strumenti,
per posizionare il secondo nodo esattamente sul primo nodo. Selezionate il terzo
nodo e trascinatelo in alto. Selezionate il quarto nodo e trascinatelo in basso, in
modo tale da realizzare una curva caratterizzata da un dolce andamento
sinusoidale. Utilizzate la linea che esprime il tempo in percentuale per portarvi sul
primo keyframe. Selezionate la forma della sfera dal menù Shape. Muovetevi sul
secondo keyframe e selezionate dal menù Shape la forma del cubo. Portatevi sul
terzo keyframe e selezionate l'effetto prospettiva. Selezionate la strumento di
rotazione, e ruotate il cubo. Posizionatevi sul quarto keyframe e selezionate la
forma della piramide. Infine, portatevi sul quinto keyframe e selezionate un cilindro.
Per cambiare la velocità dell'animazione posizionatevi sulla linea gialla che indica il
tempo in percentuale e trascinate il quadratino rosso del quarto keyframe più a
destra, verso la fine. Ciò abbrevierà i tempi tra i keyframes 4 e 5 e farà muovere
l'animazione in modo molto più veloce dopo aver raggiunto il quarto nodo. Infine,
utilizzate il preview strutturale (wireframe) per avere un'idea del movimento e delle
trasformazioni che occorreranno sull'oggetto mentre si muove sullo schermo.

Keyframe1 Keyframe2

Nodo 3

Nodo 1 e 2 Nodo 4

Nodo 5
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Comandi dei Menù del Video Screen Animation
Nella parte alta della finestra del VSA sono presenti cinque voci: Edit, Motion,
Effect, View ed Help. Nella parte alta della finestra dell'Advanced VSA è
disponibile anche una voce addizionale, Tools.

Il Menù Edit
Undo: Annulla l'ultima modifica o azione.
Redo: Ripristina l'ultima azione che era stata annullata.
Copy: Copia l'oggetto selezionato nella memoria del computer. L'ultima operazione
di copia cancella le precedenti.
Paste: Incolla una copia dell'oggetto prelevandola dalla memoria del computer.
Questa operazione è possibile solo dopo aver effettuato l'operazione di copia.
Delete: Cancella il keyframe selezionato e il suo oggetto. Questo  comando non è
disponibile se l'oggetto si trova all'inizio o alla fine della traiettoria di movimento.
Node Style: Imposta lo stile dei nodi da utilizzare in una traiettoria di movimento. E'
possibile scegliere tra: Line, Corner, Smooth e Symmetrical. Stili differenti
permettono il controllo nei nodi creati dall'utente. Lo stile Line costringe i due rami
di traiettoria, quello antecedente e quello successivo al nodo, ad avere andamento
assolutamente lineare. Lo stile Corner crea dei cambi di direzione netti in
corrispondenza dei nodi. Gli stili Smooth e Symmetrical creano curve
estremamente arrotondate.
Snap Corner: Questa funzione serve per lavorare con oggetti 2D caratterizzati da
angoli retti. Se un angolo, in relazione ad un latro angolo, è portato ad avere un
valore molto ampio, sarà automaticamente corretto, venendo posizionato
verticalmente od orizzontalmente rispetto al punto dell'altro angolo.***
Re-Interpolate: Questa funzione può essere utilizzata su traiettorie di movimento
che hanno tre o più keyframes. La sua azione fa sì che venga realizzata una
transizione morbida delle forma, dal primo all'ultimo keyframe. Ogni keyframe
intermedio viene considerato durante il processo di trasformazione, perdendo però
qualsiasi forma che era stata impostata ai keyframes in precedenza.
Keep Aspect: Quando selezionata, questa opzione blocca la funzione di
ridimensionamento in modo che quando i pulsanti degli assi X, Y e Z sono premuti,
i valori sui tre assi vengono cambiati dello stesso ammontare. Quando questa
funzione non è attiva, un oggetto sarà dimensionato in modo indipendente in base
al movimento del mouse, e, ad esempio, un  movimento diagonale potrebbe
incrementare la dimensione in una direzione più che in un'altra.
2D Shape: Trasforma l'oggetto selezionato in una forma 2D standard. Le forme tra
cui potete scegliere sono rettangolo, cerchio ed ellisse.
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3D Shape (Deluxe/ 3D FX Package):  Trasforma l'oggetto selezionato in una
forma 3D standard. Le forme tra cui potete scegliere sono cubi, cilindro, cono
piramide e sfera.
Shape File:  Ogni forma può essere salvata come file sul vostro hard disk per un
utilizzo futuro. Selezionate l'oggetto che desiderate salvare e selezionate l'opzione
di salvataggio presente in questo menù. Ai file forma viene data automaticamente
l'estensione .oa. Per caricare un oggetto, selezionate un qualsiasi keyframe posto
lungo la traiettoria di movimento e selezionate l'opzione Load di questo menù.
Selezionate il file (.oa) che volete caricare, Video Action lo sostituirà a quello del
keyframe selezionato.
Attach Video by Surface: Come da impostazione base, il Video Screen Animation
mapperà tutte le superfici dell'oggetto con la clip selezionata sulla Timeline.  Una
qualunque di queste superfici può essere rimappata con una qualsiasi altra clip o
colore. Questa funzione funzione è disponibile sia per gli oggetti 2D che per quelli
3D.
Attach background Surface (solo Advanced VSA):  Come impostazione base il
VSA utilizzerà la clip posta al di sopra (sulla Timeline) della clip animata come clip
di sottofondo. Quando utilizzate questa funzione dovete selezionare la voce enable
nella finestra Attach Background Surface, per fare in modo che questa funzione
abbia effetto.
Cropping: Dal momento che il Video Screen Animation accetta l'utilizzo di clip
multiple, questo può anche accettare parametri di crop (taglio) dal menù Edit,
fornisce all'utilizzatore la flessibilità di cambiare il crop delle varie clip. Questa
impostazione ha effetto unicamente sulle clip non presenti sulla Timeline, mappate
come superfici. Alla clip animata posta sulla Timeline il crop viene invece applicato
secondo le impostazioni definite nella finestra File> Preferences.

Il Menù Motion
No Motion: Rimuove ogni traiettoria di movimento tra il keyframe corrente e quello
successivo, posizionando i due nodi relativi uno sopra l'altro. Ciò farà anche in
modo che l'oggetto del primo keyframe sia identico a quello del keyframe seguente.
Potete cambiare ciò, impostare l'oggetto in modo che utilizzi differenti forme o
proprietà in keyframes differenti. Utilizzate la linea che rappresenta il tempo in
percentuale per portarvi su keyframes differenti e per cambiare le impostazioni del
vostro oggetto.
Reverse Motion: Inverte la direzione del movimento lungo l'intera traiettoria di
movimento. Ad esempio se una clip si trasforma da un quadrato in un cerchio
mentre si muove da destra a sinistra, l'inversione della traiettoria di movimento farà
sì che la clip si trasformi da un cerchio ad un quadrato mentre si muove da sinistra
a destra.
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Motion File: Salva o carica una traiettoria di movimento lungo tutti gli oggetti che
risiedono sulla traiettoria. Ai file traiettoria viene assegnata automaticamente
l'estensione .sa.Il caricamento di una traiettoria di movimento rimpiazzerà
completamente la traiettoria di movimento corrente e tutti gli oggetti presenti nel
Video Screen Animation.
Il salvataggio o il caricamento di una traiettoria di movimento mentre ci si trova
nell'Advanced VSA salverà o caricherà tutte le traiettorie di movimento presenti.
Mentre vi trovate all'interno dellAVSA potete anche copiare ed incollare una singola
traiettoria di movimento all'animazione, cliccando prima con il tasto destro sulla
traiettoria che volete copiare e cliccando poi con il tasto destro  su un'area vuota
della traiettoria di movimento, selezionando Paste Path dal menù che appare.
Motion Path:
Gravity Motion: La selezione di questo menù farà apparire un riquadro di selezione
che specifica una traiettoria di movimento caratterizzata da suna simulazione di
gravità. Le opzioni che possono essere modificate sono numerose.

• Object - Seleziona l'oggetto ai keyframes.

• Bounces - Numero di rimbalzi che l'oggetto effettuerà.

• Reflection - Quando selezionate questa opzione l'oggetto rimbalzerà al
contatto del limite inferiore. Quando non è selezionata la schermo passerà
attraverso il limite del bordo inferiore e cadrà dall'alto.

• Damping Factor - Determina l'altezza relativa di ogni rimbalzo consecutivo.
Quando il dampening factor è impostato al 50%, il rimbalzo successivo sarà
smorzato del 50% rispetto al rimbazo precedente.

• Boundaries - Definisce i Limiti a sinistra, a destra, in alto, in basso della
traiettoria di movimento gravitazionale. Il confine sinistro determina il punto di
partenza il punto di partenza della traiettoria mentre il confine destro determina
il punto finale.  Il confine superiore determina l'altezza che raggiungerà il primo
rimabalzo, mentre il confine inferiore determina il punto sorgente del rimbalzo.

Cube to Sphere (Deluxe/3D FX Package): L'oggetto comincia il suo moto come
cubo a pieno schermo per poi trasformarsi in una sfera che vola via.
Default: Questa è la traiettoria di movimento che viene mostrata quando avviate
inizialmente il VSA: una traiettoria diritta con due soli nodi alle estremità. Potete
scegliere quale degli oggetti 2D o 3D utilizzare sulla traiettoria di base.
Smoothness: Questa opzione permette di scegliere il modo in cui il vostro oggetto
cambierà forma mentre si muove lungo la traiettoria di movimento. La selezione
standard è Continuous, che determina un cambiamento graduale della forma
dell'oggetto. Potete anche scegliere Discontinuous, per fare in modo che l'oggetto
si trasformi in maniera repentina al raggiungimento del keyframe successivo.
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Menù Effect
Flip: Inverte traiettoria di movimento e oggetti verticalmente od orizzontalmente.
Fit to Screen: Fa in modo che l'oggetto correntemente in uso nel Video Screen
Animation assuma la forma dello schermo e venga centrato. Lo schermo può
essere impostato su un quarto, sulla metà, o sulla dimensione attuale dello
schermo.
Slant (2D Shapes Only): La selezione dello Slant determina un rettangolo verde
attorno all'oggetto correntemente selezionato con un punto di controllo ad ogni
bordo e ad ogni angolo. Muovendo i punti di controllo dei bordi riuscirete ad
inclinarli.
Distort (2D Shapes Only): Questa opzione determina un rettangolo verde attorno
all'oggetto correntemente selezionato, con punti di controllo ad ogni angolo e ad
ogni bordo. Muovendo i punti di controllo potrete realizzare forme irregolari. I punti
posti negli angoli permettono di deformare liberamente l'oggetto.
3D Resize: Ci sono due modi di ridimensionare un oggetto: liberamente o tramite
percentuale. Ridimensionando tramite percentuale è possibile ottenere risultati
accuratissimi, attribuendo una percentuale all'oggetto originale lungo ogni asse. Il
ridimensionamento libero prevede l'uso del mouse per il ridimensionamento visivo
dell'oggetto in tempo reale. Durante l'operazione di ridimensionamento libero vi
appariranno numerosi pulsanti sulla barra laterale di controllo che rappresentano il
movimento lungo ogni piano (X, Y e Z per forme tridimenzionali). Selezionate uno o
tutti questi durante  il ridimensionamento. Ad esempio per aumentare le dimensioni
di un oggetto mantenendo inalterate le proprorzioni, dovete selezionare tutti i
pulsanti.
3D Rotate:  La rotazione può anche essere realizzata liberamente o per gradi.
Rotando in base ai gradi è possibile ottenere la massima precisione ed è possibile
specificare fino a 10 giri (ognuno equivalente a 360 gradi di rotazione). Quando
ruotate un oggetto in modo libero,  vi appariranno tre pulsanti, ognuno
rappresentante uno degli assi. E' possibile selezionare uno più pulsanti
contemporaneamente, ad ogni modo, per evitare confusione è consigliabile
selezionare un solo asse per volta.
Clear 3D Trasformation: Ciò rimuoverà ogni rotazione o ridimensionamento che è
stato assegnato all'oggetto correntemente selezionato. Ciò non rimuoverà né
distorsione né slant.
3D Effect Option (3D Objects Only): Ciò permette di dare ai vostri oggetti 3D una
prospettiva, con linee che convergono in punto infinitamente distante.
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3D Texture Map Option:  Controlla il modo in cui il video viene mappato su oggetti
3D. Le opzioni disponibili sono tre. Quella di base è  No Wrap Around, che mappa
il 100% dell'immagine su  ogni superficie dell'oggetto. Scegliendo Wrap Around
Mapping è possibile mappare una sola immagine su tutte le superfici, mappando
una porzione dell'immagine su ogni superficie.  Potete anche scegliere Wrap
Around by Percentage, che consente una mediazione tra le due opzioni precedenti.
L'impostazione del valore 100% corrisponde a No Wrap Around  mentre il 400%
corrisponde a Wrap Around Mapping.
Force Front-side Mapping: Ciò forza l'oggetto ad utilizzare su tutte le superfici
l'immagine assegnata alla superficie frontale, per aiutare ad evitare che vengono a
crearsi problemi di rispecchiamento dell'immagine, che possono verificarsi durante
la rotazione.
Border: Aggiunge bordi alle superfici individuali al''interno di oggetti animati.
Possono essere utilizzati tre tipi differenti di bordi: color border, 3D color border e
3D glass color border. Lo spessore di tutti questi bordi può essere modificato con il
cursore thickness, ed il colore può essere selezionato cliccando due volte sul
pannello del colore o cliccando sul pulsante Front Color per trasformare il cursore
del mouse in un contagocce che viene utilizzato per selezionare un colore che si
trova attualmente sul vostro schermo.

• Color Border - Un bordo costituito da un solo colore.

• 3D Color Border (per gli oggetti bidimensionali) - Crea un bordo sfumato
basato sul colore prescelto. Dà al bordo un effetto 3D.

• 3D Glass Border (per gli oggetti bidimensionali) - Crea un bordo 3D dotato
anche di impostazioni di trasparenza.

Feather:  Ammorbidisce il bordo di una qualsiasi animazione realizzata con il VSA.
La parte interna del bordo sarà più scura e diverrà più luminosa quando si avvicina
alla parte esterna del bordo. Per abilitare questa funzione è necessario segnare il
quadratino enable.
Shadow: Aggiunge ombre semitrasparenti agli oggetti animati. I cursori X ed Y vi
permettono di cambiare la posizione dell'ombra in relazione all'oggetto che la
genera. La finestra di dialogo dell'ombra vi permette anche di aggiungere
sfumatura e trasparenza, tramite i cursori feathering e transparency. Per abilitare
questa funzione è necessario segnare il quadratino enable.
Color Keying: Permette l'uso del colore chiave colore all'interno dello schermo
video animato. Per abilitare questa funzione è necessario segnare il quadratino
enable.
Antialiasing: Elimina il fenomeno dell'aliasing dagli spigoli degli oggetti creati. Il
suo utilizzo allunga i tempi di rendering.
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Flying Video/Flying Color/Flying Transparency: Seleziona il tipo e le
caratteristiche degli oggetti creati e animati utilizzando il Video Screen Animation.
L'impostazione di base prevede l'utilizzo della clip posta sulla Timeline come video
animato.

• Flying Video: Mappa la clip video sull'animazione di uno schermo, utilizzando
un'immagine come sottofondo. (questa è l'impostazione di base.)

• Flying Color: Utilizza due colori differenti per la parte anteriore e posteriore
dell'animazione invece di utilizzare la clip video selezionata.

• Flying Transparency (solo per gli oggetti 2D): Invece di mappare la clip video
all'interno di un oggetto animato, l'oggetto reagisce come una finestra
caratterizzata da un filtro di trasparenza che rivela solo parte della clip
all'interno dell'oggetto.

Menù View
Il menù view mostra le anteprima e permette di cambiare la disposizione dei
comandi del Video Screen Animation.
Show Effect (Anteprima di un solo fotogramma): Questo comando mostrerà
esattamente il modo in cui il fotogramma corrente apparirà dopo il rendering finale.
Quick Play (Anteprima):  Questo comando genera una serie di fotogrammi che
saranno riprodotti per darvi un'idea del modo in cui apparirà l'animazione.
Show Wireframe: Mostra o nasconde la struttura della forma.
Show Trailing: Questo comando fa in modo che lo schermo non venga rinfrescato
durante l'anteprima per simulare il modo in cui l'animazione apparirebbe con un
effetto scia.
Instant Feedback: Quando è selezionato, questo comando fa in modo che vi
venga mostrato l'oggetto con la superficie mappata al keyframe più vicino dopo
ogni modifica.
View Resolution:  Determina la risoluzione dell'instant feedback, dello show effect,
e del quick play. Potete scegliere tra 80x60, 160x120 o 320x240.
View Curve Option: Permette di scegliere tra 5 differenti viste delle traiettorie di
movimento, dei suoi nodi e le relative maniglie di controllo.
View 3D Wireframe Option (solo Oggetti 3D): Controlla la densità dei nodi, per
dare all'oggetto 3D più linee durante la rappresentazione della sua struttura. E'
anche possibile se controllare o meno le linee della struttura che sarebbero
nascoste dalla superficie nella versione renderizzata, dando come risultato un
oggetto meno confuso mostrato durante l'anteprima.
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View Effect Option: Controlla il numero di fotogrammi mostrati durante
un'anterprima. E' dotato anche di un'opzione che consente di mostrare o meno il
sottofondo.
Actual Size: Fa in modo che la vista di lavoro ritorni su quella base non ingrandita.
Zoom In: Permette di ingrandire immediatamente con fattori 2X, 3X, 4X, 5X, 6X,
7X o d 8X.
Zoom Out: Permette il rimpicciolimento istantaneo con fattori di 1/2X, 1/3X, 1/4X,
1/5X, 1/6X, 1/7X o 1/8X.
Tool Tip: Abilita o disabilita i suggerimenti per gli strumenti (i testi che appaiono
quando posizionate il cursore su uno dei pulsanti della barra degli strumenti).
Toolbar: Determina se mostrare o meno la barra degli strumenti.
Status Bar: Determina se mostrare o meno la barra di stato.

Il Menù Tools (solo AVSA)
Questi strumenti sono stati studiati per permettervi di lavorare con le funzioni
dell'AVSA, incluse traiettorie di movimento multiple e schermi sorgenti e di
destinazione. Consultate le pagine successive per maggiori dettagli.
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Le Barre degli Strumenti del Video Screen Animation

Barra degli strumenti disposta a Sinistra
Tutti questi controlli trovano posto nella barra degli strumenti posizionata alla
sinistra della finestra principale del Video Screen Animation.
Strumento di selezione: Il primo strumento è quello di selezione che viene
rappresentato da una grande fraccia bianca.
Strumento Zoom:  IL secondo pulsante della barra degli strumenti è lo strumento
zoom che vi permette di ingrandire particolari nella zona di lavoro. Questo
strumento è rappresentato da una lente di ingrandimento.
Strumento Pan: Il terzo pulsante è quello dello strumento Pan, rappresentato da
una mano bianca con delle frecce rosse che puntano a destra, sinistra ed in alto.
Se avete ingrandito parte dell'area di lavoro, questo strumento vi consentirà di
muovervi all'interno dell'intera area di lavoro.
Strumenti degli Oggetti: Il quarto pulsante del pannello di controllo può essere
uno dei quattro strumenti (2 strumenti per le forme 3D) che vengono utilizzati per
modificare gli oggetti. Scegliete uno strumento degli oggetti mantenendo la
pressione sul tasto sinistro del mouse e selezionando uno dei quattro pulsanti che
appaiono accanto ad esso. Potete scegliere strumenti per ridimensionare, ruotare,
inclinare e distorcere. Dopo la aver selezionato i pulsanti per la rotazione e per il
ridimensionamento, accanto ad essi saranno creati dei pulsanti, ognuno
rappresentante una dimensione in uno spazio 2D o 3D.
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La Barra di Controllo Superiore
Undo/Redo - Annulla o ripristina l'ultimo cambiamento.
No Motion - Rimuove la traiettoria di movimento tra due keyframes. Questa
opzione potrebbe rivelarsi utile se ad esempio volete mostrare un cubo che mostra,
ruotando, delle clip su 3 superfici prima di cominciare a muoversi
Single Frame Preview - Mostra un rapido rendering dell'effetto nella posizione del
cursore.
Quick Play Preview - Mostra un'anteprima ad un numero di fotogrammi/secondo e
risoluzione ridotti.
Wireframe Preview - Mostra un'animazione della sola struttura utilizzando  un
numero ridotto di fotogrammi. Questo rappresenta il metodo più rapido per avere
un'idea del modo in cui apparirà un'animazione.
Back and Forth Wireframe Preview - Permette di vedere in avanti ed indietro
l'animazione, con la sola struttura.
Speed Change - Tramite i pulsanti co la frecce in alto ed in basso (anche
contrassegnati da una lepre e da una tartaruga) per cambiare la velocità
dell'anteprima.

Righello del Tempo e Keyframes - Posizionato nella parte mediana della barra
degli strumenti, il righello mostra la posizione dei keyframes espressa col tempo in
percentuale. Quando muovete il cursore su un keyframe, questo keyframe diventa
attivo e viene mostrata una chiave rossa. Un keyframe può essere riposizionato
sul righello trascinandolo nella posizione desiderata, tra due keyframes adiacenti.
Questa operazione modifica i tempi dell'animazione, ma non modifica la forma
dell'animazione. In altre parole il movimento rimane identico, variano solo le
velocità dei movimenti intermedi. Il tempo totale del righello del tempo è uguale al
totale della durata della clip animata. Se la clip si trova per parte di questo tempo
all'esterno dell'area dello schermo, la clip non sarà ovviamente mostrata per tutta la
durata dello scorrimento del cursore sul righello del tempo. Ciò succede quando
l'animazione comincia all'esterno dello schermo e si muove dall'interno all'esterno.
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Advanced VSA (AVSA)
Il programma AVSA utilizza due schermi per definire ogni effetto: uno Schermo
Sorgente e uno Schermo Destinazione. Lo Schermo Sorgente viene utilizzato per
definire il modo in cui l'immagine viene divisa in aree differenti, utilizzando forme
2D. Ad ogni area viene associato un numero. Lo Schermo di Destinazione viene
utilizzaper creare oggetti e etraiettorie di movimento, così come nel VSA. Ogni
oggetto 2D nello schermo di destinazione può utilizzare l'intera clip come mappa di
superficie, come nel VSA, o può essere associata ad una sola delle aree definita
nello schermo sorgente. Utilizzando l'AVSA potete utilizzare anche oggetti e
traiettorie di movimento multipli. Se assegnate aree dallo schermo sorgente allo
schermo di destinazione potete creare effetti come una clip che si spezza durante il
movimento, o titoli nei quali ogni parola si muove indipendentemente.

SUGGERIMENTO PER LO SCHERMO DI DESTINAZIONE E PER
LO SCHERMO SORGENTE

Quando la vorate nello schermo di destinazione i nodi e gli oggetti vengono
sottolineati in marrore e le traiettorie di movimento appaiono nere.
Quando lavorate nello Schermo Sorgente i nodi e gli oggetti vengono sottolineati in
rosa e le traiettorie di movimento appaiono di colore rosa.

Per comprendere il modo in cui questo effetto può essere utilizzato potete studiare
le traiettorie già pronte accessibili tramite Tools> Motion Tools.

Esempio: Riga X Colonna
Cominciate dallo schermo sorgente cliccando sul pulsante SO posto nella parte
alta della barra degli strumenti. Dal menù selezionate  Tools> Motion Tools> Row
X Column. Utilizzate i valori base di due righe per due colonnne.
Nello schermo sorgente vedrete la clip completa divisa
in 4 aree rettangolari. Ogni area ha inizialmente una
traiettoria di movimento caratterizzata dallo stato "no
motion" (ferma), dove i nodi iniziale e finale sono uno
sopra l'altro.
Portatevi nello Schermo di Destinazione cliccando sul
pulsante DE posto nella parte alta della barra degli
strumenti. Selezionate nuovamente Tools> Motion
Tools> Row X Column ed utilizzate i valori base di due
righe per due colonne.
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Inizialmente ogni rettangolo utilizzerà l'intera clip come
sorgente per mappare la superficie di ognuno dei quattro
oggetti, e la traiettoria di movimento di ogni oggetto sarà
creata con i nodi iniziale e finale sovrapposti.
Selezionate Tools> Auto Associate. Ciò assocerà
ognuno dei 4 rettangoli dello schermo sorgente ai 4
rettangoli dello schermo di destinazione.
In questo caso, l'utilizzo della funzione Auto Associate
significa che l'immagine originale è stata divisa in 4 aree,
che potete muovere e deformare in maniera
indipendente. Ogni area è sta mappata nel relativo
oggetto di appartenenza, con una sua traiettoria di
movimento, i suoi nodi e keyframes.
In questo esempio il nodo finale è stato trascinato via dal
centro, per ognuna delle traiettorie di movimento dei
rettangoli. Ciò dà come risultato un'immagine che
scomponendosi vola via.

Note relative all'AVSA
Prima di passare al prossimo esempio è opportuno notare alcune cose. Nella barra
degli strumenti superiore del AVSA trovano posto 4 pulsanti supplementari. I
pulsanti So e DE vanno utilizzati per portarsi sugli Schermi Sorgente e
Destinazione. Accanto ad essi trovano posto altri due pulsanti Next Path  e Pre
Path.Questi pulsanti vi consentono di cambiare l'oggetto e la traiettoria di
movimento su cui volete operare modifiche. Ogni oggetto e traiettoria di movimento
possono essere modificate individualmente, nessuno dei keyframes per un oggetto
ha effetto su altri oggetti. Quando vi portate su di un'altra traiettoria di movimento, i
keyframes impostati sulla traiettoria di movimento precedente non saranno
mostrati, che, anche se non visibili, resteranno invariati nella loro posizione, e
risulteranno visibili nuovamente quando farete ritorno sulla relativa traiettoria di
movimento.

Se volete editare tutti gli oggetti contemporaneamente, vi sono degli strumenti
appositi nella finestra accessibile tramite Tools> Motion> Group Effects. I
comandi disponibili sono il ridimensionamento, il riposizionamento (numerico), il flip
verticale, il flip orizzontale ed il movimento al contrario. Un di questi effetti può
modificare un nodo, un oggetto, o entrambi contemporaneamente, può modificare
uno o tutti i keyframes.
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Nell'esempio precedente lil comando Auto Associate è stato utilizzato per
assegnare un'area sorgente ad ogni effetto di destinazione. Ciò associa ogni
oggetto dello Schermo Sorgente ad un  oggetto dello Schermo di Destinazione,
nell'ordine in cui gli oggetti sono stati creati. Ciò può essere pratico abbastanza se
state utilizzando gli schemi già realizzati presenti alla voce Motion Tools. Ad ogni
modo, si potrebbero verificare volte in cui vorrete personalizzare queste
associazioni.
Se cliccate con il tasto destro sulla traiettoria di movimento di qualunque oggetto (il
piccolo quadrato posto al centro di ogni oggetto), vi apparirà un menù.

Selezionate dal fondo del menù la voce Motion Path Options. Nel successivo
menù, nella parte bassa, troverete Associate with 1, dove il numero vi indica il
numero dell'area sorgente a cui è associato l'oggetto di destinazione. Se passate
alls visione dello Schermo Sorgente, cliccando sulla traiettoria di movimento di un
oggetto, vi apparirà un menù molto simile. Dal fondo del menù selezionate Motion
Path Options. Nel successivo menù, nella parte bassa, troverete Associate Id: 1,
dove il numero vi indica il numero assegnato dell'area sorgente al momento della
creazione. Il numero dell'area sorgente non può essere cambiato. Ad ogni modo,
potete cambiare in modo molto semplice l'area sorgente usata da ogni oggetto
nell'area di destinazione. Cliccate con il tasto destro sulla traiettoria dell'oggetto di
destinazione e selezionate Motion Path Options> Associate with 1. Si aprirà una
piccola finestra che vi consentirà di scegliere il numero di un'area sorgente
qualsiasi. Se scegliete 0, l'oggetto di destinazione non sarà associato ad un'area
sorgente, ed utilizzerà l'intera della clip originale come mappa di superficie.
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Esempio: Stile Circolare
Lo stile circolare divide lo schermo in triangoli arrangiati in uno schema circolare
che riempie l'intero schermo.
Cominciate sullo Schermo Sorgente cliccando sul pulsante SO della barra degli
strumenti posta in alto. Selezionate dal menù Tools> Motion Tools> Circular
Style.

Potete personalizzare:

• Le traiettorie: Il numero di triangoli utilizzati per realizzare il cerchio. Questo
può essere solo un numero pari.

• X ed Y: Le coordinate X ed Y del punto centrale

• Fly  e Same Speed: Due quadratini di selezione che faranno volare al di fuori i
pezzi. Se Fly è selezionato ogni triangolo sarà corredato da una traiettoria di
movimento che lo fa  allontanare dal punto centrale. Selezionando Same
Speed, tutti i triangoli voleranno via con la stessa velocità. Quando Same
Speed non è selezionato le velocità dei vari triangoli saranno diverse, in modo
da far sì che tutti i triangoli escano dallo schermo nello stesso fotogramma.

Per la realizzazione di questo esempio, deselezionate le opzioni Fly e Same Speed
mentre vi trovate sullo Schermo Sorgente. Se create una traiettoria di movimento
sullo schermo sorgente l'area selezionata seguirà la traiettoria di movimento  come
se fosse sullo Schermo di Destinazione. Sebbene questa possa essere una
opzione pratica per alcuni dei vostri effeti AVSA, sarà più semplice comprendere
questo esempio se non lo utilizzate nello Schermo Sorgente.
Utilizzate il pulsante DE per portarvi sullo Schermo di Destinazione. Selezionate dal
menù Tools> Motion Tools> Circular Style. Questa volta selezionate Fly, in
modo tale che l'oggetto venga creato con una traiettoria di movimento. Inizialmente
ogni oggetto non è associato con un oggetto dello Schermo Sorgente, così ogni
triangolo utilizzerà l'intera clip come mappa di superficie. Selezionate dal menù
Tools> Auto Associate. Ciò assocerà ognuno dei 4 triangoli nello Schermo
Sorgente con uno dei triangoli dello Schermo di Destinazione. Utilizzate l'anteprima
strutturale (wireframe preview) per visionare il modo in cui appare la vostra
animazione.
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Esempio: Stile a ZigZag
Lo Stile a ZigZag divide lo schermo in righe che volano via dallo schermo in
direzioni alternate.
Cominciate dallo Schermo Sorgente cliccando sul pulsante SO che si trova nella
barra degli strumenti superiore. Selezionate dal menù Tools> Motion Tools>
ZigZag Style.

Potete definire il numero di righe rettangolari che saranno create e lo stile che
utilizzeranno (orizzontale, verticale, diagonale a sinistra e diagonale a destra). Lo
Stile a ZigZag è dotato anch'esso di selezioni Fly e Same Speed, che lavorano alla
stessa maniera di come descritto nllo Stile Circolare.
Per questo esempio, deselezionare Fly e Same Speed mentre vi trovate nello
Schermo Sorgente. Se create una traiettoria di movimento sullo schermo sorgente
l'area selezionata seguirà la traiettoria di movimento  come se fosse sullo Schermo
di Destinazione.
Utilizzate il pulsante DE per portarvi sullo Schermo di Destinazione. Selezionate dal
menù Tools> Motion Tools> ZigZag Style. Questa volta selezionate Fly, in modo
tale che l'oggetto venga creato con una traiettoria di movimento. Inizialmente ogni
oggetto non è associato con un oggetto dello Schermo Sorgente, così ogni nastro
utilizzerà l'intera clip come mappa di superficie. Selezionate dal menù Tools> Auto
Associate. Ciò assocerà ognuno dei 4 nastri nello Schermo Sorgente con uno dei
nastri dello Schermo di Destinazione. Utilizzate l'anteprima strutturale (wireframe
preview) ed il Quick Play per visionare il modo in cui appare la vostra animazione.
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Esempio: Realizzazione di vostri effetti
AVSA
Oltre ai tre esempi già realizzati, potete creare vostri efferri utilizzando il menù
Motion.
Cominciate dallo Schermo di Destinazione e selezionate Effect> Fit to Screen>
Full Screen. Ciò assicurerà che l'intera immagine venga mostrata sullo Schermo
Sorgente, rendendo più semplice l'operazione di definizione delle aree sullo
Schermo Sorgente.
Portatevi sullo Schermo Sorgente cliccando sul pulsante SO posto nella barra degli
strumenti superiore. Sullo schermo Sorgente verrà mostrata una traiettoria di
movimento base. Se non volete che la vostra area finale si muova, assicuratevi di
trovarvi sul primo keyframe della linea percentuale. Muovete il primo nodo,
cambiate forma all'oggetto, ridimensionatelo, e riposizionatelo nell'area che volete
definire. Cliccate sul pulsante No Mot che si trova nella barra degli strumenti
superiore per posizionare il secondo nodo sul primo, e per utilizzare tutte le
impostazioni dell'oggetto (dimensione, forma) su entrambi i nodi. All'area che avete
appena creato sarà assegnato Association Id: 1. (Ad ogni area che definite in
successione verrà dato automaticamente il numero successivo.)
Portatevi sullo Scremo di Destinazione cliccando sul pulsante DE.  L'oggetto che
era stato creato inizialmente a pieno schermo sarà mostrato sullo schermo. Per
questo esempio portatevi sul primo keyframe e selezionate Edit> 2D Shape>
Circle dal menù. Portatevi sull'ultimo keyframe e fate la stessa cosa. Cliccate con il
tato destro su un nodo della traiettoria di movimento e selezionate Motion Path
Options> Associate with Motion. Apparirà una finestra che vi permette di
cambiare su 1 il numero di associazione. Rinfrescate lo schermo portandovi sul
keyframe precedente. L'oggetto di destinazione utilizzerà l'area che avete definito
sullo Schermo Sorgente. Potete creare nodi addizionali, cambiare e/o deformare le
forme utilizzate e muovere i keyframes per creare l'effetto che desiderate.
In modo differente, se volete utilizzare il movimento sullo Schermo Sorgente potete
creare una traiettoria di movimento per la vostra area sorgente. Se poi utilizzate un
oggetto stazionario sullo Schermo di Destinazione, la superficie mappata
sull'oggetto stazionario cambierà assecondando l'area mostrata dall'oggetto che si
muove sullo Schermo Sorgente.
Schermo Sorgente:
Un oggetto Circolare che definisce l'area
sorgente che utilizzerà l'Association Id 1
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Schermo di Destinazione:
Un oggetto circolare che utilizza l'area sorgente 1
per la sua mappa di superficie.

Ad esempio, se avete una clip che mostra un cane che corre lungo lo schermo
potete creare un'area sullo Schermo Sorgente che utilizza una traiettoria di
movimento per mantenere centrato il cane nell'oggetto sorgente. Potete poi
associare quest'area ad un'area dello schermo di destinazione ed avere il cane che
si muove su un oggetto stazionario nello schermo di destinaizone. Potet anche
muovere lo Schermo di Destinazione in modo che questo segua una qualsiasi
traiettoria di movimento  che impostate, od in modo tale che venga deformato o
ruotato.

Strumenti dell'AVSA, Comandi e Suggerimenti

Menù Tools
Strumento Motion: Per l'AVSA sono presenti  tre schemi già pronti.

• Row X Column dividerà lo schermo in rettangoli

• Sircular Style dividerà lo schermo in triangoli a partire da un punto centrale.

• ZigZag Style dividerò lo schermo in nastri che volano al di fuori dello schermo
in direzioni alternate.

Auto Associate: Questo comando può essere utilizzato nello schermo di
destinazione per assegnare ogni oggetto creato nello Schermo Sorgente ad un
oggetto posto nello Schermo di Destinazione.
Auto Unassociate: Questo comando può essere utilizzato nello Schermo di
Destinazione per impostare tutte le associazioni degli oggetti di destinazione su 0
(Associate with nothing).
Group Effect: Questo apre una finestra che vi permette di effettuare alcune
operazioni di elaborazione su più di un pggetto, traiettoria di movimento, nodo o
keyframe.
Apply to Other Motion Paths: Quando questa opzione viene selezionata il
movimento di ogni  traiettoria di movimento viene applicato in egual misura a tutte
le traiettorie di movimento, al movimento di un nodo corrisponde un identico
movimento di tutti i nodi con lo stesso numero (di altre traiettorie di movimento) , e
all'aggiunta di un nodo o di un keyframe corrisponde l'aggiunta di un nodo o di un
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keyframe nello stesso posizione percentuale delle altre traiettorie di movimento.
Prestate attenzione al fatto che se cambiate una traiettoria di movimento senza
cambiare le altre e poi abilitate l'opzione Apply to Other Motion Paths, alcuni
movimenti potrebbero non influenzare l'unica traiettoria di movimento.

Comandi Addizionali dell'AVSA accessibili da tasto
destro

Se cliccate con il tasto destro su un oggetto vi appare un menù. Come nel VSA
molte voci di questo menù sono le stesse accessibili dal menù principale. I comandi
addizionali dell'AVSA possono essere trovati selezionando l'ultima voce del menù,
Motion Path Options.
Path Editing: I comandi Copy (copia9, Delete (cancella), Replace (rimpiazza) e
Select (Seleziona) Path (traiettoria) sono tutti disponibili.
Path Order: Se gli oggetti posizionati su una traiettoria di movimento si
sovrappongono potete scegliere quale parte mostrare in primo piano utilizzando i
comandi Forward One, Back One, To Front, To Back, e Reverse Order.
Associate: Nello Schermo Sorgente questo comando vi mostra il numero di
Associate Id che è stato assegnato ad ogni oggetto. I numeri vengono assegnati
nel momento in cui gli oggetti vengono creati e non possono essere variati. Nello
schermo di Destinazione ciò dice a quale oggetto Sorgente è assegnato l'oggetto di
destinazione. Cliccando sulla voce del menù Associate with #, si aprirà una finestra
che vi consentirà di assgnare uno dei numeri dei numeri di associazione esistenti.
Assegnando 0 l'associazione verrà eliminata (l'oggetto di destinazione non
utilizzerà un oggetto Sorgente per la mappatura della superficie).
Back Most Curve: Questa ultima voce del menù è una linea di stato che vi dice in
quale posizione si trova correntemente la traiettoria di movimento selezionata.
Questo può mostrare Back Most Curve, Front Most Curve, or Position:  from
top.

AVSA Tips
L'effetto AVSA è stato progettato per essere utilizzato con oggetti 2D. Se
aggiungete una traiettoria di movimento addizionale che utilizza un oggetto 3D, non
sarete in grado di assegnare un'area di superficie alla mappa di superficie 3D. La
clip originale verrà utilizzata per mappare tutte le superfici del vostro oggetto 3D.
Se volete effettuare un effetto multilivello 2D/3D vi consigliamo di posizionare una
clip addizionale su una traccia più bassa della Timeline e di creare un'altra
animazione indipendente.
Se scegliete di lavorare con traiettorie 3D utilizzando l'AVSA potreste ottenere
risultati imprevisti utilizzando  Edit> Attach Video to Surface quando è presente
più di un oggetto. Vi raccomandiamo di utilizzare il VSA per gli oggetti 3D. Quando
lavorate con traiettorie di movimento multiple, la selezione della traiettoria su cui
state lavvorando potrebbe risultare difficoltosa, specialmente se le traiettorie si
sovrappongono in alcuni punti. Utilizzate i pulsanti Next e Previous Path per evitare
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confuzione. Prestate molta attenzione agli oggetti e alle traiettorie che sono
evidenziati.
Durante l'utilizzodell'AVSA lo schermo non viene rinfrescato istantaneamente.
Portatevi su un altro keyframe od attivate un oggetto clicando su un nodo di una
traiettoria di movimento per tracciare nuovamente lo schermo.
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CAPITOLO 10: AUDIO

Introduzione

Cliccate sull'icona della traccia per visualizzare la traccia audio e per permetterne
l'elaborazione
Quando catturerete del video, spesso catturerete con esso anche dell'audio, in
modo tale che l'audio e il video vengano sincronizzati. Le immagini video vengono
salvate in un file RVD nei dischi della Perception RT. Il file audio ad esso associato
viene salvato nel formato RVA su un disco di sistema. Il file RVA è legato al file
RVD, in modo tale che quando riproducete un file RVA, verranno riprodotti
assieme, sincronizzati, l'audio ed il video.
Prima o durante la cattura una clip  audio/video, probabilmente, avrete bisogno di
regolarne il livello audio. E' importante che i picchi non siano talmente alti da
generare distorsione, o che il livello sia talmente basso da essere appena
avvertibile. Video Action è dotato di VU (Volume Unit) meters che vi permettono di
regolare il livello durante la registrazione. Potete utilizzare anche il controllo volume
di registrazione di Windows durante la registrazione.
Così come l'audio che registrate con le vostre clip video, avrete spesso bisogno di
utilizzare musica e suoni addizionali; è sufficiente che li digitalizziate e li salviate
come files WAV. Potete poi collezionarli all'interno della Gallery per poi posizionarli
nelle tracce audio della Timeline..
Quando lavorate su una Timeline nella quale si trova una clip audio/video,
cliccando sull'icona della relativa traccia video, che si trova all'estrema sinistra della
traccia, si apre la clip audio associata. Quando aprite una traccia audio, Video

Utilizzate i VU
Meters per
regolare i
livelli Audio

Cliccate sull'icona della
traccia per visualizzare la
traccia audio e per
permetterne l'elaborazione



       Video Action RT

______________________________

292

Action vi fornisce una rappresentazione grafica del suo volume. Questo grafico di
controllo del volume vi consente di cambiare il volume della clip dallo 0% al 200%;
ogni punto può avere un valore indipendente. Quando cambiate il livello audio in
questo modo, vedrete i cambiamenti nel momento in cui spostate in alto o in basso
la linea, e ascolterete l'effetto della vostra azione attraverso i diffusori acustici. Per
cambiare il volume di una clip, o dell'intera Timeline, potete utilizzare anche i VU
meters.
La traccia audio della Timeline può anche essere utilizzata per  mostrare e
controllare il bilanciamento tra i canali destro e sinistro, o per visualizzare la traccia
audio come waveform (Forma d'onda).
Quando lavorate con file WAV, potete aprire questi con il VA Player, cliccando due
volte su essi, sia nella Gallery che nella Timeline. Potete posizionare indici, dividere
la clip nei punti indice, e regolare la lunghezza delle vostre clip audio. Quando la
clip audio è sulla Timeline, potete regolarne la lunghezza trascinandone i bordi. Per
modificare le vostre clip, potete anche utilizzare il menù Audio Clip di Video Action.
Quando state lavorando con  dell'audio in Video Action, avete la possibilità di
ascoltare un preview (anteprima), in tempo reale, su un numero illimitato di tracce.
Le uniche restrizioni sono imposte dalla velocità del vostro computer.
Assieme a Video Action viene fornito in dotazione Sound Forge XP, che vi dà la
possibilità di intervenire sull'audio in un modo ancora più creativo, grazie ai suoi
effetti e ai suoi strumenti di elaborazione..

Registrazione dell'Audio
La scheda RIO2 è dotata di due ingressi audio non bilanciati contrassegnati da L IN
ed R IN. Potete collegare l'audio in uscita da un videoregistratore, una telecamera,
un lettore CD, o una qualsiasi altra periferica audio. La nuova RIO2+ è dotata
invece di ingressi uscite sia bilanciati che sbilanciati, e dell'ingresso per il CD-ROM.
L'opzione DV-5200 può poi permettervi l'ingresso dell'audio DV. Tutti i segnali
audio che entrano in questi ingressi possono essere catturati. Le funzioni Batch
Capture e Quick Capture di Video Action vi consentono di catturare solo il video,
solo l'audio o l'audio ed il video assieme.
Durante la cattura dell'audio potete controllare il livello del volume utilizzando i VU
Meters di Video Action o il Controllo Volume di Registrazione di Windows.
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Utilizzo dei VU Meters di Video Action
Quando aprite una delle funzioni di cattura di Video Action, i VU Meters
mostreranno una piccola luce rossa di registrazione nella parte bassa del pannello.
Ciò indica che i VU Meters stanno monitorando il livello del segnale dell'audio in
ingresso.

Quando state catturando dell'audio, molto spesso imposterete il guadagno audio su
0 dB, in modo tale che il segnale che registrate abbia lo stesso livello  del segnale
audio sorgente.  Il livello audio di registrazione dovrebbe essere di 0 Db (-20dbfs).
Se questo è più basso , potreste incontrare problemi di rapporto segnale/rumore.
Se è più alto, potreste avere problemi di saturazione. La stessa regola generale
vale per l'uscita.
In ogni caso, se state catturando un segnale molto forte, potreste notare che la
scala audio si illumina nella zona rossa, e che appare un triangolo giallo di pericolo.
Ciò indica che il segnale è troppo forte per essere registrato senza alcuna
distorsione. E' sufficiente che abbassiate i cursori per portare nuovamente i livelli
audio nella zona verde.
Se il segnale audio è molto basso noterete che la scala audio si illumina a
malapena, restando nella zona bassa della scala. Se sapete che state
riproducendo una sezione abbastanza silenziosa, ciò è normale, ma se volete che
il livello di registrazione sia più alto, è sufficiente che spostiate in alto i cursori dei
VU Meters. E' possibile incrementare il volume sino ad un massimo di 12 dB.
Fate attenzione che anche quando non c'è audio i VU Meters indicheranno la
presenza di un lieve segnale. Questo è il rumore audio, ed è comune a tutte le
periferiche di registrazione analogiche. Fintanto che resterà basso, non sarà
comunque udibile nella vostra produzione finale.
Cliccando due volte sui VU Meters nell'area grigia, posta nella parte alta o in quella
bassa del pannello, aprirete la finestra delle impostazioni dei VU Meters.

Nel momento in cui viene rilevata
saturazione audio appare un
segnale di pericolo .

La luce di registrazione rossa indica
che i VU Meters stanno
monitorando il livello audio in
ingresso.

La scala si illumina indicando il
livello audio

Potete utilizzare i cursori per
regolare i livello audio durante la
registrazione.

Il livello audio è espresso in dB
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Impostazioni dei VU Meters
Show Scale: Utilizzate questa selezione per attivare o disattivare i numeri negli
indicatori colorati del volume.

Analog Simulation: Selezionate questa funzione per cambiare la scala da digitale
(con 0dB al vertice della scala) ad analogica che interpone lo 0 tra le parti gialla e
verde della scala, con valori positivi per le parti rosse e  gialle della scala, e valori
negativi per le parti verdi della scala.

La presenza di un lieve rumore
audio è comune a tutte le
periferiche di registrazione
analogiche.

Seleziona la scala che è mostrata sui VU Meters

Blocca i Canali Destro/Sinistro
Abilita la finestra di notifica della saturazione
audio

Seleziona una periferica mixer

Seleziona la sorgente d'ingresso

Opzioni di registrazione che appaiono unicamente
quando la finestra di cattura è aperta.
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Resolution: Potete scegliere quale parte della scala volete vedere. Potete vedere
una scala da 90dB, che include interamente il rosso, il giallo ed il verde, o potete
ingrandire fino a vedere solo i 12dB della parte alta, che includono le sole zone
gialla e rossa.

Lock Left/Right: La selezione di questa opzione blocca i canali sinistro e destro, in
modo tale che quando viene variato il livello di un canale, il livello dell'altro viene
variato nella stessa misura. Con la pressione del tasto Shift, la selezione di questa
opzione viene commutata sull'inversa (se selezionata viene momentaneamente
deselezionata), fino a quando il tasto Shift non viene rilasciato.
Notify on Audio Saturation: Quando questa opzione è attiva, una piccola finestra
apparirà ogni volta che la saturazione audio viene rilevata. Se volete registrare o
riprodurre audio senza distorsione, è necessario che provvediate ad abbassare il
livello audio quando viene rilevata saturazione audio. Questa finestra interromperà
la riproduzione della Timeline e renderà difficile l'utilizzo dei cursori audio durante la
cattura, per questo motivo è probabile che in alcune situazioni vogliate disabilitare
questa funzione. Nel caso in cui questa funzione sia stata abilitata, il piccolo
triangolo giallo di avvertimento sarà mostrato sui VU Meters quando viene rilevata
saturazione audio.

Questa è la scala
da 90dB che usa la
scala digitale: lo 0
si trova al vertice
della scala.

Questa è la scala
da 90dB che
utilizza l'Analog
Simulation: Lo 0dB
si trova sulla linea
di separazione tra il
giallo ed il verde.

Visualizzazione
della scala da 90dB
ai soli 60dB superio

Questa è la scala
da 42db che
utilizza l'Analog
Simulation: lo 0dB
si trova ancora
sulla linea di
separazione tra il
verde ed il giallo.

Visualizzazione
della scala da 60dB
ai soli 12dB
superiori
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Mixer Device to Monitor: Se avete più di una periferica mixer abilitata nel vostro
computer potete utilizzare questo menù a scomparsa per selezionare la periferica
che volete monitorare.
Use Windows Volume Controls: Quando abilitate questa opzione potete
cambiare il guadagno audio solo con il Controllo Volume di Windows. I VU Meters
di Video Action continueranno a mostrare il livello audio, ma i cursori non saranno
disponibili. Quando utilizzate il Controllo del Volume di Windows i VU Meters non
vengono aggiornati, per cui, per evitare confusione, è preferibile che abilitiate
questa opzione. Se scegliete di disabilitare i VU Meters di Video Action, potete
scegliere il tipo di audio da catturare dal Pannello di Controllo Volume di
Registrazione di Windows.
Input: Se avete le opzioni di ingresso audio bilanciato, audio non bilanciato e CD,
potete scegliere il tipo di audio da registrare. Se nelle impostazioni di cattura video
avete selezionato come ingresso il DV, l'unico tipo di audio che potete registrare
simultaneamente è quello DV, che costituisce una parte della sorgente video.
Amplificazione Hardware: Questi cursori vi consentono di regolare gli attenuatori
hardware del controllo volume, sino ad un massimo di 0dB, per i segnali bilanciati,
sbilanciati o CD audio. Ogni regolazione fatta dai VU Meters di Video Action appare
su questa regolazione. Ciò produce lo stesso effetto dell'utilizzo del Controllo
Volume di Registrazione di Windows per regolare il volume principale (master) e i
cursori per ognuno degli ingressi.
Default: Quando cliccate su questo pulsante sia i VU Meters e sia il Controllo
Volume di Windows saranno ripristinati su 0dB (nessun guadagno). I VU Meters
mostreranno questo cambiamento immediatamente, ma è necessario che chiudiate
il Controllo Volume di Windows e che lo riapriate, affinchè questo venga aggiornato
graficamente. Notate che, in entrambi i pannelli, lo 0dB non si trova al fondo della
scala di entrambi i pannelli della scala.

Il Pannello di Controllo  del Volume di
Registrazione di Windows
Di solito utilizzerete i VU Meters di Video Action per controllare l'audio, e aprirete il
Controllo Volume di Windows (Recording Control) solo per avere accesso ai
pulsanti delle funzioni avanzate della periferica mixer DPS RIO2. Potete utilizzare il
Controllo Volume di Windows per controllare i livelli audio durante la cattura audio,
ma questo non è dotato di tutte le caratteristiche dei VU meters di Video Action
(come l'indicatore di saturazione o dell'indicazione dell'esatto livello del guadagno).
Potete aprire questo pannello dalla funzione di Quick Capture cliccando sul
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pulsante dell'audio posto alla base della finestra di Quick Capture, oppure in
qualsiasi momento cliccando sulla piccola icona rappresentante un altoparlante
posto all'estrema destra della barra delle applicazioni di Windows. Cliccando due
volte sull'icona dell'altoparlante, vi apparirà il Controllo Volume di Riproduzione di
Windows. Utilizzate questo pannello per selezionare Opzioni> Proprietà.
Selezionate Registrazione dal pannello delle proprietà per aprire il Controllo
Volume di Windows.

Se avete scelto di disabilitare i VU meters di Video Action, potete scegliere il tipo di
audio da catturare selezionando il relativo quadratino di selezione. Le selezioni
fatte in questa schermata verranno aggiornate anche nei VU Meters di Video
Action.
I pulsanti Avanzate posto al di sotto dei cursori degli ingressi balanced, unbalanced
e CD vi permettono di abilitare l'Automatic Gain Control. Quando questa funzione
è attiva, il software provvede ad aumentare il livello audio automaticamente quando
necessario.
Il pulsante Avanzate al di sotto del cursore  posto all'estrema sinistra vi permette di
selezionare le modalità Full Duplex (per registrare e riprodurre,
contemporaneamente, l'audio dalla sorgente) e Digital Feedback (per ascoltare
l'audio così come viene registrato). Quando utilizzate il Digital Feedback, dovete
disabilitare la riproduzione del Line In nel mixer di riproduzione (Controllo Volume
di Windows) per non sentire l'effetto dell'eco audio.
Un pulsante avanzate è presente anche nel mixer di riproduzione, sotto il cursore
del Wave Output Potete utilizzare questo pulsante per resettare la scheda DPS
RIO2. Qualora doveste avere dei problemi audio, questa opzione potrebbe essere
il modo migliore per cominciare a risolverli.
Per piacere consultate la Guida della DPS Perception RT per maggiori dettagli su
come utilizzare i pannelli del Controllo Volume di Windows con il vostro sistema
PRT.

Questo cursore controlla il
livello di registrazione
principale. Lasciatelo al
massimo della scala
(100%) per inviare il 100%
del dell'uscita del vostro
canale di linea analogico
alle funzioni di
registrazione di Video
Action. Abbassandone il
livello noterete che il
suono che state
registrando sarà più
debole.

I cursori degli ingressi
analogici ne controllano il
guadagno. Portandoli in
alto noterete che il suono
che state registrando
diventerà più forte. Fate
attenzione al fatto che lo
0dB (nessun guadagno)
non si trova al fondo della
scala. Posizionando il
cursore al di sotto dello
0dB il suono sarà più
debole.
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Utilizzo dei VU Meters durante la Riproduzione
I VU Meters controllano il livello dell'audio in riproduzione dalla Gallery, dalla
Timeline o dal VA Player. La scala colorata si illuminerà per indicare i livelli audio, e
l'indicatore di saturazione vi sarà mostrato quando necessario. Una volta che
l'indicatore di saturazione è apparso, potete resettarlo cliccandoci due volte sopra.
Quando riproducete una clip con l'audio dalla Gallery o dal VA Player, i cursori di
amplificazione non vi saranno mostrati. Non è possibile effettuare regolazioni audio
dalla Gallery o dal VA Player.
Quando riproducete una clip con l'audio dalla Timeline, vi saranno mostrati i cursori
di amplificazione, essendo possibile effettuarne regolazioni.
Quando riproducete un'intera Timeline i VU Meters saranno comunque attivi, per
permettervi di regolare l'amplificazione audio di tutta la Timeline. I cursori di
controllo dei VU Meters saranno presenti a seconda delle impostazioni di
anteprima e del tipo di clip audio che viene riprodotta.
Se una clip audio mono viene caricata all'interno di Video Action, verrà udita
un'uguale uscita da entrambi i canali destro e sinistro. I VU Meters mostreranno
entrambi i canali.

Preview  Settings Input Audio Clip Cursori VU Meter Cursori VU Meter
Timeline Clip

Stereo Stereo Due Cursori Due Cursori

Stereo Mono Due Cursori Due Cursori

Mono Stereo Un Cursore Due Cursori

Mono Mono Un Cursore Un Cursore

Quando state controllando il volume dell'intera Timeline, l'icona mostrata
nell'angolo in basso a sinistra dei VU Meters cambia da un altoparlante con una
clip (che sta ad indicare un controllo individuale sulla clip) ad un solo altoparlante
(che sta ad indicare il controllo generale del volume della Timeline).
Cliccate con il tasto destro sull'area grigia vuota posta in alto o in basso nel
pannello dei VU Meters, vi apparirà la finestra delle impostazioni dei VU Meters.
Questa vi fornirà di tutte le opzioni presenti per la registrazione, meno la selezione
"Recording: Use Windows Volume Controls" (utilizza il Controllo Volume di
Registrazione di Windows).



       Video Action RT

______________________________

299

Visualizzazione dell'Audio sulla Timeline
Se trascinate un file WAV dalla Gallery su una traccia audio, questa sarà
rappresentata da un rettangolo. Quando lavorate con una clip video che ha una clip
audio associata, cliccando sull'icona della traccia video ad essa relativa, posta
all'estrema sinistra della traccia, aprirete la corrispondente clip audio.
Quando la clip audio viene aperta, viene mostrata una linea che ne rappresenta il
volume. Per cambiare il tipo di visualizzazione cliccate con il tasto destro sull'icona
della traccia, vi apparirà l'apposita finestra.

Una finestra come questa vi sarà mostrata quando cliccate con il tasto destro
sull'icona di una traccia.
I tre formati audio sono:

• Volume: Il volume viene mostrato da una linea impostata inizialmenta al 100%.
Ciò significa che il vostro segnale d'ingresso verrà riprodotto senza alcuna
modifica. Potete regolare la linea tra lo 0% ed il 200%.

L'indicatore giallo di
saturazione può
essere resettato
cliccandoci sopra
due volte.

L'altoparlante
indica il controllo
del volume
generale della
Timeline.

L'altoparlante con
la clip indica un
controllo individuale
sul volume di una
clip

L'altoparlante con
la clip indica il
volume della
singola clip.

Durante la
riproduzione dalla
Gallery o dal VA
Player i cursori non
sono disponibili, ma
i livelli possono
essere osservati
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• Balance: Questa selezione fa sì che venga mostrato il bilanciamento tra il
canale destro e sinistro. Il valore di base prevede un bilanciamento uguale tra i
canali destro e sinistro. Potete regolare il bilanciamento da 100% a destra a
100% a sinistra.

• Waveform: Questa selezione mostra il volume di uscita come forma d'onda in
modo da avere un riferimento visivo oltre a quello uditivo per le operazioni di
montaggio (es. per l'individuazione delle battute musicali). Potete regolare il
volume della traccia audio mostrato al centro della forma d'onda.

Regolazioni dell'Audio
Quando posizionate una clip audio sulla Timeline potete regolarne il suono
spostandone la linea rossa. Per spostare la linea rossa dovrete creare una
maniglia, che è un punto sulla linea che potete trascinare. Per creare una maniglia,
posizionate il puntatore del mouse sulla linea audio. Il cursore cambierà forma,
assumendo la forma di un dito indice. Cliccando sulla linea dell'audio utilizzando il
dito indice, apparirà una maniglia audio.

Per muovere la linea dell’audio, posizionate il puntatore del mouse sulla linea
dell’audio (apparirà il puntatore a forma di dito indice). Utilizzate il pulsante sinistro
per trascinare la linea su un’altra posizione. Potete anche posizionare il  puntatore
del mouse su una maniglia ed utilizzare i tasti freccia in alto ed in basso della
tastiera per alzare ed abbassare la posizione della maniglia. Nel momento in cui
cambiate la posizione della maniglia, al di sopra di essa vi sarà mostrata, in un
riquadro giallo, la posizione percentuale corrente. Spostando una maniglia
ascolterete anche l'effetto dello spostamento sull’audio.
Nota: Le maniglie poste tra due maniglie adiacenti, possono essere mosse in alto,
in basso a destra o sinistra.

Cliccate sull'icona
della traccia
video per aprire
la traccia audio.

200%
100%

0%
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Trimming delle Clip Audio
La ridefinizione della lunghezza di una clip audio si effettua con le stesse modalità
di una clip video.

• Potete cliccare sue volte su una clip audio per aprirla nel VA Player. Potete
impostare dei nuovi punti di IN ed Out, aggiungere punti indice, e dividere la
clip nei punti indice. Consultate il capitolo 4 per maggiori informazioni sul VA
Player.

• Potete trascinare i bordi della clip audio sulla Timeline.

• Potete utilizzare il rasoio per dividere la clip audio sulla Timeline e cancellarne
la parte che non volete utilizzare.

Opzioni del Menù Audio
In basso sono riportate le impostazioni raggiungibili dal menù Edit> Audio Clip,
oppure cliccando con il tasto destro su una clip audio e selezionando  Audio Clip
dal menù che vi appare. Per attivare queste voci è però necessario che
selezioniate prima una clip che contiene audio. Tutte le funzioni di modifica audio
possono essere annullate selezionando, dal menù principale, Edit >Undo, oppure
premendo Ctrl+Z.

Comandi Audio
• Reset Volume - Il livello del Volume viene ripristinato sul 100%

• Set Volume – Questo controllo permette l’impostazione, sull’intera clip, del
livello dell’audio, dallo 0% al 200%.

• Reset Balance – Ripristina il bilanciamento perfettamente centrato tra i canali
destro e sinistro

• Set Balance - Questo controllo permette l’impostazione, sull’intera clip, del
bilanciamento dell’audio, dal 100% a sinistra (0% a destra) al 100% a destra
(0% a sinistra )

• Reset Panning – Ripristina il canale sinistro sul 100%, ed il canale destro sul
100% (valori normali).

• Set Panning – Il Pan è il movimento del suono da un altoparlante ad un altro,
ed è una funzione dell’audio stereofonico. Due cursori vi permettono di
muovere il suono dall’altoparlante sinistro a quello destro e viceversa.
Entrambi i cursori al 100% indicano che il canale sinistro sarà udibile solo
attraverso l’altoparlante sinistro, e che il canale destro sarà udibile solo
attraverso l’altoparlante destro. Posizionando entrambi i cursori sulla metà
della scala, farà sì che i canali vengano miscelati al 50% in entrambi gli
altoparlanti. Posizionando entrambi i cursori sullo 0% ha come effetto
l’inversione dei canali negli altoparlanti.

• Mute Both – Abbassa completamente il volume
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• Mute Left – Silenzia il canale sinistro

• Mute Right – Silenzia il canale destro

• Fill Left – Fa in modo che l’altoparlante sinistro riproduca i canali sinistro e
destro assieme, mentre lascia inalterata la riproduzione dell’altoparlante
destro.

• Fill Right – Fa in modo che l’altoparlante destro riproduca i canali destro e
sinistro assieme, mentre lascia inalterata la riproduzione dell’altoparlante
sinistro.

• Fill Both – Fa in mod che entrambi gli altoparlanti riproducano i canali destro e
sinistro.

• Switch Left and Right- Inverte i canali destro e sinistro.

SUGGERIMENTO: Silenziamento dell’audio

Per silenziare l’audio di clip individuali, selezionate Edit> Audio Clip> Mute Both.
Per silenziare l’audio dell’intera Timeline durante la riproduzione, deselezionate
Enable Audio in Movie> Preview Settings. Ciò evita al sistema di dover effettuare
il missaggio audio in sottofondo di ogni clip audio che richiede rendering, e quindi
può velocizzare la riproduzione in tempo reale.
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Riproduzione dell’Audio dalla Timeline

Riproduzione dell’audio in tempo reale
Video Action può riprodurre infinite tracce audio direttamente dalla Timeline. Ad
ogni modo la velocità di elaborazione del vostro computer e la velocità dell’hard
disk di sistema limiteranno il numero di tracce che possono essere riprodotte in
tempo reale, senza il rendering dell’audio. Video Action ha bisogno di effettuare
del rendering audio quando utilizzate, per la riproduzione, clip audio caratterizzate
da tassi di campionamento differenti. Potete effettuare il missaggio di clip stereo e
mono registrate a 8 o 16 bits. Per la riproduzione in tempo reale raccomandiamo
che tutte le clip audio abbiano lo stesso tasso di campionamento.
Per impostare il numero di canali in tempo reale che saranno utilizzati per la
riproduzione, selezionate, dal menù principale,  File > Preferences> RT Settings.
Potete cambiare il numero di canali da utilizzare in tempo reale in modo da
assecondare le capacità di elaborazione del vostro computer.

Per molti computers e hard disks, raccomandiamo di cominciare con il valore base
di 3 tracce. Incrementando il numero di queste tracce oltre il numero supportato dal
vostro computer, le immagini video continueranno ad essere riprodotte
normalmente, ma l’audio non sarà più sincronizzato ad esse.
Video Action, quando deve determinare il numero di tracce audio utilizzate, divide
la Timeline in segmenti di 5 secondi. Se sono state utilizzate più tracce di quelle
assegnate, Video Action renderizzerà solo quelle sezioni da 5 secondi  dove sono
presenti più tracce audio. Lo stesso tipo di rendering in sottofondo verrà effettuato
se le tracce audio utilizzano differenti tassi di campionamento.
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Considerate il seguente esempio in un sistema impostato su tre tracce audio in
tempo reale:

Da 0 a 5 secondi l’audio sarà riprodotto in tempo reale. Da 5 a 10 secondi l’audio
necessiterà di rendering prima che possa essere riprodotto (creando un file
temporaneo) perché sono presenti 4 tracce audio tra i secondi 5 e 6. Da 10 a 15
secondi l’audio sarà riprodotto in tempo reale.
Nota: Una clip video dotata di audio viene considerata come una delle tracce audio
in tempo reale. Una clip video non dotata di audio (un file RVD, un file RVA da cui è
stata separata la clip audio) non viene considerata come traccia in tempo reale.
Video Action, quando possibile, utilizza il rendering in sottofondo dell’audio di
intervalli di 5 secondi. Ciò significa che ogni qualvolta si renda necessario del
rendering audio (perché avete  posizionato dell’audio su una traccia addizionale),
Video Action ne terrà conto ed utilizzerà la prossima pausa nel vostro lavoro per
renderizzare l’audio  come processo di sottofondo. Il rendering audio in sottofondo
è un processo che può essere interrotto, pertanto non sarete mai costretti ad
aspettare la fine della renderizzazione di una sezione dell’audio. Di solito non
sarete nemmeno costretti ad aspettare la renderizzazione dell’audio prima che la
riproduzione possa avere inizio.
Se trascinate molte clip audio sulla Timeline, lavorate senza pause e poi
riproducetela Timeline, Video Action potrebbe non aver completato il rendering
audio in background. I questo caso il cursore cambierà forma durante la
renderizzazione dell’audio e poi la riproduzione avrà inizio. Se evidenziate una
parte della Timeline, verrà renderizzata solo la parte di audio di questa parte della
Timeline, in modo tale che la riproduzione possa cominciare al prima possibile.

SUGGERIMENTO: Riproduzione in tempo reale dell’audio

Per la riproduzione in tempo reale è necessario che utilizzate tutte le clip con
medesimo tasso di campionamento.
La qualità dell’audio durante la riproduzione della Timeline è impostata nella
finestra Movie > Preview Settings> Audio.
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Riproduzione dell’Audio della Timeline
Sotto trovate una lista di alcune delle opzioni di riproduzione della Timeline, e come
utilizzarle.

Per Riprodurre tutte le clip:
Cliccate sulla Timeline per attivarne la linea bianca e rossa di riproduzione.
Premete la barra spaziatrice per riprodurre la Timeline dalla linea di riproduzione in
avanti con il missaggio audio in tempo reale.

Per riprodurre una singola clip:
Ci sono due modi per riprodurre una singola clip:
1. Per una clip video dotata di audio, cliccate sull’icona di riproduzione posta al

centro della clip. La clip selezionata sarà riprodotta dal punto di In a quello di
Out. Per le clip audio, selezionate la clip e premete la barra spaziatrice.

2. Cliccate due volte sulla clip video o audio; quando apparirà il VA Player,
utilizzatene i controlli per riprodurre la clip.

Riproduzione dell’Audio di una Sezione
della Timeline
Nell’area del righello della Timeline, trascinate il cursore in modo da determinare
un’area evidenziata di riproduzione. Le clip saranno riprodotte dall’inizio alla fine di
tale area. Per fermare la riproduzione premete la barra spaziatrice. Per continuare
premete nuovamente la barra spaziatrice. Per riprodurre nuovamente l’area
evidenziata dall'inizio, premete il tasto “P”.

Ascolto Accurato (Scrubbing) dell' Audio
Lo scrubbing audio vi aiuta nell’effettuare operazioni di montaggio accurate. Per
selezionare l’accuratezza dello scrubbing aprite la finestra selezionando, dal menù
principale,  File> Preferences> General. Potete selezionare tempi di scrub da 1/30
di secondo ad 1 secondo. Più grande è il numero selezionato e più sarà l’audio che
ascolterete, dal momento che riproducerete sezioni più lunghe. Inoltre il suono sarà
più chiaro. Con numeri più piccoli ascolterete meno audio e il suono sarà meno
distinto. La vostra scelta dipende dal tipo di audio che state elaborando e dalle
vostre preferenze personali.
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Ascolto accurato di una clip senza
effettuare cambiamenti:
1. Selezionate una clip.
2. Selezionate il pulsante Watch Clip posto sulla barra degli strumenti. Sulla

vostra clip apparirà un cursore a forma di lente d’ingrandimento, che mostra il
timecode in un piccolo riquadro posto al di sopra del cursore.

3. Muovete il cursore lungo la clip. Potete ascoltare l’audio (e vedere il video)
mentre muovete il cursore.

Ascolto Accurato di una clip durante
l’elaborazione audio:
1. Selezionate una clip. Se vi interessa la parte audio di una clip video, aprite la

parte audio.
2. Cliccate sulla linea del volume dell’audio e trascinatela a destra e sinistra per

ascoltare l’audio e vedere il video. Verrà creata una maniglia.
3. Utilizzate i tasti freccia in alto e freccia in basso o il mouse per muovere le

maniglie audio per effettuare regolazioni con riscontro audio e numerico.
Nota: Lo scrubbing audio sarà abilitato quando utilizzate lo strumento rasoio,
posizionate degli indici, o quando variate la lunghezza della clip trascinandone i
bordi.

Ascolto accurato di tutte le clip:
1. Cliccate sul righello della Timeline per attivare la linea bianca e rossa di

riproduzione.
2. Trascinate la linea di riproduzione lungo la Timeline. Potrete ascoltare l'audio

miscelato assieme al video mentre muovete il cursore.
3. Quando rilasciate il pulsante del mouse, potete utilizzare i tasti freccia destra e

sinistra per muovere, un fotogramma alla volta, la linea di riproduzione a
destra o sinistra lungo la Timeline.
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Audio Durante le Transizioni
Quando posizionate due clip video sulle tracce V1 e V2 della Timeline
sovrapponendole, Video Action inserirà tra esse una transizione sulla traccia X.
L'impostazione di base prevede che all'audio venga effettuata una dissolvenza
incrociata (il volume della clip 1 viene ridotto del 100%, mentre il volume della clip 2
parte da -100%).

Questa impostazione di base per la gestione dell'audio durante le transizioni può
essere modificata selezionando dal menù principale File> Preferences> General
abilitando o disabilitando l'opzione "Audio Auto cross fade at transitions". Prestate
attenzione al fatto che non potete effettuare un'impostazione individuale per ogni
clip, ma solo per l'intera Timeline. Ad ogni modo, se volete che una sola clip audio
non venga dissolta, potete regolare il volume in modo che questo, nell'arco della
transizione, vada dal 100% al 200%. Con questa procedura la dissolvenza
dell'audio verrà cancellata. Alla stessa maniera potete variare il volume della clip il
cui audio assolve, impostandolo tra il 200% e il 100% nell'arco della transizione, in
modo che l'assolvenza venga cancellata.

 (Nota: Dividendo l'audio dal video, la dissolvenza automatica viene persa).

Fate attenzione alla
dissolvenza audio
automatica

Prestate attenzione
al modo in cui la
dissolvenza
incrociata dell'audio è
stata cancellata
regolando le linee del
volume delle clip.
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Separazione dell'Audio dal Video
Molte volte vi sarà necessario dividere l'audio dal video in modo tale da
poterli muovere ed modificare separatamente. Per separare l'audio dal
video selezionate la clip sulla Timeline. Cliccate sul pulsante V/A posto
sulla barra degli strumenti. L'audio verrà posizionato su A1 e i VU Meters
saranno immediatamente disabilitati.

Se quando separate l'audio dal video, una clip audio è già presente sulla traccia A1
della Timeline, la traccia audio preesistente sarà spostata automaticamente in
basso sulla prima traccia audio disponibile.
Quando la clip audio viene allineata alla sua clip video (nella sua posizione
originale), il sincronismo (Sync)verrà mostrato all'estrema destra di entrambe le
clip.
Se volete unire nuovamente l'audio ed il video, potete selezionare la clip audio e
cliccare sul pulsante V/A. (Nota: non potete selezionare la clip video per riunirla con
la clip audio.) L'audio può essere riunito al video  anche dopo che è stato mosso o
dopo che ne avete variato la lunghezza. Ad ogni modo, quando riunite  l'audio al
video, ogni variazione della lunghezza che avete effettuato all'audio sarà perso. I
cambiamenti al volume saranno conservati.
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Utilizzo di Sound Forge
Video Action viene fornito assieme a Sound Forge XP. Sound Forge è un
pacchetto software dedicato all'editing dell'audio, che ha numerose funzioni
avanzate per l'elaborazione dell'audio. Se volete effettuare elaborazioni
estremamente accurate potreste trovare più vantaggioso effettuarle con Sound
Forge. Quest'ultimo può essere anche utilizzato per caratterizzare il vostro audio
con effetti speciali.
Potete aprire i vostri file RVA in Sound Forge e modificarne la porzione audio
senza cambiarne la porzione video. Potete editare anche file AVI o WAV. Se avete
un file audio in un altro formato e volete utilizzarlo in Video Action, potete utilizzare
Sound Forge per convertire il file nel formato WAV.
Per maggiori informazioni su Sound Forge consultate la Guida sul CD di Video
Action in formato PDF.
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Per maggiori dettagli sull'uso di Sound Forge, per piacere, consultate il manuale di
Sound Forge, che vi è stato fornito nel formato pdf nel vostro CD.

Glossario
A

A/B Roll Editing Elaborazione da due videoregistratori sorgenti, “A” e “B”, ad un
terzo che registra.

Acustica  Le caratteristiche di un ambiente che influenza la qualità del suono
A/D Converter Una periferica elettronica che converte le forme d’onda analogiche

in numeri digitali binari.
AES Audio Engineering Socety. Controparte Nord Americana dell’EBU. Il formato

digitale AES/EBU è il formato per i segnali d’ingresso digitali, utilizzati da
schede per il mixing audio equipaggiate sia con ingressi digitali che analogici.

Aliasing Creazione di errori dovuti a perdita di dati, causati dal tentativo di
superare le limitazioni dei mezzi di memorizzazione. L’Audio Aliasing è
causato dal campionamento di una segnale a meno del doppio della naturale
frequenza del segnale. Il Video Aliasing causa errori dell’immagine, conosciuti
col nome di artefatti, che sono visibili sullo schemo. Quando si prova a
registrare su un supporto video analogico, questi errori sono causati dalla
frequenza di di informazioni video troppo alta. Quando si registra su un mezzo
digitale, gli artefatti possono essere causati dal sistema di compressione
utilizzato; la quantità degli artefatti dipende dall’ammontare e dal tipo di
compressione. Esempi di Aliasing Video sono: seghettature e formicolii delle
immagini.

Alpha Channel  Nella computer grafica, ogni canale ha tre canali per le
informazioni relative al colore: rosso, verde e blue, in varie profondità di bit.
Nella visualizzazione a 24 bit, sono presenti 8 bit per colore per ogni pixel.
Quando si incontra un file d’immagine a 32 bit, gli altri 8 bit sono relativi
all’Alpha Channel, o canale della trasparenza che fornisce delle informazioni
supplementari per propositi di compositing. NelI’Alpha Channel i pixel bianchi
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definiscono i pixel opachi, mentre quelli neri i trasparenti. I 256 valori di grigio
intermedi definiscono invece la trasparenza parziale.

AM Ampiezza di Modulazione. Uno metodo per trasmettere i dati, cambiando
(modulando) l’ampiezza di un segnale.

Ampiezza La dimensione dei picchi ed escursioni di un segnale. L’ampiezza viene
misurata con diverse unità di misura, e ciò dipende dal tipo di segnale da
misurare.

Analogico Un dato che viene registrato in modo continuo in un intervallo di tempo.
Oppure una rappresentazione di dati utilizzando diversi valori di voltaggio
elettrico. I dati analogici sono sensibili al rumore, dal momento che anche una
piccola variazione del segnale in ingresso può causare una variazione in
uscita.

Ampiezza di Banda Video  Escursione tra la frequenza compresa tra quella più
alta e quella più bassa di un segnale video. In generale, più alta è la ampiezza
di banda video, e maggiori sono le informazioni che possono essere
registrate, da cui deriva una migliore qualità delle immagini video.. Le
ampiezze di banda utilizzate di solito nelle lavorazioni da studio hanno valori
compresi tra 3 e 12 MHz. I videoregistratori del mercato consumer
raggiungono in genere valori compresi tra 3 e 5.5 MHz.

Anti-Aliasing Il processo elettronico della riduzione dell’Aliasing. Per ridurre
l’aliasing possono essere utilizzate numerose tecniche, tra cui filtri,
campionamento ad alte frequenze e sistemi speciali di compressione digitale.

Artefatti Gli errori causati da perdite di dati dovuti al tentativo di superare le
limitazioni dei mezzi di registrazione.

Aspect Ratio Coefficiente che lega l’altezza alla larghezza di un’immagine.
L’aspetto di un televisore o in monitor è in genere di 4/3 (4:3). L’aspetto della
televisione ad alta definizione  (HDTV) è di 16:9.

Attack La velocità di incremento del volume. Questo coefficiente indica con quale
velocità una periferica può rispondere ad un incremento del volume. (guarda
Decay)

Audio (Ampiezza d’onda) E’ l’escursione della frequenza audio che influenza
direttamente la fedeltà di un suono. Ad un’ampiezza dibanda più alta
corrisponde una una migliore fedeltà del suono.

Audio Dubbing Rimpiazzamento del segnale audio su una cassetta già registrata,
senza intervenire sul segnale video.

AVI Audio/Video Interlacciamento. Il formato di file utilizzato dal sistema operativo
Windows per combinare dati audio e video.

B
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Band-Pass Filter  Periferica elettronica utilizzata per limitare la risposta al di sopra
o al di sotto di una certa ampiezza di banda; è l’opposto del filtro notch.
(guarda Notch filter)

Batch Digitize/Record Processo automatico per la cattura di gruppi di clip o
sequenze

BETAMAX e BETACAM Betamax e Betacam sono due formati rispettivamente di
videocassette e telecamere, sviluppati dalla Sony. Il Betamax è un formato di
videocassetta che utilizza nastri da mezzo pollice; è stato il primo formato
utilizzato dai videoregistratori domestici. Il Betacam è un sistema video
professionale per videoregistratori e telecamere portabili, che utilizza il video
per componenti. (Guarda component)

BIOS Un termine utilizzato per le schede madri dei computers che sta per Basic
Integrated Operating System.

Bit Numero binario.
Black Burst Segnale video a colori che comprende sincronismo, color burst e

nero. Viene utilizzato per sincronizzare altre sorgenti video. I generatori di
Black Burst vengono utilizzati negli studi video per “bloccare” tutte le
periferiche su un unico segnale.

Black Level  Voltaggio in un segnale video cui corrisponde il nero sullo schermo.
Blanking Level  Livello del voltaggio prodotto alla fine di ogni linea orizzontale

dell’immagine, che rende l’elettrone invisibile per tracciare la nuova linea
visibile. Separa la porzione del segnale video contenente le informazioni
dell’immagine dalla porzione che contiene le informazioni di sincronizzazione.
Conosciuto anche come “pedestal”.

Blanking Interval (orizzontale e Vericale) Intervallo di blanking orizzontale è
l’intervallo di tempo compreso tra la fine di una linea orizzontale e l’inizio della
linea orizzontale successiva. Durante un intervallo di blanking, il facso di
elettroni di un monitor viene ridotto in modo da rendere invisibile la traccia di
ritorno. Durante l’intervallo di blanking vengono mandate pulsazioni di
sincronizzazioni e le informazioni di riferimento del colore. L’intervallo di
blanking verticale è il tempo necessario per muoversi dall’angolo dello
schermo in basso a destra a quello in alto a sinistra, per cominciare atracciare
un nuovo semiquadro. L’intervallo di blanking verticale viene impiegato per
inviare vari tipi di segnali di sincronizzazione.

BNC (Connettore) Connettore con blocco a rotazione, utilizzato per
videoregistratori ed apparecchiature video.

Bouncing (delle tracce) Processo di mixaggio di traccie preesistenti in una vuota,
allo scopo di liberare altro spazio per la registrazione.

Bus Un percorso di segnale al quale possono essere connessi uno o più ingressi
per alimentare un qualsiasi numero di uscite.

Byte Insieme di bit, in genere composto da 8 elementi. (Guarda bit, Gigabyte e
Megabyte)
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C
CATV Acronimo di TV via cavo
CCIR Consultative Committee for International Radio, ora conosciuta come ITU-RB

(International Telecommunuications Union-Radio Branch).
CCTV TV a circuito chiuso. Sistema utilizzato per propositi di sorveglianza, medici

ed educativi.
Character Generator Periferica che genera elettronicamente testi,  che possono

essere sovraimposti ad un segnale video, spesso abbreviata in CG. Il testo
viene solitamente immesso con una tastiera. Un CG permette la selezioni di
numerosi tipi di carattere, colori stili e sfondi, e può memorizzare numerose
pagine per il riutilizzo a posteriori.

Chroma I valori del colore (rosso, verde e blue)  contenuti in un immagine video. Il
Chroma è determinato sia dall’Hue (angolo di fase) e dalla saturazione
(Ampiezza) del segnale del colore. Un segnale video combina assieme i valori
di crominanza e quelli di luminanza (i valori del bianco) nei segnali video
composito, YU o Y/C. (Vedi Component, Composito, S-video, YUV e Y/C)

Chroma Key(Chiave Cromatica) Il processo di combinazione di due segnali
rimpiazzando una gamma cromatica di uno dei due segnali con l’altro
segnale. Questo processo in genere viene utilizzato riprendendo un’immagine
a colori su uno sfondo di un’unica tinta (colore chiave). L’immagine di sfondo
viene poi inserita al posto del colore chiave.

Chrominance (Crominanza) La porzione del colore del segnale, che rappresenta
la saturazione e la tinta in un punto particolare dell’immagine. Più alta è la
crominanza, più è forte il colore. Il nero il grigio e il bianco non hanno
crominanza, ma tutti i segnali a colori sono contraddistinti da luminanza e
crominanza. (Vedi Luminanza)

Clip Un singolo segmento composto da audio e/o video. Una clip contiene il nome
del nastro, le informazioni e i commenti associati ad esso.

Clipping Forma di distorsione, dove i picchi delle forme d’onda vengono  tagliati
dall’inabilità del sistema di raggiungere voltaggi più elevati.

Coassiale (Cavo) Un cavo costituito da un coduttore interno e un connettore
cilindrico esterno; viene utilizzato per molte connessioni video. Un cavo
coassiale e poco soggetto al rumore video.

CODEC Abbreviazione di Compressore/decompressore. Periferica hardware o
applicazione software che prende file digitali per produrre file compressi, in
grado poi di decomprimere il suddetto file in video digitalizzato.

Color Bars Campione generato elettronicamente, costituito da 8  barre di colore di
uguale ampiezza, utilizzate per stabilire un riferimento appropriato sul colore
prima della registrazione o della riproduzione.

Color Burst Un color burst è un segnale di sincronizzazione del colore utilizzato
per fornire un livello di riferimento per le informazioni del colore in un segnale
video. Viene utilizzato sia come riferimento per l’ampiezza, per l’intensità e la
fase per l’hue.
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Color Decoder  Periferica che divide un segnale composito o Y/C nelle sue
componenti più semplici. Viene utilizzato per ottenere i segnali richiesti da un
monitor video.

Color Subcarrier  Segnale a 3.58MHz (PAL) addizionato alla televisione in bianco
e nero per aggiungere il colore. Questa frequenza è troppo alta per poter
essere rilevata dalle impostazioni in bianco e nero. Le apparecchiature a
colori riescono a decodificare e visualizzare le informazioni del colore.

Compilazione  Operazione in cui uno o più file sorgenti (audo e/o video) vengono
processati e combinati assieme in un unico file di uscita.

Component Video  Formato di registrazione video di alta qualità, che separa le
porzioni del segnale di luminanza e crominanza del segnale. Alcune
periferiche professionali (Betacam, Beta SP e MII) e alcune amatoriali (S-VHS
e Hi-8), sono state progettate per registrare separatamente le componenti
video. Il component video utilizza numerosi metodi di registrazione: YUV
standard (Y, R-Y, B-Y); RGB (rosso, verde, blue); Y/C (luminanza e
crominanza). Il tipo di component video che permette la qualità migliore è lo
YUV, che divide il segnale in tre parti: la luminanza (Y); il segnale del rosso
meno la luminanza (R-Y); e il segnale del blue meno la luminanza (B-Y).
Utilizzando questi tre segnali può essere calcolato il verde. L’Y/C (utilizzato
dai formati S-VHS e HI-8), separa il segnale video in due parti: luminanza e
crominanza. (Guarda Video Composito, Y/C e YUV)

Composito (Video)   Vedi Video Composito
Compressione  Processo matematico che riduce l’amontare dei dati, senza

perdere l’integrità dell’informazione iniziale. La compressione può degradare
la qualità dell’informazione, come nel caso degli Artefatti. (Guarda Aliasing,
Artefatti e JPEG)

Compressore  Processore del segnale audio che riduce la gamma dinamica del
segnale.  Differisce dal limitatore perchè viene utilizzato per campionare la
maggior parte o tutto il campione, mentre il limitatore viene impiegato per
processare unicamente i picchi. (Vedi Limitatore)

Contrasto  Il controllo del contrasto su un televisore o un monitor, regola il livello
del bianco dell’immagine. Inoltre il contrasto può essere regolato intervenendo
sul livello del nero.

Control-L  (Guarda LANC)
CPU  Central Processing Unit. In parole semplici, il cervello del computer, il

microprocessore principale.

D
D1/D2/D3  Formati di registrazione e riproduzione video digitali. Il sistema D1

utilizza il component video, mentre il D2 e il D3 utilizzano il video composito. Il
D1 e il D2 utilizzano nastri magnetici da 19mm, mentre il D3 utilizza nastri da
½ pollice (12.7mm). Utilizzando formati digitali, molti problemi di riproduzione
e registrazione vengono minimizzati o eliminati, come la distorsione o la
perdita di generazione.
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D/A  (DAC) Digital-to-Analog Converter, convertitore da digitale ad analogico.
Periferica elettronica che converte segnali digitali binari in forma d’onda
analogiche continue.

DAT  Digital Audio Tape. Un sistema digitale per la registrazione e la riproduzione
dell’audio bassato su nastri, con un tasso di campionamento superiore a
quello del CD.

db  Abbreviazione di Decibel. (Guarda Decibel)
Decay  Velocità di abbassamento del volume. Il coefficiente di decay misura la

velocità in cui una periferica può ridurre un suono al di sotto del livello
selezionato. (Guarda Attak)

Decay  (Tempo di) Tempo necessario, in secondi, per un suono per ridursi ad un
milionesimo (60 db) del suo picco iniziale. Gli studi di regisrazione hanno
tempi di Decay relativamnte brevi, mentre le sale da concerto hanno tempi di
decay compresi tra 2 e 8 secondi.

Definizione  Quantità di dettagli disponibili: quanto più è alta la definizione tanti più
più sono i dettagli. La definizione dell’immagine fa riferimento alla possibilità di
distinguere dettagli molto piccoli, ad esempio due linee molto sottili, vicine e
parallele appaiono come due linee e non una leggermente più spessa. I
dettagli più piccoli sitrovano nella regione del segnale video a frequenza più
alta, per questo sono molto sensibili alla degradazione del segnale.

Digitale  Metodo di rappresentazione delle informazioni attraverso numeri binari. I
dati digitali vengono campionati in intervalli di tempo molto piccoli e i valori
risultanti vengono registrati come come numeri binari. I dati digitali sono molto
resistenti al rumore e a qualsiasi disturbo non abbastanza grande da oscurare
la differenza tra lo zero e l’uno. La registrazione digitale è anche esente da
perdite di qualità.

Digitalizzazione  Conversione di un’informazione analogica in numeri binari. Nel
caso dell’editing video non lineare, il trasferimento dei dati video e audio negli
hard disk del computer. Questo processo può utilizzare la compressione.
(Vedi Compressione)

DIN  (Deutshe Industrie Norme) Connettore standard internazionalmente. I
connettori DIN trasferiscono segnali sia audio che video  e sono comuni sugli
apparecchi Europei.

Disco di Sistema   Disco primario del computer. In questo disco sono contenuti i
file di avvio e del sistema, operativo e i dei programmi applicativi.

Distorsione Quando un segnale cambia in modo incontrollato, si dice che è
soggetto a distorsione. Nel video, di solito la distorsione si riferisce a
cambiamenti della luminanza o della crominanza, ma può anche riferirsi al
contrasto , immagini ruotate, colori sbagliati o “neve”. Nell’audio, la distorsione
si riferisce ad ogni cambiamento indesiderato della forma d’onda o del
segnale, causati dall’introduzione di segnali non puri. I tipi più comuni di
distorsione sono Armonica, d’Intermodulazione, di Crossover, di Transito e di
Fase.

Dither  Metodo utilizzato per sfumare un’immagine digitale, in modo che linee
scalinate appaino più uniformi.
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Drive Array  Periferica di immagazzinamento dati interna  o esterna, nella quale
numerosi dischi sono configurati per lavorare simultaneamente in parallelo.
Da questa configurazione scaturiscono prestazioni in scrittura e lettura molto
elevate. Si hanno miglioramenti anche nel tempo di accesso.

Drop Frame Time Code  Dal momento che nell’NTSC i fotogrammi vengono
riprodotti a 29.97 Fps invece che a 30, ogni minuto vengono persi due
fotogrammi per “colmare” questa discrepanza.

Dropout  Perdita momentanea, parziale o completa, dell’immagine o del suono;
suò essere causata da polvere, sporco sul nastro o sulle testine, da difetti nel
livello dell’ossido del nastro magnetico, danneggiamento del nastro, e così
via.

Dry  Aggettivo applicato a clip audio a cui non sono stati applicati effetti.
DSP  Digital Signal Processor. Il chip audio digitale che processa i segnali audio.
DV  Digital Video.  Sistema di registrazione utilizzato come base per i formati video

MiniDVtm , DVCAMtm  e DVCProtm. Il fomato utilizza il campionamento 4:1:1 (4
campionamenti dell’Y, 1 per l’U e 1 per la V) e una compressione DCT
(Discrete Cosine Transform) di 5:1. (Guarda YUV)

DV(Periferica) Termine utilizzato genericamente quando ci si riferisce ad una
telecamera o un videoregistratore equipaggiati con un’interfaccia FireWiretm

(IEEE-1394)

E
EBU  European Broadcasting Union. Controparte della Nord Americana AES.

(Guarda AES)
Echo  Ripetizione ritardata di un suono al quale è stata aggiunta intenzionalmente

una curva di frequenza o di colorazione differente.
EDH  Error Detenction Handling. Rileve gli errori nel segnale SDI (D1).
Edit Decision List (EDL)  Compilazione generata dal computer o scritta a mano di

tutte le modifiche della postproduzione da eseguire in un lavoro video.
Editing Video Non Lineare  Sistema di elaborazione dei filmati che prende

vantaggio dal pressochè istantaneo tempo di ricerca dei sistemi informatici
(Hard Disk, CD Rom, Laser Disk). Utilizzando questo tipo di strumenti,
l’accesso al materiale può essere non lineare; il tempo di accesso non è
influenzato dalla sua posizione sulla periferica di immagazzinamento.

Edit  Point  Posizione in cui, in un video, vengono effettuati un evento o una
modifica

E-E  Abbreviazione per Electronics-to-Electronics. Un’impostazione di una
periferica elettronica che consente il passaggio di un segnale dall’ingresso
all’uscita, senza passare attraverso il mezzo di registrazione fisica.

Enhancing  Miglioramento dell’immagine video attraverso l’innalzamento delle alte
frequenze di un segnale degradato durante una registrazione. Ce ne sono di
molti tipi, i più comuni accentuano le differenze tra immagini luminose e scure.
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EQ  Abbreviazione per equalizzazione.
Equalizzazione  Modificazione selettiva della risposta di frequenza di un segnale

audio.
Equalizzatore  Serie di filtri variabili che alterano la riposta di frequenza;

conosciuto anche come controllo dei toni. Un equalizzatore può essere
utilizzato per compensare una riduzione di alcune frequenze nella
trasmissione o nella registrazione, oppure per personalizzare la riproduzione
del suono.

Exciter  Utilizzato per innalzare la “presenza” di un segnale audio. L’apparente
loudness e la comprensibilità di un segnale audio vengono innalzate senza
intervenire sul bilanciamento delle frequnze o dei guadagni, ma aggiungendo
armonici. (Vedi Psicoacustica)

Expander  Periferica elettronica utilizzata per incrementare la gamma dinamica di
un determinato programma o segnale d’ingresso. Opposto al compressore.
(guarda compressore)

F
Fader  Levetta o potenziometro, o la loro rappresenzione computerizzata, utilizzati

per controllare l’ampiezza di segnali audio o la trasparenza di canali video.
Field  Traduzione inglese di Semiquadro (vedi semiquadro).
Fotogramma  Singola immagine di una sequenza video. E’ costituito da due

semiquadri.
FPS  Fotogrammi per secondo.
Frame Traduzione inglese di fotogramma televisivo
Frame Synchronizer  Periferica elettronica digitale atta a sincronizzare due o più

segnali video. Utilizza uno dei segnali come riferimento e lega gli altri ai
sincronismi e al color burst del segnale di riferimento (reference). La
sincronizzazione permette a due immagini video di essere elaborate fra loro
con dissolvenze, tendine e altri tipi di elaborazione. (consultate Genlok e
TBC.)

Frequenza  Numero di vibrazioni per secondo di una forma d’onda, espressa in
Hertz (Hz), dove un Hz rappresenta un ciclo per secondo. Per le registrazioni
audio, viene accettata come standard per una buona fedeltà, una prestazione
in frequenza compresa tra 20Hz e 20KHz.

G
Gamut Errors  Valori di colore che sono al di fuori dell’escursione possibile e che

quindi danno come risulata il clipping (consultate clipping), colori NTSC illegali
e altri problemi.

Generation Loss   Traduzione inglese di perdita da generazione (consultate
perdita da generazione).
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Genlock  Metodo di sincronizzazione che involve la generazione di un segnale la
cui temporizzazione viene legata ad un altro segnale. Le apparecchiature per
il genlock permettono ad una periferica video di legare i propri impulsi di
sincronizzazione a quelli ricevuti da un’altra periferica, un master generator
sync o un TBC. (Consultate TBC e Sincronizzazione.)

H
Hard Disk  Periferica comune per l’immagazzinamento dei dati in un computer. Per

l’utilizzo video, un hard disk devono avere, come requisiti minimi:
Un tempo di accesso inferiore a 10 millisecondi
U trasferimento dati continuo di 3MB/s
Un tempo massimo per il richiamo all’attività di 33 millisecondi

I
IDE Integrated Drive Electronics. Standard di controllo per Hard Disk.
Interlacciato (Video) Sistema di rappresentazione sviluppato per la televisione che

combina o interlaccia, due semiquadri per produrre ogni fotogramma video.
Ogni semiquadro contiene linee intervallate: utt ele linee con numero dispari
sono contenute dal semiquadro 2 mentre quelle pari dal semiquadro 1.
Questo tipo di rappresentazione permette di raddoppiare la frequenza di
rinfresco dello schermo video. Pertanto il tremolio delle immagino viene
notevolmente ridotto. L’interlacciamento può causare effetti indesiderati con
immagini generate da un computer, pertanto deve essere compensato
durante il trasferimento delle immagini.

ISA  Industry Standard Architecture. Slot sulle schede madri dei computer che
servono per l’installazione di schede addizionali. In questo momento il suo
utilizzo è progressivamente rimpiazzato dallo slot PCI.

J
JPEG Joint Photographic Experts Group. JPEG è una sigla che identifica un

formato digitale di compressione per immagini, al quale è stato lo stesso
nome della commissione che lo ha creato. Sono disponibili numerose opzioni
di comoressione per coniugare la qualità allo spazio occupato. Come risultato,
però , non tutti i formati di file JPEG sono direttamente compatibili.
L’estensione di questo file è spesso abbreviata in JPG.

K
Key Frame In una sequenza video, parte dell’immagine rimane immutata. Alcuni

schemi di compressione prendono grosso vantaggio da questo fenomeno,
creando dei fotogrammi chiave (key frames), che faranno da riferimento per
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un’intera sequenza. Registrando una sola volta la parte immutata
dell’immagine, la quantità di dati necessari per l’immagazzinamento
diminuisce notevolmente.

L
Limiter  Processore del segnale audio che riduce la gamma dinamica di un

segnale. Differerisce dal compressore perché in genere il Limiter viene
utilizzato solo per processare i picchi, mentre il compressore viene utilizzato
per processare tutto il segnale o una sua grossa parte.

LTC (Longitudinal Time Code)  Numeri per l’identificazione codificati come
segnale audio che viene registrato nel senso longitudinale.

Luminanza Luminosità di un segnale video. La Luminanza che è generalmente
rappresentata dalla lettara Y, è la componente bianco e nero di un segnale
video. Se la luminanza è alta, l’immagine è chiara; se invece è bassa,
l’immagine è scura.

M
Master  Videocassetta di prima generazione; un “Master Elaborato” è invece la

prima generazione di un filmato ottenuto tramite l’elaborazione di altri master.
Le duplicazioni costituiscono le differenze di generazione.

Monitor  Schermo che riceve le immagini direttamente da una telecamera, un
videoregistratore o da un computer. Un televisore, invece, riceve segnali in
RF (radiofrequenza), da un’antenna o un sistema via cavo. Un monitor può
utilizzare una gran varietà di connettori, tra cui RCA, BNC e S-Video.

MJPEG  Motion JPEG.
MPEG  Motion Picture Expert Group. Nome di una famiglia di standard di

compressione  per video in movimento che utilizza metodi di compressione
sia intraframe che interframe. Come lo standard JPEG, l’MPEG include
opzioni di compressioine per conciliare spazio e qualità.

N
Noise  Traduzione inglese di rumore. (Consultate rumore.)
Noise Gate Periferica utilizzata per modificare le caratteristiche del rumore di un

segnale. Nel video, un noise gate riesce a fornire una ottimale soppressione
della neve.

Noise Reduction Processo elettronico utilizzato per ridurre i livelli audio e video.
Nel video, la noise reduction più efficace è quella che prevede la
digitalizzazione del segnale video e la sua relativa analisi pixel-pixel. In audio,
ci si riferisce a periferiche di passaggio multibanda che attenuano un segnale
audio quando è al di sotto di un threshold determinato dall’utente. Suoni
indesiderati sono ridotti fino al punto in cui il programma è in grado di
mascherarli.
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Non-Drop Frame Time Code  Modalità di time code (nel sistema NTSC) che
identifica ogni fotogramma video con una sequenza numerica divisa in ore,
minuti, secondi e fotogrammi. A causa della discsrepanza tra i 30 fps e gli
attuali 30 fps, questa modalità non rappresenta in maniera accurata la durata
relaedi un programma video. Gneralmente il suo utilizzo è limitato a
programmi di durata molto breve (spot pubblicitari) oppure ad applicazioni
non-broadcast. (Consultate drop frame time code)

Notch Filter  Periferica elettronica utilizzata per rimuovere suoni indesiderati in una
specifica banda di frequenza, con un’interferenza minima con le bande
adiacenti.

NTSC  (National Television Standards Commitee) è uno standard che è
stato sviluppato negli USA durante gli anni 50’. È stato il primo
sistema in bianco e nero compatibile con la trasmissione del colore
simultanea, realizzato per la trasmissione pubblica. Viene utilizzato in
USA, Canada, Giappone e molti altri paesi in cui viene utilizzata la
corrente elettrica alternata a 60Hz. L’NTSC viene letto anche come
“Never Twice the Same Color” (mai due volte lo stesso colore) dal
momento che a volte genera degli errori. La definizione del nero non è
standardizzata nell’NSTC. Nel Nord America viene definito nero tutto
ciò che è al disotto di 7.5 IRE. In Giappone il nero è definito da 0 IRE.

O
Off Line  Sistema di elaborazione in cui vengono utilizzate immagini a bassa

qualità per prendere decisioni per l’elaborazione, che poi verranno utilizzate,
tramite time code, sulle immagini in piena qualità.

On Line Sistema di elaborazione nella quale la qualità vista dall’operatore è la
stessa di quella vista dallo spettatore.

8mm  Formato di registrazione e riproduzione che impiega nastri magnetici da
8mm. Ha una risoluzione orizzontale di 240 linee ed è stato concepito per uso
domestico.

Overdub  Addizione di materiale musicale o parlato a tracce preesistenti.
Oversampling  (Sovracampionamento) Utilizzo di un tasso di campionamento più

elevato di quello normale nei convertitori digitali-analogici, in modo da
correggere la distorsione che può essere causata da alcuni filtri analogici.
(Consultate campionamento)

Overscan  Area dell’immagine video televisiva che rimane all’esterno dell’area
visibile dei televisori. Le immagini video in genere sono di dimensioni maggiori
rispetto a quelle fisiche degli schermi, quindi i bordi delle immagini possono e
non possono essere visibili, a seconda delle variazioni delle impostazioni dei
televisori. Nelle produzioni video, pertanto, la parte critica per l’elaborazione è
quella centrale, chiamata spesso  “safe title” area (area in cui il titolo appare di
sicuro). I monitor professionali possono visualizzare l’intera immagine video,
inclusa l’area di overscan. (Consultate Safe Title Area.)
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P
PAL (Phase Alternate Line) è una forma modifica dell’NTSC. È stato

sviluppato in Germania, e viene impiegato in molte parti del mondo
dove viene utilizzata una corrente alternata di 50Hz. Il PAL è riuscito a
migliorare alcune delle limitazioni dell’NTSC, in particolare gli errori di
tinta che erano un problema nell’NTSC.

PCI  Pheripheral Computing Interface. Tipo di slot posti sulle schede madri dei
computers che possono essere utilizzati per l’installazione di schede
addizionali. Gli slot PCI sono più corti dei più vecchi slot ISA o EISA.
(Consultate ISA)

Pedestal  Piccolo voltaggio DC all’interno del segnale video che ha la funzione di
indicare il livello di blanking dell’immagine. Viene utilizzato nel segnale video
come riferimento per i livello di bianco e del grigio.

Perdita da Generazione  Perdita di qualità in ogni copia di generazione
successiva, evidente in special modo nelle copie analogiche. Le cause
principali della perdita da generazione sono costituite dalla risposta in
frequnza limitata dei nastri delle cassette audio/video e dall’imperfezione delle
attrezzature elettroniche. I formati digitali sono moltomeno suscettibili alla
perdita da generazione perché piccole variazioni del segnale non influenzano
i dati; ogni copia digitale è essenzialmente una copia perfetta dell’originale.

Plug-Ins  Le plug-ins software sono dei programmi esterni che vengono utilizzati
come espansione del programma principale. Fanno parte di questa categoria
filtri audio e video, effetti speciali e controlli esterni.

Porta Seriale  Porta di Ingresso/uscita dei computer, attraverso la quale questi
ultimi dialogano con periferiche eterne. I protocolli RS-232/RS-422 utlizzano
una porta seriale standard.

Proc Amp  Processori di amplificazione che permettono la regolazione
dell’intensità del colore (livello del nero, livello video, livello del chroma) e
della fase (hue, bilanciamento del bianco), relativi ad un segnale video.

R
Random Access Device  Perifesica ad accesso casuale. Periferica per

l’immagazzinamento dati, nella quale i contenuti possono richiamati con un
tempo di accesso che non varia a seconda della posizione sul mezzo di
immagazzinamento.

Raster  Il percorso delle linee di scansione orizzontali nell’immagine video.
Render  Ultimo stadio nella creazione dell’immagine, nel quale vengono inclusi tutti

i dettagli desiderati per il prodotto finale. Uno o più elementi sorgenti vengono
combina per ottenere un solo risultato. Il rendering può essere un processo
molto lungo, per questo motivo vengono utilizzate immagini semplificate
mentre vengono ancora effettuati cambiamenti (preview o anteprima).



       Video Action RT

______________________________

322

Risoluzione   Misura della quantità di dettagli presenti in un’immagine. La
risoluzione video si riferisce in genere alla risoluzione orizzontale, e viene
valutata tramite il numero di linee visibili su un campione per test. I formati per
il mercato consumer, VHS e 8mm, raggiungono, in genere, 240 linee di
risoluzione; le immagini televisive trasmesse raggiungono le 330 linee; S-VHS
e Hi-8mm raggiungono le 400 linee; le telecamere Beta SP raggiungono le
770 linee.

Reverb  (Riverbero) Immagini sonore multiple miscelate fra loro (eco non
discernibili individualemnte fra loro), causate dai riflessi su porte, pavimento,
soffito e altre superfici che non assorbono il suono.

RGB  Red/Blue/Green. Rosso/Blue/Verde. Colori primari di un monitor o uno
schermo televisivo, e componenti elementari del segnale video a colori.
(Consultate Component, Composito e YUV)

Rough Cut  Tentativo di ordinazione delle clip video in sequenza, lunghezza e
contenuti approssimati. Serve a dare indicazioni preliminari su un lavoro.

RS-232 / RS-422  Standard di comunicazione dei computer utilizzati nel video per il
controllo di alcune attrezzature video.    

Rumore  Ogni segnale indesiderato. In elettronica, termine  generale utilizzato per
indicare un segnale elettrico indesiderato al segnale originale. IL Rumore
Video si manifesta generalmente come neve, granulosità, immagini fantasma.
IL Rumore Audio si manifesta invece come fruscìo.
RVA  Formato di file del sistema Perception RT utilizzato per la registrazione
dell’audio.

RVD  Formato di file del sistema Perception RT utilizzato per la registrazione dei
file video.

S
Sampling  Campionamento. Processo in cui alcune varibili continue sono misurate

a discreti (di solito uniformi) intervalli di tempo. Nell’audio, è il processo della
misurazione del voltaggio istantaneo di un segnale audio che varia
continuamente, ad intervalli regolari. I livelli misurati sono espressi
numericamente in codifica binaria, e vengono poi registrati.  Essi formano un
dettagliato insieme di informazioni che permettono la replica della forma
d’onda originaria dell’audio che deve essere generata dal lettore digitale.

Sampling Rate  Numero di campionamenti misurati ogni secondo  in un particolare
sistema di registrazione digitale. Esso è di 44.1KHz per il CD e di 48KHz per il
D.A.T. (digital audio tape).

Scan Line   Linea di scansione. Risultato del rapido processo di scansione del
televisore, che “dipinge” una serie di linee orizzontali da sinistra a destra, una
alla volta.

SCSI  Small Computer Systems Interface. Standard di controllo per Hard Disk e
altre periferiche. E’ il tipo di interfaccia utilizzata per le applicazioni
audio/video. La specifica SCSI originale prevedeva l’accesso ad un massimo
di 7 periferiche; l’interfaccia SCSI-2 permette l’accesso a 15 periferiche, con
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un incremento dell’ampiezza di banda. In genere i dischi SCSI sono più veloci
e di dimensioni maggiori ripetto a quelli IDE o EIDE.

SDI  Serial Digital Interface. Utilizzata come porta d’ingresso e d’uscita per il video
in componenti serial digitale (D1). Lo standard D1 è anche conosciuto vome
SMPTE259M.

SECAM  Sequential Couleur Avec Memoire. Standard utilzzato per produrre un
segnale composito per la trasmissione del segnale televisivo a colori,
sviluppato in Francia. Fu sviluppato per sopperire ad alcune delle limitazioni
dell’NTSC. Lo standard SECAM è capace di 625 linee di risoluzione per
fotogramma e di 25 fotogrammi per secondo. Nei paesi che utilizzzano il
SECAM, la maggiorparte delle produzioni video viene effettuata il PAL e poi
convertita in SECAM prima dsella trasmissione.

Seek  Movimento delle testine di un hard disk da una traccia ad un’altra.
Semiquadro  Un fotogramma televisivo è costituito da due metà di fotogramma,

chiamati semiquadri. I due semiquadri non sono costituiti da una continuità di
lineee, sono costituiti, per così dire, da una riga si e una no. Il semiquadro 1
contiene nel sistema PAL le righe pari (la riga 2, 4, 6 etc.), mentre il
semiquadro 2 contiene le righe dispari (1, 3, 5, etc.). Nel sistema NTSC vale il
contrario.
SMPTE Time Code  Society of Motion Picture and Television Engineering
time code. Time code standard utilizzato nelle produzioni video professionali.
E’ un codice digitale che identifica ogni fotogramma come unico valore
temporale espresso nel formato HH:MM:SS:FF, dove HH sono le ore, MM i
minuti, SS i secondi e FF i frames. (Conultate LTC, RC, Time code e VITC)

S-Video  Separated Video. Sistema video che mantiene separate le informazioni di
luminanza (Y) e crominanza . Per questo viene anche chiamato Y/C. Questo
sistema incrementa notevolmente la qualità dell’immagine, non subendo
l’interazione dei segnali.

Sincronizzazione (Sync)  Termine utilizzato in elettronica per descrivere la
temporizzazione orecisa di due segnali o funzioni. Nel video, il sync è un
elemento essenziale per il mantenimento delle giuste temporizzazioni del
segnale video. IL segnale di sync è utilizzato dal monitor per sapere quando e
come iniziare il tracciamento dell’immagine video. (Consultate Blanking, Sync
Orizzontale, TBC e Sync Verticale)

T
TBC  Time Base Corrector. Una periferica TBC viene utilizzata per correggere

problemi di sincronizzazione video, generando una nuova base del tempo e
dei nuovi segnali di sincronizzazione video. Molti TBC hanno anche la
possibilità di regolare la tinta, il colore, la luminosità e il contrasto del segnale
video.

Test Pattern  Combinazione di linee convergenti, di segni di allineamento e di
scale di grigio che appaiono sullo schermo per aiutare nella regolazione
dell’allineamento dell’immagine, della registrazione e del contrasto delle
apparecchiature video.
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Time Code  Codice digitale numerico che identifica ogni frame video in ore, minuti,
secondi e fotogrammi, a partire dall’inizio della registrazione. Ad ogni frame
video viene assegnato un unico indirizzo, requisito indispensabile per
un’elaborazione accurata. I tre sistemi di time code utilizzati per il video sono:
LTC, RC e VITC.

Transcoder  Periferica video utilizzata per convertire un segnale video component
in un altro (es: da RGBa Y/C), oppure da un sistema ad un altro (es: da PAL a
SECAM).

U
U  Componente scalare del segnale video sviluppata per il PAL. U=0.493(B-Y),

dove B sta per il segnale blue e Y sta per la luminanza.

V
V  Componente scalare del segnale video sviluppata per il PAL. V=0.877(R-Y),

dove R sta per il segnale rosso e Y sta per la luminanza.
VITC  Vertical Interval Time Code. Segnale di sincronizzazione registrato come

un’invisibile componente del segnale video, accessibile per l’elaborazione di
precisione.

Video Component  (vedi Component Video)
Video Composito  Formato di registrazione analogico che combina le componenti

luminanza e  crominanza, assieme alle informazioni di sincronismo, di
blanking e di color burst. Il Composito Baseband (non modulato) viene
utilizzato dalle attrezzature professionali e da quelle amatoriali evolute (con
connettori BNC o RCA), mentre il composito RF (modulato), viene utilzzato
dalla maggior parte delle attrezzature video domestiche. Gli standard per la
trasmissione (PAL, NTSC, SECAM) specificano il modo in cui vengono
combinate le informazioni di luminaza, crominanza, impulsi di blanking,
impulsi di sincronismo e di color burst.

Video for Windows  Sottosistema presente all’interno del sistema operativo
Windows®, che facilita la registrazione, l’elaborazione e la registrazione di
mezzi audio e video combinati.

VTR  Video Tape Recorder. Questo termine viene utilizzato di solito quando ci si
riferisce a videoregistratori professionali.

VU Meter   Abbreviazione di Volume Unit Meter. Periferica di misurazione che
indica i valori medi dei livelli, utilizzata per la registrazione e la trasmissione.

W
WAV   Formato di file utilizzato all’interno del sistema operativo Windows® per la

riproduzione e la registrazione dell’audio.
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Y
Y  Lettera utilizzata come riferimento per il segnale di luminanza.
Y/C  Formato video per componenti che divide il segnale in due parti: Luminanza

(Y) e crominanza (C). Anche chiamato “color under” viene utilizzato per
registrazioni S-VHS e Hi-8.

YUV  Formato video per componenti professionale, che divide il segnale in tre parti;
luminanza (Y); segnale blue meno la la luminanza (B-Y), solitamente
contrassegnato con la lettera U; segnale rosso meno la luminanza (R-Y),
solitamente contrassegnato con la lettera “V”. La componente verde viene
calcolata utilizzando queste tre componenti. (Consultate Component Video, U,
V e Y)


